
Payment and Registration

To change modes of Eudora after you install Eudora, to pay for Eudora, and to register Eudora, do the 

following.

1. From the Help menu, choose Payment & Registration. The Payment and Registration dialog box 

appears.

2. In the Which Eudora is for you? section: 

To use Eudora Email in sponsored mode, click Sponsored Mode (free, with ads). Eudora will display 

the ad window. 

To use Eudora Email in paid mode, click Paid Mode (costs money, no ads). Eudora displays the 

Eudora web site for you to purchase Eudora.

To use Eudora Email in light mode, click Light Mode (free, fewer features). Eudora changes to Eudora 

Email in light mode by turning off certain features.

3. In the Keeping Current section:

To register Eudora, click Register with Us. Eudora takes you to a web site where you can register 

Eudora. It’s good to register because if you are using Eudora in paid mode, you will be eligible for 

technical support..

To customize the ads, click Customize the Ads You See. Eudora displays a web site where you can 

provide information about yourself to help in customizing which ads should be displayed to you.

To find and retrieve the most current version of Eudora, click Find the Latest Versions. The Eudora 

web site displays where you can retrieve the latest version of Eudora.

In the Your Registration Information section, click Change Your Registration to change your 

registration when you change from one Eudora mode to another. The Registration dialog box appears.

Enter the information and click OK.

If you cannot find your Eudora registration code, click I Lost the Code. The Eudora web site appears 

for you to search for your registration code.

4. To exit the window, click the X in the right-hand corner or the window.



Link History

(Sponsored and Paid modes only)

Link History is an option on the Tools menu that displays Internet web site URLs and ads that have appeared in 

Eudora.

To display your link history, do the following.

1. From the Tools menu, choose Link History. The Link History dialog box appears.

2. To view a link in the list, click to highlight it, then click View, or double-click the item. To remove the link 

from the list, click Remove.

If you right-click in the Link History window, a context menu appears.

Copy—copies the link item to the clipboard.

View—displays the link item’s web site page.

Remove—deletes the link item. 

Change Date Display—displays a submenu allowing you to set reminders when to see the link, bookmark the 

link, or sort the link items by date.

Note. The items in this window expire and do not appear after 30 days.



Personality 

Select a personality. This menu includes your <Dominant> personality and any additional personalities you have 
defined for you to select for this message.



Stationery drop-down list 

Selects a stationery file for the new message.



Retrieve new mail

Transfer new mail for the personalities that have the Check mail option turned on in the Personalities Options. 
Or, as specified in the list on the right.



Include Headers

If this is on, the message’s (or the first of multiple messages) header information is included in the saved 
document. If this is not checked, only the body of the message is saved.



Guess Paragraphs

If this is on, extraneous carriage returns are removed from the message(s), leaving returns only at the ends of 
paragraphs and converting multiple spaces into tabs.



Stationery

Save as a stationery file.



Send Queued messages

Send all the queued messages (marked "Q") in your Out mailbox.



Delete messages marked for deletion

Delete the messages on the server that are marked Delete in Eudora. This is for messages that were left on the 
server with the Leave mail on server, Skip messages over _ k, or Fetch all message headers option.

To mark a message Delete, either click on the Trash icon in the message toolbar, or select Delete from the Server 
Action drop-down menu of the message summary.



Retrieve messages marked for retrieval

Retrieve the messages on the server that are marked Fetch or Fetch & Delete in Eudora. This is for messages 
that were left on the server with the Leave mail on server, Skip messages over x k, or Fetch all message 
headers option.

To mark a message Fetch or Fetch & Delete, either click on the icons in the message toolbar, or select an option 
from the Server Action drop-down menu of the message summary.



Delete all messages that have been retrieved

Delete all the messages on the server that have already been transferred to the computer you are on.



Delete all messages on server

Delete all of your messages on the server. Be absolutely sure this is what you want to do because there is no 
way to undo it.



Fetch all message headers to In mailbox

Retrieve the header and the first few lines of every new message. If you select this option, the messages are 
filtered but Copy and Transfer actions are not done (the message won’t leave the In mailbox). Set the Server 
Action in the message summaries to specify what you want to do with the messages the next time you check mail.

Important:    If you delete the message header, and you have the Delete from server when emptied from Trash 
option on in the Checking Mail Options, the message is gone completely from Eudora and the server.



Apply Options to Personalities

Specify the personalities that you want to use with this mail transfer (hold down the Shift key to select multiple 
personalities in sequence, or the Ctrl key to select them out of sequence).



Find dialog

Use this dialog box to find a character string within one message.



Find

Initiates a new search in a current message.



Next

Continues a search until the character string is found in either the same message or one of the other messages in 
the current mailbox.



Next Message

Begins a search at the next message following the current message.

Eudora continues the search even if it has to open more than one message or a new mailbox.



Next Mailbox

Begins the search at the next mailbox following the current mailbox.

Eudora continues the search among all messages in that mailbox and any subsequent mailboxes, including the In, 
Out, and Trash mailboxes.



Character String Field

Specifies the character string to be found.

You can type the string into this field or highlight the character string you want (somewhere in Eudora), then select 
Enter Selection from the Find submenu. This automatically inserts the highlighted string into this field.



Match Case

When this is checked, Eudora searches for exact matches of the character string, including any capitalization.



Summaries Only

When this is checked, Eudora searches only the Sender and Subject fields of message summaries as they appear 
in mailbox windows. (This is much faster than a full search).



Checking Spelling dialog

Use this dialog box to check for misspellings in the body of current message composition windows, text files, and 
signature files. It includes a built-in dictionary and also allows for the creation of a custom user dictionary.

You can set the spell checker to ignore capitalized words, words with numbers, and mixed case words, to report 
mixed case and doubled (repeated) words, and to suggest alternative spellings.



Unknown

The unknown word is one that is not found in Eudora's    dictionary or your own custom dictionary. You can act on 
an unknown word using the buttons in this dialog box.



Change To

Gives a suggestion for the correction, and lets you enter your own text if the suggestion does not work. You can 
also click on a suggestion in the Suggestions field and it will be entered in the Change To field.

To change the unknown word to the text in the Change To field, click on the Change or Change all button.



Suggestions

Lists suggestions for the correct spelling of the unknown word.

If the Always Suggest option is turned on (click on Options to see what options are on), all suggestions are listed 
here by default. If the option is turned off, click the Suggest button to display the suggestions.



Ignore

Leaves this occurrence of the unknown word as it is and continues the spelling check.



Ignore all

Leaves all occurrences of the unknown word as they are and    continues the spelling check.



Change

Changes the unknown word to the text in the Change To field.



Change all

Changes every occurrence of the unknown word to the text in the Change To field.



Suggest

Displays in the Suggestions field all the suggestions for the correct spelling of the unknown word. If there are no 
suggestions in the dictionary, then none are listed.

If you want the suggestions displayed automatically, click on the Options button and turn on the Always Suggest 
option.



Add

Adds the unknown word to your custom dictionary.



Edit Dictionary

Displays the Edit User Dictionary dialog box so that you can add or delete words or clear your dictionary.



Edit User Dictionary dialog

Use the User Dictionary dialog box to add words to or delete words from your dictionary, or to clear the entire 
dictionary.



Word

Specifies what word is to be added or deleted from your dictionary.

You can type this into the field, or select a word from the dictionary.



Dictionary

Lists the words in your dictionary.



Add

Adds the word in the Word: field to your dictionary.



Delete

Deletes the word in the Word: field from your dictionary.



Clear

Clears the dictionary so that it is left empty.



Options

Displays the spell checking Spelling Options dialog box so that you can set your spell checking options.



Spelling Options (Checking Spelling Options)

Lists the six spell checking options. A check mark in the box next to the option name indicates that it is turned on.



Ignore capitalized words

If this is checked, words that start with capital letters are ignored.



Ignore words with numbers

If this is checked, words that contain numbers are ignored.



Ignore words with mixed case

If this is checked, words that contain both upper and lower case characters are ignored.



Report words with mixed case

If this is checked, words that contain both upper and lower case characters are reported and identified as Mixed 
case.



Report doubled words

If this is checked, words that appear twice in sequence in text are reported and identified as Doubled words.



Suggest words (Checking Spelling Options)

If this is checked, Eudora's suggestions for the correct spelling of an unknown word are displayed in the 
Suggestions field by default.



New Mailbox dialog

Use this dialog box to create a new mailbox.



Name the new mailbox

Enter the name of the new mailbox.



Make it a folder

If this is checked, the new mailbox is created as a folder.

The New Mailbox dialog box appears again so that you can create a mailbox that goes into the folder.



Don’t Transfer

If this is checked, the new mailbox is created but the selected messages are not transferred into it.



Change Queueing...

Use this dialog box to queue the current messages, unqueue messages, or set a time for queued messages to be 
sent.



Send Message:

These options specify when the selected messages should be sent.



Right Now

Sets the message to send immediately when you click the OK button.



Next Time Queued Messages are Sent

Sets the message to be sent the next time queued messages are sent.



On or after

Sets a time and date for the message to be sent.

The message is saved in the Out mailbox with a clock icon in the status column, just as if it were a normal 
queued message. However, the message is not sent until the specified time. For the message to be sent at the 
correct time, Eudora must be running at that time. If Eudora is not running then, the message is sent when Eudora 
is opened.



Time

Specifies what time the message will be sent.

Change the default time if you want the message to be sent at a different time. The message is saved in the Out 
mailbox with a clock icon in the status column, then sent at the specified time. For the message to be sent at the 
correct time, Eudora must be running at that time. If Eudora is not running then, the message is sent when Eudora 
is next opened.



Date

Specifies what date the message will be sent.

Change the default date if you want the message to be sent at a different date. The message is saved in the Out 
mailbox with a clock icon in the status column, then sent on the specified date. For the message to be sent at the 
correct time, Eudora must be running at that time. If Eudora is not running then, the message is sent when Eudora 
is next opened.



Don't Send

Changes the message status from queued to saved.



Change Password

Change the password for the selected account (personality).



Change Password

Enter the password for the selected account.



Filters

The Make Filter dialog box lets you create quick, simple filters that perform one operation—a mail transfer 

based on one match condition—a piece of header information. The Filters window lets you create more 

complex, powerful filters that use multiple match conditions and perform multiple filter actions. (You can also 

use the Filters window to create simple filters such as those created by the Make Filter dialog box.)

Note: To toggle from the left and right window panes, press F6.

To create or modify a detailed filter, do the following:

1. Click the New button or select an existing filter.

2. Choose the options for how you want the filter to be used, as an automatic filter to be invoked on any 

Incoming and/or Outgoing mail, and as a Manual filter that can be invoked when you choose Filter 

Messages from the Special menu. Any combination of these options works.

3. Define the criteria for the filter; use the header item pop-ups and the text fields to specify which header 

items should include a particular string of text. You can define two related terms for the criteria so that your 

filter is as specific as possible. 

4. Define the action or actions to be taken on messages that fit the and save the filters. 

Some filter actions have an associated icon. For these actions, Eudora places the action icon next to the filter in 

the filters list. Up to five icons can appear per filter.

The Actions options are as follows:

None ¾ No action.

Make Status ¾ Assigns the selected status to message summaries.

Make Priority ¾ Assigns the selected priority level to messages. If you select a set level, messages are set to 

that priority. If you select Raise or Lower, messages are raised or lowered one priority level based on their pre-

filter level.

Make Label (Sponsored and Paid modes only)¾ Assigns the selected label to messages. Label colors and 

names are set in the Labels options panel.

Make Personality (Sponsored and Paid modes only) ¾ Assigns the selected personality to messages. For 

outgoing messages, the message is sent from the assigned personality. For incoming messages, all your 

responses to the message will be from the assigned personality until you change the personality associated 

with the incoming message or your response.

Make Subject ¾ Assigns the new subject to message summaries (does not affect the subject in the message 

itself). If you choose this option, the entire subject of the message is replaced with the new subject. Use the "&" 

symbol to stand for the old subject if you want to add the new subject to the old subject. For example, entering 

New Subject [was &] results in New Subject [was Old Subject].

Play Sound ¾ Plays the selected sound when messages are filtered.

Speak (Sponsored and Paid modes only)¾ A voice makes you aware when a certain email message is 

retrieved. The voice can read the name of the sender and the subject line of the message, if you so choose. 



Also, you can select the type of voice you prefer from a drop-down list that appears. After you select Speak, the 

Who and Subject fields and a drop-down voice list appear. If these fields are grayed out, you must install 

Microsoft’s Text to Speech Engine applications. Click www.microsoft.com/IIT/download/speechengines.htm 

Open (Sponsored and Paid modes only)¾ Opens the Mailbox and/or Message when a message is received. If 

you set a previous action to filter messages into a mailbox, then that mailbox is opened.

Print (Sponsored and Paid modes only)¾ Prints one copy of each message.

Notify User (Sponsored and Paid modes only)¾ Notifies you As Normal and/or In Report when messages are 

received. The As Normal option notifies you based on the options you have selected in the Getting Attention 

options panel. The In Report option notifies you by opening the Filter Report window and displaying in that 

window a filter report that details what filter actions have been done. 

Notify Application ¾ Notifies the selected application when messages are received, and provides information 

from the message. Specify the application to use and the part of the message to be included.

Use the Browse button to select an application, or enter the command line yourself. The command line should 

include the path to the executable, any options, and the following substitution variables, all separated by blank 

spaces:

%1 Date

%2 To

%3 From

%4 Subject

%5 Cc

%6 The entire message

For example, the command line to send the subject of a message to a pager might look like this:

C:\apps\pager.exe -c %4

Forward To (Sponsored and Paid modes only)¾ Forwards messages to the email address given. Forwarded 

messages are placed in the queue in the Out mailbox, and sent the next time you send queued messages.

Redirect To (Sponsored and Paid modes only)¾    Redirects messages to the email address given. Redirected 

messages are placed in the queue in the Out mailbox, and sent the next time you send queued messages.

Reply with ¾ Replies to messages with the selected stationery message. Replies are placed in the queue in 

the Out mailbox and sent the next time you send queued messages. One typical use of this action is to reply to 

specific senders with stationery telling them that you’re on vacation: "I’m out till the 10th. I’ll reply to your 

message when I get back." 

Server Options (Sponsored and Paid modes only)¾ Sets the message’s server status to Fetch and/or Delete 

(incoming server only). The Fetch option specifies that the entire message be transferred from the server the 

next time mail is checked, and the Delete option specifies that the message be deleted from the server the next 

time mail is checked. If you select both, the message will be transferred and deleted.

Copy To ¾ Copies messages to the selected mailbox.

Transfer To ¾ Transfers messages to the selected mailbox.



Skip Rest ¾ Stops filtering for the message (the message is not matched to the rest of the filters in the filter 

list).

When the filters are invoked (automatically or manually), each message is matched against each filter in order 

from top to bottom. If the message meets a filter’s criteria, the actions are done as specified until there are no 

more actions, then the message is matched against the next filter. If at any point a Skip Rest action is done, 

nothing else is done with that message, and the next message is filtered.

You can change the width of the filters list to create more or less space for your list. To do this, put the arrow 

over the bar to the right of the list and drag the line to the left or right. 



Filter List

Displays the filters you have defined.

Filters are invoked from top to bottom. This order may be important when overlapping matches exist.



Up

Moves the selected filter up in the filter list, changing the order it is invoked.



Down

Moves the selected filter down in the filter list, changing the order it is invoked.



New

Adds a new filter named "Untitled" to the filter list. The filter is named automatically based on the information you 
enter in the Header and Matching Text fields.



Remove

Removes the selected filter from the filter list. The filter is deleted when you save changes to the Filters window.



Incoming

If this is checked, the filter is invoked on all incoming messages.



Outgoing

If this is checked, the filter is invoked on all outgoing messages after they are sent.



Manual

If this is checked, the filter is invoked only when you select Filter Messages from the Special menu.



Header

Specifies which section of the message the filter will search. You can select an option from the drop-down menu or 
enter one yourself. This is helpful if you want to use a header item that does not appear on the menu, such as X-
Persona (for an alternate personality).

The «Any Recipient» option searches all possible recipient items (To, Cc, Bcc), the «Any Header» option 
searches all message headers (including hidden headers that are shown with the Blah Blah Blah option), and the 
«Body» option searches the message body.



Match

Specifies the type of match the filter performs when comparing the character string to the specified header.

contains or does not contain
If the specified header item contains or does not contain the text string, filter the message.

is or is not
If the specified header item is or is not a complete match of the text string, filter the message.

starts with or ends with
If the specified header item starts with or ends with the text string, filter the message. The starts with item refers 
to the first non-whitespace character after the colon, so any spaces after the colon are ignored.

appears or does not appear
If the header item appears or does not appear in the message, filter the message (the text field is ignored). This is 
useful for filtering messages based only on the types of fields they contain.

intersects nickname
If the text string is included in a nickname (whether it is a full address or a nickname within the nickname), filter the 
message.

doesn’t intersect nickname

If the text string is not included in a nickname, whether it is a full address or a nickname within the nickname, filter 
the message.

intersects address book

If the text string or nickname is included in any one of your address books, whether it is a full address or a 
nickname within the nickname, filter the message. In other words, the filter looks in all of your address books for all 
nicknames. If the nickname that appears in the header of the message is in the address book, Eudora filters the 
message accordingly. This match criterion is good to use if you wish all messages that are not from the entries in 
your address book to go in other mailboxes. This is an alternate method to control SPAM. 

doesn’t intersect address book

If the text string or nickname is not included in an address book, whether it is a full address or a nickname within 
the nickname, filter the message. 

matches regexp (case insensitive) (Sponsored and Paid modes only)

If the specific item matches the regular expressions characters with no case sensitivity, filter those messages.

Note. Regular Expressions is an advanced and complex method of searching for text. 

Regular Expression is a search string that uses special characters to match text characters. For example, if you 
are filtering messages sent to you by two people, choose From in the first drop-down options list, then choose 
matches regexp, then type their usernames between parentheses separated by a vertical slash, for example 
(bobclark)|(janedoe)in the text box. Eudora searches and displays all messages from these two people. 

matches regexp

If the specific item matches the regular expressions characters, filter those messages. 



Matching Text

Specifies the character string that the filter searches for.

Keep this as specific and brief as possible. The more complex the search is, the less the likelihood of an exact 
match.



Conjunction

Specifies how the second criteria is to be used.

ignore
Ignore the second term; if the message matches the first term, filter the message.

and
If the message matches both the first and second terms, filter it.

or
If the message matches either term, filter it.

unless
If the message matches both the first and second terms, do not filter it. (This lets you exclude certain variations of 
the first term.)



Filter Actions

None (Filter Action) ¾ No action.

Make Status ¾ Assigns the selected status to messages. Select a status from the drop-down menu.

Make Priority ¾ Assigns the selected priority to messages. Select a priority from the drop-down menu.

Make Label (Sponsored and Paid modes only)¾ Assigns the selected label to messages. Select a label from 

the drop-down menu.

Make Subject ¾ Assigns the subject to messages. Enter a subject in the text field. The new subject is given in 

the message summary in the mailbox window, but the subject is not changed in the message itself. To include 

the text of the previous subject in your new subject, use the "&" symbol. For example, typing test message:& in 

this field results in the subject test message:previous subject.

Play Sound ¾ Plays the selected Sound when messages are received. Select a sound using the file dialog box 

from the Sound button.

Speak (Sponsored and Paid modes only)¾ A voice makes you aware when a certain email message is 

retrieved. The voice can read the name of the sender and the subject line of the message, if you so choose. 

Also, you can select the type of voice you prefer from a drop-down list that appears. After you select Speak, the 

Who and Subject fields and a drop-down voice list appear. If these fields are grayed out, you must install 

Microsoft’s Text to Speech Engine applications. Click www.eudora.com/download/other. 

Open (Sponsored and Paid modes only)¾ Opens the Mailbox and/or Message when a message is received. If 

you set a previous action to filter messages into a mailbox, then that mailbox is opened.

Print (Sponsored and Paid modes only)¾ Prints one copy of each message.

Notify User (Sponsored and Paid modes only)¾ Notifies you As normal and/or In report when messages are 

received. The As normal option notifies you based on the options have selected in the Getting Attention 

Options. The In report option notifies you by displaying a Filter Report that details what filter actions have been 

taken.

Notify Application ¾ Notifies the selected application when messages are received, and provide information 

from the message. Specify the application to use and the part of the message to be included. Use the Browse 

button to select an application, or enter the command line yourself. The command line should include the path 

to the executable, any options, and the following substitution variables, separated by blank spaces:

%1 Date

%2 To

%3 From

%4 Subject

%5 Cc

%6 Filename (will contain the entire message)

For example, the command line to send the subject of a message to a pager might look like this:

C:\apps\pager.exe -c %4



Forward To (Sponsored and Paid modes only)¾ Forwards messages to the email address. Enter an email 

address in the text field. Forwarded messages are placed in the queue in the Out mailbox, and sent the next 

time you send queued messages.

Redirect To (Sponsored and Paid modes only)¾ Redirects messages to the email address. Enter an email 

address in the text field. Redirected messages are placed in the queue in the Out mailbox, and sent the next 

time you send queued messages.

Reply With ¾ Replies to messages with the selected stationery file. Select a stationery file from the drop-down 

menu. Replies are placed in the queue in the Out mailbox, and sent the next time you send queued messages.

Server Options (Sponsored and Paid modes only)¾ Assigns the selected server actions to messages 

(incoming server only). The Fetch option specifies that the entire message be transferred from the server the 

next time mail is checked, and the Delete option specifies that the message be deleted from the server the next 

time mail is checked. If you select both, the message will be transferred and deleted.

Copy To ¾ Copies messages to the selected mailbox. Select a mailbox from the drop-down menu.

Transfer To ¾ Transfers messages to the selected mailbox. Select a mailbox from the drop-down menu. If you 

add a new Transfer To action, a dialog box appears asking if you want to add an implied Skip rest action. If 

you do not, subsequent actions in that or other filters could cause the message to be transferred out of the first 

mailbox you transferred it to.

Skip Rest ¾ Stops filtering for the message (the message is not matched to the rest of the filters in the list).



Mailboxes Window

The Mailboxes window lets you create new mailboxes and folders, remove and rename them, and move 

mailboxes among folders. Mailboxes or folders that are bolded have unread messages.

By default, the Mailboxes window is provided as the first window in a five-window tool group docked vertically to 

the left side of the main Eudora window.

To open a mailbox or folder within the window, double-click it, or click it once and press Enter. You can move 

among the folders and mailboxes using the up and down arrow keys, or close or open folders using the left and 

right arrow keys. You can also start typing the name of the mailbox or folder you want, and it is highlighted 

when you have typed enough unique characters to identify it (the item must be displayed, so a mailbox that is in 

a closed folder cannot be selected).

Right-click any item in the Mailboxes window and a pop-up menu appears whose commands let you, 

depending on the item, create, remove, and rename mailboxes and folders, open existing mailboxes and 

folders, and empty the trash from the Trash mailbox.

Note: Try not to keep too many messages in your In, Out, or Trash mailboxes    because it can slow down your 

system’s performance. However, you can transfer messages from your In and Out boxes to other mailboxes 

and delete messages from you Trash box on a regular basis.

The folder trees displayed in the Mailboxes window, and some of the operations available from the pop-up 

menu, depend on whether your incoming mail server for one or more mail accounts uses the POP or the IMAP 

protocol. 
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To create a new mailbox or folder in the Mailboxes window, do the following:

1. Right-click on the folder. A pop-up menu appears.

2. From the pop-up menu, choose New. A dialog box appears requesting the name of the new mailbox or 

folder.

3. Type in the new name, check the Make it a folder option if you want to, and click OK. If you chose to make 

it a folder, enter the name of the mailbox when the dialog box appears again, and click OK. The new 

mailbox or folder appears in the lists, and is added to the Mailbox and Transfer menus.

To rename a mailbox or folder, do the following:

1. Click the mailbox or folder name once, pause, then click again to highlight just the name. 

2. Type in the new name. Or, right-click the item and choose Rename, or click once on the item and press F2, 

then type in the new name. 

3. Press Enter to accept your change, or Esc to cancel it.

To move a mailbox from one folder to another, in the Mailboxes window select the one you want to move and 

drag it to where you want it.

To remove a mailbox or folder, either right-click it and choose Delete from the pop-up menu, or click once on it 

to highlight it and then press the Delete key.

If you choose to remove a mailbox in which messages are still stored, or a folder in which other mailboxes or 



folders are stored, you are prompted to confirm the deletion for each such item selected. Click Remove it to 

delete the current item for which you are being prompted, or click Remove all to remove all items selected for 

deletion—no further prompts will appear. Or click Cancel to cancel the deletion. If you delete a non-empty 

mailbox or folder, all messages, mailboxes, and folders contained within the mailbox or folder are also deleted.



Address Book Files and Entries

Lists all your Address Book files and entries.

Files are shown as book icons and can be opened and closed by double-clicking on them.

· To select multiple files and entries, hold down the Shift key and make selections in sequence, or hold down the 
Ctrl key and make selections out of sequence.

Lists all your Address Book files and entries.

· To open and close an Address Book file (shown as a book icon), double-click on it.

· To select multiple files and entries, hold down the Shift key and make selections in sequence, or hold down the 
Ctrl key and make selections out of sequence.



View By

Determines how the Address Book entries are displayed in the list-by Nickname, Full Name, Last Name, First 
Name, Address, Name, Postal address, Phone, Fax and so on.



New (Address Book)

Creates a new address book entry.

A new highlighted entry appears on the list. Type in the new address book name. You can also put the entry on the 
Recipient List.



Delete (Address Book)

Removes a selected entry or address book from the list.



To (Address Book)

Creates a new message addressed to the selected entry, or adds the selected entry to the active message.

To select multiple entries, hold down the Shift key and make selections in sequence, or hold down the Ctrl key and 
make selections out of sequence.

You can also drag selected entries to the recipient fields of open messages.



Cc (Address Book)

Creates a new message CC’d (carbon copy) to the selected entry, or adds the selected entry to the active 
message.

To select multiple entries, hold down the Shift key and make selections in sequence, or hold down the Ctrl key and 
make selections out of sequence.

You can also drag selected entries to the recipient fields of open messages.



Bcc (Address Book)

Creates a new message Bcc’d (blind carbon copy) to the selected entry, or adds the selected entry to the active 
message.

To select multiple entries, hold down the Shift key and make selections in sequence, or hold down the Ctrl key and 
make selections out of sequence.

You can also drag selected entries to the recipient fields of open messages.



Expand Nickname

If this is checked, the full address(es) are inserted into the message address fields (instead of the nickname) when 
you use the To, Cc, or Bcc buttons.



Nickname

The Nickname for the entry.



Recipient List

If this is checked, the nickname is included in the Recipient List.

To put multiple entries on the Recipient List, select the entries then check this option for any one of them.



Address(es)

The email addresses that are included in the nickname.

You can use full addresses and nicknames in this field, just be sure any nicknames you use are defined in another 
entry. Separate each address or nickname with a comma or a carriage return (Enter). This is the only place you 
can use a carriage return to separate addresses.

If you do not have a Name defined for the entry (in the Info tab), all of the addresses in this field will be included in 
outgoing mail.



Name

This is the name of the entry.

If there is more than one address for an entry, only the Name is given in the To field of outgoing messages, not the 
list of addresses. This is similar to Bcc, because the recipient list is hidden to each recipient.



Postal Address

This is the postal address the entry. This information is not included in an outgoing message.



Phone

This is the phone number for the entry. This information is not included in an outgoing message.



Fax

This is the fax number for the entry. This information is not included in an outgoing message.



New Nickname

The New Nickname dialog box lets you create a new entry for your Address Book.



What do you wish to call it?

This is the nickname for the new entry.



File

The file that the entry should go into.

This option is not available if you select the Make it an address book option.



Put it on the recipient list

If this is checked, the entry is included in the recipient list.



Make it an address book

If this is checked, a file is created instead of a new entry.



Directory Services

Use Directory Services to access two different directory services, for example Ph and Finger.

Certain directory service inquiries will only work if you have the appropriate software running on your server.



Server field

Lists the server from the Server field of the Hosts Options dialog box.

You can enter a different server name for this session. The next time you open the window, the server will be reset 
to the name in the Options dialog box.



Command

Specifies the name or address being searched for, whether you will use Ph or Finger.



Response

Displays the server or host response.



Ph

Initiates a Ph query for the text in the Query field.



Finger

Initiates a Finger query for the text in the Query field.



To

Adds the selected query results to the To field of a new message (opens a new message if necessary).



Cc

Adds the selected query results to the Cc field of a new message (opens a new message if necessary).



Bcc

Adds the selected query results to the Bcc field of a new message (opens a new message if necessary).



Keep on top

If this is on, when you use the To, Cc, or Bcc buttons the Directory Services windows stays active (on top of the 
message window).



Signature Name

The name of the new signature you are creating.



Real Name

The real name assigned to this email account: generally a first and last name. The text you enter here is included 
in the From field of all your outgoing messages from this account, and identifies to your recipients whom the mail 
is from.



Return Address

The return email address used in outgoing messages and your recipients' replies for this account, if the address is 
different from this personality's incoming email account. The address you enter is included in the From field of all 
your outgoing messages from this account, and when a recipient replies to a message from this personality, the 
reply is sent to this address. If you do not enter an address in this field, Eudora uses the personality's incoming 
email account as the return address. Note: If you do enter an address in this field, first test the address to be sure 
that mail sent to it is indeed delivered to you. If you use an invalid return address, no one will be able to reply to 
your mail sent from this personality.



Login Name

This is the name you use to log in to this email account, if the account requires a user login. Login names 
generally consist of the text before the at sign (@) in your return address or incoming email account. For example, 
in the return address beatrixp@qualcomm.com, the login name is beatrixp.



SMTP Server

This is the name of the outgoing mail server for this account. SMTP stands for Simple Mail Transfer Protocol. 
Outgoing messages you send are routed through this server. If the computer that this personality's incoming mail 
account is on also runs an SMTP server, you can leave this field blank. Otherwise, enter the full name of the 
computer running the SMTP server.



Default Domain

This is the domain name that Eudora automatically adds to an unqualified name addressed in messages sent from 
this account. An unqualified name is a name that doesn't have an "@" sign followed by a domain name. This can 
be used to save time when addressing large numbers of messages to users in the same domain.



Default Stationery

The default stationery to use for all outgoing messages sent from this account. Select a stationery file from the 
drop-down menu, or select <No Default> for no default stationery. See the User Manual for details on using 
stationery with alternate personalities.



Default Signature

This sets the default signature to use for all outgoing messages sent from this account, but only when you are not 
using stationery (that is, only when the Default Stationery drop-down menu in this dialog box is set to <No 
Default>). If you have chosen a stationery file in the Default Stationery field, then the signature saved with that 
stationery will override your setting here.

Select a signature from this drop-down menu, or select <No Default> for no default signature. If you select a 
signature, Eudora automatically attaches that signature to the end of all outgoing messages sent from this 
account. You can always change the signature in a particular outgoing message using the Signature drop-down 
menu in the composition window. See the User Manual for more details about using signatures with alternate 
personalities.



Check Mail

If this option is on, then mail checking is activated for this account in the following ways:

If you have specified a number in the Check for mail every _ minutes option in the Checking Mail Options, then 
when automatic mail-checks are performed at these intervals, mail for this account is checked too.

Each time you do a manual check for mail, by selecting the Check Mail command from the File menu or via 
another method, mail is checked for this account too.

If this option is off, then mail for this personality is not checked during manual or automatic mail-checks, except 
that you can override the setting and still check for the personality's mail using the Mail Transfer Options dialog 
box (POP account only) or the Check Mail command on the drop-down menu displayed by right-clicking in the 
Personalities window.



Transfer to New Mailbox

Click this button to transfer the filtered message to a new mailbox that you will specify. The text field is filled in 

with a suggested new-mailbox name based on your selected content match condition (From, Any Recipient, or 

Subject). You can change this name if you like.



Transfer to Existing Mailbox

Click this button to transfer the filtered message into one of your existing mailboxes. Select the mailbox from 

the button next to the field. The default mailbox is the In box. When you click the button, a version of the 

Transfer menu appears, letting you choose the mailbox from the Transfer menu.



Delete Message

Click this button to delete the message that satisfies the filter match conditions, transferring it to your Trash 

mailbox. This feature is useful for deleting junk email, or "spam" as it is called in the Internet world.



From

If you are making a filter from an existing email message, the sender of the email’s name and email address is in 
this field. You can modify this field. For example, if you want all messages from this person to go to a specific 
mailbox, just leave this field as is.



Any Recipient

This field searches all possible recipient items. The default is your name and email address. You can change the 
name in this field. For example, if you want mail to this recipient other than you to be placed into a specific 
mailbox, enter the name and email address of that person in this field.



Stationery

Stationery files are templates for outgoing messages. If you find yourself repeatedly sending the same 

message, save the message as a stationery file and send it whenever you need to with the New Message With 

or Reply With commands. This way you don’t have to copy and paste text into a message; you can just open a 

pre-written message and edit it as necessary.

The Stationery window displays a single-column list of your stationery files.

Note: You can select only one item at a time in the list; you cannot select multiple items.

If you right-click a stationery item in the list, a context menu appears with the following commands (the standard 

Eudora window-management commands appear at the bottom):

• New — Create a new piece of stationery (a new stationery file). An untitled stationery window opens; enter 

the stationery name and from the File menu, choose Save As Stationery.

• Edit — Open an editing window for the selected stationery item. Make your changes and from the File menu, 

choose Save As Stationery, or close without saving to discard your changes.

• Delete — Delete the selected stationery item. Eudora asks you to confirm the deletion. Use the Del key 

(Delete) as a shortcut for this command.

• Rename — Rename the selected stationery file. Use the F2 key as a shortcut for this command, or click the 

stationery file’s name box, then edit the name right in the box.

• New Message With — Create a new message with the selected stationery. As a shortcut for this command, 

either select the stationery item and press Enter, or just double-click the stationery item.

• Reply With — Reply with the selected stationery to the sender(s) of the received messages that are currently 

selected.

• Reply to All With — Reply with the selected stationery to the sender(s) and all recipients of the received 

messages that are currently selected.

You can also display the context menu and create new stationery by right-clicking anywhere in an empty 

Stationery window or by right-clicking anywhere off a stationery item in a non-empty Stationery window. 



Signatures

A signature is a few lines of text that is added automatically to the end of an outgoing message when it is sent. 

A signature can be whatever you want, but it is mostly used to give contact information (telephone, address, 

etc.). You use only one signature at a time in a message, but you can create as many different signatures as 

you want.

You can choose to show or hide your signature when composing a messages. From the Options menu, go to 

the Composing Mail options window. You can turn the Show signature when composing option on or off. 

The Signature window displays a single-column list of your signature files.

Note: You can select only one item at a time in the list; you cannot select multiple items.

If you right-click a signature in the list, a context menu appears with the following commands (the standard 

Eudora window-management commands appear at the bottom):

• New — Create a new signature. Eudora prompts you for the name of the new signature, then opens an 

editing window for you to type the signature text. Save the text with the File menu Save command, or close 

without saving to discard.

• Edit — Open an editing window for the selected signature. Double-click a signature as a shortcut for this 

command. Save your changes with the File menu Save command, or close the window without saving to 

discard your changes.

• Delete — Delete the selected signature. Eudora asks you to confirm the deletion. Use the Del key (Delete) as 

a shortcut for this command.

• Rename — Rename the selected signature. Use the F2 key as a shortcut for this command, or click the 

signature item’s name box, then edit the name right in the box.

You can also display the context menu and create a new signature by right-clicking anywhere in an empty 

Signature window or by right-clicking anywhere off a signature item in a non-empty Signature window.



Address Book

The Address Book is where you keep information about individuals or groups that you correspond with. Each 

entry in the Address Book includes a nickname for a person or group, their full email addresses, a real name, 

any contact information, and any notes. You can also use the Address Book to put nicknames on the Recipient 

List, and to address a new message.

You can use the View By option to display the entries using any of the fields except the Notes field. For 

example, if you want to view the entries by nicknames, choose View By Nickname.

You can perform a search for any entry in your address book. Press Ctrl+Shift+F or from the Edit menu, choose 

Text, then Find Text. In the Find dialog, enter the nickname of the person you are searching for. That person’s 

file appears.

You can also start typing in the list of entries, and the appropriate entry will be selected when you enter enough 

unique characters to identify it.

To create a new entry or entries to be included in the address book, do the following:

1. From the Tools menu, choose Address Book, or press Ctrl+L. Or, if the Address Book is an inactive 

window in an open tabbed window group, click its tab.

2. In the Address Book, choose which address book (if more than one is set up) in which you want this 

person’s information listed, for example "Family." 

3. Either click New in the Address Book, or right-click anywhere in the entry list to display the drop-down list 

and choose New. A new entry appears in the address book column (left side). To add a new address book, 

click New Book.

4. In the Nickname field (right side of window), enter what you want to call this person or address book. 

A nickname, sometimes called an alias, is an easily remembered, shorter substitute for the email address 

in the entry. Nicknames can be used in place of proper email addresses in the To, Cc, and Bcc header 

fields of outgoing messages. A nickname entered here should be the name you wish to type in a header 

field (To, Cc, Bcc) when composing an email message. For example, although your Dad's name is John 

Smith, you can enter "Dad" as the nickname. So when you address a message, you can just enter "Dad" in 

the header field.

You cannot use the actual email address as the nickname. It must be different.

5. If you want the nickname on your recipient list, check the Recipient list box. Once the person is on the 

recipient list, the name is bolded in the address book list. 

6. To create the entry, click anywhere or press Enter. 

7. Click the Personal tab. The Personal dialog appears.

8. In the Full Name field, type the real name or an informal name for the person. If there is just one address 

for the entry, this name and the address are included in the "To:" field for your recipient to see.

9. In the First Name and Last Name fields, type the first and last name of the person. You can interchange 

the first and last names by clicking Swap.



10. In the This nickname will expand to the following addresses text field, enter at least one complete 

email address for this person. If this person has more than one address, enter the additional addresses 

here if you want him or her to receive your messages at each address. 

Make sure this field contains no other information except addresses and nicknames, or your messages will 

be addressed incorrectly.

It is recommended that you have no more than 2,000 nicknames per nickname file. If the files are too large, 

they may appear collapsed in the address book, but you can still use all the nicknames when addressing 

messages. If you have a large number of entries, you might want to consider using a Ph or LDAP server.

11.    You may continue adding Home, Work, Other, and Notes information by clicking on the appropriate tabs.

12.      To save your changes to the Address Book, from the File menu choose Save.

Note: To toggle from the left and right window panes, press F6.

To include a nickname in the Recipient List, do the following:

§ Right-click the appropriate Address Book entry in the list and from the pop-up menu, choose Add to 

Recipient List. The nickname for the selected entry is included on the Quick Recipient List, and the entry is 

bolded in the Address Book list.

To remove a nickname from the Quick Recipient List, do the following:

§ Right-click the item in the Address Book list and from the pop-up menu, choose Remove From Recipient. 

The nickname for the selected entry is removed from the Quick Recipient List, and the entry is unbolded in 

the Address Book list.

If you change a nickname, the Quick Recipient List is updated as appropriate. 

Note: You can add or remove multiple nicknames to or from the Quick Recipient List by selecting multiple 

entries before right-clicking. Hold down the Shift key to select multiple entries in sequence, or the Ctrl 

key to make non-consecutive selections.



Directory Services

Eudora lets you look individuals up on the Internet, within your company, and in your Eudora Address Book (if 

you have one set up) using four directory service protocols: Ph, Finger, LDAP (Lightweight Directory Access 

Protocol), and Eudora Address Book.

The directory service protocols available to you for your search are listed in the Protocols section of the window. 

The Protocols section of the Directory Services window lists the directory service protocols available to you that 

you can use when creating and modifying databases for looking up individuals via these services.

Note: The Eudora Address Book protocol does not appear in the list until you have created an Address 

Book in Eudora.

To sort the protocols alphabetically, click the column heading (Registered Drivers). Shift-click the column 

heading to sort in reverse order.

You can resize the column by dragging the divider line to the right of the column heading to the left or right.

The databases you can use to look up your target individual are listed in the Databases list. The Databases 

section of the Directory Services window lists the databases that are available to you for searching for 

individuals over the Internet, within your company, or in your Address Book (if one is set up).

Eudora comes with these servers already configured by default:

• ldap.bigfoot.com

• ldap.switchboard.com

• ldap.whowhere.com

• ldap.infospace.com

• ldapbiz.infospace.com

• ldap.four11.com

• Eudora Nicknames [or the name of your nicknames file; this last item appears only if you have a Eudora 

Address Book set up]

You can modify or delete these databases, and you can also create new databases and modify and delete 

them. 

You use the databases in this list to perform your lookup queries. To perform a query, you must first select one 

or more databases in the list. To select a database, click the checkbox to the left of the database name, until a 

checkmark appears in the box. If no databases are selected, you cannot perform a query.

You can select multiple databases to perform a query, and you can mix protocols.

Click a column heading to sort this list by that column, alphabetically. Shift-click the column heading to sort in 

reverse order.

To look someone up on the Internet, within your company, or in your Eudora Address Book, do the following:

1. In the Databases list, select the database(s) you want to search in your query.



To select a database, click the checkbox to the left of the database until a checkmark appears in the box. You 
can select multiple databases, and you can use multiple protocols. You must select at least one database 
in the list in order for Eudora to perform the query. 

Note: Eudora remembers which databases you’ve selected when you quit and restart the 

program.

3. In the Query field, type a text string you want to search against.

If one or more of your selected databases use a protocol other than Ph, your entry in this field will always 

be interpreted as a name. If you only have Ph servers selected as your databases, you can enter any 

commands that Ph will interpret.

4. After you’ve typed the text, start the query by pressing Enter or clicking the Start button.

The query begins, and the Start button changes to Stop.

5. To stop the query before it is completed, click the Stop button.

When the query is completed, or if you click Stop to cancel the query, the Stop button changes back to Start.

To resize columns, position the mouse pointer over the divider line to the right of the desired column, and drag 

the line to the left or right.



Filter Report

If the Generate Filter Report option is turned on in Getting Attention options panel found in Options under the 

Tools menu. So when filters are used, Eudora generates a filter report. This report can be viewed in the Filter 

Report window found under the Tools menu.

If filter report generation is enabled via the option mentioned above, then each time a filter operation is 

performed, Eudora adds the entry or entries to the Filter Report window and activates the window.

The Filter Report window displays three columns of data:

• Mailbox — Lists the names of the mailboxes into which messages have been filtered during the current 

Eudora session. Each listing represents one filter operation for that mailbox.

• Messages — For each mailbox listed in the Mailbox column, lists the number of messages filtered into that 

mailbox during the filter operation.

• Time — For each mailbox listed in the Mailbox column, lists the time that the messages were filtered into that 

mailbox during the filter operation.

By default, the entries in the window are sorted by time. However, you can click the column headings and sort 

the display by mailbox names (Mailbox) or by the number of messages filtered (Messages).

Note: Whenever new entries are added to the list, Eudora always appends them to the bottom of the list in 

order of arrival, ignoring the current sort order. Simply click a column heading to re-sort.

Select one or more entries in the list and double-click the selection, or press Enter, and Eudora opens the 

mailbox windows associated with those selections.

The Filter Report listing is a cumulative log of the filter actions for the current Eudora session. Eudora 

automatically clears the log when you quit the program.

Closing the Filter Report window does not erase the contents of the filter report, as it did in previous versions of 

Eudora. Only quitting Eudora erases this information.



File Browser

Use this window to browse the Windows desktop. You can use this window to find files to attach to new 

outgoing messages, for example.

The File Browser window performs some, but not all, of the functions of the standard Windows 95 and Windows 

NT 4.0 Explorer programs.

The File Browser window contains three controls:

• Drive Selector (top box) — A drop-down menu in this field contains a fixed set of high-level folders on your 

system, just like the corresponding control in Windows Explorer. The Drive Selector field determines what 

gets displayed in the Folder Browser (middle section). When you first launch Eudora, the Drive Selector 

automatically sets itself to the drive containing your Windows folder. Note that the first entry in the pop-up 

menu is a shortcut called "My Attachments" that points to your Eudora attachments folder.

• Folder Browser (middle section) — This is a tree control that displays the folder hierarchy whose root is the 

selection entered in the Drive Selector field. For example, if in the Drive Selector box you choose the C: 

drive, then the Folder Browser displays the folder tree-hierarchy branching down from the C: drive folder. 

Right-click a folder item in the Folder Browser to display the standard Windows context menu for that folder.

• File List (bottom section) — This is a list control that displays the files contained in the folder selected in the 

Folder Browser. You can select one or more file items in the list, then right-click the selection to display the 

standard Windows context menu for those files. (Note: Eudora does not fill in the Send To submenu on the 

context menu.) When selecting multiple items, use the Shift key to select a range of items, and use the Ctrl 

key for non-consecutive selections.

The File List control shows these four columns:

• Name — Displays the name of the file and the icon associated with the file.

• Type — Based on the file name extension, displays the file type as set in the Options dialog box of Windows 

Explorer.

• Size — Displays the size of the file in kilobytes (K), where 1K = 1,024 bytes.

• Modified — Displays the date and time that the file was last modified.

As in Windows Explorer, you can click any of the four column headings to sort the listing by the data in that 

column.

You can also resize the widths of the columns by dragging the separator line between the column heading 

labels. Position the pointer over the separator until you see a splitter cursor, then drag the line to left or right.

In the File List control, double-click an item in the Name column, or select one or more items in the column and 

press Enter, to open the selected items. For program files, this action launches the program. For document 

files, this action generally launches the registered viewing or editing application for that document. Eudora 

displays an error dialog box if it is unable to open a file in this way.

To adjust the relative heights of the Folder Browser and File List controls, position the pointer over the separator 

bar between the Folder Browser and File List controls until the splitter cursor appears, then click and drag the 

separator up or down. Note that the File Browser window maintains a minimum height for the Folder Browser 



and File List controls, so you cannot close them all the way.

To manually refresh the File Browser window display, right-click anywhere in the File Browser window but not 

on a Folder Browser item or File List item, then choose Refresh from the context menu. (Tip: A good place to 

right-click is in the Drive Selector box.) Alternately, press the F5 key while keyboard focus is in the File Browser 

window.

You can select one or more files in the File List control and drag them to a message composition window to 

attach those files to that outgoing message. This is especially handy if you keep the File Browser window 

docked and open. (For multiple file selections, use the Shift key to select a range, and use the Ctrl key to make 

non-consecutive selections.)

You can also select one or more items in the File List control and drag them to another application that can 

receive such files.

In general, the File Browser window lets you drag items out of the window (copying them rather than moving 

them), but the window is not a proper drop target; you cannot drop items into the window that you’ve dragged 

from elsewhere on your desktop. In particular, you cannot move files by dragging them to a target folder in the 

Folder Browser control. You also cannot drag and drop items within the File Browser window (from one control 

to another, for example). You can, however, manage the files and folders in the window using the commands on 

the window’s context menu, such as Cut, Copy, Paste, and Delete. 



Personalities

Use this window to manage, access, and apply your email accounts —    "multiple personalities" — when you 

use more than one account.

The Personalities window displays two columns of data:

• Persona — The identifying name assigned to the personality. <Dominant> indicates your principal email 

account, which is the account Eudora uses whenever you don’t specify otherwise, and is the account 

associated with all mail stored before you began using alternate personalities.

• Account — The incoming mail account assigned to the personality. This is generally in the form 

loginname@incomingmailserver

To resize the column widths, position the pointer over the divider line between the column headings, until a 

splitter cursor appears. Then just drag the divider to left or right. Note that it is possible to completely collapse 

the Persona column.

Note: You cannot manually sort the information in the Personalities window. Clicking on a column heading 

does not do a sort 

Note: You can select multiple items in the Persona column to perform some of the operations listed below. 

Use the Shift key to select a range of items, and use the Ctrl key to make non-consecutive selections.

If you select one or more personalities in the Persona column and right-click the selection, a context menu 

appears with the following commands (the standard Eudora window-management commands appear at the 

bottom):

• Check Mail — Check mail now for all selected personalities.

• Send Queued Messages — Send messages queued by all selected personalities now.

• Message — This submenu lets you perform message-creation functions using only one selected personality. 

The submenu is unavailable if multiple personalities are selected in the Persona column. 

- New Message As — Create a new message as the selected personality. As a shortcut for this command, 
double-click a personality in the Persona column, or select the personality and press Enter.

- Reply As — Reply as the selected personality to the sender(s) of the one or more received messages 
that are currently selected.

- Reply to All As — Reply as the selected personality to the sender(s) and all recipients of the one or 
more received messages that are currently selected.

- Forward As — Forward as the selected personality the one or more received messages that are 
currently selected.

- Redirect As — Redirect as the selected personality the one or more received messages that are 
currently selected.

- Send Again As — Resend as the selected personality the one or more received or composition 
messages that are currently selected.

• New — Create a new personality. When you select this command, Eudora walks you through the New 

Account Wizard. Enter a Personality Name (e.g., My Laptop Account) and click Next. You then have the 

choice to create a new email account or import the settings from an existing email account. If you choose a 



new email account, Eudora prompts you for your name, your return email address, your login name, and 

your incoming email server (POP or IMAP). Fill in each item as instructed. If you choose to import the 

settings from an existing email, Eudora asks you to choose the account to import, then asks you to confirm 

the settings and optionally change them. If you leave them unchanged, the imported account is created 

when you click Finish. If you choose to change them, Eudora walks you through the settings as above: 

name, return address, login name, and incoming email server. Change these settings as desired, and when 

you are complete, the new account is created.

• Properties — Modify the selected personality. You can only modify one personality at a time. When you 

select this command, the Account Settings dialog displays, with its fields filled in with the information 

associated with that personality. See the description of this dialog box below.

• Delete — Delete all selected personalities. Note, however, that you cannot delete the <Dominant> 

personality. You are prompted to confirm the deletion for each personality you have selected to delete. Note 

that these deletions are permanent and cannot be undone! When you delete a personality, any messages 

associated with that personality are reassigned to your Dominant personality. You can use the Del key 

(Delete) as a shortcut for this command (you will still get the confirmation requests).

You can also display the context menu and create a new personality by right-clicking in a blank area of the 

Personalities window, off all personality items, when none of the items are selected. When creating a new 

personality this way, you are walked through the New Account Wizard as in the description of the New 

command above.

If you drag one or more received messages to a personality item in the Personalities window, Eudora will Reply 

As that personality to the messages (hold down the Ctrl key to Reply to All As).



Query

Enter the name of the person you are searching for. 

If one or more of your selected databases use a protocol other than Ph, your entry in this field will always 
be interpreted as a name. If you only have Ph servers selected as your databases, you can enter any 
commands that Ph will interpret.



Start

After you’ve typed the text, start the query by pressing Enter or clicking the Start button. The query begins, and 

the Start button changes to Stop. To stop the query before it is completed, click the Stop button.

When the query is completed, or if you click Stop to cancel the query, the Stop button changes back to Start.



Status

This field displays the status of your query (such as Ready, Connecting, Getting Data, etc.) and the number 

of items found in your summary list. This number is updated dynamically until the query is complete or you stop 

it.



To

Click the To button to create a new message with the To header field appropriately addressed with the selected 

query results.



Cc

Click the Cc button to create a new message with the Cc header field appropriately addressed with the selected 

query results.



Bcc

Click the Bcc button to create a new message with the Bcc header field appropriately addressed with the 

selected query results.



Keep on top

When the Directory Services window is in the normal state (either alone or as part of a tabbed window group), 

check the Keep on top button to keep the Directory Services window on top of the other opened windows.



Results List

Your query results are listed in the left half of the Directory Services window, in the results list (top view) and the 

details pane (bottom view). You can resize the two views relative to each other using the separator between 

them; drag the separator up or down.

The results list consists of one-line summaries of the successful targets of your query. These are listed by four 

columns: Name, Email, Phone, and Database. Name indicates the username (or other name) of the target. 

Email is the email address of the target. Phone is the target’s telephone number. Database tells you in which of 

your selected databases the target was found.



Details List

Your query results are listed in the left half of the Directory Services window, in the results list (top view) and the 

details pane (bottom view). You can resize the two views relative to each other using the separator between 

them; drag the separator up or down.

To view the details of a result in the details pane, select the result in the results list by clicking once on it. The 

full data appears in the details pane. If nothing is selected in the results list, the details pane is blank. If multiple 

summaries are selected in the results list, the details pane lists the details for each item, with each item 

separated by a divider line.



Protocols

The Protocols section of the Directory Services window lists the directory service protocols available to you 

that you can use when creating and modifying databases for looking up individuals via these services.

Eudora comes with four protocols installed by default: 

Ph, Finger, LDAP (Lightweight Directory Access Protocol), and Eudora Address Book.

Note: The Eudora Address Book protocol does not appear in the list until you have created an Address 

Book in Eudora.

To sort the protocols alphabetically, click the column heading (Registered Drivers). Shift-click the column 

heading to sort in reverse order.



Databases

The Databases section of the Directory Services window lists the databases that are available to you for 

searching for individuals over the Internet, within your company, or in your Address Book (if one is set up).

Eudora comes with these servers already configured by default:

• ldap.bigfoot.com

• ldap.whowhere.com

• ldap.infospace.com

• ldapbiz.infospace.com

• ldap.four11.com

• Eudora Nicknames [or the name of your nicknames file; this last item appears only if you have a Eudora 

Address Book set up]

You can modify or delete these databases, and you can also create new databases and modify and delete 

them. 

You use the databases in this list to perform your lookup queries. To perform a query, you must first select one 

or more databases in the list. To select a database, click the checkbox to the left of the database name, until a 

checkmark appears in the box. If no databases are selected, you cannot perform a query.

You can select multiple databases to perform a query, and you can mix protocols.

Click a column heading to sort this list by that column, alphabetically. Shift-click the column heading to sort in 

reverse order.



TOC/Preview Pane

The top half of this window is the TOC (Table of Contents), and the bottom half is the Preview Pane. When you 

check for mail, messages are delivered to your mailboxes with the In mailbox opened in the TOC (If you have 

no filters set up, all new messages are delivered to your In mailbox).The messages are listed in the order they 

are received, with the most recent message listed last. Unread messages are designated by a bullet in the 

Status column of the message summary.

Double-click anywhere on a message summary to open the message. You can also view messages using the 

message preview pane (see below for details) at the bottom of the mailbox window while the message 

summary is highlighted. 

Incoming messages are saved indefinitely in the In mailbox (or the mailbox they are filtered into) until they are 

deleted or transferred to another mailbox.

Also, you can select a message in the TOC and transfer it to another mailbox or to the Trash.

Once you select another mailbox, its messages and summaries are displayed in the TOC.

The Preview Pane shows you the full or partial content of a message without opening the message. It is 

located to the bottom of the list of messages in a mailbox. You can adjust the size of the preview window by 

placing the cursor on the window frame. Once the cursor changes to a double arrow, you can resize the 

preview window.

To activate the preview pane, do the following:

1. From the Tools menu, choose Options.

2. Scroll and select Viewing Mail . The Viewing Mail options window appears.

3. Click the Show message preview pane box.

4. Click OK.

The preview pane shows the key headers and the message body of the currently selected message in the 

message summary list. If the full message body is not visible in the preview window, scroll bars are displayed, 

allowing you to view the rest of the message. Only one message can be previewed at a time.

Press Tab or F6 to move the keyboard focus from the message summary list to the preview window (and back 

again). Or simply click in the preview window to put the focus there.

Once keyboard focus is in the preview window, you can do any of the following, as you can in an open incoming 

message window:

• Press Space to page down through the message.

• Use the arrow keys, as set in the Miscellaneous options window (unmodified or with Ctrl or Alt), to switch to 

the next or previous message in the mailbox.

• Use standard keyboard shortcuts such as Ctrl+R for Reply, Ctrl+D for Delete, etc.

• Right-click anywhere in the preview window to display a pop-up menu with commands appropriate for the 

previewed message.



• Click an attachment icon or name to open the attachment.

• Click a URL (hot link) to launch the application for that URL.

If the Show message preview pane option is turned on in the Viewing Mail options window , you can press F7 

to show and hide the preview window within the current mailbox only (this does not control the visibility of the 

preview window in other mailboxes).

If the Show message preview pane option is off in the Viewing Mail options window , only the message 

summaries are shown in any mailbox window.

If the preview window option is on and the Mark previewed messages as read after _ second(s) option is 

turned on in the Viewing Mail options window, then the currently previewed message is marked as read (blank 

in the Status column) after the specified number of seconds. You can always change the message’s status 

back to Unread (•) by pressing Shift+Space while the message is selected or open (press again to change 

back to Read). If the Mark previewed option is off, previewed messages are never automatically marked as 

read.

Note: Eudora only performs the auto-marking behavior when you manually switch messages, not when it 

performs actions such as automatic mail checks or filtering.



Technical Support

Displays technical support information for this version of Eudora.



Tip of the Day

Displays the Tip of the Day. The Tip of the Day displays information about Eudora’s functionality.



Task Error Window

The Task Error window displays an error message as it occurs. For example, a password error appears. You 

can indicate if you want the Task Error window brought to the front when an error occurs. See Background 

Tasks.

To access and display the Task Status window, do the following.

1. From the Tools menu, choose Task Errors. Or, if the Task Error window is in a visible tabbed window, click 

its tab. The Task Error window appears.

Notice the yellow task error icon on the Eudora tool/status bar at the lower- right of the main Eudora window. 

Click this icon to display the Task Error message.

2. Click Details to expand the message.

Following are field descriptions for the Task Error details window.

Persona—The personality name associated with this error appears.

Title—The name of the Eudora function when this error occurred.

Status—The name of the system function when this error occurred.

Info—More information on this error appears, if any.

Time—The time and day of this error appears.



Task Status Window

The Task Status window displays background activity: retrieving mail from incoming servers, and sending mail 

to outgoing servers. Mail can be retrieved and sent from each of your personalities simultaneously. Progress 

information is described in Background Tasks.

To access and display the Task Status window, do the following.

1. From the Tools menu, choose Task Status. Or, if the Task Status window is in a visible tabbed window, click 

its tab. The Task Status window appears. Notice the progress indicators on the status bar located at the right-

hand bottom of the Eudora window. A progress bar and spinning black and white ball indicate that background 

tasks are occurring.

2. On the progress bar or spinning indicator, click to display the Task Status window. Right-click to display the 

indicator’s drop-down menu.

3. Choose Stop All Tasks to cancel the tasks currently occurring.

4. Choose Go offline to disconnect from the server. An alert window appears letting you know that you are 

offline and cannot connect to the server. This is useful if you are using a laptop computer.

Note: Offline does not apply to personalities that use IMAP incoming servers.

Choose Show Task Status to display the Task Status window.

You can see if your sent messages are sent, queued, or processing in your Out mailbox.

Following are field descriptions for columns in the Task Status window.

Task—(default) An icon and its description displays in this column indicating what function Eudora is 

performing. 

Persona—This column is available only if have set up more than one personality. If checked, the Personality 

column displays the personality name for the given task.

Status—(default) Displays a general description of the tasks current status, for example, "Logging into POP 

server."

Details—Displays more information of the tasks’ status including network protocol commands. 

Progress—(default) Displays a progress bar indicating the overall progress of the tasks.

Details—Displays more information of the tasks’ status including network protocol commands. 

Progress—(default) Displays a progress bar indicating the overall progress of the tasks.



Forget Password (personalities)

If you have more than one personality, this dialog box displays listing the names of your personalities. You can 

select the personalities whose passwords you want Eudora to forget. All the personalities are selected by 

default. Deselect the personalities you don’t want Eudora to forget. 



Search category drop-down list

Anywhere—Choose this option to search everywhere in the message including all header fields and message 

body. This includes headers that are normally exposed only with the Blah Blah Blah icon button turned on.

Headers—Choose this option to search only in the header fields of the message. This includes headers that 

are normally exposed only with the Blah Blah Blah icon button turned on.

Body—Choose this option to search only in the body of the message.

Attachment Name(s)—Choose this option to search only attachment names in the message.

Summary—Choose this option to search text entered in only the header From: and Subject: fields of the 

message.

Status—Choose this option to search for messages by status. A status drop-down options list displays (the 

default is Unread). You can choose from Unread, Read, Replied, Forwarded, or Redirected. The conjunction 

field defaults to is. 

Priority—Choose this option to search for messages by priority. A priority drop-down options list displays (the 

default is Highest). You can choose from Highest, High, Normal, Low, or Lowest. The conjunction field defaults 

to is.

Attachment Count—Choose this option to search the number of attachments joined to each message. A 

counter appears for you to select the desired number, or you can type the number in the text box. The 

conjunction field defaults to is. 

Label—Choose this option to search for messages by label. Choose Label, and the labels drop-down options 

list displays (the default is None). You can choose from the labels you previously set up. The conjunction field 

defaults to is. 

Date—Choose this option to search for messages by date. Once selected, today’s date appears. Click the 

down arrow to display the current month’s calendar. Using the arrows on the calendar, you can display the 

preceding or proceeding months and years. Choose the date to or from where you want the search to begin. 

Size—Choose this option to search for messages by their file size (in kilobytes). A counter appears for you to 

select the desired number of kilobytes, or you can type the number in the text box. The conjunction field 

displays is. 

Age—Choose this option to search for messages by age (in days). A counter appears for you to select the 

desired number of days, or you can type the number in the text box. The conjunction field displays    is. 

Personality—Choose this option to search for messages by account. A drop-down list displaying your 

previously set up personalities appears. Select the desired personality.

Mailbox Name—Choose this option to search for messages in a specific mailbox. Enter the name of the 

mailbox in the text box.

To—Choose this option to search text entered in only the To: header field of the message.

From—Choose this option to search text entered in only the From: header field of the message.

Subject—Choose this option to search text entered in only the Subject: header field of the message.



CC—Choose this option to search text entered in only the Cc: header field of the message.

BCC—Choose this option to search text entered in only the Bcc: header field of the message.

Any recipient—Choose this option to search text entered in only the To:, Cc:, and Bcc: header fields of the 

message.



Search Messages

You can now perform complex searches through messages in all or a selected number of mailboxes or folders. 

Once your search is complete, right-click to view the message, open the mailbox where the message resides, 

transfer, reply, reply to all, forward, redirect, or delete the message. You can search for a specific piece of 

information in all your mail or just search for a particular item that matches the criteria you set. Set up the 

criteria for your search by selecting options from the drop-down lists and by entering text. 

To set up criteria for a message search, do the following:

1. From the Edit menu, choose Find or press [Ctrl] + F. The Find submenu appears.

2. From the Find submenu, choose Find Messages. The Find Messages dialog box appears. 

In the Find Messages dialog box, your mailboxes display along with checkboxes. If the boxes are checked, 

Eudora will perform a search in these mailboxes according to the criteria you are about to set up. To omit a 

mailbox from the search, just deselect the box. 

Note. If you see a gray check in the checkbox for a specific mailbox or folder, this indicates that the 

mailbox’s sub-folders and sub-mailboxes are not checked. 

The top part of the dialog box is where you select and enter criteria for your search. Each search can use up 

to five "terms" and "conjunctions" as its criteria, connecting them as appropriate. The drop-down and 

conjunction lists displaying the criteria you can select. 

3. In the drop-down criteria list (Anywhere is the default), choose where in the message you want Eudora to 

search for text. Following is a description of each option.

Anywhere—Choose this option to search everywhere in the message including all header fields and 

message body. This includes headers that are normally exposed only with the Blah Blah Blah icon button 

turned on.

Headers—Choose this option to search only in the header fields of the message. This includes headers 

that are normally exposed only with the Blah Blah Blah icon button turned on.

Body—Choose this option to search only in the body of the message.

Attachment Name(s)—Choose this option to search only attachment names in the message.

Summary—Choose this option to search text entered in only the header From: and Subject: fields of the 

message.

Status—Choose this option to search for messages by status. A status drop-down options list displays (the 

default is Unread). You can choose from Unread, Read, Replied, Forwarded, or Redirected. The 

conjunction field defaults to is. 

Priority—Choose this option to search for messages by priority. A priority drop-down options list displays 

(the default is Highest). You can choose from Highest, High, Normal, Low, or Lowest. The conjunction field 

defaults to is.

Attachment Count—Choose this option to search the number of attachments joined to each message. A 

counter appears for you to select the desired number, or you can type the number in the text box. The 



conjunction field defaults to is. 

Label—Choose this option to search for messages by label. Choose Label, and the labels drop-down 

options list displays (the default is None). You can choose from the labels you previously set up. The 

conjunction field defaults to is. 

Date—Choose this option to search for messages by date. Once selected, today’s date appears. Click the 

down arrow to display the current month’s calendar. Using the arrows on the calendar, you can display the 

preceding or proceeding months and years. Choose the date to or from where you want the search to 

begin. 

Size—Choose this option to search for messages by their file size (in kilobytes). A counter appears for you 

to select the desired number of kilobytes, or you can type the number in the text box. The conjunction field 

displays is. 

Age—Choose this option to search for messages by age (in days). A counter appears for you to select the 

desired number of days, or you can type the number in the text box. The conjunction field displays is. 

Personality—Choose this option to search for messages by account. A drop-down list displaying your 

previously set up personalities appears. Select the desired personality.

Mailbox Name—Choose this option to search for messages in a specific mailbox. Enter the name of the 

mailbox in the text box.

To—Choose this option to search text entered in only the To: header field of the message.

From—Choose this option to search text entered in only the From: header field of the message.

Subject—Choose this option to search text entered in only the Subject: header field of the message.

CC—Choose this option to search text entered in only the Cc: header field of the message.

BCC—Choose this option to search text entered in only the Bcc: header field of the message.

Any recipient—Choose this option to search text entered in only the To:, Cc:, and Bcc: header fields of the 

message.

4. After you select the option from the drop-down list, select a conjunction to link the first option with the text 

you will be searching for. 

Following is a description of each conjunction option in the drop-drop list. 

contains—If the specific item contains the text string, search and display those messages.

contains word—If the specific item contains the exact word, search and display those messages.

does not contain—If the specific item does not contain the text string, search and display those 

messages.

is—If the specific item is an exact match, search and display those messages.

is not—If the specific item is not an exact match, search and display those messages.

starts with—If the specific item starts with the text string, search and display those messages.



ends with—If the specific item ends with the text string, search and display those messages.

matches regexp—If the specific item matches the regular expressions characters, search and display 

those messages. Regular Expression is a search string that uses special characters to match text 

characters. For example, if you are searching for messages sent to you by two people, choose From in the 

first drop-down options list, then choose matches regexp, then type their usernames between brackets 

separated by a vertical slash, e.g., (bobclark)|(janedoe) in the text box. Eudora searches and 

displays all messages from these two people. 

For more information, see Regular Expressions.

Note. Regular Expressions is an advanced and complex method of searching for text. There are several web 

sites where you can get information on Regular Expressions.

is after/is before (Date only)—If the date is after or before the date displayed, search and display those 

messages.

is greater than/is less than (Age, Size, Priority, Attachment Count only)—If the specific item is greater than 

or less than the number indicated, search and display those messages. 

5. Once you have chosen the conjunction, enter the text string in messages you are searching for, or choose 

a value from the drop down list if one displays. In the text box, you can enter as much text as you want.

If you click Search, Eudora will search through all of your mailboxes for every message that contain the 

text you specified anywhere in the header portion of the message. 

6. To continue adding a second level of criteria (you can add up to five levels), click More. Choose and enter 

more criteria to further streamline the search. You can also select Match All or Match Any to include or 

differentiate the criteria from one level to the other.

If you click Search, Eudora will search for every message through every mailbox that contains the word you 

specified anywhere but only if the text you specified is somewhere in the header. 

To continue adding a third level or criteria, click More. Choose and enter more criteria to further reduce the 

search. Click Search to display the messages that contain the criteria you entered.    You can now search 

further from the results of the search by clicking on More to continue entering more criteria.

The messages that fulfill the search criteria appear in the Results window.

The Search feature will not work if you have any text boxes blank. You can click Fewer to reach a level where 

all text boxes are filled to conduct your search.

§ To sort the messages, click the column headings to sort by that column. To sort in descending order, click 

the column header again. 

§ To open a message, select and double-click the message, or right-click to display the context menu. 

Choose Open Message. 

§ To open the mailbox where this message resides, highlight the message, right-click to display the context 

menu. Choose Open Mailbox.

§ To delete a message, highlight the message and press the Delete key, or right-click to display the context 



menu. Choose Delete Message.



Conjunction drop-down list (Search messages)

contains—If the specific item contains the text string, search and display those messages.

contains word—If the specific item contains the exact word, search and display those messages.

does not contain—If the specific item does not contain the text string, search and display those messages.

is—If the specific item is an exact match, search and display those messages.

is not—If the specific item is not an exact match, search and display those messages.

starts with—If the specific item starts with the text string, search and display those messages.

ends with—If the specific item ends with the text string, search and display those messages.

matches regexp—If the specific item matches the regular expressions characters, search and display those 

messages. Regular Expression is a search string that uses special characters to match text characters. For 

example, if you are searching for messages sent to you by two people, choose From in the first drop-down 

options list, then choose matches regexp, then type their usernames between brackets separated by a vertical 

slash, e.g., (bobclark)|(janedoe) in the text box. Eudora searches and displays all messages from these 

two people. Regular Expressions is an advanced and complex method of searching for text.

is after/is before (Date only)—If the date is after or before the date displayed, search and display those 

messages.

is greater than/is less than (Age, Size, Priority, Attachment Count only)—If the specific item is greater than or 
less than the number indicated, search and display those messages.



Text (Search messages)

 Enter the text (word or string of words) you want; that is, according to the criteria and conjunction you specified 

in the drop-down lists. If you click the Search button, all messages that pertain to this word or words, as set up 

in the criteria and conjunction fields, will appear in the Results window.



is after/is before (Search messages)

Choose is after/is before (Date only) if the date is after or before the date displayed; then search and display 

those messages.



is/is not/is great than/is less than (Search messages)

Choose is/is not/is greater than/is less than (Age, Size, Priority, Attachment Count only) if the specific item is 

greater than or less than the number indicated; then search and display those messages. 



is or is not (Search messages)

Choose is if the specific item is an exact match; then search and display those messages.

Choose is not if the specific item is not an exact match; then search and display those messages.



Number (Search messages)

Enter the number you want; that is, according to the criteria and conjunction you specified in the drop-down 

lists. If you click the Search button, all messages that pertain to this number, as set up in the criteria and 

conjunction fields, will appear in the Results window.



Select number (Search messages)

Enter the number you want or choose a number by clicking on the up or down arrows; that is, according to the 

criteria and conjunction you specified in the drop-down lists. If you click the Search button, all messages that 

pertain to this number, as set up in the criteria and conjunction fields, will appear in the Results window



Size or Age (Search messages)

If you selected Size in the criteria drop-down list, enter the number of kilobytes or click the up or down arrow 

counting to the kilobyte number you want to base the search on. If you click the Search button, all messages 

that pertain to this number, as set up in the criteria and conjunction fields, will appear in the Results window.

If you selected Age in the criteria drop-down list, enter the number of days or click the up or down arrow 

counting the number of aging days you want to base the search on. If you click the Search button, all messages 

that pertain to this number, as set up in the criteria and conjunction fields, will appear in the Results window.



Personality (Search messages)

If you selected Personality in the criteria drop-down list and chose the conjunction, click the down arrow to 

display your personalities. Select the personality that you want to base the search on. If you click the Search 

button, all messages that pertain to this personality, as set up in the conjunction field, will appear in the Results 

window.



Status (Search messages)

If you selected Status in the criteria drop-down list and chose the conjunction, click the down arrow to display 

your choices. Choose the message status that you want to base the search on. They are unread, read, replied, 

forwarded and redirected. If you click the Search button, all messages that pertain to this status, as set up in 

the conjunction field, will appear in the Results window.



Label (Search messages)

If you selected Label in the criteria drop-down list and chose the conjunction, click the down arrow to display 

your label choices. Choose the message label that you want to base the search on. If you click the Search 

button, all messages that pertain to this label, as set up in the conjunction field, will appear in the Results 

window.



Priority (Search message)

If you selected Priority in the criteria drop-down list and chose the conjunction, click the down arrow to display 

your choices. Choose the message status that you want to base the search on. They are Highest, High, Normal, 

Low, and Lowest. If you click the Search button, all messages that pertain to this priority, as set up in the 

conjunction field, will appear in the Results window.



Date (Search message)

If you selected Date in the criteria drop-down list and chose the conjunction, click the down arrow to display your 

choices. When you click the down arrow, the current month’s calendar appears. You can move around the 

calendar by clicking the arrows on the top of the calendar. Double arrow buttons indicate years, and single arrow 

buttons indicate months. Left arrows moves the calendar to the past, and the right arrows moves the calendar to 

the future. Choose the date that you want the search to be based on. If you click the Search button, all messages 

that pertain to this date, as set up in the conjunction field, will appear in the Results window.



Search button (Search message)

Click the Search button to begin your search. You can click the Search button during any level of the search. 



More button (Search message)

Click the More button to display the next level of search criteria. You can display as many as five levels of 

search criteria.



Fewer button (Search message)

Click the Fewer button to display the previous level of search criteria. 



Match All button (Search message)

Click the Match All button to include all the criteria from one level to the next. It’s like saying "and" between 

levels.



Match Any (Search message)

Click the Match Any button to differentiate criteria from one level to the next. It’s like saying "or" between levels.



Results Information

This displays the number of matches found in the number of mailboxes checked.



Results window

The Results window displays the summaries of messages that contain the criteria you set up in your search. 

Each message summary displays the mailbox where the message resides, who sent the message, when it was 

sent, and what it was about. You can click on any result message to open it.

Also, you can perform a search on the resulting messages that appear by entering another level of criteria and 

by clicking the Search button.



Mailbox window (Search message)

The Mailbox window displays all of your mailboxes and folders. Check the mailboxes and folders to include in 

your search. Uncheck the mailboxes and folders you don’t want included in the search. 

The search mailbox window looks and behaves like your Eudora mailbox window. 



Mood Watch icon button

This button displays one, two, or three red chili peppers indicating how offensive your message content is. Three 
red chili peppers is the most offensive and one is the least.



Statistics Window

The statistics you see in this window keep track of how many messages you receive and send in a particular 

day, week, month, or year. You can also see how many attachments were received and sent as well as how 

many messages were read. In the Sent Email section, you can see how many messages you have replied to, 

forwarded, and redirected during a specific timeframe.

Note. Eudora usage statistics are statistics for you only. No statistical information is sent to Qualcomm or 

any other web site address. 



New Book (address book)

Click this button to create an address book file in Eudora's Address Book. Once you click this button, the New 
Address Book dialog box appears. Enter the name of the new address book and click OK. Your new address book 
appears in the list..



Configuring Eudora

To configure Eudora, do the following:

1. Install Eudora and restart your computer.

2. Double-click the Eudora icon to open it. If you are installing Eudora for the first time, the New Account 

Wizard opens, showing the welcome screen. 

3. Click Next to begin setting up your new email account.

4. Select an appropriate method of setting up your account: 

a. Create a brand new email account (go to step 7).    Select this method to set up a new account 

if you are not familiar with Eudora or other email programs. You are prompted to enter one 

piece of information per window.

b. Import settings from an existing email account (go to step 5). Select this method if you want to 

import your settings, mail, and address book from Outlook Express™ 5.0, Outlook 98™, 

Outlook 2000™, or Netscape Messenger™ 4.x, and higher into Eudora. 

If you need more information on migrating settings from another email program to Eudora, see 

Importing Settings to Create a New Account. Note that this process may take some time 

depending on the amount of mail, the complexity of your settings, and the size of your address 

book.

c. Instruct Eudora to get your settings from an ACAP server (go to step 6). Select this method to 

instruct Eudora to attempt to get your settings from an ACAP server. To get your settings from 

an ACAP server, make sure that you are connected to the Internet. Your email administrator or 

Internet Service Provider (ISP) can tell you whether an ACAP based setup is available to you.

d. Create a new account using the advanced account setup. Select this method if you are familiar 

with Eudora or other email programs. An Account Settings window appears with two tabbed 

panels. Enter all of your Eudora information on these panels. Go to Account Settings Dialog.

5. If you choose to import settings from an existing email account, and select the account and click Next. 

Eudora asks you to confirm the settings and optionally change them. If you choose No and click Next, your 

account is set up when you click Finish in the final window. If you choose Yes and click Next, the New 

Account wizard walks you through the fields to be changed as described further below. When you click 

Finish in the final window, your new account is set up.

6. If you choose the ACAP option and click Next, the Auto Configure window appears. Click Next again to 

instruct Eudora to get your account settings from the ACAP server. If the attempt fails, click Back and try 

one of the other options. 

7. If in the Account Setup window you choose to create a brand new email account and click Next, the New 

Account Wizard begins guiding you through the fields for which you need to enter setup information.

8. In the windows of the New Account wizard, enter the following field information (click Next after filling out 

each window):



• Your Name — Enter your name as you would like it to appear in the From field of all of your outgoing 

messages from this email account, to indicate to your recipients whom the mail is from.

• Return Address — Enter the email address that has been assigned to you by your Internet Service 

Provider or your email administrator. This is the address that other people will use to send you email. 

Return addresses are generally in the form loginname@domainname, for example, 

beatrixp@myfirm.com.

• Login Name — Enter the name that you will use to log in to this email account, if required. This name is 

provided by your Internet Service Provider or your email administrator, and it usually consists of the text 

that appears before the at sign (@) in your return email address. In the example jcamp@myfirm.com, 

the login name is jcamp.

• Incoming E-mail Server — All of your incoming email messages are delivered to your incoming email 

account, which resides on a computer that runs your incoming email server. When your messages 

arrive at your mail account, Eudora picks them up and transfers them to your computer. Your incoming 

email server must use one of the two Internet mail communications protocols IMAP (Internet Message 

Access Protocol) or POP (Post Office Protocol). If you are not sure which protocol it uses, select POP; 

you can always change this later. In the edit box, type the full name of the computer that runs your 

incoming email server; jcamp.myfirm.com is an example.

• If you chose IMAP in the previous setup window, an IMAP Mailbox Location Prefix may be required to 

indicate the location of your personal mailboxes on the IMAP server. If so, enter the name of that 

location prefix as given to you by your Internet Service Provider or email administrator. If the information 

is not required, leave the field blank. Click Next, then in the last window, click Finish. Your new IMAP 

email account is set up.

If you chose POP in the previous setup window, click Finish in the final window and your new POP 

email account is set up.

When you have finished setting up your account via the New Account wizard, you are now ready to receive 

messages. However, you may need to take an additional step in order to send messages.

To send messages in Eudora, you must have access to a computer running an SMTP (Simple Mail Transfer 

Protocol) server. Your outgoing messages are sent to the SMTP server, which delivers them to your recipients.

If the computer that runs your POP or IMAP server (incoming email account) also runs an SMTP server, then 

no additional setup action is required. You are now ready to send and receive messages in Eudora.

If, however, your SMTP server runs on a different computer from the one running your POP or IMAP server, 

take the following final setup action (you may want to consult your Internet Service Provider or email 

administrator to help you set up the SMTP server).

To set up your SMTP server, do the following:

1. From the Tools menu, choose Options.

2.  Scroll through the icons, and choose Sending Mail. 

3. In the SMTP server field, enter the full name of the computer that runs your SMTP (outgoing) server, for 



example: smtp.myfirm.com. 

4. To save your settings and close the Options dialog box, click OK. You are now ready to send and receive 

mail in Eudora.

If you ever wish to change the settings of your email account, you can do so from the Options dialog box. 

You can also change these settings in the Account Settings dialog, which is accessed from the Personalities 

window. This window also lets you create alternate email accounts and edit the settings in those accounts. For 

more details, see the sections Using an Alternate E-mail Account, Personalities Window, and Account Settings 

Dialog.



Tip of the Day

Each time you open Eudora (including the first time after install), the Eudora Tip of the Day appears. You can 

display next and previous tips by clicking the Next Tip and Previous Tip buttons. To prevent the Tip of the Day 

dialog box from being displayed on startup, uncheck the checkbox. You can always display the Tip of the Day 

from the Help menu.

Click the Close button to close the Tip of the Day dialog box.



Online Help

There are several ways to get online help with Eudora:

· To find out what something in the user interface does, use either Context Sensitive Help from the Help 

menu, or the Help button on the main toolbar and click the item in question. A brief description of the item 

appears. Click anywhere to close the description window.

· The F1 key also displays context sensitive Help or contains information about an open window. Select the 

user interface item you want to know about, or use the Tab and arrow keys to move keyboard focus to that 

item, then press F1. Keyboard focus is indicated by a dashed highlight box, a highlighted entry or item, or a 

flashing insertion cursor.

If in a tabbed window, move the mouse arrow to a field and press F1. The entire procedure for the window 

appears.

· For instructions on how to do certain tasks, select Topics from the Help menu. The Help Contents 

(Contents, Index, and Find) are displayed, and you either browse the contents or use the Find and Index 

options.

· The Eudora Tip of the Day can be selected from the Help menu. It provides snapshot information about an 

assortment of Eudora features. See Tip of the Day.



Starting and Quitting Eudora

To start Eudora, do the following:

§ On the desktop, double-click the Eudora icon or choose Eudora Email from the Start menu under 

Programs.    Eudora opens.

To quit Eudora, do the following:

§  From the File menu, choose Exit, or press [Ctrl]+Q. Eudora closes.

If you have queued or timed messages due to be sent in the next 12 hours, you are given the option to send 

them. See the sections Queueing a Message to Send Later and Queueing a Message to Send at a Certain 

Time.

The Trash mailbox is emptied if the Empty Trash when exiting option is on in the Miscellaneous options. The 

Miscellaneous options are found under the Tools menu, then Options.



Uninstalling Eudora

You can uninstall Eudora by using the tools provided with your Windows 95/98 or Windows NT 4.0 (or later) 

operating system. To uninstall Eudora, do the following:

1. From the Start menu, choose Settings, then Control Panel. 

2. Open the Control Panel, double-click Add/Remove Programs, select Eudora Email, and click Remove. 

Eudora will uninstall.



Create an Outgoing Message

An outgoing message is a message you send to someone else. The simplest way to create an outgoing 

message is to do the following:

· From the Message menu, choose New Message. A new message window appears, the composition 

window. 



Use the Composition Window

The composition window consists of the title bar, the Toolbar, the message header, and the message body.

Title Bar

The title bar provides information about the message, including the name of the addressee, the time and date 

the message was sent, and the message subject.

Toolbar

The toolbar consists of a series of buttons and drop-downs that are displayed just under the title bar. It allows 

you to control the priority of your message, override some of your default options for the current message, send 

or queue the message, and apply text styles. Each button can be turned on or off for the current message by 

clicking it (a button is on when it is depressed, and off when it is raised). You can set some of the defaults for 

the toolbar in the Composing Mail Options Window.

The drop-down menus and buttons on the top row are described below.

Priority Popup ¾ This lets you indicate that your message is of higher or lower priority than a normal message. 

For most messages, this is just an empty box (normal priority). For details, see Setting the Message Priority .

Signature Popup ¾ This lets you automatically append one of your signatures to the end of a message. For 

details, see Using a Signature .

Attachment Type Popup ¾ This lets you select the encoding format for attachments. For details, see 

Attaching a File to a Message .

Quoted-Printable Encoding ¾ If this is on, quoted-printable encoding is used when sending messages that 

contain special characters or long lines of text. It is used for all plain-text attachments. We recommend that you 

always keep this on.

Text As Attachment ¾ If this is on, plain text files are attached to messages, not incorporated into the 

message as part of the message body.

Word Wrap ¾ If this is on, a carriage return is not required at the end of each line. When the message is sent, 

the text is automatically "wrapped," meaning that carriage returns are inserted at the end of each line of text, 

with roughly 76 characters per line.

Tabs in Body ¾ If this button is on, pressing the Tab key within the message body inserts a tab. If this button is 

off, pressing the Tab key within the message body returns the cursor to the To field of the message header.

Keep Copy ¾ If this is on, a copy of each sent message is kept in the Out mailbox. These messages are saved 

there until they are deleted or transferred.

Return Receipt ¾ (Sponsored and Paid modes only) If this is on, the message to your recipients includes a 

Notify Sender button that when clicked creates a message notifying you that the original message has been 

viewed. This function does not work in all cases. For details, see Requesting a Return Receipt .

Show Text Symbols ¾ If this is on, invisible text symbols, such as carriage returns, tabs, and spaces appear in 

the message. You can see these symbols only in your composition window. They do not appear in the message 

you send.

Send or Queue ¾ These choices let you send a message immediately or put it in the queue to send later. If the 



Immediate Send option in the Sending Mail Options Window is on, the button is labeled Send. If the option is 

off, the button is labeled Queue. For details, see Sending a Message Immediately or Queueing a Message to 

Send Later.

Following are descriptions of the drop-down menus and buttons on the bottom row. Note that this bottom row of 

the toolbar, which controls text styles and other attributes, also appears in text file and signature windows.

Font Popup ¾ Apply the highlighted text the selected font (typeface).

Size ¾ Apply the highlighted text the selected size.

Bold ¾ Apply bold to the highlighted text.

Italics ¾ Italicize the highlighted text.

Underline ¾ Underline the highlighted text.

Strikeout¾Strikeout the highlighted text.

Color ¾ (Sponsored and Paid modes only) When typing a message, your text color defaults to Automatic 

(typically black).    You can change the color as you type or by selecting text.    If you change the text 

color, then this button will retain and display that color.    When you want to change colors, click this 

button and choose the color from the drop-down menu. Note that if you change the text color to 

Automatic, this button will not change color. You can also ignore the color change by pressing the 

Shift key while changing colors.

Typewriter ¾ (Sponsored and Paid modes only) Make the selected text the fixed-width width (typewriter-style) 

message font set in the Fonts options window .

Align Left ¾ (Sponsored and Paid modes only) Align the selected paragraph to the left of the indent.

Align Center ¾ (Sponsored and Paid modes only) Align the selected paragraph to the center of the indent.

Align Right ¾ (Sponsored and Paid modes only) Align the selected paragraph to the right of the indent.

Indent In ¾ (Sponsored and Paid modes only) Indent the selected paragraph once to the left.

Indent Out ¾ (Sponsored and Paid modes only) Remove one left indent for the selected paragraph.

Bulleted List ¾ (Sponsored and Paid modes only) Make the selected text a bulleted list.

Make Hyperlink ¾ (Sponsored and Paid modes only) Make the selected text or graphic a clickable hyperlink to 

a URL, so that when the recipient clicks the item, he or she is immediately taken to the URL.

Clear Formatting ¾ Removes all the formatting from the selected text or paragraph.

Insert Object ¾ (Sponsored and Paid modes only) Insert a specified picture file or a horizontal line at the 

current cursor position in body text. For details, see Inserting Objects in Message Text.

For more information on text styles, see Formatting Text.

Message Header¾Outgoing mail headers consist of six fields: To, From, Subject, Cc, Bcc, and Attached. 
Each field is described below. The To, Subject, Cc, and Bcc fields can be directly edited. To move the cursor 
from field to field, press the Tab key or click in the desired field with the mouse.

To resize the Header region of the outgoing message window, drag the separator up or down. This applies to 



the current message only.

To: The intended recipients’ email addresses or nicknames you have defined (see Using the Address Book and 

Using the Quick Recipient List). Multiple addresses and nicknames must be separated by commas. If you have 

the Automatic Name Completion turned on (see Auto-Completion Options Window), a window appears with 

your address book and history files entries for you to select.

From: The sender’s email address. This is usually your incoming email account plus your real name. You can 

use a return address other than your incoming mail account by entering the address in the Return address 

field of the Getting Started Options Window. If you have more than one personality, click From to display your 

personality list and choose the personality you want to use.

The From field also reflects changes made with the Change Personality menu under the Message menu, if 

you have alternate personalities set up. See Using an Alternate E-mail Account .

Subject: Some brief text indicating the contents of the message. This field can be left blank although it is 

considered a point of email etiquette to include a Subject with each message.

Cc: The email addresses or nicknames of people to whom a copy of the message is to be sent. These 

recipients are displayed in the message header for all recipients to see. Multiple addresses must be separated 

by commas. This field can be left blank. Cc stands for "carbon copy."    If you have the Automatic Name 

Completion turned on (see Auto-Completion Options Window), a window appears with your address book and 

history files entries for you to select.

Bcc: The email addresses or nicknames of people to whom a blind copy of the message is to be sent. These 

recipients are not displayed in the message header, and the recipients in the To or Cc fields will not know that a 

copy went to these addresses. Multiple addresses must be separated by commas. This field can be left blank. 

Bcc stands for "blind carbon copy."    If you have the Automatic Name Completion turned on (see Auto-

Completion Options Window), a window appears with your address book and history files entries for you to 

select.

This field also can be used to put a copy of the message in one or more of your mailboxes. To do this, right-

click in the body of the message and select the mailbox from the Fcc menu (equivalent to the Transfer menu). 

The name of the mailbox is inserted into the Bcc field preceded by the expression "I\." Repeat the procedure to 

Fcc to multiple mailboxes; Eudora automatically separates the entries with commas. When the message is 

sent, a copy is put in each specified mailbox. Fcc stands for "folder carbon copy."

Attached: A list of documents being attached to and sent along with the message. See Attaching a File to a 

Message for instructions on how to add attachments. To delete an attachment from an outgoing message, 

select it and press the backspace or delete key. This field can be left blank.

Message Body ¾ After filling in the header fields, move the insertion point to the space below the message 
header. Type the body of the message here. For information about formatting your message text, see 
Formatting Text.

You can insert pictures and horizontal lines into message text. For details, see Inserting Objects in Message 

Text.



Using an Alternate Email Account

(Sponsored and Paid modes only)

You can set up "multiple personalities" in Eudora for each email account you have. For example, if you have 

Work, Home, and School email accounts, you can set up Eudora to send and receive email from each of these 

accounts, all without having to quit and restart Eudora. That is, you can check mail either for all of your 

accounts, or for selected accounts at once, and you can do the same for sending mail.

You use the Personalities window and the Account Settings dialog to set up your personalities. Your "dominant" 

personality, or principal email account, is set up via the New Account Wizard when you install Eudora and can 

also be modified via the Account Settings dialog.

For detailed information on the Personalities window, its columns, the commands on its context menu (right-

click), and the options in the Account Settings dialog, see Personalities Window. Below is the basic procedure 

for setting up alternate accounts, followed by additional information on using personalities to send and receive 

mail.

To create a new personality, or alternate email account, do the following:

1. From the Tools menu, choose Personalities or click the Personalities window’s tab if it is the inactive 
window in a tabbed group. The Personalities window appears.

2. Right-click anywhere inside the Personalities window and choose New from the context menu (right-
click). The first window of the New Account Wizard appears.

3. Follow the setup instructions in each window of the New Account Wizard to create the new personality. 
See Personalities Window for more information.

4. When you have completed the new account setup, click Finish and the new personality is created.

During new account setup you specify the personality name and the following items associated with the 

account: the real name, the return email address, the login name, and the incoming email server (POP or 

IMAP).

To modify an existing personality, do the following:

1. Open the Personalities window.

2. Right-click the desired personality to display the context menu (right-click).

3. Choose Properties and make your changes in the Account Settings dialog. For more information, see 
Account Settings Dialog.

No options can be changed for alternate personalities except those specified in the New Account wizard or the 

Account Settings dialog; they are effective for all. If you want to change other options for an alternate 

personality or use a separate set of mailboxes for an account, see the section "Putting Multiple Users on One 

PC" in the online Eudora User Manual for additional information.

To create an outgoing message from an alternate account, that is, as an alternate personality, do the following:

1. Open a new message. 

2. In the From field, click the arrow to display your personalities. Choose the desired personality.

Or, in the personality window, select the desired personality and press Enter. 

Or, simply double-click the desired personality. A new message opens from that personality.



When the composition window opens in response to any of the three message-creation methods above, the 

default signature for the selected personality is used. But if a stationery file was selected or a default stationery 

file specified in the account’s options, then the signature stored with the stationery file is used. However, you 

can always change the signature drop-down in the composition window (for details, see Using a Signature ).

After you open a new composition message from a particular personality, you can also change the message’s 

personality, that is, the sender, by selecting the new personality from the Change Personality submenu under 

the Message menu. The From field of the message header changes to the information associated with the new 

personality.

When you respond to a message, Eudora assigns your response the same personality under which it received 

the message. For example, if you receive a message sent to your Home account, your replies to that message 

are sent from your Home account.

Note: You can also set up a filter to automatically assign a desired personality to incoming or outgoing 

messages that satisfy the filter criteria. See the Make Personality action in Filter Actions.



Using Stationery

(Sponsored and Paid modes only)

Stationery files are templates for outgoing messages. If you find yourself repeatedly sending the same 

message, save the message as a stationery file and send it whenever you need to with the New Message With 

or Reply With commands. This way you don’t have to copy and paste text into a message; you can just open a 

prewritten message and edit it as necessary.

Stationery files are created and managed from the Stationery window. For more information, see Stationery 

Window. You can also open a new stationery message from the Stationery window.

For more information, see Creating a Stationery File and Sending a Stationery Message.



Create a Stationery File

(Sponsored and Paid modes only)

To create a new stationery file, do the following:

1. From the Tools menu, choose Stationery or click the Stationery window’s tab if it’s an inactive window 
in a tabbed group. The Stationery window appears. 

Or click the Stationery window’s tab if it is the inactive window in a tabbed group.

2. Right-click anywhere inside the Stationery window and choose New from the context menu (right-click). 
Eudora opens a composition window to be used for stationery. The Send/Queue button is inactive in the 
window; thus the message cannot be sent or queued.

3. Enter the text you want to see into the message body, fill in the headers as appropriate (subject, copies, 
and so forth), and make any desired setting in the toolbar.

4. Choose Save As Stationery from the File menu to display the Save as Stationery dialog box.

5. Enter a file name and click Save to save the stationery file. The file is saved to your Stationery folder.

6. Close the stationery message.



Change a Stationery File

(Sponsored and Paid modes only)

To change a stationery file, do the following:

1. In the Stationery window , right-click the stationery item that you want to change.

2. Choose Edit from the context menu (right-click), then make your changes and save them with the Save As 

Stationery command from the File menu.



Delete a Stationery File

(Sponsored and Paid modes only)

To delete a stationery file, do the following:

1. Select the desired item in the Stationery window and press the delete key; or right-click the stationery item 

and choose Delete from the context menu (right-click). In either case you are prompted to confirm the 

delete.



Send a Stationery Message

(Sponsored and Paid modes only)

To send a stationery message, do the following: 

1. From the Message menu, select a stationery file from the New Message With or Reply With submenus. A 

composition window appears containing the header and body from the stationery file. If you are replying to 

a message, the stationery information is added to the reply. You can edit and send this new message just 

as you would any other message.

2. Or you can send a new stationery message by double-clicking a stationery item in the Stationery window or 

by selecting the stationery item and pressing Enter. In either case, a new composition window opens 

containing the selected stationery.

To use a particular stationery file for all of your outgoing messages, do the following:

1. Open the Tools menu, choose Options, scroll and choose Composing Mail.

2. From the Stationery drop-down in the Composing Mail Options Window (for your dominant account only), 

select a stationery, or in the Account Settings dialog (for any of your personalities), select a stationery. Most 

new messages use this file, unless you create the message using the Redirect, Send Again, New 

Message With, or Reply With command.

You can also set up a filter to reply with a stationery message. See Filtering Messages for more information.



Create a Message with Stationery

(Sponsored and Paid modes only)

To send a stationery message, do the following:

1. From the Message menu, select the stationery you want from the New Message With or Reply With 

submenus. A Composition Window appears containing the toolbar, header, and body from the stationery 

file. 

If you are replying to a message, the stationery is incorporated into the reply. You can edit and send this 

new message just as you would any other message.

The stationery message toolbar overrides any of the Composing Mail or Personality options such as the default 

signature, but you can change them after you open the message. See Filter Actions.



Use a Stationery File for all Outgoing Messages

(Sponsored and Paid modes only)

To use a particular stationery file for all of your outgoing messages, do the following:

1. Open the Tools menu, choose Options, scroll and choose Sending Mail.

2. From the Stationery drop-down in the Composing Mail Options Window (for your dominant account only), 

select a stationery, or in the Account Settings dialog (for any of your personalities), select a stationery. Most 

new messages use this file, unless you create the message using the Redirect, Send Again, New 

Message With, or Reply With command.

You can also set up a filter to reply with a stationery message. See Filtering Messages for more information.



Use a Signature

A signature is a few lines of text that are added automatically to the end of an outgoing message when it is 

sent. A signature can be whatever you want, but it is mostly used to give contact information (telephone, 

address, and so forth). You use only one signature at a time in a message, but you can create as many different 

signatures as you want.

You can choose to see or hide your signature while composing your message. See Composing Mail Options 

Window.

For more information, see Creating a Signature and Including a Signature in Messages.



Create a Signature

Eudora comes with a default signature called Standard. This is an empty signature file that you fill with 

signature text.

To create a new signature, do the following:

1. From the Tools menu, choose Signatures or click the Signature window’s tab if it is the inactive 
window in a tabbed group. The Signature window appears.

2. Right-click anywhere inside the Signature window and choose New from the context menu (right-click). 
Eudora displays the Create New Signature dialog box, and asks you for a name.

3. In the dialog box, enter a signature name and click OK. A signature window appears.

4. Enter your signature text in the signature window. To format the text with styles, see Formatting Text.

5. Save the signature file using the File menu Save command.

6. Close the signature window.



Change a Signature

To change a signature file, do the following:

1. In the Signature window, right-click the signature and choose Edit from the context menu (right-click). The 

signature window appears for that signature. 

2. Make any changes you want, then save the file with the File menu Save command, and close the window.



Delete a Signature

To delete a signature file, do the following:

§ In the Signature window, select the desired signature and press the delete key or right-click the signature 

item and choose Delete from the context menu (right-click). In either case you are prompted to confirm the 

delete.



Include a Signature in Messages

To include a particular signature in an outgoing message, select the signature you want from the Signature 

drop-down list on the message toolbar.

To include a particular signature in all of your outgoing messages—unless you are using stationery—select a 

signature from the Signature drop-down list in the (for your dominant account only), or in the Account Settings 

dialog (for any of your personalities). You can change this signature for a particular message by selecting a 

different signature or None from the Signature drop-down on the message toolbar.

Note that if you open a new composition message with stationery or if you have default stationery set for all 

new messages, then the signature stored with that stationery file is the one used with the new message, 

overriding any default signature. However, you can always make the final decision about what signature to send 

with a new message by choosing it from the Signature drop-down listM on the message toolbar. See Using 

Stationery .



Set the Message Priority

You can assign a priority to incoming and outgoing messages. The priority is only for you and your recipients—it 

does not affect the way mail transport systems handle the messages.

There are five priority levels available, 1 being the highest, 5 being the lowest. Each is represented by a small 

symbol in the Toolbar of a message window and the Priority column of a message summary. Priority 3 (Normal) 

is used for messages that have no assigned priorities; it is not displayed. The Highest priority symbol, a 

double-caret, is red; the Lowest priority symbol, an inverted double-caret, is blue.

New messages are created with a Normal priority. To change the priority of the current message, use the 

Priority drop-down.

Note: To set up Eudora to always use the sender’s priority on your replies, turn on the Copy original’s 

priority to reply option in the Replying Options Window. You can always change the priority in the 

message window.



Request a Return Receipt

(Sponsored and Paid modes only)

You can request that your recipients notify you when they have seen your message. To do this, click the Return 

Receipt button in the message toolbar.

When your recipients open the message and then close it, a dialog box appears asking them to create a 

notification message now, later, or never (if you send yourself a copy of the message, you will see the 

notification request). If a recipient chooses to create a notification message, it is sent to you and tells you when 

the recipient displayed your message.

If you receive a request for notification, click Now to queue the notification message in your Out mailbox: it will 

be sent the next time queued messages are sent. Click Later to close the message without sending a 

notification or click Cancel to dismiss the notification request from the screen while the return receipt message 

is open; however, each time you open the message and then close it (or if you try to delete it), the notification 

request will appear until you click either Now or Never. Click Never to cancel the notification request without 

ever sending a notification message.

The Return Receipt options may work differently than described, depending on your recipients’ email software.



Format Text

(Sponsored and Paid modes only)

You can use standard text-editing options to format the text of your outgoing messages, your text files, and your 

signatures. The formatting your recipient sees depends on how well their email package supports these 

standards.

It’s important to remember that you cannot completely control what happens on your recipient’s computer. 

Depending on the type of computer they are using, their installed fonts, and their options or preferences, they 

could end up viewing something different from what you had intended. Although your formatting changes are 

sent to your recipient, your default text settings are not. Any text that you did not change appears using your 

recipient’s default text, which may be different from yours.

Text in outgoing messages, text files, and signature files can be formatted using the commands on the Edit 

menu Text submenu and using the formatting toolbar.

· To format text, use the text styles buttons on the message window’s Icon bar or from the Text submenu 

from the Edit menu. You can change the font, size, style, color, and the margins.



Text Editing Menu Commands

To format text, do the following:

1. Highlight the text you want to format.

2. From the Edit menu, choose Text. The Text submenu appears. 

3. Select the desired text format that you wish to apply to the highlighted text. If no text is selected but the 

cursor is in the message body, then the font-related commands apply the formatting to the next text you 

type, and the margin-related commands apply the formatting to the current paragraph that contains the 

cursor.

The formatting options are as follows:

Plain, Bold, Italic, Underline ¾ Changes the type face to plain (the default), bold, italic, or underlined.

Typewriter ¾ (Sponsored and Paid modes only) Sets the text to the fixed-width (typewriter-style) message font 
selected in the Fonts options window.

Size ¾ Changes the text to the selected size: Very Small, Small (the default), Medium, Large, Larger, Very 
Large, and Humongous. The increase or decrease is based in standard point size increments.

Remember that you are viewing the text based on your default settings in the Fonts options window, but your 
recipient’s settings and fonts will be different. For example, if your recipient’s default font size is larger than 
yours and you send a message with text set to "Humongous," your recipient will see text larger than yours.

Color ¾ (Sponsored and Paid modes only) Changes the text to black (the default) or the selected color.

Font ¾Changes the text to a certain font by choosing from the fonts available on your system. Remember that 
your recipient may not have the same fonts.

Margins—Normal ¾ (Sponsored and Paid modes only) Aligns the selected or current paragraph’s left margin 
to normal (flush left, the default.

Margins—Indent In, Indent Out ¾ (Sponsored and Paid modes only) Indents the selected or current 
paragraph’s left margin in one level or removes one level of indent.

Left, Right, Center ¾ (Sponsored and Paid modes only) Aligns the selected or current paragraph to the left, 
the right, or the center of the current indent.

Bulleted List ¾ (Sponsored and Paid modes only) Converts the selected text to a bulleted list, or begin a 
bulleted list at the insertion point.

Make Hyperlink ¾ (Sponsored and Paid modes only) Converts the selected piece of text or graphic to a 
clickable, underlined hyperlink to a URL. When your recipient clicks the hyperlink, he or she is immediately 
linked to the URL.

Clear Formatting ¾ Clears all formatting and goes back to the default settings.



Word Wrap

If you turn on the Word Wrap button in the message toolbar, carriage returns are automatically inserted at the 

end of each line of message text, with roughly 76 characters per line when a message is sent. This makes the 

message legible on your recipient’s computer.

Do not include your own carriage returns within paragraphs if you have the Word Wrap option turned on. Only 

use carriage returns to create new paragraphs in the message.

To manually wrap text, do the following:

1. Select the desired text.

2. From the Edit menu, choose Wrap Selection. 

To unwrap text, do the following:

1. Select the desired text.

2. Hold down the Shift key and from the Edit menu, choose Wrap Selection.

To copy wrapped text without the carriage returns (that is, to copy and unwrap), do the following:

1. Select the desired text.

2. Hold down the Shift key and from the Edit menu , choose Copy.



Inserting Objects in Message Text

(Sponsored and Paid modes only)

Use the Insert submenu under the Edit menu to insert pictures and horizontal lines into the body of a message. 

You can also do this using the Insert Object button on the message toolbar.

You can insert an object in the middle of a line of text or between lines of text in the message body.

To insert a picture in message text, do the following:

1. Move the cursor to where you want the picture.

2. From the Edit menu, choose Insert Picture. 

3. In the dialog box that displays, select an image file and click Open. 

The picture is inserted into the message body at the cursor position. You can continue typing text. When your 

recipient opens your message, he or she will see the picture in the message body. Note, however, that what 

your recipient sees depends on whether or not the receiving computer and email package supports the display 

of inline images embedded in message text.

To insert a horizontal line in message text, put the cursor in the message body, then choose Insert Horizontal 

Line from the Edit menu. A horizontal rule is inserted immediately above the line on which the cursor resides.



Attaching a File to a Message

Any file can be attached to and sent with a Eudora message. Most of the time, an attached document functions 

like a "rider" to the email message and does not appear within the message text. Instead, the name of the 

document appears automatically in the Attached field of the message header.

To attach a file to an outgoing message, do the following:

1. From the Message menu, choose Attach File [to New Message]. The Attach File dialog box appears. 

2. Locate the file you want, select it, and click the Open button to attach the document to the current 

message or to open a new message with the file attached. You can add as many attachments as you want 

to a message, one at a time.

You can also drag one or more files from either the Desktop or the File Browser window onto the message 

window to attach them. (See File Browser Window.)

To detach an attached document before the message is sent, do the following:

1. Select the document in the Attached field.

2. Press either the Backspace key or the Delete key.

When the message is sent, if the chosen document is not a plain text (ASCII) file, it is encoded in the selected 

attachment type. This allows you to send any kind of document through the mail, even applications. Encoding 

options for attachments are MIME, BinHex and Uuencode.

If the document is an ASCII file, you can put it in the body of the by turning on the Put text attachments in 

body of message option in the Attachments options window (under Options from the Tool menu). The toolbar 

button applies to the current outgoing message; the Attachments option applies to all outgoing messages.



MIME

This is best for recipients with MIME-compliant email readers, regardless of what operating system they are 

using. For more information on MIME, see the section "MIME and Mapping" in the online Eudora User Manual.



BinHex

This is best for recipients on a Macintosh with an email reader that is not MIME-compliant.



Uuencode

This is best for recipients using PC or UNIX systems that are not MIME-compliant.



Manually Decoding Attachments

If you send an attachment and your recipient’s email program does not correctly decode it, it will probably be 

included in the body of the message in the chosen attachment format (MIME, BinHex, or Uuencode).

If you receive a large message consisting largely of indecipherable text, it is probably an attachment that was 

not automatically decoded. Usually this is because the attachment headers are formatted incorrectly.

To decode an attachment that was not automatically decoded, do the following:

1. Open the message.

2. From the File menu, choose Save As to save the message as a text file. 

3. Run the decoding utility for the encoding method that the sender used. Decoding utilities can be found at 

various shareware sites on the Internet.



Including a URL in a Message

(Sponsored and Paid modes only)

To include a hot link in a message—also known as a URL, for Uniform Resource Locator—enclose it with less 

than and greater than signs (angle brackets) to ensure that your recipient’s email application can identify it as a 

URL. For example, <http://www.eudora.com>.



Creating a Hyperlink in a Message

(Sponsored and Paid modes only)

Eudora lets you create a hyperlink in an outgoing message; that is, convert a piece of text or a graphic into a 

link to a URL, so when your recipients click the text or graphic, their browser opens and takes them to that URL.

To create a hyperlink, do the following:

1. Type the text you want to link in your outgoing message.

2. Select the text to highlight it or insert a graphic file using the Insert then Picture command under the Edit 

menu and select the inserted graphic. 

3. From the Text submenu under the Edit menu, choose Make Hyperlink, or click the insert Hyperlink icon 

on the message toolbar. 

4. In the URL field of the Hyperlink dialog box, enter the full address of the URL, for example, 

<http://www.eudora.com> 

5.  Click OK. 

The text or graphic is now linked, highlighted, and underlined in the message. When your recipient receives the 

message, opens it, and clicks on the hyperlink, their browser or other application will open and go directly to the 

URL you specified.



Checking Your Spelling

(Sponsored and Paid modes only)

Eudora includes a built-in spelling checker that checks for misspellings in the Subject field of the header and 

the body of current message composition windows, text files, and signature files. It includes a built-in dictionary 

and also allows for the creation of a custom user dictionary. Additionally, it can be configured to ignore 

capitalized words, words with all capitals, words with numbers, and mixed-case words; to report doubled 

(repeated) words; and to suggest alternative spellings.

Note: Changes to the spelling options can be made in the Spell Checking Options Window found in Options 

under the Tools Menu or by selecting Options from the Check Spelling dialog box.

See the "Sources" section in the online Eudora User Manual for information on how to get dictionaries for 

languages other than U.S. English.

To automatically check spelling    as you type, turn on the Automatically as you type option in the Spell 

Checking options window . If this option is on, then when you send or queue a message, the message is 

checked for spelling errors. If you complete the spell-checking process, the message is automatically sent or 

queued. If you instead click Cancel, or leave spelling errors in the message, a dialog box appears asking you if 

you still want to send or queue the message. If you don’t want that dialog box to be displayed, turn off the Warn 

me when sending/queueing message with misspellings option (this can also be set in the Spell Checking 

options window ).

To check the spelling of a current composition window, text file, or signature file, click the Check Spelling 

button in the main window toolbar or choose Check Spelling from the Edit menu (Ctrl+6). If there are no 

misspellings, the "No misspellings found" alert appears.

Note: For an alternate way to check your spelling using the Shift+Check Spelling option, which lets you 

see all misspelled words at once and change only those you want to, see Automatic Spell Checking.

Note: If text is selected, Eudora checks the spelling only of the selected text. Otherwise, it starts the spelling 

check from the beginning of the message body or text file, and checks the entire text.

If a misspelled, unknown, or repeated word is found, the Check Spelling dialog box appears with the word listed 

in the Unknown field.

To correct the misspelled word, either (1) type the correct spelling of the word in the Change To field (if it is not 

already there) and click the Change button, (2) select the correct word from the Suggestions list and click the 

Change button, or (3) double-click the correct word in the Suggestions list. The spelling checker then proceeds 

with the check. 



Check Spelling Dialog

(Sponsored and Paid modes only)

The Check Spelling dialog box allows you to ignore an unknown word, change it, suggest the correct spelling, 

add the word to your user dictionary, edit your dictionary, or change the spelling options. Each of the fields and 

buttons is described below.

Unknown ¾ An unknown word is one that is not found in Eudora’s built-in dictionary or your own custom 
dictionary. You can act on an unknown word using the Ignore, Ignore all, Change, Change all, or Add buttons, 
as described below.

Change To ¾ This field works in conjunction with the Change and Change all buttons. It allows you to modify 
the unknown word by typing its correct spelling in this field, or selecting a suggested alternative spelling from 
the Suggestions field, and then clicking the Change or Change all buttons, as described below.

Suggestions    ¾ This field lists Eudora’s suggestions for the correct spelling of the unknown word. If the 
Suggest words option is turned on, all suggestions are listed here by default. If the option is turned off, click the 
Suggest button to display Eudora’s suggestions.

Ignore ¾ This button causes the spelling checker to ignore this occurrence of the unknown word.

Ignore all ¾ This button causes the spelling checker to ignore this occurrence and all subsequent occurrences 
of the unknown word.

Change ¾ This button substitutes the contents of the Change To field for the unknown word.

Change all ¾ This button substitutes the contents of the Change To field for this occurrence and all subsequent 
occurrences of the unknown word.

Suggest ¾ This button causes the Suggestions field to display a list of Eudora’s suggestions for the correct 
spelling of the unknown word.

Note: If Eudora doesn’t have suggestions in its dictionary, then it doesn’t list any suggestions.

Add ¾ This button adds the unknown word to your custom user dictionary.

Edit Dictionary ¾ This button displays the Edit User Dictionary dialog box. The Edit User Dictionary dialog box 
lists all of the words in your user dictionary in the Dictionary field. It also allows you to add words to or delete 
words from your personal user dictionary, or even clear the entire dictionary.

Note: Words in the user dictionary are saved in all lower case.

To add a word to the dictionary using this dialog box, type the correct spelling of the word in the Word field and 

click the Add button. The word is then added to the dictionary and displayed in the Dictionary field.

Note: The Add button in this dialog box works the same as the Add button in the Check Spelling dialog box.

To remove a word from the user dictionary, first type it in the Word field, or locate it in the Dictionary field and 

single-click it to display it in the Word field, then click the Delete button.

To delete the entire user dictionary, click the Clear button. You will then be prompted to confirm the deletions. If 

you click Yes, all of the words are deleted from the user dictionary.

Options Button ¾ This button displays the Spelling Options dialog box.

The Spelling options window lists the spell-checking options. A checkmark in the box next to the option name 

indicates that the option is turned on.



Note: The spelling options can also be modified in the Options dialog box (Spell Checking category).

The options are as follows:

Ignore capitalized words ¾ The spelling checker ignores words that start with a capital letter, such as proper 

nouns.

Ignore words with all capitals ¾ The spelling checker ignores words that contain all capital letters, such as 

acronyms.

Ignore words with numbers ¾ The spelling checker ignores words that contain numbers.

Ignore words with mixed case ¾ The spelling checker ignores words that contain a mixture of uppercase and 

lowercase characters.

Report doubled words ¾ The spelling checker reports words that appear twice in sequence in text and 

identifies them as Doubled words.

Suggest words ¾ The spelling checker displays Eudora’s suggestions for the correct spelling of an unknown 

word. You can select any combination of the suggestion options: Phonetic words, Split words, Typographic 

words.

Note: If Eudora doesn’t have suggestions in its dictionary, then it doesn’t list anything.



Saving a Message for Later Changes

Sometimes it is convenient to save an outgoing message either as a safeguard when typing long messages or 

so you can return to it later to make changes.

To save the current message, do the following:

1. From the File menu, choose Save. Saved messages are put in the Out mailbox, and if at least one 

recipient is entered in either the To or the Bcc field, the saved message is shown with a bullet (•) in the 

Status column. If both the To and the Bcc fields are empty, the Status column is blank. The bullet indicates 

that the message not only has been saved, but is also ready to be sent or queued.

You can continue making changes to the message or close it. If you try to close an outgoing message window 

without saving that version of the message, an alert appears asking if the message should be saved or the 

changes discarded. If you select Discard and the message has never been saved, the message is deleted. 



Sending a Message Immediately

If you want to send your messages immediately instead of putting them in a queue to send later, then be sure 

the Immediate send option is on in the Sending Mail Options Window. The Sending Mail options are found on 

the Sending Mail window in Options under the Tools menu.

To send the current message, do the following:

1. Click the Send button or from the Message menu, choose Send Immediately. A progress window appears 

to show the progress of the transmission.

If you have the Immediate send option on, but want to put the current message in the queue, hold down the 

Shift key and click the Send button. The Change Queueing dialog box appears and you can set detailed 

instructions. For more details, see Queueing a Message to Send at a Certain Time. 



Queueing a Message to Send Later

If you want to put your messages in a queue in the Out mailbox to send all together at a later time, be sure the 

Immediate send option is off in the Sending Mail Options Window. The Sending Mail options are found on the 

Sending Mail window in Options under the Tools menu.

You can set up Eudora to warn you if you try to delete a queued message or try to quit Eudora before queued 

messages have been sent. To do this, turn those options on in the Extra Warnings options. The Extra 

Warnings options are found on the Extra Warnings window in Options under the Tools menu.

To put the current message in the queue, do the following:

1. Click the Queue button or from the Message menu, choose Queue For Delivery. The message window is 

closed (if it was open), the message is saved in the Out mailbox marked Q (meaning it’s ready to be sent), 

and the date and time are placed in the Date column.

To send all of your queued messages, do the following:

1. From the File menu, choose Send Queued Messages. A progress window appears momentarily at the top 

of the screen indicating the progress of the transmission.

If you have the Immediate send option off, but want to send a message immediately, hold down the Shift key 

and click the Queue button. The Change Queueing dialog box appears and you can choose the Send 

Message Right now option. 



Queueing a Message to Send at a Certain Time

You can specify that a message be sent at a certain time in the future. To do this for the current outgoing 

message, choose Queueing from the Change submenu under the Message menu. The Change Queueing 

dialog box appears.

If you choose Right now, the message is sent immediately when you click OK. If you choose Next time 

queued messages are sent, the message is sent the next time queued messages are sent.

If you choose On or after, you can use the Time and Date fields to fill in the time and date at which the 

message should be sent. The message is saved in the Out mailbox with a clock icon in the Status column, and 

the specified date and time in the Date column. The message is sent when the specified time arrives.

Important: For the message to be sent at the correct time, Eudora must be up and running at that time. If 

Eudora is not running, the message is sent the first time Eudora is run after the specified time 

has passed.

If you choose Don’t send for a message that has never been queued, nothing happens. The message is held 

in the Out mailbox until it is either deleted or re-queued and sent. 



Editing a Queued Message

To edit a queued message, do the following:

1. Open the Out mailbox.

2. Select the desired message summary. 

3. Make the necessary edits and save them. The message is kept in the Out mailbox. If you close the 

changed message without saving it, an alert appears asking you to verify the changes.



Taking a Message Out of the Queue

A message that is queued but is not yet sent can be unqueued using the Change Queueing command. To take 

a message out of the queue, do the following:

1. Open the Out mailbox. 

2. Select the desired message summary. 

3. From the Message menu, choose Change Queueing and click Don’t send. This changes the message 

status from queued (Q) to sendable (•). The message is held in the Out mailbox until it is either deleted, re-

queued, or sent. To send the message immediately, open it and click Send.



Sending Queued Messages When Checking Mail

If the Send on check option in the Sending Mail Options Window is on, then every time Eudora checks for mail 

(automatically or manually), all queued messages are automatically sent.



Sending Messages with Special Server Instructions

To send your queued messages with special instructions for the server (POP server only), do the following:

1. Hold down the Shift key and from the File menu choose Send Queued Messages. The Mail Transfer 

Options dialog box appears. 

2. Set the options you want and click OK. All the actions you have requested are completed. For details, see 

Managing your Mail on a POP Server.



Replying to a Message

To reply to the current message, do the following:

1. From the Message menu, choose Reply. 

A new message window appears with the original sender’s address automatically placed in the To field of the 

header. All of the sender’s original text is quoted in the message body. This text can be edited as needed. 

Additional text can be added to the reply just as to any outgoing message, and the reply can then be sent or 

saved for further changes.

The sender’s text is quoted in the message with a left sidebar, also called an "excerpt bar."

Messages that have been replied to are identified with a left arrow in the Status column of their message 

summary.



Using the Reply Functions

There are several options for replying to messages.

To include everyone who received the original message, do the following:

1. From the Message menu, choose Reply to All.

To include yourself as a recipient, do the following:

1. Open the Tools menu and choose Options.

2. Scroll and select Replying. The Replying dialog box appears.

3. Check the Include yourself box and click OK. This only works if you are using Reply to All.

Note: To determine who you are for the Include yourself option, Eudora uses the "me" nickname. If you do 

not have a "me" nickname set up in your Address Book, Eudora uses the contents of the Mail Server 

(Incoming), Login Name, and Return address fields from the Getting Started Options Window. 

(Incoming mail accounts are usually of the form loginname@mailservername.) The "me" nickname 

is particularly useful if you have multiple addresses and don’t want replies to go to any of those 

addresses.

To put the addresses of the other recipients of the original message in the Cc field (instead of the To field), do 

the following:

1. Open the Tools menu and choose Options.

2. Scroll and select Replying. The Replying dialog box appears.

3. Check the Put original To: recipients in Cc: field box and click OK. Only the original sender’s address is 

put in the To field. This works only if you are using Reply to All.

To copy the original message’s priority to your replies, do the following:

1. Open the Tools menu and choose Options.

2. Scroll and select Replying. The Replying dialog box appears.

3. Check the Copy original’s priority to reply box in the Replying Options Window.

To change the keyboard shortcut Ctrl+R from its normal function of Reply to Reply to All, do the following:

1. Open the Tools menu and choose Options.

2. Scroll and select Replying. The Replying dialog box appears.

3. Check the Map Ctrl+R to "Reply to All" box in the Replying dialog box. The change is reflected on the 

Message menu.



Replying with a Stationery File

(Sponsored and Paid modes only)

To reply to a message with a stationery file, do the following:

1. From the Message menu, choose Reply With.

2. From the Reply With submenu, select a stationery file. The stationery file is opened as a message and is 

addressed as appropriate (your Replying options are used). For information on stationery files, see Using 

Stationery.

Other ways to reply with stationery:

• With the desired message open or selected in a mailbox window, open the Stationery window, right-click a 

stationery item, and choose Reply With from the drop-down menu.

• With the desired message open or selected in a mailbox window, open the Personalities window, right-click 

a personality, and choose Reply As from the Message submenu of the drop-down menu. The default 

stationery assigned to that personality is used in the reply.

• With the Personalities window open, drag an open message by its Tow Truck, or drag selected message 

summaries in a mailbox window onto a personality in the Personalities window: a reply is initiated from that 

personality, and the stationery stored with that personality is used in the reply.

• Set up a filter that uses the Reply with filter action. See Filtering Messages and Filter Actions.



Forwarding a Message

Any message can be forwarded to someone else. To forward the current message, do the following:

1. From the Message menu, choose Forward. 

A new message window appears with your address in the From field, the original subject preceded by "Fwd:" 

and a space in the Subject field, the original sender’s text quoted in the message body, and the original 

attachments in the Attached field. For details on how text is quoted, see Replying to a Message. Make any 

changes you want, and enter the recipient’s address in the To field. The message can then be sent or saved for 

further changes.

Note: If you forward an outgoing message (a message you sent), the attachments are not automatically 

included.

Messages that have been forwarded are identified with a right arrow in the Status column of their message 

summary.

Other ways to forward a message:

• With the desired message open or selected in a mailbox window, open the Personalities window, right-click 

a personality, and choose Forward As from the Message submenu of the drop-down menu.

• Set up a filter that uses the Forward To filter action. See Filtering Messages and Filter Actions.



Redirecting a Message

Incoming messages can be sent to a new recipient "by way of" you, maintaining the original sender’s address 

in the From field. This is called redirecting.

To redirect the current message, do the following:

1. From the Message menu, choose Redirect. 

A new message window appears with the original sender’s address in the From field and the statement "by 

way of" followed by your real name and/or return address, the original sender’s text in the message body, and 

the original attachments in the Attached field. Make any changes you want, and enter the recipient’s address 

in the To field. The message can then be sent or saved for further changes.

Note: You may want to enclose any changes in brackets ([]) so that you don’t confuse the recipient about 

who wrote what.

Messages that have been redirected are identified with a diagonal arrow pointing up and right in the Status 

column of their message summary.

Other ways to redirect a message:

• With the desired message open or selected in a mailbox window, open the Personalities window, right-click 

a personality, and choose Redirect As from the Message submenu of the drop-down menu.

• Set up a filter that uses the Redirect To filter action. See the sections Filtering Messages and Filter Actions.



Turbo Redirecting

You can redirect a message to someone on your recipient list, queue the new message (without displaying it), 

and delete the original message, all with one command. To turbo redirect a message, do the following:

1. From the Tools menu, choose Options.

2. Scroll and select the Miscellaneous icon. The Miscellaneous options window appears.

3. Check the Turbo redirect by default box and click OK. 

When you select a recipient from the Redirect To submenu under the Message menu, a turbo redirect is 

automatically performed.



Redirect and Signatures

When you use Redirect or Redirect To, your signature is not added to the message when it is sent, unless you 

originally created the message. Eudora considers the message to be originally from you if the address in the 

From field exactly matches either your return address or one of the addresses belonging to your nickname    

"me," if you have one.



Keeping Copies of Outgoing Messages

There are three ways to keep copies of your outgoing messages.

• To put a copy of every outgoing message in the Out mailbox, turn on the Keep copies option in the 

Composing Mail Options Window . To put a copy of the current outgoing message in the Out mailbox, turn 

on the Keep Copy button in the message toolbar.

• To put a copy of the current outgoing message in a particular mailbox, right-click in the body of the message 

and select the mailbox from the Fcc menu.

In all these cases, when the messages are sent they are put in the specified mailbox with a checkmark in the 

Status column, indicating that the message has been sent.

If none of these options are used, outgoing messages are put into the Trash mailbox after they have been sent.

Note: You can also set up a filter to save outgoing messages in particular mailboxes based on information 

contained in the message. See Filtering Messages for more information.



Sending Rejected Messages Again

If for some reason an email message can’t be delivered to a recipient, mail transport agents return the 

message to the original sender (you). A message is typically rejected because of an error in the recipient’s 

address, although other reasons are possible.

The return message usually includes cryptic information that may let you determine the reason the message 

was rejected. It also includes the text of the original message.

You can easily recover the original message, make any corrections, and resend it.    To resend a rejected 

message again, do the following:

1. From the Message menu, choose Send Again. This eliminates the inserted extra text and reformats the 

message as it originally appeared. You can then make changes or additions and send the message again.

The Send Again command is also useful for resending saved messages—from your Out box, for example—

and messages you’ve copied to yourself, in order to save yourself some retyping. You can send the same 

message to another recipient to avoid having to retype the whole message, or you can send a different 

message to the same recipients to avoid having to retype their addresses in the header.

Another way to send a message again: 

1. In a mailbox window, open or select the desired message. 

2. From the Tools menu, choose Personalities, or select the Personalities tab. The Personalities window 

opens.

3. Right-click a personality, and from the Message submenu of the drop-down menu, choose Send Again 

As. 

The message is sent again but from the selected personality (which may or may not be the same as the 

personality under which it was originally sent).



Checking for Incoming Mail

The incoming mail server is where your mail is received and stored until it is transferred by Eudora to your 

computer. You can use several different mail accounts with Eudora: Your main account, or "dominant 

personality," is specified in Configuring Eudora, and additional mail accounts, or "multiple personalities," are 

described in Personalities Window and Account Settings Dialog.

Note: To best understand the functioning of the incoming mail server with respect to Eudora, see the section 

"Mail Transport" in the Online Eudora User Manual.

There are two ways to check your incoming mail server and transfer mail to your computer: automatically or 

manually. 

You can also control how your mail is transferred from the server, and what happens to it on the server. For 

details, see Managing your mail on a POP Server and Managing Your Mail on the IMAP Server. 



Checking for Mail Automatically

To set up Eudora to automatically check your incoming mail account and transfer new mail, do the following:

1. From the Tools menu, choose Options.

2. Scroll and select Checking Mail.

3. In the Check for mail every _ minutes field, enter the number of minutes that you want between mail 

checks. 

4. Open the Personalities window and for each personality that you want to be automatically checked, right-

click the personality, choose Properties from the context menu (right-click), and when the Account Settings 

dialog appears, turn on the Check Mail option for that personality.

Note: Fifteen minutes is a good minimum interval because checking mail more frequently puts an 

unnecessary load on your incoming mail server. If the field is empty, or is set to 0, mail is not 

automatically checked.

If automatic checking is set, the Check Mail command under the File menu displays the next time that 

an automatic check is scheduled to occur.

The Check Mail option also specifies that an account should be checked for new mail when a manual mail 

check is done.



Checking for Mail Manually

You can manually check for new mail at any time by selecting Check Mail from the File menu. Any account that 

has the Check Mail option turned on (in the Account Settings dialog accessed from the Personalities window) 

is checked. If you haven’t successfully entered your password since opening the Eudora program, you are 

prompted for it for each account being checked. A progress window is momentarily displayed at the top of the 

screen indicating that an attempt to reach your incoming mail account is being made. 



Using Your Password

Each time you open Eudora and check mail for the first time, you need to enter a password for each incoming 

mail account that you have. This password is required by the incoming mail server before it will transfer your 

mail, so that no one else can get your mail from the server.

Note: This does not protect your mail once it is on your computer. Unless a message has been sent with 

some type of security, it is plain text that many applications can read. If you are interested in securing 

the messages on your computer, you may want to consider a disk driver that can encrypt hard disk 

data.

If you need to enter a password, the Eudora Password dialog box appears. Enter your password and click OK. 

If you make a mistake before clicking OK, simply backspace and re-enter the password correctly.

Note: Your incoming mail account password is case sensitive, so the uppercase and lowercase characters 

must be typed in exactly. Be sure that Caps Lock is off.

If your password is rejected, an error message appears indicating that you have entered the wrong password. 

Choose Check Mail from the File menu to redisplay the password dialog box.

As long as Eudora is running, it remembers all of your passwords. If you don’t want it to remember (if, for 

example, you are away from your computer), choose Forget Password(s) from the Special menu. The next 

time you check mail for any account, you are prompted for your password again.

Note:      If you have more than one personality, a window appears listing the names of your personalities. 

You can select the personalities whose passwords you want Eudora to forget. All the personalities are 

selected by default. Deselect the personalities you don’t want Eudora to forget. 

You can also make Eudora remember all of your passwords from one session to the next, which means you 

never have to enter passwords again, even if you quit and restart Eudora. You want to do this only if your 

computer is in a secure location where there is no possible chance of someone else is having access to it. To 

use this option, turn on Save password in the Checking Mail Options Window.



Changing Your Password

To change the password for one of your personalities, choose Change Password from the Special menu, and 

select the personality whose password you want to change. You are prompted to enter your old password once 

and your new password twice. Depending on the server you are using, the password can be up to 30 

characters, but normally it is only 7 or 8.

Note: This only works if the incoming mail server is running a compatible password-change server. For 

information about these servers, see the "Sources" section of the Online Eudora User Manual.

When you choose a new password, try not to use real words, names, dates, or familiar acronyms. Some 

systems require you to use at least one number or symbol in your password, and you may want to do that even 

if it is not required.



Receiving New Mail

When Eudora does a mail check, you can be notified of new mail in one or all of the following ways: 

· Alert dialog box

· Mailbox receiving new mail opens

·  "New Mail" sound. 

These options are turned on or off in the Getting Attention window. To display the Getting Attention window, 

open the Tools menu, choose Options. Scroll through the icons and select Getting Attention.

When you receive notice that new mail has arrived, select Eudora from the Windows task bar. Mail usually 

arrives in the In mailbox unless you are using filters to transfer messages. If the In mailbox is not already open, 

from the Mailbox menu, choose In. The messages are listed in the order that they are received, with the most 

recent message listed last. Unread messages are designated by a bullet in the Status column of the message 

summary.

Double-click a message summary to open the message. You can also view messages using the message 

preview window at the bottom of the mailbox window while the message summary is highlighted.

Incoming messages are saved indefinitely in the In mailbox (or the mailbox they are filtered into) until they are 

deleted or transferred to another mailbox.



Incoming Message Window

To open an incoming message, double-click its message summary in a mailbox window, or, if the message 

summary is current (highlighted), press the Spacebar or Enter key.

Note: You can also view the message in the message preview window. See The Message Preview Pane for 

more details.

The incoming message window consists of the title bar, the toolbar, and the message body.

Title Bar ¾ The title bar provides information about the message, including the name of the sender, the time 
and date the message was delivered, and the message subject.

Toolbar ¾ The toolbar consists of buttons and drop-downs displayed just under the title bar.

Tow Truck ¾ This icon can be used to drag any current message into a different mailbox. Just hold the mouse 

button down on the icon and drag it to an open mailbox or a mailbox in the Mailboxes window.

Fixed Width ¾ Click this button to convert the message text to the fixed-width (typewriter style) message font 

set in your Fonts options window. This lets you view aligned text, such as columns and tables, more easily.

BLAH BLAH BLAH ¾ If this button is on, all the message headers and any formatting codes are displayed.

Pencil ¾ If this button is on, you can edit the message.

Delete From Server ¾ If this button is on, the message is deleted from the server the next time mail is 

checked.

Retrieve From Server (Fetch) ¾ If this button is on, the message is retrieved (fetched) from the server the 

next time mail is checked.

Priority drop-down list ¾ This button lets you indicate that the message is of higher or lower priority than a 

normal message. For most messages, this is just an empty box (normal priority). For details, see Setting the 

Message Priority .

Subject ¾ This button is the subject that was assigned by the sender, and is shown in the message summary. 

For instructions on changing this subject, see Editing Incoming Messages .

Message Body ¾ The message body contains the message header and text information as well as the name 

of each attachment.

Eudora lets you view incoming mail with advanced formatting, graphics, multimedia, and the like. Additionally, if 

you have the Use Microsoft’s viewer option turned on in the Viewing Mail Options Window , and you have 

Microsoft Internet Explorer 4.0 or later installed and available on your system, Eudora lets you take full 

advantage of the viewing capabilities of a Web browser in the email message itself or linked to the Internet 

without having to open your Web browser.



Receiving Attachments

Unless you have specified a particular directory for your incoming attachments (see Specifying an Attachment 

Directory), they are automatically decoded and saved in the Attach Directory in your Eudora Directory. If you 

receive multiple attachments with the same name, a number is added to the end of each duplicate name in the 

order they are received.

Attachment names are displayed at the bottom of incoming messages and the message preview window. 

To open an attachment from the open message window or the message preview window, click the attachment 

name or its icon. If you have the application that the attachment was created in, that application launches and 

the attachment opens.

You can drag and drop attachments from your message. Use this feature to easily file the documents you 

receive.

If you receive a large message consisting largely of indecipherable text, it is probably an attachment that was 

not correctly decoded. Usually this is because the attachment headers are formatted incorrectly. To decode an 

attachment that was not automatically decoded, open the message and choose Save As from the File menu to 

save the message as a text file. Then run the decoding utility appropriate for the encoding method that the 

sender used. Decoding utilities can be found at various shareware sites on the Internet. Also see Attaching a 

File to a Message.

When receiving email messages from a mailing list that supports MIME digest, you can now have Eudora 

create a mailbox specifically for these messages. To turn this feature on, go to the Tools menu, choose 

Options. Scroll and choose Attachments. Check the Receive MIME digest as a mailbox attachment box.



Specifying an Attachment Directory

If you do not want to use the default Attach Directory to receive your attachments, do the following:

1. From the Tools menu, choose Options and scroll and select    Attachments. 

2. Beneath the Attachment directory prompt, click the large button. A standard file dialog box appears.

3. Double-click the name of the directory you want to use (its name should be displayed above the list).

4. Click    Use Directory. The dialog box closes, leaving the Options dialog box displayed. The name of the 

folder you just selected is now displayed in the Attachment directory button.

Note: If at any time Eudora cannot find your selected directory, Eudora will use the Attach Directory in the 

Eudora Directory for attachments until you designate a new directory.



Editing Incoming Messages

You can edit the message body in an incoming message if you turn on the Pencil button in the Toolbar. You can 

also edit the Subject in the Toolbar (this is the subject shown in the message summary), without turning on the 

Pencil button.

To edit an incoming message, do the following:

1. Click the Pencil button to turn it on.

2. Edit the text in the message body. (See Formatting Text for details on how you edit the message text.) 

3. When you are finished, save your changes and close the message.

To edit the subject of an incoming message, open it and edit the subject in the Toolbar (not the subject in the 

message body). When you are finished, click somewhere else in the message or close it. The new subject 

appears in the message summary. The contents of the Subject field of the message header remain 

unchanged.

Note: If you reply to the message, the original subject is used for the reply, not your changed subject.



Using Active URLs

(Sponsored and Paid modes only)

Any string of text that Eudora recognizes as a hot link or URL (Uniform Resource Locator, such as http, ftp, 

gopher, ph, finger) is active. Click a URL to open a World Wide Web location, transfer a file, do a gopher 

search, or use the finger tool. URLs are highlighted and underlined to show that they are active.



Managing your Mail on a POP Server.

During a mail check, your incoming messages are normally transferred from your account on the POP server to 

your computer, and then deleted from the POP server. But this can be awkward if you want to read mail from 

two or more computers and keep your mail organized at the same time.

There are several options that you can use to control your mail transfers and the storage on the server. Some 

of these options are available in the Incoming Mail Options Window for your dominant account only, and the 

Account Settings window, for any of your personalities; some of the options are available in the Mail Transfer 

options window. To access these windows, open the Tools menu and choose Options. Scroll to find the 

windows you need.



Managing your Mail on the IMAP Server

If your incoming mail server uses the Internet Message Access Protocol (IMAP), you manage your mail, 

mailboxes, and folders on the server, not on your computer. You actually create mailboxes and on the server, 

but    you can see them in the Mailboxes window in Eudora. When you launch Eudora, you retrieve your 

mailboxes and folders from the server. When you check mail, the mail you retrieve is filtered on the server 

although your filters are created in Eudora. This is beneficial if you have to retrieve mail from different 

computers because your mail remains on the server for you to retrieve at anytime on any computer.

During mail checks, partial messages or full messages are transferred to your computer, with or without 

attachments, depending on the options you specify in the Incoming Mail options window for your main account 

(see Incoming Mail Options Window). This is beneficial if you use a computer with limited disk space or a slow 

network connection. To specify options for your personalities, access the Account Settings dialog box from the 

Personalities window (see Account Settings Dialog). 

When a message is transferred either in part or in full from the IMAP server to your computer during a mail 

check, a copy of the message remains on the server until you actively delete it. 



IMAP Tasks Performed Offline

If you use IMAP as your incoming server, you can perform tasks offline. Being offline is a preferred method 

when you are using a laptop away from home or office.

When you are offline, you are disconnected from the server. 

To go offline, do the following:

1. Move your mouse pointer to the taskbar and right-click. A context drop-down menu appears.

2. From the context menu (right-click), choose Offline. You are now disconnected from your IMAP server.

When offline, you can do the following:

· Disable timed mail checks

· Manually check for mail

· Transfer and delete messages after they are retrieved. However, a dialog box appears asking you to 

connect for as long as it takes to transfer and delete your messages. When the tasks are completed, you 

immediately disconnect from the server. 



Downloading Minimal Headers vs. the Full Message

By default, the Minimal Headers Only option is turned on in the Incoming Mail Options Window for your 

dominant account and in the Account Settings dialog for your alternate personalities.

As a result, when you check mail for an account and the incoming mail is delivered to your IMAP server, only a 

minimal amount of information about each message is transferred to your computer. This consists of the 

information you would see in the message summary of a mailbox window: the sender, the date and time of the 

message, the subject, and so forth. However, when you open or preview the message, the full set of message 

headers and the entire message body is transferred to your computer. Whether or not any attachments to the 

message are also transferred depends on your setting for the Full Message Except Attachments Over _    K 

option which is found under the Tools menu, Options, then Incoming Mail.

If you always want the full message to be transferred to your computer during mail checks (with or without 

attachments, as specified separately) rather than just the minimal headers, turn off the Minimal Headers Only 

option.



Full Message Except Attachments Over _ K

To prevent Eudora from transferring large attachments to your computer during mail checks, turn on the Full 

message except attachments over _ K option and specify a size. You can set this option in the Incoming Mail 

options for your main account, or in the Account Settings dialog box for any of your personalities. See Incoming 

Mail Options Window.

Subsequently, each time mail is checked for the account, attachments larger than the specified size are not 

transferred to your computer with the message. The rest of the message is transferred including the complete 

message body. Attachments within the specified size are also transferred.

Attachments not transferred during mail checks can be retrieved, however. When you open or preview the 

message associated with the attachment, an icon for the attachment appears in the incoming message window 

or the message preview pane. To retrieve the attachment, do the following:

· Click the icon to retrieve the attachment from the IMAP server or right-click a message to display the 

drop-down menu; and from the drop-down menu, choose Fetch, then Include Attachments.

If you wish to re-retrieve a message at any time, do the following:

1. Right-click a message to display the drop-down menu. 

2. From the drop-down menu, choose Fetch. 

3. Either choose Include Attachments or Use Defaults. If you want to delete the local copy of a message, 

right-click the message to display the drop-down menu. From the drop-down menu, choose Remove 

Cached Contents. The message still exists on the server if you want to re-retrieve it. 

If the "Full message except attachments over _ K" option is deselected, then all attachments are transferred to 

your computer during mail checks, regardless of their size.

Important: In IMAP, your attachments download to the Attach folder, which is in the IMAP folder. 

However, if you have previously set up a directory in the Attachments options window where you want 

your attachments to go, all attachments (POP and IMAP) go to that directory. See Attachments 

Options Window.



Deleting a Message from the IMAP Server

If you have the When I delete a message, move it to Trash option turned off in the Incoming Mail options 

window (see Incoming Mail Options Window), all new messages are delivered to your IMAP server and are 

kept there until you actively delete them. 

Also, whenever you retrieve a message either in part or in full from the IMAP server to your computer, a copy of 

the message is kept on the IMAP server until you actively delete it. 

Therefore to delete an IMAP message, you must delete it from the IMAP server. To delete messages from the 

IMAP server, you must perform two steps. 

· Mark the message for deletion. 

· Remove all marked messages.

To mark a message for deletion, do the following:

1. Open the IMAP mailbox or folder containing the message.

2. Select or open the message.

3. From the Message menu, choose Delete. Or press the Delete key. 

To unmark a marked message so that it won’t be deleted from the IMAP server, select or open the 
message and from the Message menu, choose UnDelete. Or right-click to display the drop-down menu; 
then choose UnDelete.

4. To remove all messages from the IMAP server marked for deletion, from the Message menu, choose 
Purge Messages. The messages are completely removed both from the IMAP server and from your 
computer.

Once you remove marked messages using the "Purge Messages" command, these messages are completely 
gone and cannot be restored. Therefore, use this command with caution.



Resynchronizing an IMAP Mailbox or Folder

General mailbox and folder management for POP and IMAP servers is performed from the Mailboxes window. 

See Using the Mailboxes Window for more information. This section discusses resynchronization.

Keeping your mailboxes and folders remotely on an IMAP server lets you perform operations on them from 

different computers. For a particular IMAP mailbox, you may delete some messages from the mailbox from one 

computer; check mail from another computer, resulting in new messages being transferred to the mailbox; and 

change the status of some of the messages from a third computer.

Each computer has no idea what has been done to the mailbox from the other computer until you 

resynchronize the mailbox, which updates all operations performed on the mailbox from all computers that have 

access to the mailbox. In some situations, others may have access to these same mailboxes.

To resynchronize an IMAP mailbox or folder, do the following:

1. From the Tools menu, choose Mailboxes, or click the Mailboxes window tab if it is the inactive window in a 

tabbed group. The Mailboxes window appears.

2. Right-click the mailbox or folder to display the drop-down menu.

3. From the drop-down menu, choose Resynchronize Mailbox. The content of the mailbox or folder is 

completely updated according to all operations that have been performed on the mailbox from all 

computers that have access to it.

Note: Every time you open an IMAP mailbox, you cause it to resynchronize automatically.

General mailbox and folder management for POP and IMAP servers is performed from the Mailboxes window. 

For more information, see Using the Mailboxes Window. 



Refreshing Your List of IMAP Mailboxes and Folders

General mailbox and folder management for POP and IMAP servers is performed from the Mailboxes window. 

See Using the Mailboxes Window for more information. This section discusses how to update the list of IMAP 

mailboxes and folders in the Mailboxes window.

If you have shared folders set up, you and other users can access and change messages stored in mailboxes 

and folders you keep stored remotely on an IMAP server. However, users may access shared folders only; your 

personal folders cannot be accessed. The Mailboxes window does not reflect the "real-time" status of the IMAP 

mailbox list, and between mail checks, a disparity can grow between what appears in the list and what is 

actually on the IMAP server, as new mailboxes are added and existing ones are changed or removed.

To refresh your list of mailboxes and folders on the IMAP server, as it appears in the Mailboxes window, do the 

following:

1. From the Tools menu, choose Mailboxes, or click the Mailboxes window tab if it is the inactive window in a 

tabbed group. The Mailboxes window appears.

2. Right-click the top folder in the IMAP tree to display the drop-down menu.

3. From the drop-down menu, choose Refresh Mailbox List. The mailbox list is updated according to what 

actually appears on the IMAP server at that time. Also, the Mailbox and Transfer menus are updated with 

the current IMAP mailbox configuration.



Leaving Mail on the Server

If you use the POP protocol for your incoming server to retrieve mail, your mail is normally deleted from the 

server once it is delivered to Eudora. However, most POP incoming servers allow you to indicate that you wish 

to keep your mail on the server so you can retrieve it from several different computers at various times. 

Facts you should know if you decide to leave your mail on the server:

· Some mail servers won’t allow you to keep mail on them.

· Your system administrator may not allow you to keep mail on the server even though you have the option 

turned on. Usually administrators do not like to keep too much mail on the server because of space 

concerns.

· Keeping a lot of mail on the server may slow down the mail checking process.

· If you check mail from several computers at different times, you can end up reading your messages two or 

more times. However, if you delete mail from your Trash folder, the message is deleted on the server.

Eudora has an option that allows you to leave your email messages on the server for a specified number of 

days. 

To transfer all of your new messages from the incoming server to Eudora and also leave copies of those 

messages on the server, do the following:

1. From the Tools menu, choose Options.

2. Scroll through the categories and click Incoming Mail.

3. In the Incoming Mail options window, turn on the Leave mail on server option. This options is available only if 
you are using POP.

4. Select the Delete from server after _ days box and set the maximum number of days the copies of your email 
messages should be kept on the server. This number is determined by the time it takes for you to check mail 
from all of your computers. If this number is too small, copies of your mail will not be delivered to all of your 
computers. 

Important: Make sure the settings in steps 3 and 4 are identical on all of the computers from which you will 

be receiving your mail. If you don’t, one computer will delete the mail from the server before you can 

receive it at another computer.

5. Click OK and close the window.

At the next mail check from that computer, Eudora ignores the copies of those previously read messages and looks 
for new ones. However, if you check mail from another computer, those messages are treated as new and are 
transferred to that computer.

Note:    The "Leave mail on server" option can also be set for each alternate personality you have. To do this, 

use the Account Settings dialog box, accessed from the Personalities window.

Important: The "Leave mail on server" option should be used with care, since it can result in a buildup of 

messages on the POP server.



Deleting a Message from the POP Server

To delete a message that has been left on the server (without retrieving it again), do the following:

1. Turn on the Trash button in the message Toolbar or set the message summary’s server status to Delete.

2. Check mail again. Or, use the Delete all messages that have been retrieved option in the Mail Transfer 

options    (described in the section Checking for Mail with Special Server Instructions).



Skipping Messages Over a Certain Size

To stop Eudora from transferring incoming messages that are too large, do the following:

1. From the Tools menu, choose Options.

2. Scroll and select Incoming mail. The Incoming mail window appears.

3. Check the Skip messages over _ K in size box and specify a size. Only the first few lines of the 

messages that exceed that size are transferred, with a note at the bottom stating that the whole message 

has not been transferred. If zero is entered, no messages are skipped. If you enter zero, all messages are 

downloaded.

4. Click OK.

Note: The Skip messages over _ K in size option can also be set for each alternate personality you have. To 

do this, use the Account Settings dialog, accessed from the Personalities window (choose the 

personality, right-click, and choose Modify).

If you decide you want to transfer the whole message, click the Fetch button in the incoming message window, 

or select the Fetch server status in the message summary, then check mail again. You can also use the Trash 

button or the Fetch then Delete server status so that the message is deleted from the server after it is 

transferred.

If you decide you don’t want the message and want to delete it from the server, click Trash in the incoming 

message window, or select the Delete server status in the message summary, then check mail again.



Checking for Mail with Special Server Instructions

To check your mail and give special transfer and storage instructions to the POP server, do the following:

1. Hold down the Shift key and from the File menu, choose Check Mail. The Mail Transfer Options dialog 

box appears. 

2. Set the options you want and click OK to continue checking for mail.

The mail transfer options are described below.

Retrieve new mail

Transfer your new mail from the POP server to your computer.

Send queued messages

Send all the queued messages (marked "Q") in your Out mailbox.

Delete messages marked for deletion

Delete from the POP server the messages that are marked Delete in Eudora. This is for messages that were 

retrieved only in part, either with the Leave mail on server or Skip messages over _ K in size options (in the 

Incoming Mail Options Window for your main account or the Account Settings dialog for your alternate 

personalities), or with the Fetch all message headers to In mailbox option (in the Mail Transfer options 

window).

Retrieve messages marked for retrieval

Retrieve from the POP server the messages that are marked Fetch or Fetch then Delete in Eudora. This is for 

messages that were retrieved only in part, either with the Leave mail on server or Skip messages over _ K in 

size options (in the Incoming Mail options window for your main account or the Account Settings dialog for your 

alternate personalities), or with the Fetch all message headers to In mailbox option (in the Mail Transfer 

options window).

Note: To mark a message Fetch, Delete, or Fetch then Delete, either click the buttons in the incoming 

message window, or select an option from the Server Status drop-down of the message summary.

Delete all messages that have been retrieved

Delete from the POP server all of the messages that have already been transferred to the computer you are on.

Delete all messages on server

Delete all of your messages from the POP server. Note: Be absolutely sure this is what you want to do, 

because there is no way to undo it!

Fetch all message headers to In mailbox

Retrieve from the POP server the header and the first few lines of every new message. If you select this option, 

the messages are not filtered. Set the Server Status in the message summaries to specify what you want to do 

with the messages the next time you check mail.

Important: If you delete the message header, and you have the Delete from server when emptied from 

Trash option on in either the Incoming Mail Options Window for your main account, or the 

Account Settings dialog for an alternate account, the message is gone completely from Eudora 

and the POP server.

How should checking/sending be performed



If you have multiple personalities, you can check or send mail based on the options on the left of the Mail 

Transfer options window (turn on Using options at left), or as specified in the Incoming Mail options window, 

for your dominant account only, or in the Account Settings dialog (accessed from the Personalities window), for 

any of your personalities (turn on Normally). You can also specify the personalities that you want to check or 

send with this mail transfer. Hold down the Shift key to select multiple personalities in sequence, or the Ctrl key 

to select them out of sequence.

Note: Another way to check mail for multiple personalities, regardless of your settings elsewhere, is to open 

the Personalities window, select your desired personalities, right-click the selection, and choose 

Check Mail from the drop-down menu.



Opening a Mailbox

To open a mailbox, do the following:

1. Select it from the Mailbox menu, or double-click it in the Mailboxes window.

Note: The unread message icon appears in the Mailbox menu whenever a mailbox or folder contains 

unread messages that are less than five days old, and any mailboxes or folders in the Mailboxes 

window that contain unread messages are displayed as bold.



Message Summaries in Mailboxes

Each line in the list portion of a mailbox window represents a message and is called a message summary. 

Outgoing messages that are in any mailbox other than Out are shown with italicized message summaries.

To select one or more message summaries, use one of the following options: 

• To select one summary, click it.

• To select two summaries and all the summaries between them, select a summary, hold down the Shift key, 

and select another summary. Or, drag the mouse over the summaries to select them (as long as you begin 

on an unselected summary).

• To select all of the summaries that have the same information in a particular column, hold down the Alt key 

and click the column in the summary. For example, if you click the Status column for one summary, all of the 

summaries with that status are selected.

• To make nonconsecutive selections, hold down the Ctrl key and select summaries.

Each message summary is divided into columns: Status, Priority, Attachments, Label, Sender/Recipient (Who), 

Date, Size (in K), Server Status, and Subject. You can show or hide these columns using the Display options 

window.

A message’s Status, Priority, Label, and Server Status can be changed directly in the mailbox window. To do 

this, select the messages you want to change and click the right mouse button inside the selection. Select an 

option from the drop-down menu to make your change.

To turn on the display of lines in the message summaries portion of mailbox windows—horizontal lines to 

separate summaries, and vertical lines to separate columns—turn on the Show Mailbox Lines option in the 

Mailboxes Options Window.

Column

This column displays the message status, which is one of the following:

• The message has not been read (all mailboxes except Out), or is queueable or 
sendable but has not been queued or sent (Out mailbox only).

<blank> The message has been read (all mailboxes except Out), or is not yet able to be 
queued or sent because it has no recipients in the To or Bcc fields (Out mailbox only).

left arrow Reply has been chosen for the message.

right arrow Forward has been chosen for the message.

diagonal arrow Redirect has been chosen for the message.

check mark The message has been sent (outgoing messages only).

Q The message is queued to be sent (outgoing messages only).

clock icon The message is queued to be sent at a specified time (outgoing messages only).

_ The message was transferred from the Out mailbox before being sent.

You can change the status of one or more selected messages, or an open message, from Read (blank) to 

Unread (•) or from Unread to Read by pressing Shift+Space (all mailboxes except Out).

Priority Column

This column displays the message priority. You can use the drop-down to set a particular priority.

Attachments Column



This column displays the attachment icon (a paper clip) if a message has attached documents.

Label Column

This column displays the message label. Labels are assigned to incoming messages by the recipient, either 

manually or automatically using filters (see Filtering Messages ). When a message summary is assigned a 

label, the entire summary changes color to match the label color.

Note: Label colors and titles are assigned using the Labels options window.

Sender/Recipient Column (Who)

This column shows the sender of the message (for incoming messages) or the intended recipients (for outgoing 

messages).

Note: Bugs in some POP servers/mail transport systems cause Eudora to display the sender of incoming 

messages as ???@???. This is because the required From header is missing.

Date Column

This column displays the date and time the message was composed, or, for timed messages, the date and time 

the message is scheduled to be sent. Date formats, including age-sensitive indications such as the day of the 

week or today are set in the Date Display options window . 

Size Column (K)

This column displays the size of the message in kilobytes, K (1 K = 1,024 bytes). Also, an indicator in the Size 

column of mailboxes tells if the body of the message is empty.

Server Status Column (V)

This column displays the action that is done to the corresponding incoming message on the POP server. The 

next time you check mail, the server status you requested is automatically completed.

Solid diamond indicates that the message has been retrieved.

Open diamond indicates that the message has not yet been retrieved.

Half filled diamond (IMAP only) indicates that the message body is retrieved, but not all attachments.

An "X" indicates that the message is deleted from the server.

An "X" and down arrow indicate the whole message is to be retrieved and then deleted from the server.

Note: To control the mail transfer, you can also use the Mail Transfer options window. For details, see 

Checking for Mail with Special Server Instructions.

MoodWatch Column

This column displays one, two, or three red chili peppers indicating the level of offensive text in the message. 

Subject Column

This column displays the subject of the message. The sender originally typed this information into the message 

header, but you can modify it (see Editing Incoming Messages).



Displaying and Resizing Columns

To specify which columns you want to be displayed in your mailboxes, do the following:

1. From the Tools menu, choose Options. 

2. Scroll and select Mailboxes. The Mailboxes Options Window    appears.

3. Check the boxes of the columns you want to see.

4. Click OK.

To resize a column in a mailbox window, move the mouse pointer until it is over the column heading divider to 

the right of the column you want to resize, then drag the divider to the position you want. The column divider 

moves to the new location, and the mailbox is redrawn.

You can only shrink a column as far as its left divider. If you do that, a double divider line appears in place of the 

column, and its contents are hidden. To redisplay the column, drag the right divider line to the right.



Using the Mailbox Size Display

In the lower left corner of the message summary part of each mailbox window, three numbers show the size 

information for that mailbox. The first is the number of messages in the mailbox; the second is the total amount 

of space those messages require; the third is the amount of disk space that is wasted with the mailbox.

Wasted space is created when messages are deleted from a mailbox. This wasted space is automatically 

removed when the amount of wasted space in the mailbox is greater than the amount of space the messages in 

the mailbox use, or if the amount of space wasted in the mailbox is greater than 5% of the free space on the 

disk drive that contains it.

To manually clean up the wasted space in a mailbox, click the mailbox’s size display. Or, to clean up all your 

mailboxes, choose Compact Mailboxes from the Special menu.



Preview Pane

The Preview Pane shows you the full or partial content of a message without opening the message. It is located 

at the bottom of the list of messages in a mailbox. You can adjust the size of the preview window by placing the 

cursor on the window frame. Once the cursor changes to a double arrow, you can resize the preview window.

To activate the preview pane, do the following:

1. From the Tools menu, choose Options.

2. Scroll and select Viewing Mail . The Viewing Mail options window appears.

3. Click the Show message preview pane box.

4. Click OK.

The preview pane shows the key headers and the message body of the currently selected message in the 

message summary list. If the full message body is not visible in the preview window, scroll bars are displayed, 

allowing you to view the rest of the message. Only one message can be previewed at a time.

Press Tab or F6 to move the keyboard focus from the message summary list to the preview window (and back 

again). Or simply click in the preview window to put the focus there.

Once keyboard focus is in the preview window, you can do any of the following, as you can in an open incoming 

message window:

• Press Space to page down through the message.

• Use the arrow keys, as set in the Miscellaneous options window (unmodified or with Ctrl or Alt), to switch to 

the next or previous message in the mailbox.

• Use standard keyboard shortcuts such as Ctrl+R for Reply, Ctrl+D for Delete, and so forth.

• Right-click anywhere in the preview window to display a drop-down menu with commands appropriate for 

the previewed message.

• Click an attachment icon or name to open the attachment.

• Click a URL (hot link) to launch the application for that URL.

If the Show message preview pane option is turned on in the Viewing Mail options window , you can press F7 

to show and hide the preview window within the current mailbox only (this does not control the visibility of the 

preview window in other mailboxes).

If the Show message preview pane option is off in the Viewing Mail options window , only the message 

summaries are shown in any mailbox window.

If the preview window option is on and the Mark previewed messages as read after _ second(s) option is 

turned on in the Viewing Mail options window, then the currently previewed message is marked as read (blank 

in the Status column) after the specified number of seconds. You can always change the message’s status 

back to Unread (•) by pressing Shift+Space while the message is selected or open (press again to change 

back to Read). If the Mark previewed option is off, previewed messages are never automatically marked as 

read.



Note: Eudora only performs the auto-marking behavior when you manually switch messages, not when it 

performs actions such as automatic mail checks or filtering.



Creating Mailboxes and Folders

Eudora lets you create mailboxes to put messages in, and folders to put mailboxes (or more folders) in.

There are three ways to create mailboxes and folders:

• Using the New command from the Mailbox menu and folder submenus.

• Using the New command from the drop-down menu in the Mailboxes window (see Using the Mailboxes 

Window ).

• Using the New command from the Transfer menu (see Creating a Mailbox or Folder During Transfer ).

Note that depending on whether your incoming mail server uses the POP or IMAP protocol, there are some 

differences in the way mailboxes and mail folders are created, stored, and managed. For more information, see 

Mailbox and Folder Management: POP vs. IMAP Server .



Creating a Mailbox or Folder Using the Mailbox Menu

To create a new mailbox or mail folder, do the following:

1. From the Mailbox menu, choose New, or from a mail folder submenu (placing the new mailbox in that 

folder). The New Mailbox dialog box appears.

2. To create a mailbox, type in the new mailbox name and click OK. The mailbox is created and added to the 

Mailbox and Transfer menus and to the Mailboxes window.

3. To create a mail folder, type the name of the new mail folder and check the Make it a folder option. Click 

OK to create the folder. The New Mailbox dialog box appears again. Type the name of a mailbox to create 

within the new folder, then click OK. The new folder and its mailbox are displayed in the Mailbox and 

Transfer menus and in the Mailboxes window.



Using the Mailboxes Window

The Mailboxes window lets you create new mailboxes and folders, remove and rename them, and move 

mailboxes among folders. Mailboxes or folders that are bolded have unread messages.

By default, the Mailboxes window is provided as the first window in a five-window tool group docked vertically to 

the left side of the main Eudora window.

To open the Mailboxes window, choose Mailboxes from the Tools menu, or click the Mailboxes window tab if it 

is part of a visible tabbed window group. See Window States and Tabbed Windows .

To open a mailbox or folder within the window, double-click it, or click it once and press Enter. You can move 

among the folders and mailboxes using the up and down arrow keys, or close or open folders using the left and 

right arrow keys. You can also start typing the name of the mailbox or folder you want, and it is highlighted 

when you have typed enough unique characters to identify it (the item must be displayed, so a mailbox that is in 

a closed folder cannot be selected).

Right-click any item in the Mailboxes window and a drop-down menu appears whose commands let you, 

depending on the item, create, remove, and rename mailboxes and folders, open existing mailboxes and 

folders, empty the trash from the Trash mailbox, and find messages in mailboxes and folders.

The folder trees displayed in the Mailboxes window, and some of the operations available from the drop-down 

menu, depend on whether your incoming mail server for one or more mail accounts uses the POP or the IMAP 

protocol. For more information on these differences, see Mailbox and Folder Management: POP vs. IMAP 

Server .



Creating a New Mailbox or Folder

To create a new mailbox or folder in the Mailboxes window, do the following:

1. From    the Tools menu, choose Mailboxes.

2. Right-click the folder. A drop-down menu appears.

3. From the drop-down menu, choose New. A dialog box appears requesting the name of the new mailbox or 

folder.

4. Type in the new name, check the Make it a folder option if you want to, and click OK. If you chose to make 

it a folder, enter the name of the mailbox when the dialog box appears again, and click OK. The new 

mailbox or folder appears in the lists, and is added to the Mailbox and Transfer menus.



Renaming a Mailbox or Folder

To rename a mailbox or folder, do the following:

1. Click the mailbox or folder name once, pause, then click again to highlight just the name. 

2. Type in the new name. Or, right-click the item and choose Rename, or click the item and press F2, then 

type in the new name. 

3. Press Enter to accept your change, or Esc to cancel it.



Moving a Mailbox from One Folder to Another

To move a mailbox from one folder to another, do the following:

· In the Mailboxes window, choose the one you want to move and drag it to where you want it.



Removing a Mailbox or Folder

To remove a mailbox or folder, do the following:

· Either right-click it and choose Delete from the drop-down menu, or click to highlight it and then press 

the Delete key.

If you choose to remove a mailbox in which messages are still stored, or a folder in which other mailboxes or 

folders are stored, you are prompted to confirm the deletion for each such item selected. Click Remove it to 

delete the current item for which you are being prompted, or click Remove all to remove all items selected for 

deletion—no further prompts will appear. Or click Cancel to cancel the deletion. If you delete a non-empty 

mailbox or folder, all messages, mailboxes, and folders contained within the mailbox or folder are also deleted.



Mailbox and Folder Management: POP vs. IMAP Server

The location of your mailboxes and mail folders depends on whether your incoming mail server for your account 

uses the POP or IMAP protocol.

If your incoming mail server uses POP, then all of your mailboxes and mail folders are created and stored on 

your computer. If your incoming mail server uses IMAP, then all of your mailboxes and mail folders are created 

and stored on the IMAP server.

The parallel situation holds true if you have multiple email accounts: mailboxes and folders for all of your POP 

accounts are stored on your computer; mailboxes and folders for all of your IMAP accounts are stored on the 

respective IMAP servers.

You create an IMAP server account using the New Account Setup wizard for your dominant personality (see 

Configuring Eudora ), or using the Account Settings dialog, accessed from the Personalities window, for an 

alternate personality (see Personalities Window and Account Settings Dialog ).

The Mailboxes window is the main tool for managing your IMAP mailboxes and mail folders. In the Mailboxes 

window, right-click the folders or mailboxes in an IMAP hierarchy and select an item from the drop-down menu. 

(The additional commands for IMAP are Refresh Mailbox List and Resynchronize Mailbox.)

Mail folders stored on an IMAP server can contain not only mailboxes but also messages. Mail folders stored 

on a POP server can only contain mailboxes, not messages.

Some mailboxes stored on your IMAP server may have been created by others and made accessible to you. 

For some of these mailboxes you may have both "read and write" permission; that is, you cannot only read the 

messages stored in them but also change or delete the messages. Other mailboxes may give you only "read" 

permission: you can only read the messages, not change or delete them.

If you have multiple email accounts and the incoming mail servers for all of them use POP, then you will have 

only one top-level mail folder, named Eudora by default. If the incoming mail server for at least one of your 

personalities uses IMAP, then you can have multiple top-level mail folders: one to hold mail from all of your POP 

accounts, and one top-level folder for each of your IMAP accounts. The name of a top-level IMAP folder is the 

personality name for that IMAP account.

For more information on managing your mail on POP and IMAP servers, see Managing your Mail on a POP 

Server. and Managing Your Mail on the IMAP Server. 



Deleting a Message

As a safeguard against inadvertent deletions, two steps are used to delete a message from your computer: first 

you put the message in the Trash, then you empty the Trash. (If your incoming mail server uses IMAP, the 

procedure is slightly different, as described below.)

POP Procedure

To put a message in the Trash, do the following:

1. Select the message. 

2. From the Message menu, choose Delete, or choose Trash from the Transfer menu, or press the Delete 

key, or click the Delete toolbar button. The message is transferred to the Trash mailbox.

Note: To cancel a deletion to the Trash, from the Edit menu, choose Undo.

To delete the messages in the Trash mailbox (removing them permanently from your computer), do the 

following:

1. From the Special menu, choose Empty Trash. Or, if the Mailboxes window is open on your desktop, right-

click the Trash mailbox in the window and choose Empty Trash from the drop-down menu.

You can set up Eudora to warn you if you try to delete unread, queued, or unsent messages. To do this, use the 

Extra Warnings options window found in Options on the Tools menu to turn on those options.

Quitting Eudora empties the contents of the Trash mailbox when the Empty Trash when exiting option in the 

Miscellaneous options window found in Options on the Tools menu is turned on.

Finally, if you want to delete just a few messages from the Trash mailbox, open the Trash mailbox, select the 

desired messages, then choose Delete from the Message menu, or press the Delete key. Deleting a message 

from the Trash removes it completely.

IMAP Procedure

If you have the When I delete a message, move it to Trash option turned off in the Incoming Mail options 

window (see Incoming Mail Options Window), all new messages are delivered to your IMAP server and are 

kept there until you actively delete them. 

You must perform two steps to remove a message from your computer: first mark it for deletion, then remove 

marked messages. 

To mark for deletion a message stored in an IMAP mailbox or folder, do the following:

1. Select the message. 

2. From the Message menu, choose Delete. To unmark the message for deletion, select it and then choose 

UnDelete from the Message menu. To remove all messages marked for deletion, choose Purge 

Messages from the Message menu. The messages are completely removed not only from your computer 

but also from the IMAP server.

Note: Once you remove marked messages using the Purge Messages command, these messages are 

gone and cannot be restored! Use this command with caution.



Automatically Deleting Attachments

When you delete messages, you can have their attachments automatically deleted by doing the following, 

1. From the Tools menu, choose Options.

2. Scroll and select Attachments. The Attachments options window appears.

3. Check the Delete attachments when emptying Trash box. Be sure the attachments are still in the Attach 

Directory (or the directory you have specified for attachments). If you have this option on and want to 

delete a message but save its attachment, move the attachment into another directory before deleting the 

message.

4. Click OK.



Transferring Messages

You can transfer messages to any of your mailboxes. There are several ways to do this:

• Select the message(s) you want to transfer, then select a mailbox from the Transfer menu.

• Select the message(s) you want to transfer, then right-click the selection and choose a mailbox from the 

transfer submenu.

• Drag a message summary to an open mailbox window or to a mailbox icon in the Mailboxes window.

To put a copy of a message in another mailbox (instead of transferring the message), hold down the Shift key 

and use one of the transfer options above. This is useful if you want to file a message in more than one 

mailbox.

If you try to transfer a message to the Out mailbox an alert appears informing you that some header information 

may be removed from the message during transfer. Click Yes to transfer the message.

Note: You can undo mailbox transfers using the Undo command under the Edit menu.



Using the Transfer menu

The Transfer menu is one way to transfer messages among your mailboxes. With a current message open, or 

message summaries selected, select a mailbox from the Transfer menu. The messages are transferred from 

their previous mailbox to the mailbox you selected.



Dragging Messages

You can drag messages from one mailbox to another using the message summaries or the Tow Truck icon in 

an open message window.

· To drag a message summary to another mailbox, select the message summary (or summaries) and drag 

the summary into any open or minimized mailbox window, or any mailbox in the Mailboxes window. When 

you release the mouse button, the message is transferred.

· To drag an open message to another mailbox, hold down the mouse over the Tow Truck icon and drag the 

message into any open mailbox or any mailbox in the Mailboxes window. When you release the mouse 

button, the message is transferred.

When dragging to the Mailboxes window, pause over a closed folder and the folder temporarily opens, making 

its mailboxes visible so that you can complete the drop operation. The folder closes again when you complete 

or cancel the drop.

Note: You can only drag messages around if the Allow drag and drop transfers box is checked in the 

Mailboxes Options Window found in Options on the Tools menu.



Creating a Mailbox or Folder During Transfer

To create a mailbox and transfer the current message into it at the same time, choose New from the Transfer 

menu instead of the name of a mailbox. The New Mailbox dialog box appears.

You can create a new mailbox or mail folder (for details, see Creating Mailboxes and Folders ). When you are 

done, the current message is transferred into the new mailbox.

To create the new mailbox without transferring the message into it, check the Don’t transfer, just create 

mailbox option.



Filtering Messages

Note. If you are using Eudora in Light mode, you may use only a few of the filter functions when filtering 

messages.

Many of the email management functions in Eudora can be done automatically using filters. For example, you 

can automatically reply to a request for information, transfer all the messages from your children into a Personal 

mailbox, and label all the messages from your customers as "Important."

A filter can be thought of as a personal organizer that takes your mail and does certain things to it that you 

specify. One kind of organizer might watch for particular mail from a mailing list and move it into a mailbox, 

open the message, and play a sound. Another might look for other kinds of mail and give it a label color, a high 

priority, and a new Subject line. You can create as many of these organizers as you like and give each of them 

from one to five instructions on what to do with your mail that fits a certain set of criteria, based on information 

in the header of the message and the message body.

For examples, see Quick and Simple Filters with the Make Filter Dialog and Detailed Filters with the Filters 

Window.



Quick and Simple Filters with the Make Filter Dialog

The simplest filters are those that transfer incoming messages to a particular mailbox based on the sender of 

the message or one or more of the recipients. For example, each time you check your mail, you may want to 

have Eudora take all of the incoming messages it receives from your friend Joe and automatically transfer them 

into a mailbox you’ve called "Mail from Joe." To get Eudora to do this, you set up a simple filter.

For new users, the Make Filter dialog box provides an easy way to learn how to use filters. Once you get 

comfortable with the simple filters created this way, you can go on to make more complex, powerful filters using 

the Filters window. Experienced users will find that the Make Filter dialog box provides a rapid, convenient 

method for making a simple transfer filter.

To open the Make Filter dialog box and create a simple filter, do the following:

1. Open an incoming or outgoing message containing the information you want in your filter, or select one or 

more message summaries in a mailbox.

2. From the Special menu, choose Make Filter. Or, right-click in the body of the open message, or in the 

selection of message summaries, or in the preview window for a single-selected message, and choose 

Make Filter from the drop-down menu. The Make Filter dialog box appears with the selected message 

criteria already entered.

Match Conditions

The Match Conditions area of the dialog box helps you set up the criteria that will determine whether or not a 

particular message will get acted on by this filter. The two match conditions reflect type and content.

You can specify that the type of messages you are interested in should be Incoming and/or Outgoing. You can 

also specify that this should be a Manual filter (described below). You can check and uncheck any combination 

of the three boxes Incoming, Outgoing, and Manual.

Note: If the messages you selected when you chose Make Filter were in any mailbox other than your Out 

mailbox, the Incoming and Manual checkboxes are checked automatically. If the messages you 

selected were in your Out mailbox, the Outgoing and Manual checkboxes are checked automatically.

• Incoming ¾ If this box is checked, then any incoming message that satisfies the content match condition 

you specify will be acted on according to the action you’ve specified in this filter.

• Outgoing ¾ If this box is checked, then any outgoing message that satisfies the content match condition 

you specify will be acted on according to the action you’ve specified in this filter.

• Manual ¾ If this box is checked, then, when you select one or more message summaries in a mailbox 

window and choose Filter Messages from the Special menu, the incoming and/or outgoing messages 

selected that satisfy the content match condition you specify will be acted on according to the action you’ve 

specified in this filter. Whether the messages that are manually filtered by this filter are incoming and/or 

outgoing messages depends on which other box or boxes are checked: Incoming or Outgoing or both.

Note: If Incoming or Outgoing is checked (or both), the filter is automatic; that is, Eudora performs the filter 

operation behind the scenes, automatically, when you send or check mail. If you now also check 

Manual, the filter becomes both automatic and manual; that is, you can now manually perform the 

filter operation, by selecting Filter Messages from the Special menu while message summaries are 



selected in a mailbox window—but Eudora will still automatically filter the messages during mail 

sends and checks. In short, checking Manual does not "turn off" Eudora’s automatic filtering for that 

filter.

Note: Making a filter Manual also gives you a good way to test the filter to your needs as soon as you set it 

up, rather than having to wait until the next time you send or check mail. After creating a manual filter 

with the Make Filter dialog box, check to see that it does what you want by selecting Filter Messages 

from the Special menu; your open message or selected message summaries are immediately filtered 

according to the new filter.

You can choose one of three content matches: From, Any Recipient, or Subject.

Click From (turned on by default) to match the message against the From field—the sender—of the messages 

you selected. You can then edit the field. The From field of a target message must contain the information in 

this box but does not have to exactly equal it. Note that if you selected multiple messages and they do not have 

a common sender, the From field is unselectable and is left blank.

Click Any Recipient to match the message against any of the recipients in the messages you selected 

(recipients are contained in the To and Cc fields and, in an outgoing message, the Bcc field). Choose one 

recipient from the pulldown menu (accessed from the menu button next to the field), or edit the text in the field. 

Note that the information you enter in the field must be contained in any of the recipient fields of the target 

message but does not have to exactly equal any recipient field.

Click Subject to match the message against the Subject field of the messages you selected. If you have 

selected multiple messages and they do not have a common Subject, this field is left blank. In either case you 

can edit the field. The Subject line of a target message must contain the information in this box but does not 

have to exactly equal it.

Action Area

The Action Area lets you determine the one action that will be performed on messages that satisfy the Match 

Conditions you’ve specified for this filter. The three action choices are all message-transfer actions; they 

transfer the filtered message to a mailbox. For messages that satisfy your match conditions, your simple filter 

will transfer the messages to either a new mailbox, an existing mailbox, or your Trash mailbox.

Click Transfer to New Mailbox to transfer the filtered message to a new mailbox that you will specify. The text 

field is filled in with a suggested new-mailbox name based on your selected content match condition (From, Any 

Recipient, or Subject). You can change this name if you like. The In Folder field is a label showing you the 

folder in which your new mailbox will be created. By default, this is the same folder that holds the mailbox 

containing the messages you’ve selected. The new mailbox is created as soon as you create this filter.

Note: You can set the value of the In Folder field to your own desired default folders based on the chosen 

match condition—From, Any Recipient, or Subject—using the three Eudora.ini file entries 

FilterFromFolder, FilterRecipFolder, and FilterSubjectFolder, respectively. Enter the path as it 

appears on the mailbox window. For example: FilterFromFolder=mail-lists\entertainment.

Click Transfer to Existing Mailbox to transfer the filtered message into one of your existing mailboxes. Select 

the mailbox from the button next to the field. The default mailbox is the In box. When you click the button, a 

version of the Transfer menu appears, letting you choose the mailbox from the Transfer menu.



Click Delete Message (Transfer to Trash) to delete the message that satisfies the filter match conditions, 

transferring it to your Trash mailbox. This feature is useful for deleting junk email, or "spam" as it is called in the 

Internet world.

Buttons

• Create Filter ¾ When you have set up your match conditions and filter action, click Create Filter to create 

the filter. The filter is added to the bottom of your filters list in the Filters window (discussed below). The filter 

is available immediately and will act on messages that satisfy the conditions at the next mail check, mail 

send, or selection of the Filter Messages command, as appropriate.

• Add Details ¾ Alternately, after setting up the filter information, click Add Details to both create your filter 

and also open the Filters window so that you can add additional information to your new filter and make it 

more powerful or just change it. The filter is added to the bottom of your filters list and is immediately 

available in the form in which it was set up in the Make Filter dialog box. Any changes you make in the 

Filters window must be saved before they become effective. See below for more information on the Filters 

window.

• Cancel ¾ Click Cancel to cancel the filter if you change your mind. The filter is canceled and your changes 

are not saved.



Detailed Filters with the Filters Window

The Make Filter dialog box, discussed in Quick and Simple Filters with the Make Filter Dialog, lets you create 

quick, simple filters that perform one operation, that is a mail transfer based on one match condition and 

specific header information. The Filters window lets you create more complex, powerful filters that use multiple 

match conditions and perform multiple filter actions. (You can also use the Filters window to create simple filters 

such as those created by the Make Filter dialog box.)

To create or modify a detailed filter, do the following:

1. To open the Filters window, from the Tools menu, choose Filters, or click the Filters window’s tab if it is 

part of a visible tabbed window group. The Filters window appears, and any filters you have created are 

listed on the left. (For more information on how to manipulate the Filters window alone and as part of a 

tabbed window, see Window States and Tabbed Windows .)

2. Click the New button or select an existing filter.

3. Choose the options for how you want the filter to be used, as an automatic filter to be invoked on any 

Incoming and/or Outgoing mail, and as a Manual filter that can be invoked when you choose Filter 

Messages from the Special menu. Any combination of these options works.

4. Define the criteria for the filter; use the header item drop-downs and the text fields to specify which header 

items should include a particular string of text. You can define two related terms for the criteria so that your 

filter is as specific as possible. See Filter Criteria (The Match Area)

5. Define the action or actions to be taken on messages that fit the criteria (see Filter Actions ) and save the 

filters.

Note: Eudora places a small icon next to the filter, in the filters list on the left, for each action you have 

selected for that filter—up to five icons/actions per filter.

Note: Filters are automatically named based on the criteria for the filter. You can re-order them by dragging 

a filter up or down in the list.

When the filters are invoked (automatically or manually), each message is matched against each filter in order 

from top to bottom. If the message meets a filter’s criteria, the actions are done as specified until there are no 

more actions, then the message is matched against the next filter. If at any point a Skip Rest action is done, 

nothing else is done with that message, and the next message is filtered.

You can change the width of the filters list to create more or less space for your list. To do this, put the arrow 

over the bar to the right of the list and drag the line to the left or right.

For information on the match conditions and filter actions in the Make Filter dialog box, see Quick and Simple 

Filters with the Make Filter Dialog. 



Filter Criteria (The Match Area)

Each filter in the Filters window can use one or two "terms" as its criteria, connecting them as appropriate with 

the conjunction drop-down.

Use the Header field to specify which message header items you want the filter to search. You can select an 

option from the drop-down menu or enter one yourself (this is helpful if you want to use a header item that does 

not appear on the menu, such as X-Priority). The selections are as follows:

• To:

• From:

• Subject:

• Cc:

• Reply-To:

• <Any Header>

• <Body>

• <Any Recipient>

• <Personality>

The <Any Header> option searches all message headers (including hidden headers that are shown with the 

BLAH BLAH BLAH option). The <Body> option searches the message body. The <Any Recipient> option 

searches all possible recipient items (To, Cc, Bcc). The <Personality> option searches the name of the 

personality (email account) associated with the message.

Use the Match Type drop-down to control how the header item is matched with the text string in the text field. 

The match options are as follows:

contains or doesn’t contain ¾ If the specified header item contains or does not contain the text string, filter 
the message.

is or is not ¾ If the specified header item is or is not an exact match of the text string, filter the message.

starts with or ends with ¾ If the specified header item starts with or ends with the text string, filter the 
message. The starts with item refers to the first non-whitespace character after the colon, so any spaces after 
the colon are ignored.

appears or doesn’t appear ¾ If the header item appears or does not appear in the message, filter the 
message (the text field is ignored). This is useful for filtering messages based only on the types of fields they 
contain. Example: Some messages contain a Reply-To header; some don’t.

intersects nickname ¾ If the text string is included in a nickname (whether it is a full address or a nickname 
within the nickname), filter the message.

doesn’t intersect nickname—If the text string is not included in a nickname, whether it is a full address or a 
nickname within the nickname, filter the message.

intersects address book—If the text string or nickname is included in any one of your address books, whether 
it is a full address or a nickname within the nickname, filter the message. In other words, the filter looks in all of 
your address books for all nicknames. If the nickname that appears in the header of the message is in the 
address book, Eudora filters the message accordingly. This match criterion is good to use if you wish all 
messages that are not from the entries in your address book to go in other mailboxes. This is an alternate 



method to control SPAM. 

doesn’t intersect address book—If the text string or nickname is not included in an address book, whether it 
is a full address or a nickname within the nickname, filter the message. 

matches regexp (case sensitive) (Sponsored and Paid modes only)—If the specific item matches the regular 
expressions characters with case sensitivity, filter those messages. See Regular Expressions. 

Note. Regular Expressions is an advanced and complex method of searching for text. 

Regular Expression is a search string that uses special characters to match text characters. For example, if you 
are filtering messages sent to you by two people, choose From in the first drop-down options list, then choose 
matches regexp, then type their usernames between parentheses separated by a vertical slash, for example 
(bobclark)|(janedoe) in the text box. Eudora searches and displays all messages from these two people. 
For more information on regular expressions, refer to the readme.txt file in your Eudora folder. 

matches regexp—If the specific item matches the regular expressions characters, filter those messages. 

Use the Text fields to specify the text strings that the filter is searching for.

Note: It is recommended that the contents of this field be kept as specific and brief as possible. The greater 

the complexity, the less likelihood of a match.

Do not enter a header label in the Text field as part of the text string (e.g., To, From, Bcc). For example, to filter 

all messages from Justine, do not enter From: Justine in the Text field. Rather, select From in the Header 

field, and enter simply Justine in the Text field (choosing "contains" from the Matching drop-down list to link 

the two terms. 

The conjunction options are as follows:

ignore ¾    Ignore the second term; if the message matches the first term, filter the message.

and ¾ If the message matches both the first and second terms (but not just one alone), filter it.

or ¾    If the message matches either term (or both), filter it.

unless ¾  If the message matches the first term, filter it unless the message also matches the second term, in 
which case do not filter it. (This lets you exclude certain variations of the first term.) 



Filter Actions

For a filter you’re creating or modifying in the Filters window, all messages that match the filter criteria are acted 

on as specified with the Actions drop-downs. Each filter can do up to five things to a message that matches the 

criteria. You can use the same action twice if it does not directly affect the original message (for example, Copy 

To can be used twice, but not Transfer To).

Some filter actions have an associated icon. For these actions, Eudora places the action icon next to the filter in 

the filters list. Up to five icons can appear per filter.

The Actions options are as follows:

None ¾ No action.

Make Status ¾ Assigns the selected status to message summaries.

Make Priority ¾ Assigns the selected priority level to messages. If you select a set level, messages are set to 
that priority. If you select Raise or Lower, messages are raised or lowered one priority level based on their 
prefilter level.

Make Label (Sponsored and Paid modes only)¾ Assigns the selected label to messages. Label colors and 
names are set in the Labels options window.

Make Personality (Sponsored and Paid modes only)¾ Assigns the selected personality to messages. For 
outgoing messages, the message is sent from the assigned personality. For incoming messages, all your 
responses to the message will be from the assigned personality until you change the personality associated 
with the incoming message or your response. For more information, see Using an Alternate Email Account .

Make Subject ¾ Assigns the new subject to message summaries (does not affect the subject in the message 
itself). If you choose this option, the entire subject of the message is replaced with the new subject. Use the "&" 
symbol to stand for the old subject if you want to add the new subject to the old subject. For example, entering 
New Subject [was &] results in New Subject [was Old Subject].

Play Sound ¾ Plays the selected sound when messages are filtered.

Speak (Sponsored and Paid modes only)¾ A voice makes you aware when a certain email message is 
retrieved. The voice can read the name of the sender and the subject line of the message, if you so choose. 
Also, you can select the type of voice you prefer from a drop-down list that appears. After you select Speak, the 
Who and Subject fields and a drop-down voice list appear. If these fields are grayed out,    you need to install 
SAPI and Mircrosoft’s text-to-speech engine. The installers are both available at: 
www.eudora.com/download/other. 

Open (Sponsored and Paid modes only)¾ Opens the Mailbox and/or Message when a message is received. If 
you set a previous action to filter messages into a mailbox, then that mailbox is opened.

Print (Sponsored and Paid modes only)¾ Prints one copy of each message.

Notify User (Sponsored and Paid modes only)¾ Notifies you As Normal and/or In Report when messages are 
received. The As Normal option notifies you based on the options you have selected in the Getting Attention 
options window. The In Report option notifies you by opening the Filter Report window and displaying in that 
window a filter report that details what filter actions have been done. See Filter Report     Window   .

Notify Application ¾ Notifies the selected application when messages are received, and provides information 
from the message. Specify the application to use and the part of the message to be included.

Use the Browse button to select an application, or enter the command line yourself. The command line should 
include the path to the executable file, any options, and the following substitution variables, all separated by 



blank spaces:

%1 Date
%2 To
%3 From
%4 Subject
%5 Cc
%6 The entire message

For example, the command line to send the subject of a message to a pager might look like this:

C:\apps\pager.exe -c %4

Forward To (Sponsored and Paid modes only)¾ Forwards messages to the email address given. Forwarded 
messages are placed in the queue in the Out mailbox, and sent the next time you send queued messages.

Redirect To (Sponsored and Paid modes only)¾    Redirects messages to the email address given. Redirected 
messages are placed in the queue in the Out mailbox, and sent the next time you send queued messages.

Reply with ¾ Replies to messages with the selected stationery message. Replies are placed in the queue in 
the Out mailbox and sent the next time you send queued messages. For more details, see Using Stationery .

Server Options (Sponsored and Paid modes only) ¾ Sets the message’s server status to Fetch and/or Delete 
(POP server only: see Managing your Mail on a POP Server.). Sets the message’s server status to Fetch 
and/or Delete (incoming server only). The Fetch option specifies that the entire message be transferred from 
the server the next time mail is checked, and the Delete option specifies that the message be deleted from the 
server the next time mail is checked. If you select both, the message will be transferred and deleted.

Copy To ¾ Copies messages to the selected mailbox.

Transfer To ¾ Transfers messages to the selected mailbox.

Skip Rest ¾ Stops filtering for the message (the message is not matched to the rest of the filters in the filter 
list).



Sorting Messages Within Mailboxes

The message summaries in mailboxes are automatically sorted by date, in ascending order (the newest 

messages at the bottom of the mailbox). To change this, select the appropriate command from the Sort 

submenu under the Edit menu. Or, click any of the column headings to sort by that column. To sort in 

descending order, hold down the Shift key and either select a command from the Sort submenu or click the 

column headings.

Mailboxes are sorted based on the previous state of the mailbox. For example, if a mailbox is sorted by Date, 

and then you sort by Sender, the messages are grouped by sender and each group is in order by date.

Note: Sometimes sorting by Date can be incorrect. This usually happens if the messages have incorrectly 

formatted date fields, or unknown or incorrect time zones.

See the Date Display options window for information on age-sensitive indications that might appear in the Date 

column, such as the day of the week or "Today."



Finding Text Within One Message

To search for text within a single message, do the following:

1. Open the message and make sure it is current (active).

2. From the Edit menu, choose Find. 

3. From the submenu, select the Find Text command or press Ctrl+Shift+F. The Find dialog box appears 

with the blinking insertion point located in the text field.

4. In the text field, type the text you want to find. When finished entering the desired text, click the Find 

button.

Starting at the cursor’s current position in the message, Eudora searches the current message for the specified 

text. If no match is found, the not found alert appears.

If the search is successful, the message is scrolled to the first point where the match is found and the matching 

text is highlighted.

To continue searching in the same message for the next occurrence of the text, click the Find Next button.



Match Case

Normally, Eudora ignores capitalization when searching. If you want Eudora to consider capitalization when 

searching, check the Match case option in the Find dialog box. When this option is checked, Eudora searches 

for exact matches of character strings, including any capitalization.



Stopping a Find

If you want to stop Eudora from continuing a search, click the Stop button in the progress window or press the 

Esc key. 



Saving a Message to a File

You can save a message to a separate text file on your computer by doing the following: 

1. Open or select the messages you want to save. 

2. From the File menu, choose Save As. The Save As dialog box appears.

3. Enter the name you want to give the text file, and select the appropriate options.

Important: Be sure to change the Save as type option to Text Files.

Include Headers retains the first message’s header information in the saved document. If this is not checked, 

only the body of the messages is saved.

Guess Paragraphs removes extraneous carriage returns from the message, leaving returns only at the ends of 

paragraphs, and converts multiple spaces into tabs.

4.        Once you’ve made all of your choices, click the Save button in the dialog box.

If you select multiple messages from a mailbox window and choose Save As, all of the messages are saved to 

a single file.



Window States and Tabbed Windows

There are three types of windows in Eudora: Normal Windows, Docked Windows, or Floating Windows.

A tabbed window is a collection of windows combined into a single window in which each window has its own 

tab, for activating and dragging. A tabbed window can exist in any of the three window states, normal, docked, 

or floating. See Tabbed Windows. 

Note that only tool windows — those windows accessible from the Tools menu (excluding the Options dialog 

box)    can exist as docked windows, floating windows, and tabbed windows. All other windows in Eudora, 

particularly mailbox windows and message windows, exist only in the normal state and cannot be combined 

into tabbed windows.

The tool windows that can be docked, floating, or tabbed are as follows, in order down the Tools menu:

· Filters 

· Filter Report 

· Mailboxes 

· File Browser 

· Stationery 

· Signatures 

· Personalities 

· Task Status 

· Task Error 

· Address Book 

· Directory Services 

· Link History

Note: If you minimize and then restore the main Eudora window, then all normal, docked, and floating 

Eudora windows — including tabbed windows — are also minimized and restored with it.

Note: Unlike in previous versions of Eudora, closing a tool window does not erase its contents, unless the 

contents can be saved, and you choose to discard changes. When you close a tool window or a 

tabbed window, the content, state, and position of the window or of all windows in the tabbed window 

are preserved. The preservation of content is useful for "persistent data" such as filter reports and 

directory service queries. If you try to close or de-activate a tool or tabbed window with unsaved 

changes, Eudora asks you if you want to save the changes.



Normal Windows

A window is said to be in the normal state if it is restricted to the window work area of the main Eudora window 

and cannot be dragged out of the main window.

Normal windows can be moved around within the window work area. They can also be minimized and 

maximized to completely fill the visible window work area. When a normal window is maximized, its title bar 

partially blends with the main window title bar.

Normal windows can overlap other normal windows and are obscured by both docked and floating windows.

The title bar of a normal window contains the window-menu icon (far left) and three window buttons: 

minimize/restore, maximize/restore, and close.

A tool window in the normal state, whether alone or in a tabbed group, can be dragged out of the confines of 

the main Eudora window, but it must first be converted to a dockable or floating window. To perform this 

conversion, right-click the window’s border or tab, uncheck (turn off) Float In Main Window on the context 

menu (right-click), then select (turn on) Allow Docking on the menu.

A nontool window in the normal state, such as a mailbox window or a message window, can never be dragged 

out of the confines of the main Eudora window.

To convert a docked or floating window to a normal window, right-click the docked or floating window’s border 

or tab, and choose Float In Main Window from the context menu (right-click).



Docked Windows

A window is said to be dockable if it is capable of being attached to one of the four edges of the main Eudora 

window. A window is said to be in the docked state if it is currently attached to one such edge.

Note: Some application programs identify the docking feature by words such as "gravity," "snap," "glue," 

"sticky," "join," and the like.

Only tool windows as described in Window States and Tabbed Windows , whether alone or tabbed, are 

dockable. All other windows in Eudora, particularly message windows and mailbox windows, are not dockable.

Note: The main toolbar, although not a window, is also dockable, to any edge of the main Eudora window or 

to another dockable window.

Dockable windows can be docked to any edge of the main Eudora window and to each other. You can also 

dock multiple windows along a single edge of the main window.

When you dock a window to the main window, the visible window work area is reduced. Docked windows 

cannot be obscured by normal windows, but they can be obscured by floating windows.

To make a window dockable, do the following:

1. Right-click the window’s border or tab and make sure the Float In Main Window command is unchecked 

(off) on the context menu (right-click).

2. Select (check) the Allow Docking command on the menu.

3. To dock the window, drag the window to an edge of the main Eudora window or to another docked window, 

and when the ghosted docking rectangle appears indicating that the window will be docked, release the 

mouse button. The window attaches to the main window edge or the other window.

Note: If you want to move a docked window to another location, right-click in the docked window to display the 

context menu (right-click).    Uncheck Allow Docking and check Float in Main Window. After the window 

changes shape, right-click again and check Allow Docking. Move the window to where you want it. 

Some windows are more convenient to use when docked vertically (tall and skinny), while others are more 

convenient to use when docked horizontally (short and wide). Examples of windows that work better as tall-and-

skinny windows are the Mailboxes window and the File Browser window. Examples of windows that work better 

as short-and-wide windows are the Personalities window and the Filter Report window.

Following are descriptions of the controls in docked windows. 

The Gripper Bar

The gripper bar, also called the grab handle, is the double line at one edge of the docked window. Drag the 

window by the gripper bar to undock it from the main window frame. The window now floats; you can leave it as 

a floating window, or you can dock it to any edge of the main window or to another docked window. 

Note: The toolbar has a gripper bar.

The Zoom Bar

When two or more windows are docked on the same edge of the main window, Eudora activates each 

window’s zoom button. This button appears next to the "x" close button and contains a small triangle. Click the 

zoom button to minimize, maximize, or restore the width or height of that docked window relative to the other 



docked windows adjacent to it. 

The Close Button

The close button contains an "x" and appears next to the zoom button. Click the close button to close the 

docked window. 

The Resize Bar

When two windows are docked side by side along one edge of the main window, a bar appears between them, 

called the resize bar. Drag this bar up or down, or to the left or right, as appropriate, to enlarge one of the 

docked windows and reduce the other. 



Floating Windows

A window is said to be in the floating state if it floats above the main Eudora window and can be placed 

anywhere on the desktop, including outside the main Eudora window. In this way a floating window is a 

standard Windows "Always on Top" window, like tool palettes in paint programs.

Only tool windows as described in Window States and Tabbed Windows, whether alone or tabbed, can be 

made to float. All other windows in Eudora, particularly message windows and mailbox windows, cannot be 

made to float.

All windows in Eudora can be thought of as "living" in one of three layers or areas:

• Normal windows live in the window work area, at the bottom layer.

• Docked windows live at the level of the main Eudora window’s border, the middle layer.

• Floating windows live at the level above the main Eudora window, the top layer.

Therefore, a floating Eudora window floats above all other Eudora windows except other floating windows.

The title bar of a floating window contains, in addition to the title, only the close button. This distinguishes the 

window from a normal window when both appear to be in the window work area; a normal window’s title bar 

contains the window-menu icon (left) and three buttons. But also note that a floating window can be dragged 

outside of the main Eudora window, whereas a normal window cannot.

You can diagonally resize any floating window in Eudora. Simply position the pointer over any window corner, 

and click and drag to enlarge or reduce.

To convert a window to a floating window, either undock it from the main window, if it is docked, or do the 

following: right-click the window’s border or tab, make sure the Float In Main Window command is unchecked 

(turned off) on the context menu (right-click), then turn off (uncheck) the Allow Docking command on the 

menu. For a docked window, you can also temporarily override the Allow Docking command and suspend 

docking by holding down the Ctrl key while dragging the window. The window drags as a floating window. 



Tabbed Windows

A tabbed window is a collection of windows combined into one window; that is, windows accessed from the 

Tools menu. Each tool window in the tabbed window has its own window tab.

A window tab has two purposes: 

· It lets you bring the window to the front of the group to display it (by clicking the tab). 

· It serves as a "drag handle" that lets you drag the window from one tabbed window to another, so that you 

can reorganize your tabbed windows and create new tabbed windows.

Only tool windows are accessible from the Tools menu except for Options and are capable of being combined 

into a tabbed window. All other windows in Eudora, particularly mailbox windows and message windows, are 

not capable of being combined into a tabbed window.

A tabbed window can be in any of the three window states, normal, docked, or floating, and you can convert a 

tabbed window from any state to any other state.

If a tabbed window shows a title bar, the title in the bar is the name of the active window in the group.

With the combined windows, you are able to change the order of the tabbed windows. You can even move a 

tabbed window between two main windows. To move a tabbed window to the front of the list (the topmost is 

always displayed), drag and drop the tab to the far-left of the tabbed window group. As you drag the tabbed 

window, you will see an outline of the action of moving the tabbed window. When you see the long, vertical up 

arrow, you can insert the window into the new position. 



Default Tabbed Windows

Eudora comes with two default tabbed windows that together include all eleven tool windows.

The first default is a vertically oriented tabbed window that is docked to the left side of the main window and 

contains the following five tool windows, with tabs in left-to-right order:

• Mailboxes Window

• File Browser Window

• Stationery Window

• Signatures Window

• Personalities Window

The second default    tabbed window is a normal window that contains these four tool windows, with tabs in left-

to-right order (to display this window, display one of the member windows from the Tools menu):

• Directory Services Window

• Address Book

• Filters Window

• Filter Report Window

The third default tabbed window is a docked window that contains two tool windows, with tabs on the left side in 

top to bottom order. To display this window, display one of the member windows from the Tools menu.

· Task Status Window

· Task Errors Window

Note: The far-left window is the default window that will display. To change this default window, select the 

window you want to display as the default, and drag it to the far-left tabbed window grouping. See 

Reorganizing Tabbed Windows for more information.

You can reorganize these default tabbed windows any way you like. Your new organization will be preserved 

when you quit and restart Eudora.

Note: Due to file format incompatibilities, if you upgrade from a pre-4.0 version of Eudora you will lose the 

previous docking state of your Mailboxes window and toolbar. Eudora will reset the toolbar and 

docking states to the default configuration noted above. However, customized toolbar information is 

preserved; only the size and location of your toolbar may change.



Opening and Activating Tabbed Windows

To open a tabbed window that’s hidden, open any of its member windows by selecting the appropriate 

command from the Tools menu. The tabbed window opens with the selected window as the active (frontmost) 

window.

If the tabbed window is already visible, and you wish to display one of its member windows that is currently not 

active, simply click the member window’s tab. You can also select the appropriate item from the Tools menu. 

The desired window comes to the front of the tabbed group.

You can also use the tool window’s keyboard shortcut, if it has one, to open or activate the tool window in its 

tabbed window. 



Reorganizing Tabbed Windows

You are not restricted to the default tabbed window arrangements supplied with Eudora. You can mix and match 

tabbed windows any way you like.

At one extreme, you can have each of the nine tool windows in its own container with its own tab. At the other 

extreme, you can have all nine tool windows combined into one tabbed window. In between, you can have 

multiple tabbed windows open at once, mixed and matched to suit your purposes.

To move a window from one tabbed group to another, drag the window tab from the first group and drop it onto 

the second.

While the drag operation is in progress, the cursor changes and Eudora displays a small ghosted rectangle 

when you are over a valid drop location.

If you drop the window tab onto another tab in the second group, the new window tab is inserted at that position 

and the other tabs are displaced to accommodate it. If you don’t drop the tab onto an existing tab, Eudora adds 

the new tab at the "end" of the group of existing tabs, where that end depends on the location of the tabs in the 

tabbed window: top, bottom (the default), left, or right. For example, with tabs along the bottom, the "end" is the 

far right.

Note that the relocated window takes on the window state — normal, docked, or floating — of the destination 

tabbed window.

To reorganize the left-to-right or top-to-bottom order of tabs within a tabbed window, just drag the tabs left and 

right or top and bottom. The drop scheme is the same as that described above. 



Creating a New Tabbed Window

To create a new tabbed window, do the following:

1. Drag one of the tabs from an existing tabbed window.

2. Drop it onto an exposed portion of the window work area. If the window work area is completely obscured 

(for example, a normal window is maximized), then drop the tab onto the status bar.

The dropped window converts into a normal tabbed window with a single tab. 

To convert the window to docked or floating, do the following: 

1. Right-click the tab or the window border.

2. On the context menu (right-click), uncheck Float In Main Window. 

3. Check the Allow Docking command on the menu to make the window dockable. 

4. While dragging the floating or docked window, hold down the Ctrl key to temporarily suspend docking 

behavior. When you release the key, docking behavior resumes. 



Tab Display in Single-Tabbed Windows

If a tool window is in a tabbed window by itself, with one tab, you can hide or show the tab by doing the 

following:

1. Right-click the tab or the window border to display the context menu (right-click).

2. From the Tab Location submenu, select    Show Single Tab. 

Note: You cannot hide the tabs in a tabbed window with two or more tabs.



Tab Contents, Location, Auto-Activation

• Tab Contents — A window tab contains both the icon and the text label associated with that window. If 

there is room enough in the tabbed window, both the icon and the label are displayed on each tab. If there is 

not enough room, only the icon appears for each tab. If only the icon is visible, pause the mouse pointer 

over the tab icon, and Eudora will display the tab text in a tool tip.

• Tab Location — By default, Eudora arranges window tabs along the bottom edge of a tabbed window. 

Sometimes it is more convenient to have the tabs displayed along a different edge. For example, in a short-

and-wide tabbed window (one that is docked horizontally), you can improve the visibility of the window’s 

contents by moving the tabs to the right edge. To change the location of the tabs in a tabbed window, right-

click the tabs or on the window border, and select a new location from the Tab Location submenu of the 

context menu (right-click).

• Tab Auto-Activation — During a drag and drop operation, if you pause the mouse pointer over the tab of 

an inactive window in a tabbed window, that window becomes active (is brought to the front), and you can 

complete the drop. For example, if you drag received messages to the Mailboxes window when it is inactive 

in a tabbed window, pause the pointer over the Mailboxes window’s tab; the window is made active and you 

can drop the messages in a mailbox. Note that tab auto-activation is disabled when you are dragging a tool 

window tab. 



Closing Tabbed Windows

To close a tabbed window, click the "x" close button in the corner of the window.

Alternately, right-click any tab in the window, or on the window border, and choose Hide from the context menu 

(right-click).

Note that when you close or hide a tabbed window, the contents of all member windows, and the state and 

position of the tabbed window, are all preserved. When you redisplay the tabbed window, the active window 

shows its prior contents and the tabbed window appears in its prior state and position.

However, if you attempt to close or hide a tabbed window in which the active window contains unsaved 

changes, or you attempt to deactivate that active window by making another window active in the group, 

Eudora asks you if you want to save your changes. 



Window Context Menu

If you right-click the tab or border of a single tool window, or on any tab or the border of a tabbed window, 

Eudora displays a context menu containing window-management commands.

The commands on the context menu are described below.

Note that if you right-click in the interior of some tool windows, and sometimes on an item in the window itself, 

these window-management commands appear at the bottom of the context menu (right-click) specific to that 

tool window. 

Tab Location

This submenu is always available on the window context menu. It lets you change the location of the tabs in a 

tabbed window, and lets you show and hide the tab in a single-tabbed window.

By default, Eudora places window tabs at the bottom of a tabbed window. Choose Top, Bottom, Left, or Right 

from this submenu to move the tabs to the top of the tabbed window, the bottom, or the left or right side. Eudora 

places a bullet (radio button) next to the current tab location selection.

Changing tab locations can sometimes increase the visible space within a tabbed window. For example, a 

short-and-wide tabbed window (one docked horizontally) might show more content if you move the tabs to the 

right side.

Show Single Tab is available in a single-tabbed window, and lets you show or hide the tab. A checkmark next 

to the command indicates that the tab is shown (the default). This command is not available in a tabbed window 

containing two or more tabs; you cannot hide the tabs in such a window. 

Allow Docking

This command controls the ability to dock of floating and docked windows. It is available only when the Float In 

Main Window command is turned off (unchecked). It is not available for normal windows (that is, when Float In 

Main Window is turned on).

A checkmark next to the command indicates that it is on.

When this command is on for a docked or floating window, the window can be docked to any edge of the main 

Eudora window.

When Allow Docking is turned off for a docked window, the window is converted to a floating window and 

cannot be redocked. When the command is turned off for a floating window, the window cannot be docked.

Even with Allow Docking on, you can hold down the Ctrl key while dragging a docked or floating window to 

suspend its ability to dock until you release the key. 

Hide

This command is always available on the context menu.

Choose Hide to hide (close) the tool window or tabbed window. Hide performs the same function as the Close 

command (Ctrl+F4) on the standard MS Windows window context menu (right-click).

Note, however, that when you hide or close a tool window, its content, state, and position are all preserved. And 

when you hide or close a tabbed window, the content, state, and position of all member windows are preserved. 

Thus, if you hide and redisplay a floating tabbed window, the window floats in its same position.



If you attempt to hide or close a tool window that contains unsaved changes, or a tabbed window in which the 

active window contains unsaved changes, Eudora asks you if you want to save your changes.

To redisplay a tool window after you’ve hidden it, select it from the Tools menu. To redisplay a tabbed window 

after you’ve hidden it, select one of its member windows from the Tools menu. The tabbed window redisplays 

with the selected window active. You can use keyboard shortcuts to redisplay hidden tool or tabbed windows 

where appropriate. 

Float In Main Window

This command is always available on the context menu (right-click).

Turning this command on (indicated by a checkmark next to the command) converts a docked or floating 

window to a normal window. Turning this command off converts a normal window to a docked or floating 

window.

Note that the availability of the Allow Docking command depends on the state of this command. When Float 

In Main Window is turned on (checked), Allow Docking is unavailable (the window is normal). When Float In 

Main Window is turned off, Allow Docking is available. 



Filter Report Window

If the Generate Filter Report option is turned on in the Getting Attention options window found in Options 

under the Tools menu, Eudora generates a filter report. This report can be viewed in the Filter Report window 

found under the Tools menu.

To open the Filter Report window, do the following:

1. From the Tools menu, choose Filter Report. Or, if the Filter Report window is in a visible tabbed window, 

click its tab.

If filter report generation is enabled via the option mentioned above, then each time a filter operation is 

performed, Eudora adds the entry or entries to the Filter Report window and activates the window.

The Filter Report window displays three columns of data:

• Mailbox — Lists the names of the mailboxes into which messages have been filtered during the current 

Eudora session. Each listing represents one filter operation for that mailbox.

• Messages — For each mailbox listed in the Mailbox column, lists the number of messages filtered into that 

mailbox during the filter operation.

• Time — For each mailbox listed in the Mailbox column, lists the time that the messages were filtered into 

that mailbox during the filter operation.

By default, the entries in the window are sorted by time. However, you can click the column headings and sort 

the display by mailbox names (Mailbox) or by the number of messages filtered (Messages).

Note: Whenever new entries are added to the list, Eudora always appends them to the bottom of the list in 

order of arrival, ignoring the current sort order. Simply click a column heading to re-sort.

Select one or more entries in the list and double-click the selection, or press Enter, and Eudora opens the 

mailbox windows associated with those selections.

The Filter Report listing is a cumulative log of the filter actions for the current Eudora session. Eudora 

automatically clears the log when you quit the program.

Closing the Filter Report window does not erase the contents of the filter report, as it did in previous versions of 

Eudora. Only quitting Eudora erases this information.



File Browser Window

Use this window to browse the Windows desktop. You can use this window to find files to attach to new 

outgoing messages, for example.

To open the File Browser window, do the following:

1. From the Tools menu, choose File Browser. Or, if the File Browser window is in a visible tabbed window, 

click its tab.

The File Browser window performs some, but not all, of the functions of the standard Windows 95/98 and 

Windows NT 4.0 Explorer programs.

The File Browser window contains three controls:

• Drive Selector (top box) — A drop-down menu in this field contains a fixed set of high-level folders on your 

system, just like the corresponding control in Windows Explorer. The Drive Selector field determines what 

gets displayed in the Folder Browser (middle section). When you first launch Eudora, the Drive Selector 

automatically sets itself to the drive containing your Windows folder. Note that the first entry in the drop-

down menu is a shortcut called "My Attachments" that points to your Eudora attachments folder.

• Folder Browser (middle section) — This is a tree control that displays the folder hierarchy whose root is the 

selection entered in the Drive Selector field. For example, if in the Drive Selector box you choose the C: 

drive, then the Folder Browser displays the folder tree-hierarchy branching down from the C: drive folder. 

Right-click a folder item in the Folder Browser to display the standard Windows context menu (right-click) for 

that folder.

• File List (bottom section) — This is a list control that displays the files contained in the folder selected in the 

Folder Browser. You can select one or more file items in the list, then right-click the selection to display the 

standard Windows context menu (right-click) for those files. (Note: Eudora does not fill in the Send To 

submenu on the context menu (right-click).) When selecting multiple items, use the Shift key to select a 

range of items, and use the Ctrl key for nonconsecutive selections.

The File List control shows these four columns:

• Name — Displays the name of the file and the icon associated with the file.

• Type — Based on the file name extension, displays the file type as set in the Options dialog box of Windows 

Explorer.

• Size — Displays the size of the file in kilobytes (K), where 1K = 1,024 bytes.

• Modified — Displays the date and time that the file was last modified.

As in Windows Explorer, you can click any of the four column headings to sort the listing by the data in that 

column.

You can also resize the widths of the columns by dragging the separator line between the column heading 

labels. Position the pointer over the separator until you see a splitter cursor, then drag the line to left or right.

In the File List control, double-click an item in the Name column, or select one or more items in the column and 

press Enter, to open the selected items. For program files, this action launches the program. For document 



files, this action generally launches the registered viewing or editing application for that document. Eudora 

displays an error dialog box if it is unable to open a file in this way.

To adjust the relative heights of the Folder Browser and File List controls, position the pointer over the separator 

bar between the Folder Browser and File List controls until the splitter cursor appears, then click and drag the 

separator up or down. Note that the File Browser window maintains a minimum height for the Folder Browser 

and File List controls, so you cannot close them all the way.

To manually refresh the File Browser window display, right-click anywhere in the File Browser window but not 

on a Folder Browser item or File List item, then choose Refresh from the context menu (right-click). (Tip: A 

good place to right-click is in the Drive Selector box.) Alternately, press the F5 key while keyboard focus is in 

the File Browser window.

You can select one or more files in the File List control and drag them to a message composition window to 

attach those files to that outgoing message. This is especially handy if you keep the File Browser window 

docked and open. (For multiple file selections, use the Shift key to select a range, and use the Ctrl key to make 

nonconsecutive selections.)

You can also select one or more items in the File List control and drag them to another application that can 

receive such files.

In general, the File Browser window lets you drag items out of the window (copying them rather than moving 

them), but the window is not a proper drop target; you cannot drop items into the window that you’ve dragged 

from elsewhere on your desktop. In particular, you cannot move files by dragging them to a target folder in the 

Folder Browser control. You also cannot drag and drop items within the File Browser window (from one control 

to another, for example). You can, however, manage the files and folders in the window using the commands on 

the window’s context menu (right-click), such as Cut, Copy, Paste, and Delete. 



Stationery Window

(Sponsored and Paid modes only)

Use this window to manage and apply stationery.

To open the Stationery window, do the following:

1. From the Tools menu, choose Stationery. Or, if the Stationery window is in a visible tabbed window, click 

its tab. 

The Stationery window displays a single-column list of your stationery files.

Note: You can only select one item at a time in the list; you cannot select multiple items.

If you right-click a stationery item in the list, a context menu (right-click) appears with the following commands 

(the standard Eudora window-management commands appear at the bottom):

• New — Create a new piece of stationery (a new stationery file). An untitled stationery window opens; enter 

the stationery name and from the File menu, choose Save As Stationery.

• Edit — Open an editing window for the selected stationery item. Make your changes and from the File 

menu, choose Save As Stationery, or close without saving to discard your changes.

• Delete — Delete the selected stationery item. Eudora asks you to confirm the deletion. Use the Del key 

(Delete) as a shortcut for this command.

• Rename — Rename the selected stationery file. Use the F2 key as a shortcut for this command, or click the 

stationery file’s name box, then edit the name right in the box.

• New Message With — Create a new message with the selected stationery. As a shortcut for this command, 

either select the stationery item and press Enter, or just double-click the stationery item.

• Reply With — Reply with the selected stationery to the sender(s) of the received messages that are 

currently selected.

• Reply to All With — Reply with the selected stationery to the sender(s) and all recipients of the received 

messages that are currently selected.

You can also display the context menu (right-click) and create new stationery by right-clicking anywhere in an 

empty Stationery window or by right-clicking anywhere off a stationery item in a non-empty Stationery window. 



Personalities Window

(Sponsored and Paid modes only)

Use this window to manage, access, and apply your email accounts — "multiple personalities" — when you use 

more than one account.

To open the Personalities window, do the following:

1. From the Tools menu, choose Personalities. Or, if the Personalities window is in a visible tabbed window, 

click its tab.

Note: The Personalities window replaces the Personalities window of the Options dialog box that appeared 

in previous versions of Eudora.

The Personalities window displays two columns of data:

• Persona — The identifying name assigned to the personality. <Dominant> indicates your principal email 

account, which is the account Eudora uses whenever you don’t specify otherwise, and is the account 

associated with all mail stored before you began using alternate personalities.

• Account — The incoming mail account assigned to the personality. This is generally in the form 

loginname@incomingmailserver. (See Account Settings Dialog .)

To resize the column widths, position the pointer over the divider line between the column headings until a 

splitter cursor appears. Then just drag the divider to left or right. Note that it is possible to completely collapse 

the Persona column.

Note: You cannot manually sort the information in the Personalities window. Clicking a column heading 

does not do a sort 

Note: You can select multiple items in the Persona column to perform some of the operations listed below. 

Use the Shift key to select a range of items, and use the Ctrl key to make nonconsecutive selections.

If you select one or more personalities in the Persona column and right-click the selection, a context menu 

(right-click) appears with the following commands (the standard Eudora window-management commands 

appear at the bottom):

• Check Mail — Check mail now for all selected personalities.

• Send Queued Messages — Send messages queued by all selected personalities now.

• Message — This submenu lets you perform message-creation functions using only one selected 

personality. The submenu is unavailable if multiple personalities are selected in the Persona column. 

- New Message As — Create a new message as the selected personality. As a shortcut for this command, 
double-click a personality in the Persona column, or select the personality and press Enter.

- Reply As — Reply as the selected personality to the sender(s) of the one or more received messages 
that are currently selected.

- Reply to All As — Reply as the selected personality to the sender(s) and all recipients of the one or 
more received messages that are currently selected.

- Forward As — Forward as the selected personality the one or more received messages that are 



currently selected.

- Redirect As — Redirect as the selected personality the one or more received messages that are 
currently selected.

- Send Again As — Resend as the selected personality the one or more received or composition 
messages that are currently selected.

• New — Create a new personality. When you select this command, Eudora walks you through the New 

Account Wizard. Enter a Personality Name (e.g., My Laptop Account) and click Next. You then have the 

choice to create a new email account or import the settings from an existing email. If you choose a new 

email account, Eudora asks you for your name, your return email address, your login name, and your 

incoming email server (POP or IMAP). Fill in each item as instructed. If you choose to import the settings 

from an existing email account, Eudora asks you to choose the account to import, then asks you to confirm 

the settings and optionally change them. If you leave them unchanged, the imported account is created 

when you click Finish. If you choose to change them, Eudora walks you through the settings as above: 

name, return address, login name, and incoming email server. Change these settings as desired, and when 

you are complete, the new account is created.

• Preferences — Modify the selected personality. You can only modify one personality at a time. When you 

select this command, the Account Settings dialog displays, with its fields filled in with the information 

associated with that personality. See the description of this dialog box below.

• Delete — Delete all selected personalities. Note, however, that you cannot delete the <Dominant> 

personality. You are prompted to confirm the deletion for each personality you have selected to delete. Note 

that these deletions are permanent and cannot be undone! When you delete a personality, any messages 

associated with that personality are reassigned to your Dominant personality. You can use the Del or Delete 

key as a shortcut for this command (you will still get the confirmation requests).

You can also display the context menu (right-click) and create a new personality by right-clicking in a blank area 

of the Personalities window, off all personality items, when none of the items is selected. When creating a new 

personality this way, you are walked through the New Account Wizard as in the description of the New 

command above.

If you drag one or more received messages to a personality item in the Personalities window, Eudora will Reply 

As that personality to the messages (hold down the Ctrl key to Reply to All As).



Account Settings Dialog

(Sponsored and Paid modes only)

This tabbed dialog box appears when you select Skip directly to advanced account setup from the New 

Account Wizard Account Settings window, or when you choose Properties from the drop-down context menu 

(right-click) in the Personalities window. When you display the dialog box, enter the information in the fields. If 

you are modifying an existing personality, the fields are filled in with the information associated with the 

personality you have selected.

After you make your changes in the dialog box, click OK to save them, Cancel to discard them, or Help for 

more help.

Any changes you make to your dominant personality in this dialog box are also changed where they are 

mirrored in relevant options of the Options dialog box. The same is true in reverse; changes you make in the 

Options dialog box are carried over here, when you next open this dialog box.

Generic Properties Panel

This dialog box window contains the general characteristics associated with this personality.

Following are the field descriptions for Generic Properties panel.

Personality Name—This is a label that shows the name assigned to the personality being modified (for 

example, Business or My PC Account). <Dominant> indicates your dominant personality.

Your dominant personality is your principal email account; it’s the personality Eudora uses whenever you don’t 

specify otherwise, and it’s also the personality associated with all mail stored before you began using alternate 

personalities.

Note that the name shown here may be different from the Real Name associated with the personality (see 

below).

Traits:

Real Name—This is the real name assigned to this personality—generally a first and last name. The text you 

enter here is included in the From field of all your outgoing messages from this personality and identifies the 

source to your recipients.

Return Address—This is the return email address used in outgoing messages and recipients’ replies for this 

personality, if this address is different from the personality’s incoming mail account. The address you enter here 

is included in the From field of all your outgoing messages from this personality, and when a recipient replies to 

a message from this personality, the reply is sent to this address. If you do not enter an address in this field, 

Eudora uses the personality’s incoming mail account as the return address. Incoming mail accounts are usually 

of the form loginname@incomingmailserver. For example, suppose your incoming mail account is 

rclark@worldmail.myfirm.com but your return address is rclark@myfirm.com — slightly different. You would 

then enter rclark@myfirm.com in this field.

Note: If you do enter an address in this field, first test the address to be sure that mail sent to it is 

indeed delivered to you. If you use an invalid return address, no one will be able to reply to 



mail sent from this personality.

Login Name—This is the name you use to login to this email account, for accounts that require a user login. 

For example, in the incoming mail account rclark@worldmail.myfirm.com, the login name is rclark. The part 

after the "@" sign is the name of the incoming mail server. See Incoming Mail Options Window.

SMTP Server—This is the name of the outgoing-mail server for this personality. SMTP stands for Simple Mail 

Transfer Protocol. Outgoing messages you send are routed through this server. If the computer that this 

personality’s incoming mail account selected also runs an SMTP server, you can leave this field blank. See 

Sending Mail Options Window.

Allow authentication— Eudora can log in to an SMTP server when sending mail, just like it does for receiving 

mail. Not all SMTP servers require or allow such authentication. Eudora will attempt authentication to servers 

that allow it. The preferred SMTP authentication method is CRAM-MD5. If CRAM-MD5 is not available, LOGIN 

or PLAIN will automatically be used.

Default Domain—This is the domain name that Eudora automatically adds to an unqualified name addressed 

in messages sent from this personality. An unqualified name is a name that doesn’t have an "@" sign followed 

by a domain name. This can be used to save time when addressing large numbers of messages to users in the 

same domain. Also, different personalities can be used to send messages to different domains. For example, 

you can use one personality to send work-related messages to the domain myfirm.com, and another 

personality to send personal messages to the domain in your home email address, or to your school account 

(for example, myschool.edu).

Default Stationery—The default stationery to use for all outgoing messages sent from this personality. Select a 

stationery file from the drop-down menu, or select <No Default> for no default stationery. For more details about 

using stationery with alternate personalities, see Linking a Signature and Stationery to a Personality and 

Composing Mail Options Window. 

Default Signature—This sets the default signature to use for all outgoing messages sent from this personality, 

but only when you are not using stationery — that is, only when the Default Stationery drop-down menu (above) 

is set to <NoDefault>. If you have chosen a stationery file, then the signature used when that stationery file was 

saved overrides your setting here.

Select a signature from this drop-down menu, or select <No Default> for no default signature. If you select a 

signature, Eudora automatically attaches that signature to the end of all outgoing messages sent from this 

personality. You can always change the signature in a particular outgoing message using the Signature drop-

down in the composition window. For more details about using signatures with alternate personalities, see 

Using a Signature and Composing Mail Options Window.

Check Mail—If this is selected, mail checking is activated for this personality in the following ways:

· If you have specified a number in the Check for mail every _ minutes option in the Checking Mail options 

window, then when automatic mail-checks are performed at these intervals, mail for this personality is 

checked as well.

· Each time you do a manual check for mail, by choosing the Check Mail command from the File menu or via 

another method, mail is checked for this personality as well.



If this option is deselected, mail for this personality is not checked during manual or automatic mail checks, 

except that you can override the setting and still check for the personality’s mail using the Mail Transfer Options 

window or using the "Check Mail" command from the Personalities window’s drop-down context menu (right-

click).

Secure Sockets when Sending¾You can choose how you wish to use SSL with this personality when sending 
messages by choosing one of the options in the SSL drop-down menu. The following are the SSL options when 
sending mail.

Never— Do not use SSL for server authentication and mail transfer security, even if SSL is available on 
the server. 

If Available STARTTLS (default)— Use SSL for server authentication and mail transfer security by 
having Eudora automatically invoke the STARTTLS command method to start SSL, that is, if the server 
supports STARTTLS. If your server doesn’t support STARTTLS, mail transfers will occur successfully, but 
they will not be secured with SSL.

Required, Alternate Port— Use SSL for server authentication and mail transfer security by having 
Eudora automatically use the older style alternate port method for starting SSL. If your server does not 
support SSL on the appropriate ports, mail transfers will fail. 

Required STARTTLS— Use SSL for server authentication and mail transfer security by having Eudora 
automatically invoke the STARTTLS command method to start SSL. If your server does not support 
STARTTLS, mail transfers will fail. 

Important. If you use SSL and cannot make a connection when receiving or sending mail, you may need to 

check with your ISP to update any invalid SSL certificates. However, to override any issues with SSL 

when retrieving or sending mail, choose Never from the drop-down menu to make a successful 

connection.

Last SSL info¾To display the most current information for an SSL connection between a server and Eudora 
since the last time you started Eudora, click Last SSL info. The Eudora SSL Connection Information Manager 
window appears with SLL and certificate information. 

Caution: If you display the SSL information windows, make certain you don’t change any of the field 

information unless you are familiar with SSL.

Incoming Mail Panel

This panel contains settings that identify and configure the incoming mail server to be used in receiving mail for 

this account.

When Configuration = POP:

Following are field descriptions for the Incoming Mail panel (POP configuration):

Server—This is the name of the incoming-mail server for this personality. All incoming messages to this 

personality are routed through this server.

Configuration—This indicates which email protocol the incoming mail server uses: POP (Post Office Protocol) 

or IMAP (Internet Message Access Protocol). Ask your email administrator which one to use, if you are not 

sure.

The settings in the rest of this panel depend on whether you’ve chosen POP or IMAP in this field. Settings for 



both configurations are described below.

Leave mail on server—If this is selected, then during mail checks, incoming mail for this personality is left on 

the incoming mail server and a copy is transferred to your computer. If this is deselected, then when mail is 

checked, incoming mail for this personality is deleted from the incoming mail server after it is transferred to your 

computer. For more details, see Managing your Mail on a POP Server.

Delete from server after _ days—This option has a check box for selecting or deselecting and an edit box for 

specifying the number of days mail that was left on the POP server should be saved before being deleted. It is 

a good idea not to leave copies of your messages on the POP server indefinitely because this will create mail 

storage problems on the server.

Delete from server when emptied from Trash—If this is selected, any messages that are deleted from your 

Trash mailbox are also deleted from the POP server. For details, see Managing your Mail on a POP Server.

Skip messages over _ K in size—If this is selected, messages over the specified size are downloaded only in 

part. These messages include the first few lines, and a statement that says the message is not complete. This 

can be useful on slow connections. If you enter zero, all messages are downloaded. For details, see Managing 

your Mail on a POP Server.

Authentication style—This specifies which POP account authentication technology to use for this personality: 

Passwords, Kerberos, APOP, or RPA. Ask your email administrator which one to use. If you use Eudora at 

home, most likely your Authentication Style is Password. CompuServe users should use the RPA authentication 

method.

Secure Sockets when Receiving¾You can choose how you wish to use SSL for this personality when 
receiving messages by choosing one of the options in the SSL drop-down menu. The following are the SSL 
options when receiving mail.

Never— Do not use SSL for server authentication and mail transfer security, even if SSL is available on 
the server. 

If Available STARTTLS (default)— Use SSL for server authentication and mail transfer security by 
having Eudora automatically invoke the STARTTLS command method to start SSL, that is, if the server 
supports STARTTLS. If your server doesn’t support STARTTLS, mail transfers will occur successfully, but 
they will not be secured with SSL.

Required, Alternate Port— Use SSL for server authentication and mail transfer security by having 
Eudora automatically use the older style alternate port method for starting SSL. If your server does not 
support SSL on the appropriate ports, mail transfers will fail. 

Required STARTTLS— Use SSL for server authentication and mail transfer security by having Eudora 
automatically invoke the STARTTLS command method to start SSL. If your server does not support 
STARTTLS, mail transfers will fail. 

Important. If you use SSL and cannot make a connection when receiving or sending mail, you may need to 

check with your ISP to update any invalid SSL certificates. However, to override any issues with SSL 

when retrieving or sending mail, choose Never from the drop-down menu to make a successful 

connection.

Last SSL info¾To display the most current information for an SSL connection between a server and Eudora 
since the last time you started Eudora, click Last SSL info. The Eudora SSL Connection Information Manager 
window appears with SLL and certificate information. 

Caution: If you display the SSL information windows, make certain you don’t change any of the field 



information unless you are familiar with SSL.

When Configuration = IMAP:

Following are field descriptions for the Incoming Mail dialog box (IMAP configuration):

IMAP Mailbox Location Prefix—This specifies the mailbox location prefix that IMAP will use when locating 

your mailboxes on the incoming mail server. An example prefix is /usr/mail. Ask your email administrator what to 

enter here, if you are not sure.

For new mail, download—These two settings let you control the way incoming mail is downloaded from the 

IMAP server.

Minimal Headers Only—If this setting is selected, only a limited set of message headers is downloaded for 

each incoming message. If this setting is deselected, the full set of message headers is downloaded for each 

incoming message.

Full message except attachments over _ K—If this setting is selected and a number is entered in the edit 

box, then any attachments larger than the specified size will not be downloaded with the message. If you enter 

0 in the text box, all attachments regardless of size are retrieved.

Authentication style—This specifies which IMAP account authentication technology to use for this personality: 

Passwords, Kerberos, or CramMD5. Ask your email administrator which one to use.

Secure Sockets when Receiving (same as for POP)



Using the Address Book

The Address Book is where you keep information about individuals or groups that you correspond with. Each 

entry in the Address Book includes a name for a person or group, their full email address (email addresses for 

groups), a full name, any contact information including both home and work information, other email addresses 

and information, and any notes. You can also use the Address Book to put names on the Recipient List, and to 

address a new message. 

You can perform a search for an entry in your address book. With your address book open, press Ctrl+Shift+F 

or from the Edit menu, choose Text, then Find Text. In Find dialog, enter the nickname of the person you are 

searching for. That person’s file appears.

To open your Address Book, do the following:

· From the Tools menu, choose Address Book, or press Ctrl+L. Or, if the Address Book is an inactive 

window in an open tabbed window group, click its tab. See Window States and Tabbed Windows for more 

details on tabbed windows.

All of the Address Book entries are kept in files. For example, you can show files for Business, Family, and 

Friends (Eudora Nicknames is the default file). You can show or hide the entries in a file by double-clicking the 

file. The icon shows an open or closed book, depending on whether the file is open or closed.

You can use the View By option to display the entries using any of the fields except the Notes field. For 

example, if you want to view the entries by nicknames, choose View By: Nickname. If you view by a field that 

doesn’t contain any data, the entry appears with <>.

Note: Eudora remembers your selection in the View By field when you quit and restart the program.

You can also start typing in the list of entries, and the appropriate entry will be selected when you enter enough 

unique characters to identify it.

To page up and down in the list of entries, use the arrow keys. To resize the list, drag the divider.

To move the keyboard focus back and forth between the left and right sides of the Address Book, press F6.

To move quickly through the tabbed windows on the right side of the Address Book, use the Ctrl+Tab, 

Ctrl+PgUp, Ctrl+PgDn, Ctrl+Home, and Ctrl+End keys.



Creating a New Entry

To create a new entry or entries to be included in the address book, do the following:

1. From the Tools menu, choose Address Book, or press Ctrl+L. Or, if the Address Book is an inactive 

window in an open tabbed window group, click its tab.

2. In the Address Book, choose which address book (if more than one is set up) in which you want this 

person’s information listed, for example "Family."    The default is "Eudora Nicknames."

3. Either click New in the Address Book, or right-click anywhere in the entry list to display the drop-down list 

and choose New. A new entry appears in the address book column (left side). To add a new address book, 

click New Book.

4. In the Nickname field (right side of window), enter what you want to call this person, for example, "Dad," or 

address book, for example, "Family." 

A nickname, sometimes called an alias, is an easily remembered, shorter substitute for the email address 

in the entry. Nicknames can be used in place of proper email addresses in the To, Cc, and Bcc header 

fields of outgoing messages. A nickname entered here should be the name you wish to type in a header 

field (To, Cc, Bcc) when composing an email message. For example, although your Dad's name is John 

Smith, you can enter "Dad" as the nickname. So when you address a message, you can just enter "Dad" in 

the header field.

You cannot use the actual email address as the nickname. It must be different.

5. If you want the nickname on your recipient list, check the Recipient list box. Once the person is on the 

recipient list, the name is bolded in the address book list. 

6. To create the entry, click anywhere or press Enter. 

7. Click the Personal tab. The Personal dialog appears.

8. In the Full Name field, type the real name or an informal name for the person. If there is just one address 

for the entry, this name and the address are included in the "To:" field for your recipient to see.

9. In the First Name and Last Name fields, type the first and last name of the person. You can interchange 

the first and last names by clicking Swap.

10. In the This nickname will expand to the following addresses text field, enter at least one complete 

email address for this person. If this person has more than one address, enter the additional addresses 

here if you want him or her to receive your messages at each address. 

Make sure this field contains no other information except addresses and nicknames, or your messages will 

be addressed incorrectly.

It is recommended that you have no more than 2,000 nicknames per nickname file. If the files are too large, 

they may appear collapsed in the address book, but you can still use all the nicknames when addressing 

messages. If you have a large number of entries, you might want to consider using a Ph or LDAP server.

11.    You may continue adding Home, Work, Other, and Notes information by clicking on the appropriate tabs.

11. To save your changes to the Address Book, from the File menu choose Save.



You can perform a search for an entry in your address book. With your address book open, press Ctrl+Shift+F 

or from the Edit menu, choose Text, then Find Text. In Find dialog, enter the nickname of the person you are 

searching for. That person’s file appears.



Changing, Moving, Copying, Seaching, and Deleting Entries

· To change an Address Book entry, choose the entry from the list and edit the fields in any of the address 

book’s dialog boxes as appropriate.

· To delete an entry or an address file, select it from the list and click the Delete button or press the Delete 

key. Or, right-click it and select Delete from the drop-down list. You cannot remove the Eudora Nicknames 

file.

If a nickname file is set to read-only, meaning you cannot change it, you cannot move or copy entries into 

it, or delete an entry from it.

· To search for an entry, press Ctrl+Shift+F or from the Edit menu, choose Text, then Find Text. In Find          

dialog, enter the nickname of the person you are searching for. That person’s file appears.

· To update your recipient list and address book, hold down the Ctrl key and open the address book (this 

rebuilds your address book's table of contents).

Important: If you change a nickname, but sure to correct any entries that reference that nickname.

To move or copy an entry to another address book, do the following:

1. Right-click the address book entry to display the drop-down list.

2. From the drop-down list, choose Move To to move an entry or Copy To to copy an entry. The Choose a 

Nickname File dialog box appears so that you can select the file to which you want to move or copy the 

entry.

3. You can move an entry (or entries) to a different file by dragging it, or copy it by holding down the Shift or 

Ctrl key and then dragging it.

4. You cannot move an entry into the file it is already in, but you can copy an entry into its file. A "Copy of 

[Entry]" is created.

5. To save your changes, from the File menu, choose Save. 



Including Nicknames on the Quick Recipient List

To include a nickname in the Quick Recipient List, do the following:

1. Right-click the appropriate Address Book entry in the list and from the drop-down menu, choose Add to 

Recipient List. The nickname for the selected entry is included on the Quick Recipient List, and the entry 

is bolded in the Address Book list.

To remove a nickname from the Quick Recipient List, do the following:

1. Right-click the item in the Address Book list and from the drop-down menu, choose Remove From 

Recipient. The nickname for the selected entry is removed from the Quick Recipient List, and the entry is 

unbolded in the Address Book list.

If you change a nickname, the Quick Recipient List is updated as appropriate. For details about using the Quick 

Recipient List, see Using the Quick Recipient List .

Note: You can add or remove multiple nicknames to or from the Quick Recipient List by selecting multiple 

entries before right-clicking. Hold down the Shift key to select multiple entries in sequence, or the Ctrl 

key to make nonconsecutive selections.



Addressing a Message from the Address Book

You can open and address a new message from the Address Book using the To, Cc, and Bcc buttons.

To create a new message from the Address Book, do the following:

1. Select the entry you want to address the mail to (hold down the Shift key to select multiple entries in 

sequence, or the Ctrl key to make nonconsecutive selections). 

2. Click To, Cc, or Bcc. A new composition window appears with the selected nickname(s) inserted in the 

appropriate field.

Note: You can also double-click an entry to enter that nickname in a header field. If no composition window 

is open, a new composition window is opened and the nickname is entered in the To field. If a 

composition window is open when you double-click, the nickname is entered in the header field that 

last had keyboard focus.

To address the message with the completely expanded address or addresses for that entry, rather than the 

entry’s nickname (the addresses are listed in the Address(es) field for the entry), turn on the Expand 

Nickname option.

Once the composition window appears, you can use the To, Cc, and Bcc buttons to insert additional 

nicknames into the corresponding fields, subject to the following restrictions.

If the Address Book is a docked or floating window (either alone or as part of a tabbed window group), the To, 

Cc, and Bcc buttons apply to the topmost composition window, if any. If the Address Book is a normal window 

(either alone or as part of a tabbed window group), the To, Cc, and Bcc buttons apply to the composition 

window, if any, that is immediately under either the Address Book or the tabbed window group containing the 

Address Book. For more information on docked, floating, normal, and tabbed windows, see Window States and 

Tabbed Windows .



Make Address Book Entry Command

The Make Address Book Entry command is used to create entries in your Address Book, and is especially 

helpful for making group entries.

· In an open window, go to step 1.

· In an open mailbox window, first select the message summary or summaries you want in the address book, 

then go to step 1.

1. From the Special menu, choose Make Address Book Entry. The Make Address Book Entry dialog box 

appears. 

2. In the Nickname text box, Eudora enters the name in the email address or the message. You can change 

it if you like.

3. In the Full Name field, Eudora enters the full name as it appears in the email address of the message. You 

can change it if you like.

4. In the First Name and Last Name fields, Eudora enters the first and last name of the person as it appears 

in the email address or the message. You can change it if you like.

5. In the This nickname will expand to the following address field, Eudora enters the email address as it 

appears in the message. You can change the email address if you like.

§ If you choose multiple message summaries in the mailbox window, addresses are taken from each 

message and all are put in the new entry.

§ If the open or selected message is an outgoing message, the new entry will include all of the 

addresses in the To:, Cc:, and Bcc: fields.

§ If the open or selected message is an incoming message, the new entry will include the address in the 

From: field.

§ If you have more than one address book, in the In the Address Book drop-down list, choose the 

address book in which you want to place this nickname. You cannot make a new address book using 

the Make Address Book Entry command.

§ If you want to put the nickname on your Recipient List, check the Put it on the recipient list box.

6.          When finished, click OK. The new entry is now in your address book.

 If your new nickname has the same name as an existing nickname, a prompt appears asking if you want to 

add the address(es) to the existing nickname or replace the existing nickname with the new address(es).

Also, when you use the Make Address Book Entry command in an open message or mailbox window, Eudora 

uses your current Replying settings. If the Reply to all By default setting is turned on (or if it is not and you hold 

down the Ctrl key when selecting Make Address Book Entry), the new entry will include all of the recipients of 

the message plus the sender. However, if the Include yourself setting is turned off and the current message is 

an incoming message, your address is not included in the new entry.



Finish Address Book Entry Command

With the Finish Address Book Entry command, you can enter a unique portion of a nickname in the To, Cc, 

or Bcc fields of a message, then from the Edit menu, choose Finish Address Book Entry, and the nickname 

will be completed for you. You must enter the characters in the nickname that make it unique, or Eudora will not 

know which nickname to use. For example, if you have two nicknames, joan and john, you would have to enter 

"joa" or "joh" for Eudora to complete them.

To insert the real addresses for the entry, instead of the nickname, hold down the Shift key and from the Edit 

menu, choose Finish Address Book Entry. To set this to happen all the time, turn on the Automatically 

expand nicknames option in the Miscellaneous options window found in Options under the Tools menu.



Using Central Address Book Files on a Server

You can set up central Address Book files on a server and configure Eudora clients so that they refer to the 

central files.

First, be sure the files are plain text, have a .txt extension, and are formatted as follows: One nickname on 

each line with the real addresses separated by commas, and one line for notes and info with the Notes text 

following the Info data. For example:

alias Wow joe@wow.com,lisa@wow.com,chris@wow.com

note Wow <fax: 222.2223><phone: 222.2222><address:1234 Street>

<name:Wow Inc.>My favorite company

Then, for each client application, add an ExtraNicknameDirs entry to the [Settings] section of the Eudora.ini 

file. This entry should be followed by the list of directories that contain Address Book files, separated by 

semicolons (;). Any Address Book files located in those directories are added to the Address Book. You need to 

exit and relaunch Eudora to see the new entries.



Using Address Book Files Not Created by Eudora

To use an Address Book file that was not created in Eudora, put the file in the Nickname directory (in your 

Eudora directory), and be sure the format is as shown in Using Central Address Book Files on a Server . You 

need to exit and reopen Eudora to see your new entries in the Address Book.



Using the Quick Recipient List 

The Quick Recipient List is your list of recipients to whom you often send mail.

      To add a nickname to the Recipient List, do the following.

1. From the Tools menu, choose Address Book, or press Ctrl+L. Or, if the Address Book is an inactive 

window in an open tabbed window group, click its tab.

2. Click to select the desired entry in your Nickname list. 

3. On the right side of the window, check the Recipient List box, or right-click the selected item to display the 

drop-down list. From the drop-down list, choose Add to Recipient List. The entry’s nickname is added to 

the Recipient List, and the entry is bolded in the Address Book list.

To add an email address to the Recipient List, do the following.

1. Open the Address Book.

2. Select the text that makes up the full address. 

3. From the Special menu, choose Add as Recipient. The recipient’s email address is added to your 

Recipient List.

To remove an entry from the list, do the following.

1. Open the Address Book.

2. Click to select the desired entry in your Nickname list.

3. Right-click the item to display the drop-down list.

4. From the drop-down list, choose Remove From Recipient List. The entry’s nickname is removed from the 

Recipient List and the entry is unbolded in the Address Book list. Or, select the item you wish to remove 

from the Remove Recipient submenu under the Special menu.

To open a new message addressed to someone on your Recipient List, do the following:

1. From the Message menu, choose New Message To, Forward To, or Redirect To. 

2. From the displayed list, select the nickname. A new message window appears addressed to the nickname 

you selected.

To insert a recipient into a message that you have already opened, do the following.

1. Move the cursor to where you want the recipient.

2. From the Edit menu, choose Insert Recipient. The Insert Recipient submenu appears.

3. From the Insert Recipient submenu, choose the recipient. The recipient you choose is inserted into the 

opened message.

To insert the real address(es), instead of a nickname, do the following.

1. Hold down the Shift key and from the Edit menu, choose Insert Recipient. The Insert Recipient submenu 

appears.



2. From the Insert Recipient submenu, choose the recipient. The real address of the recipient is inserted in 

the message. To set this to happen all the time, select the Automatically expand nicknames option in the 

Miscellaneous options window. See Miscellaneous Options Window.

More than one recipient from the Recipient List can be added to the To:, Cc:, and Bcc: fields of any message. If 

you use Insert Recipient submenu, commas are added where necessary.



Opening Directory Services

Eudora lets you look up individuals on the Internet, within your company, and in your Eudora Address Book (if 

you have one set up) using four directory service protocols: Ph, Finger, LDAP (Lightweight Directory Access 

Protocol), and Eudora Address Book.

To use directory services to look someone up, do the following:

1. From the Tools menu, choose Directory Services. Or, if the Directory Services window is an inactive 

window in a visible tabbed window group, click its tab. (See Window States and Tabbed Windows for more 

information on tabbed windows.)

The directory service protocols available to you for your search are listed in the Protocols section of the 

window. See Directory Service Protocols for more information.

The databases you can use to look up your target individual are listed in the Databases list. For more details, 

see Directory Service Databases , Creating a New Database and Deleting a Database .

To resize the left and right halves of the window relative to each other, drag the vertical separator bar to the left 

or right.



Keeping the Directory Services Window on Top

To keep the Directory Services window on top so that you can easily continue using it, turn on the Keep On 

Top option. Eudora remembers the state of this option when you quit and restart the program.

Note: The behavior of this option is subject to the restrictions in Window State Considerations .



Looking Someone Up (Making a Query)

To look up someone on the Internet, within your company, or in your Eudora Address Book, do the following:

1. From the Tools menu, choose Directory Services. Or, if the Directory Services window is an inactive 

window in a visible tabbed window group, click its tab.

2. In the Databases list, select the database(s) you want to search in your query.

To select a database, click the checkbox to the left of the database until a checkmark appears in the box. You 

can select multiple databases, and you can use multiple protocols. You must select at least one database in the 

list in order for Eudora to perform the query. 

Note: Eudora remembers which databases you’ve selected when you quit and restart the program.

3. In the Query field, type a text string you want to search against.

If one or more of your selected databases use a protocol other than Ph, your entry in this field will always 

be interpreted as a name. If you only have Ph servers selected as your databases, you can enter any 

commands that Ph will interpret.

Note: When looking up names in Eudora’s Directory Services, Eudora now remembers the name and 

places it in a directory services history file. So whenever you begin typing a name, a drop-down list of 

names from your history file display alphabetically. Just select the desired name from the list, and the 

name’s information appears. 

4. After you’ve typed the text, start the query by pressing Enter or clicking Start.

The query begins, and the Start button changes to Stop.

5. To stop the query before it is completed, click Stop.

When the query is completed, or if you click Stop to cancel the query, the Stop button changes back to Start.



Reading Your Query Results

Your query results are listed in the left half of the Directory Services window, in the results list (top view) and the 

details pane (bottom view). You can resize the two views relative to each other using the separator between 

them; drag the separator up or down.

The results list consists of one-line summaries of the "hits" or successful targets of your query. These are listed 

by four columns: Name, Email, Phone, and Database. Name indicates the username (or other name) of the 

target. Email is the email address of the target. Phone is the target’s telephone number. Database tells you in 

which of your selected databases the target was found.

Click a column header to sort the results list alphabetically (or numerically) by that column. Shift-click to sort in 

reverse order.

To resize the columns, drag the divider line to the right of the desired column to the left or right. Note that the 

columns resize dynamically during a query to accommodate the width of each target’s data.

The Status field displays the status of your query (such as Ready, Connecting, or Getting Data) and the 

number of items found as shown in your summary list. This number is updated dynamically until the query is 

complete or you stop it.

If the results list does not fit in the available viewing space, scroll bars appear to let you navigate through the 

remaining part of the list.

To view the details of a result in the details pane, select the result in the results list by clicking on it. The full data 

appears in the details pane. If nothing is selected in the results list, the details pane is blank. If multiple 

summaries are selected in the results list, the details pane lists the details for each item, with each item 

separated by a divider line.

To select multiple items in the results list, use the Shift key to select a continuous range, and use the Ctrl key 

to make nonconsecutive selections.

Scroll bars appear in the details pane if the displayed information cannot fit in the viewing space.



Addressing a Message from the Directory Services Window

You can create and address a message with the query results in the Directory Services window.

To create a new message, do the following:

1. From the Tools menu, choose Directory Services. Or, if the Directory Services window is an inactive 

window in a visible tabbed window group, click its tab.

2. Make sure there are no outgoing messages open. 

3. Perform your query. 

4. Select one or more summaries in your results list. 

5. Click the To, Cc, or Bcc button. A new message is created, and it is addressed appropriately with the 

selected query results.

To add an address to an existing message, make sure the message you want to address is active, open the 

Directory Services window, perform the query, and select one or more summaries in the results list. Now click 

the To, Cc, or Bcc button. The addresses from the selected query results are added to the appropriate field of 

the current message.

Note: The behavior of the To, Cc, and Bcc buttons is subject to the restrictions in Window State 

Considerations .



Making an Address Book Entry from Your Query Results

You can make a nickname from your query results in the Directory Services window and add the entry to your 

Address Book.

To make a nickname, do the following:

1. From the Tools menu, choose Directory Services. Or, if the Directory Services window is an inactive 

window in a visible tabbed window group, click its tab.

2. Perform a query. 

3. Select one or more summaries in the results list. 

4. From the Special menu, choose Make Address Book Entry. The Make Address Book Entry dialog box 

appears so that you can name the nickname. The real name and email address for each selected query 

result is included in the new entry. 

Note: The use of this command from this window is subject to the restrictions in Window State 

Considerations .



Printing Your Query Results

You can print, and preview for printing, the results of your query as shown in the details pane.

To print your query results, do the following:

1. From the Tools menu, choose Directory Services. Or, if the Directory Services window is an inactive 

window in a visible tabbed window group, click its tab.

2. Perform your query.

3. Select one or more summaries in the results list. The details pane lists the details of each selected item, 

with each item’s details separated by a divider line.

4. To preview your query details for printing, from the File menu, choose Print Preview. The Print Preview 

dialog box appears, showing how the query details will look when printed.

5. To print your query details, from the File menu, choose Print.

Note: The use of this command from this window is subject to the restrictions in Window State 

Considerations .



Window State Considerations

The behavior of some Eudora features internal and external to the Directory Services window depends on the 

state of the window. For definitions of window states, see Window States and Tabbed Windows.

When the Directory Services window is in the docked or floating state (either alone or as part of a tabbed 

window group), the following applies:

• The Keep on top setting in the window is ignored.

• The To, Cc, and Bcc buttons in the window apply to the topmost composition window, if any.

• The Special menu Make Address Book Entry command, and the File menu Print Preview and Print 

commands, apply to the Directory Services window only if the keyboard focus is in that window.

When the Directory Services window is in the normal state (either alone or as part of a tabbed window group), 

the following applies:

• The Keep on top setting in the window is obeyed.

• The To, Cc, and Bcc buttons in the window apply to the composition window, if any, immediately under the 

Directory Services window or the tabbed window containing it.

• The Special menu Make Address Book Entry command, and the File menu Print Preview and Print 

commands, apply to the Directory Services window only if it is the topmost normal window and is active, or if 

the tabbed window containing it is the topmost normal window and the Directory Services tab is active.



Directory Service Protocols

Protocols are servers you access in Directory Services to find information on persons by entering their name, 

email address, clicking The Protocols section of the Directory Services window lists the directory service 

protocols available to you to use when looking up individuals via these services.

Eudora comes with four installed protocols.

· Ph 

· Finger 

· LDAP (Lightweight Directory Access Protocol) 

· Eudora Address Book

The Eudora Address Book protocol does not appear in the list until you have created an Address Book in 

Eudora.

Click the column heading, Registered Drivers to sort the protocols alphabetically. Shift-click the column heading 

to sort in reverse order.

You can resize the column by dragging the divider line to the right of the column heading to the left or right.

The use of the New Database button, shown in this section of the window, is described in Creating a New 

Database .



Directory Service Databases

The Databases section of the Directory Services window lists the databases that are available to you for 

searching for individuals over the Internet, within your company, or in your Address Book (if one is set up).

Eudora comes with these servers already configured by default:

· ldap.bigfoot.com

· ldap.whowhere.com

· ldap.infospace.com

· ldapbiz.infospace.com

· ldap.four11.com

· Eudora Nicknames (or the name of your nicknames file; this last item appears only if you have a 

Eudora Address Book set up)

You can modify or delete these databases, and you can also create new databases and modify and delete 

them. 

You use the databases in this list to perform your lookup queries. To perform a query, you must first select one 

or more databases in the list. To select a database, click the checkbox to the left of the database name, until a 

checkmark appears in the box. If no databases are selected, you cannot perform a query.

You can select multiple databases to perform a query, and you can mix protocols.

Click a column heading to sort this list alphabetically. Shift-click the column heading to sort in reverse order.

To resize columns, position the mouse pointer over the divider line to the right of the desired column, and drag 

the line to the left or right.



Creating a New Database

In addition to the default directory service databases that already comes configured with Eudora, you can 

create new Ph, Finger, and LDAP databases for your Directory Services queries. By adding a new database, 

you can then query that database for names, email addresses, phone numbers, and so on. Databases are 

created from the Protocols section of the window, and they must be created using one of these three listed 

protocols.

Important: You must be able to identify the server by its description and its host name before you can add 

it to Directory Services.

Note: You cannot create a new database using the Eudora Address Book protocol in the list. Nickname 

files must be created from the Address Book window. See Using the Address Book for more details.



Deleting a Database

To delete a database, do the following:

1. Open the Directory Services window.

2. Click the database name or icon in the Databases list to highlight the item.

3. Click Delete. You are prompted to confirm the delete. Click Yes and the database is removed from the list. 

Click No and the deletion is canceled, and the database remains.

You can delete multiple databases at once; use the Shift key to select a range in the list, and use the Ctrl key to 

select items nonconsecutively.



Printing

You can print the current message or messages, a plain text window, selected text within a message or text 

window, the contents of the Directory Services window, the contents of your address book, and your filters. 

Eudora automatically prints headers and footers on each page, giving the window title, page number, and your 

return address.

To print the current message or item, choose Print from the File menu. 



Plugins (Extended Messaging Services)

Plug-ins are special add-ons that can be installed to add features to Eudora. For example, you could use a 

language conversion plug-in to translate a message to another language, a security plug-in to automatically 

secure a message, or a text manipulation plug-in to change lowercase to uppercase. Plug-ins interface to 

Eudora using the Extended Messaging Services Application Programming Interface (EMSAPI). 

• To make plugins available to Eudora, put them in the Plugins directory in your Eudora Email directory, then 

restart Eudora. Depending on the plug-in type, it will be available in Eudora through the following methods:

- The Message Plugins submenu (in the Edit menu) typically includes plugins that are used to modify the 
text of a message. These are referred to as on-request plugins. Some samples of these types of plugins 
are available with Eudora: Sort, UpperLower, and Unwrap.

- Icons in the message window are typically for plugins that are used to manipulate messages as they are 
sent or when they are received. These are referred to as on-transmission and on-display plugins.

- The Tools menu typically includes plugins that are used to do tasks that are not directly related to 
Eudora functions. These are referred to as tools plugins.

- The Attach [to New] submenu (in the Message menu) typically includes plugins that are used to create 
and attach particular files to a message. These are referred to as attachment plugins.

- Plug-ins that are automatically used when a message is received are not available through the user 
interface.

• To see all of your currently installed plugins, choose Message Plugins Settings from the Special menu. If a 

plug-in has any settings options, you can use the Settings button to change them. 

For information about available plugins, send email to <eudora-rep@eudora.com> or visit our web site 

www.eudora.com/central/plugins 



Messaging Application Program Interface (MAPI)

MAPI is an interface for sending email messages from any MAPI-compatible application, such as your word 

processor, spreadsheet, graphics application, and so forth.

MAPI-compatible applications have a Send or Send Mail option in the File menu. When you select the option, 

the Eudora MAPI server displays a new outgoing message with your current document attached. All you need 

to do is address the message, type any details you want to include in the body of the message, and click Send 

or Queue.

• To run the Eudora MAPI server, use the MAPI options window. To display the MAPI options window, choose 

Options from the Tools menu and click MAPI.

You have several options in the MAPI options window for loading the Eudora MAPI server. You can set it to 

always run or to run only when Eudora is running, or you can specify that it never run. These three options 

open or exit the server as soon as you select them.

Note: When you are running the Eudora MAPI server, Microsoft Exchange will not work. If you need to use 

Exchange, turn off the Eudora server. 

See the online User Manual for technical details on the Eudora MAPI server.

Also, you have several options for saving or deleting MAPI attachments. When you use MAPI to attach a file 

and send a message, that file is immediately copied into the Attach directory (or a directory you have specified). 

You can use the MAPI options to save those copies, delete them after sending their corresponding messages, 

or delete them after their messages are emptied from the trash.



Modifier Keys

Many operations in Eudora can be implemented by holding down one or more modifier keys. Eudora uses the 

Shift, Ctrl, and Alt keys as modifiers.

Shift + Check Mail or Send Queued Messages

Displays the Mail Transfer options window to define the interaction with your POP 

account.

Shift + Queue/Send Opens the Change Queuing dialog box.

Shift + Open an incoming message

Opens the message with all headers displayed.

Shift + Insert Recipient Inserts the address(es) instead of the nickname.

Shift + Ctrl + F Opens Find text dialog box

Shift + Ctrl + , or Shift + Finish Address Book Entry

Finishes the Address Book entry with the address(es) instead of the nickname.

Shift + Sort command Sorts in ascending order.

Shift + Transfer Puts a copy of the current message in the selected mailbox and leave the original 

where it is.

Shift + Copy Copies the selected text without the carriage returns (copy unwrapped).

Shift + Paste or Shift + Paste as quotation

Pastes the selection as plain text (do not paste the style information).

Shift + Wrap Selection Removes the carriage returns from the selected text (unwraps).

Shift + Exit Sets all open windows to open again when Eudora is next started.

Shift + Save Saves changes to all open windows.

Shift + Close Closes all open windows.



Shortcuts

The keyboard shortcuts for Eudora functions are as follows:

Ctrl + 0 Opens Out mailbox

Ctrl + 1 Opens In mailbox

Ctrl + 6 Checks spelling

Ctrl + ' Pastes as quotation

Ctrl + , Finishes nickname

Ctrl + . Removes one level of excerpt bars

Ctrl + > Adds one level of excerpt bars 

Ctrl + A Selects all

Ctrl + B Makes the selected text bold

Ctrl + C Copies

Ctrl + D Deletes

Ctrl + E Sends or Queues

Ctrl + F Finds message

Ctrl + Shift + F Finds text

Ctrl + H Attaches document

Ctrl + I Makes the selected text italic

Ctrl + J Filters messages

Ctrl + K Makes nickname

Ctrl + L Opens the Address Book

Ctrl + M Checks mail

Ctrl + N Opens a new message

Ctrl + O Opens a file

Ctrl + P Prints

Ctrl + Q Exits Eudora

Ctrl + R Replies

Ctrl + Shift + R    Replies to all

Ctrl + S Saves

Ctrl + T Sends queued messages

Ctrl + U Makes the selected text underlined

Ctrl + V Pastes

Ctrl + W Closes message

Ctrl + X Cuts

Ctrl + Y Opens Directory Services

Ctrl + Z Undo

Ctrl + Tab Switches between opened mailboxes and messages

Alt + A Jumps to Attached: field in message header; Sort by Attachments in Table of Contents

Alt + B Jumps to Bcc field in message header

Alt + C Jumps to Cc field in message header

Alt + D Sorts by date in table of contents window

Alt + Shift + D Sorts by reverse date in table of contents window

Alt +  E Opens Edit menu



Alt + F Opens File menu

Alt + H Opens Help menu

Alt + K Sorts by size in table of contents window

Alt + Shift + K Sorts by size reversed in table of contents window

Alt + L Sorts by Labels column in table of contents window

Alt + Shift + L Sorts by Labels column reversed in table of contents window

Alt + M Opens the Message menu

Alt + O Jumps to the To field in the message header; sorts by Who column in table of contents window

Alt + Shift + O Sorts by Who column reversed in table of contents window

Alt + R Opens Transfer Menu; Jump to From field in the message header

Alt + S Opens Special menu

Alt + T Opens Tools menu

Alt + U Jumps to Subject: field in the message header

Alt + V Sorts by server status in table of contents window

Alt + Shift + V Sorts by reversed server status in table of contents window

Alt + W Opens Window menu

Alt + X Opens Mailbox menu

Shift + F4 Tiles windows horizontally

Shift + F5 Cascades Windows

Shift + F10 Opens context menu (right-click) for selected item

Shift + Space Toggles current message status between read and unread

arrows Moves from one message to another in a mailbox (depends on your Miscellaneous 

Options ). 

enter Selects the outlined button in any dialog box, alert, or window, or opens the selected 

messages or URL.

esc Stops any operation currently in progress.

F1 Displays Help.

F2 Renames the selected item in a tool window (e.g., the Mailboxes window or the 

Address Book).

F3 Finds again.

[Alt] + F3 Enters the selected text in the Find window.

F5 Refreshes the view in the File Browser window.

F6 Toggles the cursor position between the left and right window panes in the Filters 

dialog box and the Address Book.

[Ctrl] + [Alt] + F6 Sends the topmost window to the back of all displayed windows.

F7 Show or hide one half of a split window (current window only): in composition 

windows, show/hide the message header; in mailbox windows, show/hide the 

message preview pane (if it is set to display).

[Home] Scrolls to the beginning of the mailbox window or to the beginning of the line in a 

message.

[End] Scrolls to the end of the mailbox window or to the end of the line a message.

page up, page down Scrolls up or down through the window.





Using the Eudora Taskbar

The Eudora taskbar appears along the bottom edge of the window work area in the main Eudora window, and 

normally shows the QUALCOMM logo at the right.

The Eudora taskbar displays a button for each normal Eudora window that is open or minimized. The taskbar 

provides a convenient way to switch between normal windows by clicking buttons, without having to display the 

different windows from the Window menu.

The Eudora taskbar is modeled after the Windows 95/98 and Windows NT 4.0 system taskbars, which usually 

appear at the bottom of the screen, but there are important differences, noted below.

To show or hide the Eudora taskbar, do the following: 

1. From the Tools menu, choose Options to open the Options dialog box. 

2. Scroll and select Display.    The Display options window appears.

3. Check or uncheck the Show MDI task bar box to turn the option on or off.

Any normal Eudora window that is open or minimized is represented by a button on the taskbar. This includes 

composition messages, received messages, mailbox windows, and any tool windows or tabbed windows that 

are in the normal state. Any open tool or tabbed windows that are in the docked or floating state are not 

represented as buttons on the taskbar.

If a tabbed window is represented by a button on the taskbar, the button shows the name and icon associated 

with the active tool window in that tabbed window.

Click a taskbar button to make that normal window active. The window comes to the front of the stack of all 

normal Eudora windows.

If you right-click a taskbar button, the standard Windows context menu displays, letting you restore, minimize, 

maximize, or close that normal window.

If you right-click an exposed area of the taskbar (not on a button), the standard Eudora context menu displays.

If you drag an object over a taskbar button and pause for several seconds, Eudora activates the normal window 

associated with that button. For a tabbed window, Eudora activates the tabbed window with the indicated 

window active. You can then complete the drag and drop operation into the normal window. For a tabbed 

window, you can further pause the pointer over one of the inactive window tabs, and that window becomes 

active and you can complete the drop.

Each taskbar button displays both the window icon and the window title of the normal window. If there is not 

enough room to display the entire title, Eudora truncates the title and places an ellipsis (...) to indicate the 

truncation. If you pause the mouse pointer over such a button, Eudora displays the entire window title in a 

tooltip.

If you have many normal windows open or minimized, the taskbar buttons shrink so that all buttons are visible. 

When the bar gets sufficiently crowded, the QUALCOMM logo is hidden to make room.

Note that, unlike with the Windows 95/98/ME/2000 and Windows NT 4.0 taskbars, you cannot move the Eudora 

taskbar to another edge of the main Eudora window; it always stays at the bottom of the window work area. You 



also cannot resize the taskbar as a separate item. It resizes automatically, however, when you resize the main 

Eudora window.



EUDORA.INI Settings File

The EUDORA.INI file is where Eudora keeps most of the settings. It is a standard Windows INI file, and may be 

edited with any text editor. 

Note: Since Windows caches information from INI files in memory while the program is running, you should 

never change the EUDORA.INI file while Eudora is in use. If you need to make a change, first quit 

Eudora, edit the file, and then restart Eudora.

The EUDORA.INI file is divided into a number of sections, the following of which appear by default:

· Settings

· Mappings

· Window Position

· Tool Bar

· Directory Services

· Debug

Optional Sections

The following sections will appear in the INI file only when the appropriate conditions are met or the appropriate 

items created:

· Personalities ¾ This section appears only when you have created alternate email accounts (personalities).

· Stationery ¾ This section appears only when you have created stationery files.

· Open Windows ¾ This section appears only when there are windows currently open in Eudora.

· Wazoo Bars ¾    This section appears only when normal Eudora windows are currently open or minimized 

on the desktop (and thus buttons appear on the Eudora taskbar, which is what this section controls).

· Recent File List ¾ This section appears only when files have been opened since the most recent Eudora 

startup.

                    Note. We strongly urge that you do not change the values in these optional sections of the INI file, 

and rather make any changes from the interface. For example, personalities can be created and 

edited from the Personalities window, and stationery can be created and edited from the Stationery 

window. Both windows are available from the Tools menu.

 The values of the settings in each of these optional sections reflect the current values of the objects or 

conditions; there are no "default" values per se.

Name and Location of the INI File

The default name is EUDORA.INI and the default location is in the mail directory.    But the name and location 

can be changed.

To specify a different INI file from the EUDORA.INI that is not in the mail directory, add a second parameter to 

the command line in the Program Item for Eudora, e.g.



Command Line: c:\apps\eudora.exe c:\mymail c:\inis\myeudora.ini

To use a different INI file that is in the mail directory:

Command Line: c:\apps\eudora.exe c:\mymail myeudora.ini

Command Line: c:\apps\eudora.exe c:\mymail\myeudora.ini

This is a way to have multiple settings for one set of mailboxes, nicknames, and so forth.    For example, you 

may have multiple email accounts in which you receive mail, but want to collect mail from all of the accounts in 

one place.    You could set up separate program Items for each account (each having a different INI file on the 

command line), and switching between accounts would be as simple as double-clicking a program Item.

And for an even more tricky specification, if the first parameter is an INI filename without a path, then the mail 

directory is searched through the normal process of checking the EUDORA environment variable and then 

using the executable directory.

Examples:

SET EUDORA=c:\mymail

Command Line: c:\apps\eudora.exe myeudora.ini

will use c:\mymail as the mail directory and c:\mymail\myeudora.ini as the INI file.

SET EUDORA=myeudora.ini

Command Line: c:\apps\eudora.exe

will use c:\apps as the mail directory and c:\apps\myeudora.ini as the INI file.

Default INI file

When an entry in the EUDORA.INI file is not found, Eudora will look in the DEUDORA.INI file located in the 

same directory as the EUDORA.EXE file. The [Mappings] section of the DEUDORA.INI file acts as though it 

was appended to the end of the [Mappings] section of the EUDORA.INI file.

Examples:

                    SET EUDORA=c:\mymail

                    Command Line: c:\apps\eudora.exe myeudora.ini

                    will use c:\mymail as the mail directory and c:\mymail\myeudora.ini as the INI file.

                    SET EUDORA=myeudora.ini

                    Command Line: c:\apps\eudora.exe

                    will use c:\apps as the mail directory and c:\apps\myeudora.ini as the INI file.

Settings

Entry Default Value Description

AllowAttachDrag 1 Controls whether attachments inside received messages.



AllowClipboardHTML 0 Controls whether Eudora should use the HTML format 
when copying from the clipboard (caution: some 
applications put very bad HTML on the clipboard).    You 
can always use Paste Special to get at the HTML 
clipboard format.

AllowDefPlugins 1 Controls whether or not EMSAPI plugins can be 
automatically added to the toolbar.

AllowOverwriteMode 1 Controls whether or not toggling the Insert key puts the 
message editor in to overwrite mode. Helpful for people 
who use the Ctrl+Insert and Shift+Insert accelerators for 
Copy and Paste and have a tendency to linger on the 
Insert key after letting go of the Ctrl/Shift key.

AlwaysConnected 0 Set to 1 if you have a constant Internet connection such 
as LAN or cable modem.

AltClickMoveSummary 1 When you hold down the <Alt> key while clicking an item 
in a mailbox, all messages in that mailbox with the same 
item are selected (e.g. <Alt> clicking a subject will select 
all messages in that mailbox with the same subject).    If 
this switch is on, then the selected messages will be 
grouped together as well.    You can temporarily turn this 
off by holding down the <Shift> key while doing the <Alt> 
click.

BackgroundColor Specifies an RGB triple (in hexadecimal) for the color to 
use for the "workspace" area of the main Eudora window. 
Can be used in conjunction with the BackgroundImage 
entry for choosing a color better suited for the image being 
displayed.    Examples: white is "FFFFFF", black is 
"000000", and blue is "0000FF".    This setting does *not* 
require QuickTime to be installed.

To install a new background color, you must open the 
Eudora.ini file and add a new header, for example:

[Decorations]

BackgroundColor=0000FF

BackgroundImage Specifies an image to be displayed in the "workspace" 
area of the main Eudora window (called "Application 
Background" in the Appearance tab of the Control Panel-
>Display options). It needs to be specified as a full path 
name. This setting requires QuickTime to be installed.

To install a new background color, you must open the 
Eudora.ini file and add a new header, for example:

[Decorations]

BackgroundImage=

BackupStatisticsDaily 0 If this is set to 1, a backup copy of the Statistics data is 
made each day in the Eudora data directory. The name of 
the file is Stats<month>-<day>.xml, where <month> and 
<day> are replaced by the current month and day. For 
example, on September 7 it would be called Stats9-7.xml.

BadPasswordString password When the POP server returns an error on sending the 
PASS command, the password will only be erased when 
the error response includes this text. 

BlackTocLines 0 If on, and displaying lines is mailboxes, draws lines as 
black instead of gray.

CenterUnreadStatus 1 When on (1), centers the bitmap in Mailbox menu items 



that indicate that the mailbox has unread messages. If the 
display of this bitmap is not correct, turn this switch off (0). 

CheckOwnerFreq 0 How often (in seconds) Eudora should check the 
OWNER.LOK file to see if another instance of Eudora has 
been started on the same set of mailboxes.

CompactDisk% 5 What the amount of "wasted space" taken up by deleted 
messages in a mailbox as a percentage of total free disk 
space must be before the mailbox automatically gets 
compacted when closed. 

CompactMailbox% 50 What the percentage of "wasted space" taken up by 
deleted messages in a mailbox must be before the 
mailbox automatically gets compacted when closed. 

CompactOutgoingPlugins 0 Controls whether the outgoing EMSAPI plugins on the 
composition message window toolbar should be separate 
buttons or contained within one button that pops up a list 
of all outgoing plugins.    By default, all ougoing plugins get 
their own toolbar button.

CompSummaryItalic 1 In mailboxes other than the Out mailbox, display the 
summaries of outgoing messages in italics. 

ConnectionStatusCacheTime 2000 Time (in milliseconds) that Eudora will cache the online 
status before checking with the system again, which can 
help with some setups where checking the online status 
can be very intensive.

ConvertFormatFlowedtoExcerpt 0,1 Turns format-flowed feature on and off.

DeleteAttachedVCFs 0 Deletes any attachment with a .VCF extension (vCard 
files), which can be handy if people who send you lots of 
messages have their email client set up to automatically 
attach their vCard.

DesDllName Des32.dll The name of the DLL implementing the DES encryption 
routines for use with Kerberos version 4, e.g., des32.dll

DisableStatistics 0 If this is set to 1, no Statistics data is saved.

DoPluginCompletion 1 Indicates whether to include nicknames generated by ESP 
(and potentially by other Eudora plugins) in the Auto-
Completion list. A value of 1 means to include them, and a 
value of 0 means don't include them.

EditAllHeaders 0 Controls whether or not the (by default, non-editable) 
From and Attached: headers in the composition message 
window.

EnrichedSoftLine 72 Number of characters sent on a line before adding a soft 
new line when sending styled text. 

EudoraPassPort 106 Default port number for the Eudora password-changing 
service (epass). 

ExceptionHandling 1 Controls whether or not Eudora's exception handling code 
is called when a program exception occurs (can be helpful 
to turn off if the exception handling code is hiding the 
source of the problem)

ExcerptBars 2 HTML style sheet parameter for excerpt bars.    Can use 



this to change the width, color, and style of excerpt bars.

(Only works when using the Microsoft viewer).

ExtraHeaders Extra headers that are sent with each outgoing message.
If multiple headers are to be sent, separate each with 
"\r\n".
For example,
"ExtraHeaders=X-Header1: foo\r\nX-Header2: bar". 

ExtraNicknameDirs List of directories to search for additional nickname files. 
Multiple directories can be entered, separated by 
semicolons (;). 

FilterTransferName 0 This controls how mailbox names should be displayed in 
the button that indicates which mailbox is the target of a 
transfer or copy filter action. 0 is the mailbox name only. 1 
is the full path of each mail folder and the mailbox name. 2 
is the full path to the filename of the mailbox. 3 is just he 
parent mail folder and the mailbox name.

FilterFromFolder When doing a Make Filter, the name of the mailbox folder 
to place the default named mailbox that is created when 
filtering based on whom the message is from.

FilterRecipFolder When doing a Make Filter, the name of the mailbox folder 
to place the default named mailbox that is created when 
filtering based on whom the message is to.

FilterSubjectFolder When doing a Make Filter, the name of the mailbox folder 
to place the default named mailbox that is created when 
filtering based on the subject of the message.

FindMatchCase 0 "Match Case" checkbox in the Find dialog box.

FindSummariesOnly 0 "Summaries Only" checkbox in the Find dialog box. 

FirstUnreadNormal 1 When checking mail on a POP server, download any mail 
that hasn’t been retrieved at this machine.

FirstUnreadStatus 0 When checking mail on a POP server, download only 
messages that haven’t been read on any machine.

FixCurlyQuotes 1 If on, then if a message contains 7-bit characters except 
for directional quotes, then those directional quotes are 
turned into regular non-directional quotes so that the 
message may be sent out as 7-bit (no quoted-printable 
encoding needed).

FlattenSpeaking 1 The Microsoft Text-To-Speech engine has troubles with 
non-ASCII characters, so this setting will make non-ASCII 
characters get converted to their ASCII equivalents before 
being handed off to the TTS engine.

FontSizeTableLarge 10,12,14,16,20,26, 42 Font sizes used for displaying text in the built-in (non-
Microsoft) viewer. They correspond to the size schemes in 
the Fonts category of the Options dialog. The seven 
values in each list correspond to the Very Small, Small, 
Medium, Large, Larger, Very Large, and Humongous 
sizes that you can specify in a message composition 
window.



FontSizeTableLargest 11,14,16,18,22,28, 48 Font sizes used for displaying text in the built-in (non-
Microsoft) viewer. They correspond to the size schemes in 
the Fonts category of the Options dialog. The seven 
values in each list correspond to the Very Small, Small, 
Medium, Large, Larger, Very Large, and Humongous 
sizes that you can specify in a message composition 
window.

FontSizeTableMedium 8,10,11,14,18,24,
36

Font sizes used for displaying text in the built-in (non-
Microsoft) viewer. They correspond to the size schemes in 
the Fonts category of the Options dialog. The seven 
values in each list correspond to the Very Small, Small, 
Medium, Large, Larger, Very Large, and Humongous 
sizes that you can specify in a message composition 
window.

FontSizeTableSmall 7,9,10,12,16,22,28 Font sizes used for displaying text in the built-in (non-
Microsoft) viewer. They correspond to the size schemes in 
the Fonts category of the Options dialog. The seven 
values in each list correspond to the Very Small, Small, 
Medium, Large, Larger, Very Large, and Humongous 
sizes that you can specify in a message composition 
window.

FontSizeTableSmallest 7,8,9,10,12,16,24 Font sizes used for displaying text in the built-in (non-
Microsoft) viewer. They correspond to the size schemes in 
the Fonts category of the Options dialog. The seven 
values in each list correspond to the Very Small, Small, 
Medium, Large, Larger, Very Large, and Humongous 
sizes that you can specify in a message composition 
window.

ForceSaveForStatistics 0 Forces the saving of the Statistics info, even if the disk 
drive is spun down.

GssDllName Gssapi32.dll For the user to specify the GSS/K5 DLL name.

GuessParagraphs 0 "Guess Paragraphs" checkbox in the Save As... dialog 
box. 

      HTMLInPlainText 0 HTML text would be displayed in messages in the

Out box.

      IMAPLeafMenu 0 Controls whether IMAP mailboxes with no child mailboxes 
should be shown in the Mailbox/Transfer menus as an 
entire menu or just a menu item.    Default is to just show it 
as a menu item.

IMAPPort 143 Default port number for IMAP connections.

IdleTime 60 The number of seconds that Eudora has to be idle before 
it will consider performing an automatic mail check. 

IgnoreEMSDelete 0 If this is 0, ESP control messages devoid of "human 
friendly" content are automatically deleted to avoid 
cluttering up your ESP mailboxes. If this is 1, those 
messages are preserved.

IgnoreIdleOnManualCheck 0 Controls whether background tasks started manually (e.g. 
Ctrl+M to do a Check Mail) should be processed 
immediately after completing, or wait until a sufficient 



amount of user idle time (see TaskMgrWaitTime below). 

IMAPPreviewPane 1 Controls whether or not IMAP mailboxes have a preview 
pane.    On slower networks, it may be desirable to turn off 
the preview pane for IMAP mailboxes, but still have the 
preview pane for local mailboxes.    You can do that by 
keeping the normal Preview Pane option turned on, but 
turning this setting off (setting to 0).

IMAPRemoveOnDelete 0 Controls whether or not a message in an IMAP mailbox 
that is deleted will be removed from the server mailbox 
immediately.    If this setting is off (the default), then you 
can remove messages from the server mailbox that have 
been marked to be deleted by using the Message->Purge 
Messages menu item.

IncludeHeaders 0 "Include Headers" checkbox in the Save As... dialog box. 

IncludeSigForward 1 Whether or not the default signature should be included 
when forwarding a message.

IncludeSigRedirect 0 Whether or not the default signature should be included 
when redirecting a message.

IncludeSigReply 1 Whether or not the default signature should be included 
when replying to a message.

InteractiveSpellCheck 1 When doing a spell check, controls whether you get 
prompted with a dialog box for each misspelled word, or 
each misspelled word gets marked with a double red 
underline (which then you can right-click to get 
suggestions and other options for the misspelled word).    
If you hold down the Shift key while doing a spell check, 
the other method of spell checking will be performed.

InterpretFormatFlowed 1, 0 Turns format-flowed off and on.

IgnoreIdleOnManualCheck 0 Controls whether background tasks started manually (e.g. 
Ctrl+M to do a Check Mail) should be processed 
immediately after completing, or wait until a sufficient 
amount of user idle time (see TaskMgrWaitTime below).

KerberosSetUserName 0 Uses KClient SetUserName() function to set user name in 
Kerberos system. Turning this switch on may cause 
Kerberos tickets to be invalidated. 

Krb4Dllname Kerberos32.dll The name of the Kerberos version 4 DLL, e.g., 
kerberos32.dll.

LastSettingsCategory 0 Last category that was displayed in the Options dialog 
box. 

LexPath Directory in which the dictionary files for spell checking 
reside. 

MainLexFiles Main dictionary files. British dictionaries can be used by 
changing this to british.tlx, british.clx. 

MainWindowState 1 The state of the Main Window (normal = 1, minimized = 2, 
or maximized = 3). The state is set when Eudora closes, 
and the Main Window is set to this state the next time 



Eudora starts up. 

MapiAutoSendSignature 1 Controls whether messages sent through Eudora's MAPI 
will tack on the default signature.

MapiExcerptFixedText 1 Controls whether messages sent through Eudora's MAPI 
will convert plain text quoting in to excerpts so that 
messages are easier to read on different width screens 
(e.g. PCs vs. PDAs).

MaxConcurrentDialupTasks 2 The maximum number of checking/sending tasks that can 
occur simultaneously while using a Eudora specified 
dialup connection.

MaxConcurrentTasks 10 The maximum number of background tasks that can be 
running at the same time.    Note that if you are connected 
over a modem (dialup networking connection) only one 
network task at a time will be run; otherwise network 
performance would suffer greatly.

MaxMenus 30000 The maximum number of popup menus for mailboxes. 
These are equivalent to mailbox folders; that is, local 
mailbox folders that contain other mailboxes, or IMAP 
mailboxes that contain other mailboxes. Used when 
Eudora can’t be started due to the large number of popup 
menus created, which is limited by Windows. This will 
allow you to start up Eudora and run it long enough to 
remove some mailboxes so that fewer menus will be 
needed. Running for extended periods of time with this 
switch in Eudora.ini is not recommended.

MDNSendAddress 0 Controls whether your return address should be used in 
the MAIL FROM command for return receipts.    RFC 2298 
says that it should be empty in order to prevent mail loops, 
but some SMTP servers reject that due to bad spam-
prevention heuristics.

MoodWatchCheckOriginal 0 Controls whether the original sender's (excerpted) text in 
the message should be used when calculating the 
MoodWatch score of a composition message.

MoodWatchCompBadWords 1 Controls whether or not phrases identified by the 
MoodWatch engine in composition messages should be 
highlighted by underlining.

MoodWatchDelayinMinutes 5 Time of the delay (in minutes) if MoodWatch is configured 
to delay the sending of messages.

MoodWatchDeltaTime 5 MoodWatchDeltaTime is how long Eudora must be idle, in 
seconds, before background MoodWatch scanning starts. 

MoodWatchInterval 1000 Number of milliseconds that Eudora will wait until 
checking the MoodWatch score after the user hits a key in 
a composition message.

MoodWatchThresholdTime 1000 MoodWatchThresholdTime is how long it keeps scanning, 
in milliseconds, once scanning starts.

NetscapeURLDDE 0 Controls whether the launching of URLs inside Eudora 
should first look to see if Netscape is currently running so 
that it can reuses an existing Netscape browser window 



for the URL.

NetworkOpenTimeout 60 The number of seconds Eudora will wait for a response to 
opening a connection before it gives up. 

NewMailUpdateFrequency 25 Number of initial messages that have to be spooled before 
the message processing begins.

NoAutoResponseHeaders errors-to:,list- Allows for better detecting of mailing list to which you 
should not auto-respond. As a default, "errors-to:,list-" is 
the value. Add any other headers that will identify it as a 
list (hence will not auto-respond via filters).

NoAutoSendPrecedence list,bulk When filtering incoming messages with precedence 
headers of list or bulk, do not automatically create new 
outgoing messages. 

NoSplashScreen 0 If on, the opening splash screen will not be displayed. 

Offline 0 Set to 1 to temporarily set Eudora offline; it will not 
perform automatic timed mail checks when offline.

OfflineLinkAction 0 Eudora displays the Offline Link Dialog if you click on an 
http: link while offline (not connected to the Internet). That 
dialog box lets you choose what action should be taken 
regarding that link the next time Eudora is online: ask you 
if you want to launch the link, launch it without asking, 
bookmark the link in your browser, or remind you later. 
The dialog box now has a checkbox that will make the 
action you choose the default from then on, which means 
you won't see the Offline Link Dialog any more. It defaults 
to 0 = ask, and the other values are 1 = launch, 2 = 
bookmark, and 3 = remind.

OldWABImport 0 Controls whether Eudora uses an older method of 
importing the Windows Address Book, which may do a 
better job of importing on some setups than the default 
method.

OpenRetryCount 5 Some external applications like to open up files that 
Eudora is using (e.g. virus checkers and backup 
software), so this setting controls how many times Eudora 
should try to open a file before it gives up.

OpenRetryInterval 250 Time (in milliseconds) Eudora waits before attempting to 
open a file again (see OpenRetryCount above).

OptionsHideCursor 1 Controls whether the cursor gets hidden to prevent flicker 
when switching between categories in the Tools->Options 
dialog, which causes a small minority of systems to lose 
the cursor while in the dialog.

OwnerLok 1 If this is non-zero, an OWNER.LOK file will be created on 
startup which helps to prevent possible corruption if 
multiple instances of Eudora are used on the same set of 
mailboxes.

PasswordChangeServer The name of the server to use for changing passwords. 



By default this is the same as your POP server.

PasswordOKWordList lock busy,own it,of 
memory,assign stream, ush 
of temp,being 
unlock,hangup,timeout, not 
owned,quota,drop name, 
recognition 
mode,accessible by 
others, ,regular 
file,flock,maillock,

few minute,locked

A comma-separated list of words that if found in the 
response text from an error from the POP PASS 
command that will not cause the password to be erased 
(works in conjunction with the BadPasswordString entry 
above).    POP servers sometimes fail after sending the 
PASS command for reasons other than your password 
was incorrect, and this entry allows greater control over 
when Eudora will decide to ask you again for your 
password.

PhReturn A string that is appended to every Ph command before 
sending to the Ph server. For example, "PhReturn=return 
all" would return all fields of the records returned by the 
query, and "PhReturn=type=person" would return all 
matches to the query with the additional filter that the 
record is a person. 

POPPort 110 Default port number for the POP service (pop3). 

PreviewHeaders To:,Subject:,Cc:,
Bcc:, X-Attachments:

A comma-separated list of headers that should be shown 
in the preview pane.    The matching is done on a prefix 
basis, so any header that begins with one of these values 
will be shown.

PreviewHeadersMaxLines 4 This is designed to keep preview pane headers to a 
minimum. This is most often used to control large To: or 
Cc: headers where someone inserts a large number of 
individual addresses.

PreviewSplitterPos 0 If non-zero, then if a mailbox hasn’t already specified a 
position for the splitter between the message list and the 
preview pane, then the splitter will be positioned this many 
pixels from the top of the mailbox window.

PreviewTableEnd </table>\r\n HTML markup for the end of the table that’s used to 
display the headers in a preview pane.

PreviewTableRowEnd </td></tr>\r\n HTML markup for the end of the table row that’s used to 
display the headers in a preview pane.    Each header 
appears in a separate row of the table.

PreviewTableRowStart <tr bgcolor=%s 
text=%s><td>\r\n

HTML markup for the start of the table row that’s used to 
display the headers in a preview pane.    Each header 
appears in a separate row of the table.

PreviewTableStart <table cellspacing=

0 cellpadding=0 
width=100%% bgcolor=%s 
text=%s>\r\n

HTML markup for the beginning of the table that’s used to 
display the headers in a preview pane.

PrintHeaders 1 When on (1), printed messages get headers and footers. 

ProgressIdle 3 Number of seconds a foreground task continues before 
the Progress window is shown.    This prevents a 
distracting flash of the Progress window for a task that 
may take a long time, but in this instance only takes a 
short time.

QuoteEnd The string that gets inserted after the original text of a 
forwarded message. A new line is added before the string. 



QuotePrefix > The string that precedes all lines of the original message 
in a forwarded message 

QuoteStart The string that gets inserted before the original text of a 
forwarded message. A new line is added after the string. 

RasUseExistingConnection 1 When switching from a task from one personality to a task 
of another personality and the two personalities have 
different dialup networking connection entries, whether or 
not the already connected dialup networking connection 
should be maintained or a new dialup networking 
connection made.    It may be necessary to turn this 
setting off (set to zero) if you have personalities that check 
mail on servers that are behind firewalls, and require that 
you dial in directly in order to connect to the mail server.

ReadMessageStyleSheet <STYLE 
TYPE=""text/css"">\r\

n{font-family = ""%s""}\r\nTT 
{font-family = ""%s""}
\r\nBLOCKQUOTE.CITE 
{border-

left = solid %s}
\r\nBLOCKQUOTE.CITE 
{padding-left = 0.5em}
\r\nBLOCKQUOTE.CITE {m

argin-left = 
0}\r\nBLOCKQUOTE.CITE 
{margin-top = 0.5em}\r\n

HTML style sheet used for displaying received messages.

ReadReceiptAsk 1 Ask user for read receipts. 

ReadReceiptNo 0 Always deny read receipts without prompting. 

ReadReceiptYes 0 Always return read receipts without prompting. 

ReplyAllAttribution At %1, %2
you wrote: 

Attribution line when a Reply to All is done. 

ReplyAttribution At %1, you wrote: Attribution line when a Reply is done. 

ReplyEnd The string that gets inserted after the original text of a 
replied message. A newline is added before the string. 

ReplyPrefix > The string that precedes all lines of the original message 
in a replied message 

ReplySelectOnlyIf \n.!? If doing a Reply with selection, if none of the characters in 
this list are in the selection then Eudora will reply using 
the entire body of the message.

ReplyStart The string that gets inserted before the original text of a 
replied message. A newline is added after the string. 

ReservedDosNames aux,com1,com2,
com3,com4,con,
lpt1,lpt2,lpt3,lpt4,
nul,prn

Reserved names of files that will not be used for filenames 
of attachments.    These filenames are reserved for DOS, 
and can causes problems in actual files when these 
names are created.

ReturnAddressFormat %1 < %2> Format of the From field in outgoing messages. %1 is the 



Real name, and %2 is the Return address. 

SaveDialupPasswordText Where your dialup password is saved (in an encrypted 
format) if you have the Save Password switch turned on. 

SavePasswordText Where your POP password is saved (in an encrypted 
format) if you have the Save Password switch turned on. 

SaveStatisticsInterval 15 The Statistics data is saved to disk at intervals of this 
many minutes.

SearchAllmapAccounts 0 Controls whether all of your mailboxes in all IMAP 
accounts will be looked at when searching, or just the 
mailboxes in the IMAP account that you start the search in 
(applies to local mailboxes as well, that is, a search 
starting in a local mailbox will only search your local 
mailboxes if this setting is off).

SeenIntro 1 You can make the introduction window return by changing 
the value to 0.

SendXAttachHeader 0 Controls whether or not the X-Attachment: header should 
be sent out with outgoing messages that contain 
attachments. 

SeparateMSHTMLSettings 0 Controls whether Eudora keeps its settings for the MS 
Viewer in a different part of the registry so that they don't 
conflict with IE (or any other app that uses MSHTML), 
which can be handy for having the default font size be 
different in Eudora than in IE.

ShowAttachmentIcons 1 Controls whether or not icons representing attachments 
should be shown in the body of the message.

ShowMeTheErrors 0 Controls whether or not to show the error dialog box 
immediately on send/receive errors. By default, errors are 
listed in the Task Errors window, and that window is 
brought to the foreground.

ShowProgress 1 Show/hide the Progress window. 

ShowProgressInactive 0 If Eudora is not the foreground application, this controls 
whether the Progress window should be shown or not.

ShowTipOfTheDay 0 Determines whether to display the Tip of the Day when 
Eudora is launched.

ShowSelectedSummaryCount 0 Adds an extra number to the beginning of the numbers 
listed in the compact button in the lower-left corner of the 
mailbox summary display that shows how many message 
summaries are currently selected in that mailbox.

SMTPAuthBanished CRAM-MD5 It should contain a comma-separated list of authentication 
schemes whose use is to be disallowed. The security 
conscious should set it to "LOGIN,PLAIN", as this ensures 
that your SMTP server password will always be strongly 
encrypted when it goes over the network. Users of 
IPSWITCH's Imail SMTP server should set it to "CRAM-
MD5" so as to avoid a bug of theirs. 



SMTPAuthAllowed 0 Allows you to add authentication to your SMTP server.

SMTPAuthRequired 0 Allows you to require authentication when gaining access 
to your SMTP server.

SMTPPort 25 Default port number for the SMTP service (smtp). 

SMTPRecipientWrap 72 Column at which recipient headers (To: and Cc:) are 
wrapped when sending a message. 

SpoolDirTemp 0 Controls whether Eudora should use the temp directory on 
your local hard drive for spooling messages when sending 
and receiving, which can increase performance when your 
data directory resides on a network drive.

SSLIMAPAlternatePort 993 Specifies IMAP alternate port only.

SSLPasswordAlternatePort 106 Specifies password alternate port only.

SSLPasswordUse 0 Use SSL for password changes or not. If used, the 
corresponding "receive" settings apply.

SSLPOPAlternatePort 995 Specifies POP alternate port only.

SSLReceiveAllowRegExp 1 Applies to POP and IMAP.

Specify whether you want to allow the usage of Regular 
Expressions in hostname matching in CN from the 
certificate subject or not. For example, if you are 
connecting to a server cgate.qualcomm.com that has a 
certificate with CN as *.qualcomm.com, then SSL will 
succeed if you have the value for this setting set as 1. A 
value of zero will require the server to have a certificate 
with CN=cgate.qualcomm.com causing SSL to fail 
because of hostname mismatch.

SSLReceiveAllowVersion2 1 Applies to POP and IMAP.
SSLReceiveIgnoreExpCert 0 Applies to POP and IMAP.
SSLReceiveMinEncryption 0 Applies to POP and IMAP.
SSLReceiveMinKeyExchangeLength 0 Applies to POP and IMAP.
SSLReceiveVersion 6 (default)

0=Undetermined

1=SSL_Version_3.0_With_2
_0_Hello

2=SSL_Version_3_0_Only

3=SSL_Version_1_0_Only

4=TLS_Version_1.0_With_2
_0_Hello

5=SSL_Version_2_0_

6=SSL_Version_3_0_

7=TLS_Version_1_0_

Applies to POP and IMAP.

SSLSendAllowRegExp 1 Applies to SMTP.

Specify whether you want to allow the usage of Regular 
Expressions in hostname matching in CN from the 
certificate subject or not. For example, if you are 
connecting to a server cgate.qualcomm.com that has a 
certificate with CN as *.qualcomm.com, then SSL will 
succeed if you have the value for this setting set as 1. A 
value of zero will require the server to have a certificate 
with CN=cgate.qualcomm.com causing SSL to fail 
because of hostname mismatch.

SSLSendAllowVersion2 1 Applies to SMTP.



SSLSendIgnoreExpCert 0 Applies to SMTP.
SSLSendMinEncryption 0 Applies to SMTP.
SSLSendMinKeyExchangeLength 0 Applies to SMTP.
SSLSendVersion 6 Applies to SMTP.
SSLSMTPAlternatePort 465 Applies to SMTP.
StatBarBlink 0 Controls whether or not the icon shown in the status bar 

for tasks that are waiting or have errors should blink.

StatBarRunningAnimationRate 125 Controls the speed of the animated icon in the status bar 
for tasks that are currently running (units in milliseconds 
between images).

StatBarWaitingAnimationRate 500 Controls the speed of the animated icon in the status bar 
for tasks that are currently waiting (units in milliseconds 
between images).

StatBarErrorAnimationRate 250 Controls the speed of the animated icon in the status bar 
for tasks that currently have errors (units in milliseconds 
between images).

StatBarGraphWidth 100 The width (in pixels) of the background task progress bar 
that shows up in the status bar.    Set to zero to prevent 
the progress bar from being displayed.

StationerySignatureRules 1 Signature precedence is as follows: User's selection; 
Stationery's signature; Personality's signature. Set this to 
0 to put Personality's signature before Stationery's. 

StripDuplicateAddresses 1 When replying to a message, controls whether or not 
duplicate copies of your email address will be removed 
from the To: and Cc: headers.    This helps to avoid buildup 
of your email address in email conversations. 

SwitchFindKeyAccl 0 If on, Ctrl+F will open the Find Text window, and the 
Ctrl+Shift+F will open the Find Message window. By 
default, it’s the opposite.

SwitchPreviewWithTab 1 When on, pressing the <Tab> key in a mailbox will switch 
focus between the message list and the previewed 
message.

TabooHeaders X-
UID,Received,Status,X-
UIDL,Message,In-
Reply,X-
Priority,Mime-
Version,Content-
,X-Persona,Resent-
Message,Referen
es,Return,X400,X-
400,Mail-
System,Errors-To,X-
List,Delivery,Disposi
tion,X-
Juno,Precedence,
X-Attachments,X-
MSMail,X-MimeOLE

A comma-separated list of headers (without colons) that 
should not be shown when the "Show all headers" switch 
(the "Blah Blah Blah" icon) is off for a message. The 
matching is done on a prefix basis, so any header that 
begins with one of these values will not be shown. 

TabSpaces 0 If on, then when the Tab key is pressed while the cursor is 
in the body of the message, spaces are inserted instead 
of a tab character. 

TabStop 8 How many spaces to insert for a <Tab> in the body of a 



composition message. 

TaskErrorKeepAll 0 When set, Eudora will not automatically remove errors 
from the task error list.

TaskErrorLinesPerRow 3 Number of lines for each error in the Task Errors window.

TaskErrorRemoveFromList 1 Controls whether or not to remove errors from the Task 
Errors window after seeing the corresponding error dialog 
box. 

TaskMgrWaitTime 20 The number of seconds in which the user has to be idle in 
Eudora (which is defined as pressing any key or mouse 
button) before background tasks are processed (see 
IgnoreIdleOnManualCheck above for an exception case).

TaskStatusGraphCompletedColor 18,106,254 RGB color of the completed portion of the progress bar in 
the Task Status window.

TaskStatusGraphRemainColor 129,207,254 RGB color of the remaining portion of the progress bar in 
the Task Status window.

TaskStatusGraphBorderColor 0,0,0 RGB color of the border of the progress bar in the Task 
Status window.

TaskStatusRecvGraphCompletedCol
or

18,106,254 RGB color of the completed portion of the progress bar in 
the Task Status window for receiving mail.

TaskStatusRecvGraphRemainColor 129,207,254 RGB color of the remaining portion of the progress bar in 
the Task Status window for receiving mail.

TimeZone TimeZone=xxxnnnyyy Where xxx, yyy are timezone abbreviations like PST, PDT, 
CDT, and nnn is the offset in hours WEST of GMT (those 
that are east of GMT should enter a negative number 
here). xxx is the timezone during Standard Time and yyy 
is the timezone during Daylight Savings Time. If you do 
not change your clocks during Daylight Savings Time, 
leave yyy blank. Here are some samples: 
TimeZone=PST8PDT TimeZone=MET-1

If you don’t specify a TimeZone entry, then a Date: header 
will not be put in outgoing messages, which is fine for 
most because their mail server will insert the correct Date: 
header. If you don’t get messages bounced because of a 
missing Date: header, then leave the TimeZone entry 
alone.

TocDateLeeway 10 Number of seconds that the date on a mailbox .TOC file 
can be behind the .MBX file that Eudora will not flag as 
being out of date. Helpful for network file systems, 
especially Windows NT Server which seems to have 
problems correctly time/date stamping files. 

ToolbarDisplayFix 0 Setting this to 1 causes the icons to be imaged from a 
device-independent bitmap to resolve issues with video 
drivers that cannot display Eudora’s toolbar icons. Setting 
this to 2 limits the toolbar to the icons that are in the 
default toolbar. 

TreeControlAutoExpandDelay 1000 Delay (in milliseconds) in which Eudora will wait before auto-
expanding an item in a tree control.

TreeControlAutoScrollDelay 100 Delay (in milliseconds) in which Eudora will wait before 
auto-scrolling a tree control.



TypeToSelectSubject 0 When on, typing characters in the summaries of a mailbox 
window will attempt to match words in the Subject field. 
(Default behavior is to match the Who field.)

UnreadExpires 5 The number of days after which a message is no longer 
used to determine if a mailbox has unread messages in it. 

URLHelper The full path of the application used to launch URLs. 

URLHighlight 1 Display URLs in blue underline style. 

UsePOPCAPA 1 Whether or not Eudora should send the CAPA command 
to the POP server. Used only to see if the server supports 
the MANGLE command modifier. See UsePOPMangle.

UsePOPMangle 0 Whether or not Eudora should use the MANGLE modifer 
to the TOP command in a POP connection. MANGLE can 
produce some better results for messages that are large, 
giving a summary for the attachments in the message. 

UsePOPSend 0 If UsePOPSend is on, Eudora will send mail using the 
POP3 extended command XTND XMIT. Since this is an 
optional command for POP3, many POP3 servers do not 
support this command (Berkeley's popper, however, 
does). There are pros and cons to using POP3 to send 
your mail. It provides a level of security since it requires a 
username/password pair to send mail messages, unlike 
SMTP. It is faster than SMTP, especially when checking 
for new mail at the same time. It doesn't check for valid 
recipients until the entire message is sent, and some 
implementations (Berkeley's popper, for example) won't 
tell you which recipients are invalid and will send the 
message to the valid recipients anyway. 

UseQuickTime 1 If off, Eudora will never attempt to use QuickTime to 
display images. Useful for situations where QuickTime is 
causing instability in the system.

UserChangeLex uchange.tlx Filename of user-defined list of words to change when 
spell checking. 

UserIgnoreLex uignore.tlx Filename of user-defined list of words to ignore when spell 
checking. 

UserSuggestLex usuggest.tlx Filename of user-defined list of words to suggest when 
spell checking. 

WarnLaunchExtension User-supplied list of extra file extensions that Eudora 
should warn when trying to launch an attachment (Eudora 
has a string resource that contains the default list of 
extensions that should be used to warn).

WarnLaunchRemove User-supplied list of file extensions that should be 
removed from the default list of extensions to warn when 
trying to launch an attachment.

WarnMapiAutoSend 1 If 1 (on), Eudora provides a warning dialog when a simple 
MAPI client tries to send messages through Eudora 
without showing any UI to the user. This was also added 
to the Tools/Options/MAPI dialog.



WebLinkReminderLaterNum Minutes 360 minutes When you get a link reminder, if you select Remind Me 
Later, the minimum wait until the next reminder.

WholeSummaryLabelColor 1 When on, the entire summary of a message that has a 
label is drawn in that label’s color. When off, only the text 
in the Label column appears in the label’s color. 

WordWrapColumn 76 When the "Word wrap" switch is on, this is the column in 
which lines in outgoing messages are wrapped. 

WordWrapMax 80 When the "Word wrap" switch is on, this is the length at 
which a line in an outgoing message is considered too 
long and must be wrapped. 

WordWrapOnScreen 0 If this is on (set to non-zero), then the composition window 
will automatically wrap text on the screen at the number of 
characters specified in WordWrapColumn, regardless of 
the width of the window.

WrapMenus 1 Controls whether menus with a lot of menu items (e.g. the 
Mailbox/Transfer menus when there are a lot of mailboxes 
at one level) should be wrapped to be in multiple columns. 
Users with later OSes (e.g. 98 and 2000) may want to turn 
off this setting to take advantage of the scrolling menus 
that those OSes provide.

Mappings

This is a sample Mappings section. It is not a default for Eudora if you have a missing or empty Mappings 

section. The Mappings section contains information for mapping between PC file extensions, Macintosh creator 

and type, and MIME type and subtype for attachment files (in that order). Entries marked "in" work on only 

incoming messages, and entries marked "out" work on only outgoing messages. Entries marked "both" work on 

both incoming and outgoing messages.

For a more detailed explanation, see the "MIME and Mappings" section of the online user manual.

out=txt,ttxt,TEXT,text,plain

both=doc,MSWD,,application,msword

in=xls,XCEL,,,

out=xls,XCEL,XLS4,,

both=xlc,XCEL,XLC3,,

both=xlm,XCEL,XLM3,,

both=ppt,PPT3,SLD3,,

both=wp,WPC2,.WP5,application,wordperfect5.1

both=zip,,,application,zip

both=rtf,,,application,rtf

both=ps,,,application,postcript

in=eps,,EPSF,,

out=eps,dPro,EPSF,application,postscript

both=mpg,,,video,mpeg

both=jpg,,,image,jpeg

both=gif,,,image,gif



both=tif,,,image,tiff

both=pct,,PICT,,

both=mac,MPNT,PNTG,,

Window Position

The Window Position section saves the positions of the standard windows (not your mailbox windows and 

message windows).

Entry Default Value 

CheckSpellingWindowPosition 0,0,0,0

DebugTraceWindowPosition 110,185,635,500

FilterReportWindowPosition 10,10,500,300

FiltersWindowPosition 60,345,580,480

FindWindowPosition 60,345,580,480

InputDialogWindowPosition 50,100,358,450

MailboxesWindowPosition 80,80,565,415

MainWindowPosition 0,0,640,480

NicknamesWindowPosition 50,5,590,475

PhWindowPosition 10,40,630,440

ProgressWindowPosition 0,0,0,0

SignatureWindowPosition 10,60,630,240

TextFileWindowPosition 0,0,600,460

Tool Bar

This section reflects the current settings of the main Eudora toolbar. If you create additional Eudora toolbars, 

then additional Tool Bar sections will appear in the INI file.

Note: We strongly recommend that you do not change any of the settings in the [Tool Bar] section(s) 

of the INI file, and that you instead make any changes to any Eudora toolbar from the toolbar 

customization dialog box (Customize dialog box). This dialog box is accessed by right-clicking 

anywhere on the toolbar and selecting Customize... from the drop-down menu. For more information, 



see "Customizing the Main Toolbar" in the online user manual.

Directory Services

The Directory Services section controls the use of the Directory Services window (accessed from Eudora's 

Tools menu) and its associated databases. For more information on Directory Services, see its dedicated 

section in the online user manual.

Note: Of the entries listed below, only those marked with an asterisk (*) are user-settable.

Entry Default Value Description

OldKeepOnTopConverted What in pre-4.0 versions of Eudora used to be [Settings] 
AddressKeepForeground is now KeepOnTop in this section. 
KeepOnTop saves the check state of the "Keep On Top" check button 
in the Directory Services window. Eudora uses this entry 
(OldKeepOnTopConverted) to determine if the 
AddressKeepForeground entry from a pre-4.0 version of Eudora has 
been mapped to the current version. When Eudora 4.x is run for the 
first time, it sets the KeepOnTop entry (described below) equal to the 
value of AddressKeepForeground. In addition, it also sets this entry 
equal to 1 so that the next time Eudora is run, it reads the check state 
from KeepOnTop rather than from AddressKeepForeground. 

PanesY* This entry reflects the height of the Directory Services window when 
Eudora was last shut down. 

LeftPaneX* This entry reflects the width of the left pane of the Directory Services 
window when Eudora was last shut down. 

RightPaneX* This entry reflects the width of the right pane of the Directory Services 
window when Eudora was last shut down. 

KeepOnTop* This entry reflects the check state of the "Keep On Top" check button in 
the Directory Services window when Eudora was last shut down. 

LDAP:ldap.bigfoot.com* This entry reflects the check state of the LDAP database 
"ldap.bigfoot.com" when Eudora was last shut down. The check state of 
other LDAP databases is reflected in similar entries. 

Ph:ph.bigfoot.com* This entry reflects the check state of the Ph database "ph.bigfoot.com" 
when Eudora was last shut down. The check state of other Ph 
databases is reflected in similar entries. 

Eudora Address 
Book:Eudora Nicknames* 

This entry reflects the check state of the Eudora Address Book 
database "Eudora Nicknames" when Eudora was last shut down. The 
check state of other Eudora Address Book databases is reflected in 
similar entries. 

Finger:hostname.domain.co
m*

This entry reflects the check state of the Finger database 
"hostname.domain.com" when Eudora was last shut down. The check 
state of other Finger databases (or daemons) is reflected in similar 
entries. 

DIRSERV-Major This entry reflects the major version of DirServ.dll that was last 
registered. Combined with the minor version of this DLL (see the next 
entry below), Eudora at run time determines whether the DLL is a 
newer version than the one last registered so that it can register the 



new COM objects, if any, in the newer DLL. 

DIRSERV-Minor This entry reflects the minor version of DirServ.dll that was last 
registered. See the description above for DIRSERV-Major. 

ISOCK-Major This entry reflects the major version of ISock.dll that was last 
registered. A similar description as the one in DIRSERV-Major above 
applies. 

ISOCK-Minor This entry reflects the minor version of ISock.dll that was last 
registered. A similar description as the one in DIRSERV-Major above 
applies. 

EUDORABK-Major This entry reflects the major version of EudoraBk.dll that was last 
registered. A similar description as the one in DIRSERV-Major above 
applies. 

EUDORABK-Minor This entry reflects the minor version of EudoraBk.dll that was last 
registered. A similar description as the one in DIRSERV-Major above 
applies. 

LDAP-Major This entry reflects the major version of Ldap.dll that was last registered. 
A similar description as the one in DIRSERV-Major above applies. 

LDAP-Minor This entry reflects the minor version of Ldap.dll that was last registered. 
A similar description as the one in DIRSERV-Major above applies. 

PH-Major This entry reflects the major version of Ph.dll that was last registered. A 
similar description as the one in DIRSERV-Major above applies. 

PH-Minor This entry reflects the minor version of Ph.dll that was last registered. A 
similar description as the one in DIRSERV-Major above applies. 

Debug

The Debug section controls aspects of the Eudora log file. The Eudora log file is a handy tool for debugging network 

connections, especially when using the dialup connection method.

Entry Default Value Description

LogFileName EUDORA.LOG The name of the log file. 

LogFileSize 100 The size (in KB) of the log file that, when reached, will cause the 
log file to be copied to the file EUDORLOG.OLD and a new log 
file to be started. 

LogLevel 11 (which is bits 1, 
2, and 4)

A bit-mapped value telling what type of information to log:
Bit 1 (1): Sending of a message
Bit 2 (2): Receipt of a message
Bit 3 (4): Dialup script navigation commands
Bit 4 (8): Alert messages
Bit 5 (16): Progress messages
Bit 6 (32): All bytes sent
Bit 7 (64): All bytes received 

Bit 8 (128): Corrupt mailbox TOC file messages

Bit 9 (256): Basic EMSAPI translator messages

Bit 10 (512): Advanced EMSAPI translator messages



To get the latest EUDORA.INI file settings, click www.eudora.com/techsupport/ini.html:

The EUDORA.INI settings are continuously being updated. 



Putting Multiple Users on One PC

To have multiple users on one computer, create shortcuts to the Eudora executable for each user. The mail 

directories can be named whatever you like, and put anywhere you like, including on floppies or network drives. 

To tell Eudora which directory to use, specify that directory in the Target field of your shortcut. A new Eudora.ini 

file will be created once the user launches Eudora.

To have multiple users on one computer, do the following:

1. For each user, create a shortcut to the Eudora executable file (Eudora.exe). 

2. Right-click on the new shortcut and select Properties.

3. Click the Shortcut tab. 

4. In the Target field, add the path to the user’s Eudora.ini file. 

5. To start Eudora, users simply double-click on their shortcut. A new Eudora.ini file will be created for each 

user located in the directory specified in the Target: field.



Customizing the Toolbar

(Sponsored and Paid modes only)

The Toolbar is a group of buttons that gives you easy access to your frequently used Eudora commands. You 

can create buttons for most Eudora commands. 

· To position the toolbar on the monitor, hold down the left mouse button on the bar itself (not on a button) and 

drag it around until you find a place you like. You can dock it to the top or bottom of the Eudora window or 

put it anywhere on your desktop. 

· To add buttons to the toolbar, click the right mouse button somewhere on the toolbar, and choose 

Customize. The Customize Toolbar dialog box appears. Select a Eudora menu from the list on the left, 

then drag buttons from the list on the right down to the toolbar. 

· To change the placement of a button on the toolbar, hold down the Alt key and drag the button to where you 

want it.

· To remove a button from the toolbar, drag the button off of the toolbar.



Toolbar Categories

Toolbar button categories (these are the same as the Eudora menu commands).



Toolbar Buttons

The toolbar buttons available in the selected category. These are generally the commands that are available 

from that menu item.



Description

A description of the last-selected toolbar button.



Fonts and Color

Displays the Font dialog box so that you can change the font, size, style, and color.



Checking Mail Options Window

The Checking Mail Options determine how Eudora checks for and receives incoming mail messages sent to 

your principal email account, that is your dominant personality.

To display the Checking Mail options window, do the following:

1. From the Tools menu, select Options.

2. Click Checking Mail. The Checking Mail options window appears.

Listed below are field descriptions for Checking Mail:

Mail Server ¾ This is the name of your incoming-mail server as entered in the Mail Server (Incoming) field of 
the Getting Started options. See the Getting Started Options Window for more details.

Login Name ¾ This is the login name you entered in the Login Name field of the Getting Started options. See 
the Getting Started Options Window section for more details.

Check for mail every _ minute(s) ¾ If you enter a number greater than zero in this field, then at regular 
intervals, Eudora automatically checks your incoming mail server for new mail and transfers to your computer 
any mail addressed to your primary account. The number you enter here specifies the number of minutes 
between automatic mail checks. It’s a good idea to set this at no less than 15 minutes. Checking mail more 
frequently puts an unnecessary drain on your incoming mail server. This option only works when Eudora is 
running. Entering 0 in this field turns off automatic mail checking.

Don’t check without a network connection—If this is selected, Eudora will not attempt to retrieve mail unless 
you are connected to a network. 

Don’t check when using battery ¾ If this is on and your computer is running on battery power, mail is not 
automatically checked even if automatic mail-checking is on (that is, the "Check for mail every _ minute(s)" field 
has a number greater than zero in it).

Send on check ¾ If this is on, any messages that are queued in the Out mailbox are sent when a mail-check is 
performed, whether the mail check is automatic or manual. If this is off, messages queued in the Out box are 
not sent during a mail check.

Save password ¾ If this is on, your password is remembered even if you quit and restart Eudora, so you’ll 
never be prompted to enter it. If this is off, you must enter your password each time you quit and restart Eudora. 
Only turn this option on if your computer is in a secure place.

Secure Sockets when Receiving¾You can choose how you wish to use SSL when receiving messages by 
choosing one of the options in the SSL drop-down menu. The following are the SSL options when receiving 
mail.

Never— Do not use SSL for server authentication and mail transfer security, even if SSL is available on 
the server. 

If Available STARTTLS (default)— Use SSL for server authentication and mail transfer security by 
having Eudora automatically invoke the STARTTLS command method to start SSL, that is, if the server 
supports STARTTLS. If your server doesn’t support STARTTLS, mail transfers will occur successfully, but 
they will not be secured with SSL.

Required, Alternate Port— Use SSL for server authentication and mail transfer security by having 
Eudora automatically use the older style alternate port method for starting SSL. If your server does not 
support SSL on the appropriate ports, mail transfers will fail. 

Required STARTTLS— Use SSL for server authentication and mail transfer security by having Eudora 
automatically invoke the STARTTLS command method to start SSL. If your server does not support 



STARTTLS, mail transfers will fail. 

Important. If you use SSL and cannot make a connection when receiving or sending mail, you may need to 

check with your ISP to update any invalid SSL certificates. However, to override any issues with SSL 

when retrieving or sending mail, choose Never from the drop-down menu to make a successful 

connection.

Last SSL info¾To display the most current information for an SSL connection between a server and Eudora 
since the last time you started Eudora, click Last SSL info. The Eudora SSL Connection Information Manager 
window appears with SLL and certificate information. 

Caution: If you display the SSL information windows, make certain you don’t change any of the field 

information unless you are familiar with SSL.



Getting Started Options Window

On the Getting Started options window, you can determine the minimum information necessary to send and 

receive mail. The information here is for your "dominant" personality, which is your principal email account.

 For your convenience, some fields appear in more than one category. For example, your return address 

appears in both the Getting Started options window and the Incoming Mail options window. Changing an option 

in one category changes the option in all categories in which it appears.

To display the Getting Started options window, do the following:

1. From the Tools menu, select Options.

2. Click Getting Started. The Getting Started options window appears.

Listed below are field descriptions for Getting Started:

Real name—This is the real name assigned to your principal account generally your first and last name. The 
text you enter here is included in the From field of all your outgoing messages from this account, and identifies 
to your recipients who the mail is from.

Return address—This is the return email address used in outgoing messages and recipients’ replies, if this 
address is different from your incoming mail account. The address you enter here is included in the From field 
of all your outgoing messages from this account, and when a recipient replies to a message from this account, 
the reply is sent to this address. If you do not enter an address in this field, Eudora uses your incoming mail 
account as the return address. Incoming mail accounts are usually of the form loginname@incomingmailserver. 
For example, suppose your incoming mail account is beatrixp@wabbits.myfirm.com but your return address is 
beatrixp@myfirm.com slightly different. You would then enter beatrixp@myfirm.com in this field.

If you do enter an address in this field, first test the address to be sure that mail sent to it is indeed delivered to 
you. If you use an invalid return address, no one will be able to reply to your mail.

Mail Server (Incoming)—This is the name of the incoming-mail server for your principal email account. All 
incoming messages to your primary account are routed through this server. Use the Incoming Mail options 
window to specify whether this server uses POP (Post Office Protocol) or IMAP (Internet Message Access 
Protocol). A sample server name might be popserver.myfirm.com.

Login Name—This is the name you use to log in to your primary email account, for accounts that require a 
user login. For example, in the incoming mail account beatrixp@wabbits.myfirm.com, the login name is 
beatrixp.

SMTP server (outgoing) ¾ This is the name of the outgoing mail server for your principal email account. All 
outgoing messages sent from your primary account are routed through this server. If the computer that your 
primary incoming mail account is on also runs an SMTP server, you can leave this field blank. SMTP stands for 
Simple Mail Transfer Protocol.

Allow authentication— Eudora can log in to an SMTP server when sending mail, just like it does for receiving 
mail. Not all SMTP servers require or allow such authentication. Eudora will attempt authentication to servers 
that allow it. The preferred SMTP authentication method is CRAM-MD5. If CRAM-MD5 is not available, LOGIN 
or PLAIN will automatically be used. 



Incoming Mail Options Window

The Incoming Mail options determine how Eudora receives incoming messages addressed to your primary 

email account. The options configure the incoming mail server, whose name is entered in the Mail Server 

(Incoming) field in the Getting Started Options Window.

To display the Incoming Mail options window, do the following:

1. From the Tools menu, select Options.

2. Click Incoming Mail. The Incoming Mail options window appears.

Listed below are field descriptions for Incoming Mail:

Server configuration ¾ Specify which email protocol the incoming mail server uses: POP (Post Office 
Protocol) or IMAP (Internet Message Access Protocol). Ask your email administrator which one to use, if you 
are not sure.

The options in the rest of this window depend on whether you’ve chosen POP or IMAP in this field. Options for 
both configurations are described below:

When Server configuration = POP:

Leave mail on server ¾ If this is on, Eudora copies incoming messages to your computer and leaves the 
message on the POP server. If this is off, Eudora transfers incoming messages to your computer and deletes 
the message from the POP server. For details, see Leaving Mail on the Server and Managing your Mail on a 
POP Server.

Delete from server after _ day(s) ¾ This option has a check box for turning it on and off and an edit box for 
specifying the number of days mail that was left on the POP server should be saved before being deleted. It is 
a good idea not to leave copies of your messages on the POP server indefinitely, as this will create mail storage 
problems on the server.

Delete from server when emptied from Trash ¾ If this is on, any messages that are deleted from your Trash 
mailbox are also deleted from the POP server. For details, see Managing your Mail on a POP Server. 

Skip messages over _ K in size ¾ If this is on, messages over the specified size are downloaded only in part. 
These messages include the first few lines, and a statement that says the message is not complete. This can 
be useful on slow connections. If you enter zero, all messages are downloaded.

Offline ¾ If this is on, Eudora won’t attempt to make any connections. This is good to have on if you’re using 
Eudora on a laptop computer that is not continuously connected.

Authentication style ¾ This specifies which POP account authentication technology to use for this account: 
Passwords, Kerberos, APOP, or RPA. Ask your email administrator which one to use, if you are not sure. Use 
RPA for CompuServe.

When Server configuration = IMAP:

IMAP Mailbox Location Prefix ¾ This specifies the mailbox location prefix that IMAP will use when locating 
your mailboxes on the incoming mail server. An example prefix is /usr/mail. Ask your email administrator what to 
enter here, if you are not sure.

For new mail, download ¾ These options (you must choose one) let you control the way incoming mail is 
downloaded from the IMAP server.



Minimal headers only ¾ If this option is on, only a limited set of message headers, and nothing else, is 
downloaded for each incoming message. (That means the remaining message headers, the message body, 
and any attachments are not downloaded for the message.)

Full message except attachments over _ K ¾ If this option is on, the full message (full set of message 
headers and the message body) and any attachments smaller than the specified size are downloaded for each 
incoming message. Also, any attachments larger than the specified size are not downloaded with the message. 
To download all of your IMAP attachments, enter a large number in this field.

When I delete a message—These options (you must choose one) let you control the way you want your 
deleted messages handled.

Mark it as deleted—Select this option to mark your messages on the IMAP for deletion. These messages are 
not removed from the server until you choose to remove them. See Deleting a Message from the IMAP Server.

Move it to (mailbox)—Select this option to move your deleted messages to a specific mailbox. The default is 
your Trash mailbox. 

When I delete a message—These options (you must choose one) let you control the way you want your 
deleted messages handled.

Authentication style—This specifies which IMAP account authentication technology to use for this account: 
Passwords, Kerberos, or CRAM-MD5. Ask your email administrator which one to use if you are not sure.



Sending Mail Options Window

The Sending Mail options determine how Eudora sends your outgoing messages from your primary email 

account (dominant personality).

To display the Sending Mail options window, do the following:

1. From the Tools menu, select Options.

2. Click Sending Mail. The Sending Mail options window appears.

Listed below are field descriptions for Sending Mail:

Return address ¾ This is your return email address, if different from your incoming mail account. See Getting 
Started Options Window for more details.

Domain to add to unqualified addresses ¾ This is the domain name that Eudora automatically adds to an 
unqualified address in messages sent from your primary account. An unqualified address is an address that 
doesn’t have an "@" sign followed by a domain name. This can be used to save time when addressing large 
numbers of messages to users in the same domain.

SMTP server ¾ This is the name of the outgoing mail server for your principal email account. All outgoing 
messages sent from your primary account are routed through this server. If the computer that your primary 
incoming mail account is on also runs an SMTP server, you can leave this field blank. SMTP stands for Simple 
Mail Transfer Protocol.

Allow authentication— Eudora can log in to an SMTP server when sending mail, just like it does for receiving 
mail. Not all SMTP servers require or allow such authentication. Eudora will attempt authentication to servers 
that allow it. The preferred SMTP authentication method is CRAM-MD5. If CRAM-MD5 is not available, LOGIN 
or PLAIN will automatically be used. 

Immediate send ¾ If this is on, the rightmost button in the toolbar of the message composition window is 
labeled Send. Clicking this button immediately sends the message to the SMTP server. If this option is off, the 
button is labeled Queue and clicking it places the message in the Out mailbox marked ready for delivery (Q).

Send on check ¾ If this is on, any messages from your primary account that are queued in the Out mailbox 
are sent when mail is checked for this account, whether the mail-check is automatic or manual.

Secure Sockets when Sending¾You can choose how you wish to use SSL when sending messages by 
choosing one of the options in the SSL drop-down menu. The following are the SSL options when sending mail.

Never— Do not use SSL for server authentication and mail transfer security, even if SSL is available on 
the server. 

If Available STARTTLS (default)— Use SSL for server authentication and mail transfer security by 
having Eudora automatically invoke the STARTTLS command method to start SSL, that is, if the server 
supports STARTTLS. If your server doesn’t support STARTTLS, mail transfers will occur successfully, but 
they will not be secured with SSL.

Required, Alternate Port— Use SSL for server authentication and mail transfer security by having 
Eudora automatically use the older style alternate port method for starting SSL. If your server does not 
support SSL on the appropriate ports, mail transfers will fail. 

Required STARTTLS— Use SSL for server authentication and mail transfer security by having Eudora 
automatically invoke the STARTTLS command method to start SSL. If your server does not support 
STARTTLS, mail transfers will fail. 

Important. If you use SSL and cannot make a connection when receiving or sending mail, you may need to 



check with your ISP to update any invalid SSL certificates. However, to override any issues with SSL 

when retrieving or sending mail, choose Never from the drop-down menu to make a successful 

connection.

Last SSL info¾To display the most current information for an SSL connection between a server and Eudora 
since the last time you started Eudora, click Last SSL info. The Eudora SSL Connection Information Manager 
window appears with SLL and certificate information. 

Caution: If you display the SSL information windows, make certain you don’t change any of the field 

information unless you are familiar with SSL.



Composing Mail Options Window

The Composing Mail options determine what Eudora features are available to you when composing messages.

To display the Composing Mail options window, do the following:

1. From the Tools menu, choose Options.

2. Scroll and click the Composing Mail icon. The Composing Mail options window appears. 

Listed below are field descriptions for Composing Mail:

Default Stationery (Sponsored and Paid modes only)—This is the default stationery to be used in all outgoing 

messages from your dominant account. Select a stationery file from the drop-down list, or select <No Default> 

for no default stationery. If a stationery file is selected, that file is used when you open new messages from this 

account (except with the Redirect or Send Again commands). The message toolbar in the composition window 

is set according to how the stationery message was saved, regardless of how the options below are set. But, 

you can always change them after you open the message. 

When not using Stationery (Sponsored and Paid modes only)—The values you choose for the following 

options apply only when you are not using a default stationery file, that is, when the "Select a default Stationery 

for new messages" option, above, is set to <No Default>, if you have selected a default stationery file from the 

drop-down list, then the values below are ignored. Instead, Eudora uses their corresponding values that were 

set when the stationery file was saved. So, for example, if you choose default stationery that uses a custom 

signature and you set the default signature drop-down list below to your Standard signature, your Standard 

signature will be ignored and the custom signature will be used.

Show signature while composing— If this is selected, you will see the signature you have previously set up 

in the message composition window. If off, you will not see the signature. To set up a signature, see Using a 

Signature. 

Word wrap— If this is selected, Eudora automatically inserts carriage returns in long lines when a message is 

sent, creating roughly 76 characters per line. This makes the message legible on the recipient’s computer. It is 

a good idea not to include your own carriage returns within paragraphs if you have this option on. Use carriage 

returns only to create new paragraphs. We strongly recommend that you leave this option selected. The default 

stationery overrides this option (see above).

Keep copies—If this is selected, a copy of each message you send is kept in the Out mailbox. If this option is 

turned off, outgoing messages are put in the Trash mailbox after they are sent. Default stationery overrides this 

option (see above).

May use quoted-printable—If this is selected, Eudora uses quoted-printable encoding when necessary, such 

as when sending messages that contain special characters or long lines of text. If this option is turned off, 

quoted-printable encoding is never used. We recommend that you leave this option selected. Default stationery 

overrides this option.

Tabs in body of message—If this is selected, pressing the Tab key within the message body inserts a tab. If it 

is turned off, pressing the Tab key within the message body moves the cursor to the To: field. Default stationery 

overrides this option (see above).



Replying Options Window

The Replying options determine how replies are created.

To display the Replying options window, do the following:

1. From the Tools menu, select Options.

2. Scroll and click Replying. The Replying options window appears.

Listed below are field descriptions for Replying:

Map Ctrl+R to "Reply to All" ¾ If this is on, then when you hold down the Ctrl key and press R, a new 
message is created addressed to all of the recipients of the original message as well as the sender.

Copy original’s priority to reply ¾ If this is on, your replies use the same priority as the original message.

Automatically Fcc to original mailbox ¾ If this is on, replies are automatically copied to the same mailbox 
that contains the original message with the exception of the In box, whose replies are copied to the Out box.

Include signature on reply — If this is selected, your default signature will be included on all of your replies 
automatically.

Quote only the selected text—If this is selected, only the text you highlight in a received message will appear 
on the reply message. 

When replying to all ¾ This specifies how to address a reply. If Include yourself is on, when you Reply to all 
(as described above) your address is left in the address list of the new message and you receive a copy of your 
own reply. If this option is off (the default), your address is removed from the reply message and you do not 
receive a copy of the reply. 

To determine who you are for the Include yourself option, Eudora uses the "me" nickname. You create the "me" 
nickname in your Address Book. If you do not have a "me" nickname, Eudora uses the contents of the    Login 
Name, Mail Server, and Return Address from the Getting Started options. 

If Put original To: recipients in Cc: field is on (the default is off), the addresses of the original message recipients 
are moved from the To field to the Cc field of the reply-to-all message. Only the address of the original sender is 
placed in the To field. If this option is off, all of the addresses are placed in the To field of the reply message.



Attachments Options Window

The Attachments options determine how Eudora sends and receives file attachments.

To display the Attachments options window, do the following:

1. From the Tools menu, select Options.

2. Scroll and click Attachments. The Attachments options window appears.

Listed below are field descriptions for Attachments:

Encoding method ¾ This specifies what default encoding method to use for attached documents: MIME, 
BinHex, or Uuencode. To change the method for just the current message, use the Attachment Type drop-down 
menu in the outgoing message window. For details, see the section "Attaching a File to a Message."

Put text attachments in body of message ¾ If this is on, Eudora puts any plain-text attachment you send 
directly within the message body, as if it were typed in manually.

Receive MIME digest as a mailbox attachment¾Turn this on if you want Eudora to create a mailbox 
specifically for email messages from a mailing list that supports MIME digest.

Attachment directory ¾ This specifies what directory to put incoming attachments into. To specify a folder, 
single-click the folder name. A dialog box appears prompting you to select a folder. The default directory is the 
Attach sub-directory off of your Eudora directory.

Delete attachments when emptying Trash ¾ If this is on, Eudora automatically deletes an attachment 
received with a message when that message is deleted from your system, that is, when the message is 
emptied from the Trash. The attachment must still be in the folder defined as the Attachments Folder. If you 
want to save an attachment but delete the message, move the attachment to another folder or turn this option 
off.

Delete automatic attachments ¾ This specifies how to handle attachments to automatically generated 
messages, such as is created with the Insert System Configuration command.

Never ¾ If this is on, automatic attachments are never deleted from the attachment directory.

After sending message ¾ If this is on, automatic attachments are deleted from the attachment directory when 
their corresponding messages are sent.

When message emptied from Trash ¾ If this is on, automatic attachments are deleted from the attachment 
directory when their corresponding messages are emptied from the trash.



Fonts Options Window

The Fonts options determine how Eudora displays and prints text. Note that the choices available for each 

option, and the default, may depend on the fonts installed in your system.

To display the Fonts options window, do the following:

1. From the Tools menu, select Options.

2. Scroll and click Fonts icon. The Fonts options window appears.

Listed below are field descriptions for Fonts:

Message ¾ These fields list the proportional and fixed-width fonts to be used for displaying the text in your 
received and composition messages and in the message preview pane in mailbox windows. Also included are 
the size of each font and the use of a proportional or fixed-width font by default.

Proportional ¾ Specify the proportional font to use in message windows and the preview pane. 
Spacing is adjusted according to each character’s width.

Fixed-width ¾ Specify the fixed-width font to use in message windows and the preview pane. Each 
character takes up the same amount of space.

Use proportional font by default ¾ If this option is on, message windows and the preview pane use 
your specified proportional font by default. If this option is off, message windows and the preview pane 
use your specified fixed-width font by default.

Size ¾ Specify the size of the font to be used for text in message windows and the preview pane.

Printer ¾ These fields list the font and size to be used when printing any text from Eudora using the Print... 
command—messages, text files, signature files, and so forth.

Font ¾ Specify the font to use when printing text from Eudora.

Size ¾ Specify the font size to use when printing text from Eudora.

Screen ¾ These fields list the font and size to be used when displaying any Eudora screen text other than that 
displayed in received and composition messages and the message preview pane. This includes text files, 
signature files, and message summaries in mailbox windows.

Font ¾ Specify the font to use when displaying all other screen text in Eudora.

Size ¾ Specify the font size to use when displaying all other screen text in Eudora.



Display Options Window

The Display options determine how Eudora displays various objects in the main Eudora window and the 

category icons in the Options list.

To display the Display options window, do the following:

1. From the Tools menu, select Options.

2. Scroll and click Display. The Display options window appears.

Listed below are field descriptions for Display:

Show toolbar ¾ If this option is on, the main window toolbar appears (see the section "Customizing the 
Toolbar).

Show toolbar tips ¾ If this option is on, holding the mouse pointer over a button in the main window toolbar 
displays a very brief description of that button’s function.

Show cool bars ¾ If this option is on, the main window toolbar buttons have a flat look and only become raised 
when you position the mouse pointer over the button. If this option is off, the main window toolbar buttons 
always have a raised look.

Show large buttons¾ If this is checked, the main window toolbar buttons are large. If this is unchecked, the 
main window toolbar buttons appear small.

Show status bar ¾ If this option is on, Eudora displays a status bar at the bottom of the main window. The 
status bar provides a brief description of menu items and toolbar buttons.

Show category icons ¾ This option allows you to turn the Category icons in the Options dialog box on and off.

Show MDI task bar ¾ If this option is on, Eudora displays the Eudora taskbar at the bottom of the window work 
area. This taskbar contains buttons for all open and minimized normal Eudora windows, such as mailboxes, 
email, and address book. See Using the Eudora Taskbar.

Automatically download HTML graphics¾If this option is on, you will able to receive an email message with 
embedded web images. Eudora retrieves the images from the World Wide Web.



Signatures Window

Use this window to manage and apply signatures.

To open the Signature window, do the following:

1. From the Tools menu, choose Signatures. Or, if the Signature window is in a visible tabbed window, click 

its tab.

The Signature window displays a single-column list of your signature files.

Note: You can only select one item at a time in the list; you cannot select multiple items.

If you right-click a signature in the list, a context menu (right-click) appears with the following commands (the 

standard Eudora window-management commands appear at the bottom):

• New — Create a new signature. Eudora prompts you for the name of the new signature, then opens an 

editing window for you to type the signature text. Save the text with the File menu Save command, or close 

without saving to discard.

• Edit — Open an editing window for the selected signature. Double-click a signature as a shortcut for this 

command. Save your changes with the File menu Save command, or close the window without saving to 

discard your changes.

• Delete — Delete the selected signature. Eudora asks you to confirm the deletion. Use the Delete key (Del) 

as a shortcut for this command.

• Rename — Rename the selected signature. Use the F2 key as a shortcut for this command, or click the 

signature item’s name box, then edit the name right in the box.

You can also display the context menu and create a new signature by right-clicking anywhere in an empty 

Signature window or by right-clicking anywhere off a signature item in a non-empty Signature window.



Viewing Mail Options Window

The Viewing Mail options determine how Eudora displays incoming and outgoing message windows and the 

message preview pane in mailbox windows.

To display the Viewing Mail options window, do the following:

1. From the Tools menu, select Options.

2. Scroll and click Viewing Mail. The Viewing Mail options window appears.

Listed below are field descriptions for Viewing Mail:

Message Window ¾ These options determine how Eudora displays received and composition messages.

Use Microsoft’s viewer ¾ If this is off, Eudora displays advanced formatting, graphics, and multimedia in 
incoming and outgoing messages, using its own built-in viewer. If this is on, Eudora takes full advantage of the 
Web browser capabilities of Microsoft’s Internet Explorer 4.0 or later by showing Web content right in incoming 
and outgoing messages or linking to the Internet, without your having to open the Web browser. This option is 
only available if you have Microsoft’s Internet Explorer version 4.0 or higher installed and available on your 
system.

Message window width ¾ This specifies the width of new and received message windows (in characters). 
This option has no effect on what your mail looks like when it is sent. When mail is sent, Eudora wraps at or 
before 76 columns.

Note: If you use a proportional font, Eudora sets the window width based on the average width of the 

characters in the font.

Message window height ¾ This specifies the height of new and received message windows (in lines).

Note: If the "Zoom windows when opening" option is turned on, received message window heights are 

automatically adjusted to the height of the message text.

Preview Pane ¾ These options determine the visibility and behavior of the message preview pane that 
appears at the bottom of mailbox windows. For more information, see Message Preview Pane.

Show message preview pane ¾ If this option is on, Eudora displays the message preview pane in mailbox 
windows. The preview pane previews a single selected message. A splitter between the preview pane and the 
message summary list lets you resize the preview pane relative to the list.

Mark previewed messages as read after _ second(s) ¾ If this option is on and the "Show message preview 
pane" option is turned on, the message currently selected in the mailbox window and previewed in the preview 
pane is automatically marked as read (blank in the Status column) after the specified number of seconds. If this 
option is off, a previewed message will not automatically be marked as read. Note: You can use the 
Shift+Space shortcut to convert a message back and forth between the Unread (•) and Read status.

Automatically open next message ¾ If this is on, deleting or transferring the current message opens the next 
message in the mailbox, but only if that message is unread.

Zoom windows when opening ¾ If this option is on, new message windows automatically open to their 
"zoomed" size. The zoomed size is computed on a window-by-window basis. For message windows, zoomed 
size is just long enough to display all of the message (but no longer than the main window), and as wide as the 
Message window width setting. Composition windows zoom to the height specified by the Message window 
height setting.

Allow executables in HTML content—If this is selected, you are able to run programs such as Java™ 
Applets, JavaScript™, VB Script™, and ActiveX™ Controls that are embedded in an HTML texted message. 
For security reasons, you may want to leave this option deselected. 



Styled Text Options Window

The Styled Text options determine when to use style information in outgoing and incoming messages.

To display the Styled Text options window, do the following:

1. From the Tools menu, select Options.

2. Scroll and click Styled Text. The Styled Text options window appears.

Listed below are field descriptions for Styled Text:

Show formatting toolbar ¾ If this is on, the formatting toolbar displays by default in new message windows. If 
this is off, the formatting toolbar is hidden by default in new message windows. This toolbar lets you easily 
format text styles in new messages.

When sending mail with styled text (HTML) ¾ This specifies what to do with HTML text styles when you send 
mail. The styles are delivered to your recipients using the HyperText Marking Language (HTML) format. 
However, the styles your recipient sees depends on how well their email software supports this standard. 

HTML is the text formatting standard used in the World Wide Web by Web browsers and newer email 
applications. HTML allows you to use enriched text, which includes different fonts, color, sizes, bold, and so 
forth. Also, HTML lets you embed pictures and create bullet lists in the emails you send.

Send both plain and styled, Send styled text only, Send plain text only ¾ These options apply only to 
messages that have some styled content. Plain text messages are always sent as just plain text. If a message 
has styled text, then these options control which versions of the message are sent: an HTML version, a plain 
text version, or both an HTML and a plain text version in the same message.

If you send plain and styled text, then your recipient will be able to view your message regardless whether their 
email program supports HTML viewing. If HTML viewing is not supported, then the message is viewed in plain 
text; otherwise, it is viewed in HTML.

Ask me each time ¾ If this is on, you are warned when you try to send or queue a message with text styles. 
And you are given the option to send a plain text version, an HTML version, or both in a single message.

When the body of a message has no styles, but the signature does have styles: Send the signature with 
styles — If this is selected, a signature with styled text is sent with a message that has no styled text. If this is 
deselected, then the signature is sent but the text styles are removed.

Note. If selected, the signature becomes part of the message text. However, if an attachment is included 

with your message, this option turns off. 



Spell Checking Options Window

(Sponsored and Paid modes only)

These options control the behavior of Eudora’s built-in checker when it performs a spelling check on the body 

of a message composition window, a text file, or a signature file. You can also change these options from the 

Spelling Options dialog box, accessed by clicking Options in the Check Spelling dialog box. For more 

information, see Checking Your Spelling.

To display the Spell Checking options window, do the following:

1. From the Tools menu, select Options.

2. Scroll and click Spell Checking. The Spell Checking options window appears.

Listed below are field descriptions for Spell Checking:

Ignore capitalized words ¾ The spelling checker ignores words that begin with a capital letter, such as proper 
nouns.

Ignore words with all capitals ¾ The spelling checker ignores words that contain all capital letters, such as 
acronyms.

Ignore words with numbers ¾ The spelling checker ignores words that contain numbers.

Ignore words with mixed case ¾ The spelling checker ignores words that contain a mixture of uppercase and 
lowercase characters.

Report doubled words ¾ The spelling checker reports words that appear twice in sequence in text and 
identifies them as doubled words.

Suggest words ¾ If this is on, then when the spelling checker encounters an unknown word, it displays 
Eudora’s suggestions for the correct spelling of the word in the Suggestions field of the Check Spelling dialog 
box (see Checking Your Spelling). You can also select any combination of the suggestion options: Phonetic 
words (off by default), Split words (on by default), Typographic words (on by default).

Note: If Eudora has no suggestions for the word in its dictionary, then no suggestions are listed.

Check spelling:

Automatically as you type ¾ Turn this on when you want to use the automatic spell checker. Misspelled 

words are highlighted automatically. For more information see Automatic Spell Checking. 

Only when requested ¾ Turn this on when you don’t want to use the automatic spell checker but would rather 

check your spelling all at once. 

Outgoing messages:

Ignore original text ¾ The spelling checker ignores any text that is preceded by a quote mark, which is a right 
angle-bracket (>) for unstyled text, and an excerpt bar (|) for styled text. Eudora assumes that this text was 
originally from another message, and therefore does not need to be spell-checked.

Warn me when sending/queuing message with misspellings ¾ If this option is on, Eudora displays a 
warning if you attempt to queue or send a message without completing the spell check.



Date Display Options Window

The Date Display Options determine how message dates are displayed in the Date column of mailbox window 

message summaries.

To display the Date Display options window, do the following:

1. From the Tools menu, select Options.

2. Scroll and click Date Display. The Date Display options window appears.

Listed below are field descriptions for Date Display:

Display dates using ¾ This specifies what time zone to use to display dates. 

Sender’s timezone ¾ If on, messages are displayed with the sender’s time and date, as determined by the 
sender’s time zone. 

Local timezone ¾ If on, messages are displayed with your time and date, based on your local time zone.

Date formats [default: Fixed] ¾ These options and fields specify how to display message dates whether with a 
fixed or an age-sensitive format and the specific formatting for the selected option. A fixed format means that all 
dates are displayed under the same formatting rule. An age-sensitive format means that message dates are 
displayed differently depending on how old the messages are. Formatting is entered in the text fields using the 
format key at the bottom of the Date Display Options window (discussed further below).

Fixed [defaults: %1 %2 %4] ¾ If this is on, all message dates are displayed using the formatting entered in the 
edit field, based on the formatting key (see below). The default format (%1%2%4) specifies that all message 
dates will be in this format: message time followed by message date followed by message time zone (but only if 
the message did not originate from your local time zone). Example: 02:56PM11/21/97-0800.

Age-sensitive ¾ If this is on, message dates are displayed differently based on the age of the messages. The 
three age categories are RECENT, OLD, and ANCIENT. The age of a message is measured from the date and 
time at which the message was composed or sent, based on the sender’s email package, and this depends on 
your setting for the Display dates using option. RECENT messages are all those that are "younger" than the 
hours you specify in the Hours to be OLD field. ANCIENT messages are all those that are older than the 
"expiration time" entered in the Hours to be ANCIENT field. OLD messages are all those whose age falls 
between that of RECENT and ANCIENT messages: they are older than the number of hours specified in the 
Hours to be OLD field, but younger than the number of hours specified in the Hours to be ANCIENT field. The 
date display format for all messages falling in the RECENT, OLD, and ANCIENT categories is determined by 
your entry in the RECENT format, OLD format, and ANCIENT format fields, respectively.

RECENT format [default: %1] ¾ Your entry in this field determines the format in which the dates of RECENT 
messages are displayed. RECENT messages are all those younger than the number in the Hours to be OLD 
field. The default RECENT format of %1 and the default Hours to be OLD of 24 means that all messages from 
the past 24 hours are displayed with the time.

Hours to be OLD [default: 24] ¾ Your entry in this field determines the point at which RECENT messages 
become OLD messages. The default entry of 24 hours means that messages become OLD after one day.

OLD format [default: %3] ¾ Your entry in this field determines the format in which the dates of OLD messages 
are displayed. OLD messages are those that are older than the Hours to be OLD but younger than the Hours to 
be ANCIENT. The default OLD format of %3, the default Hours to be OLD of 24, and the default Hours to be 
ANCIENT of 168 means that all messages older than one day and younger than one week are displayed with 
the day of the week.

Hours to be ANCIENT [default: 168] ¾ Your entry in this field determines the point at which OLD messages 
become ANCIENT messages. The default entry of 168 hours means that messages become ANCIENT after a 



week.

ANCIENT format [default: %2] ¾ Your entry in this field determines the format in which the dates of ANCIENT 
messages are displayed. ANCIENT messages are all those older than the number in the Hours to be ANCIENT 
field. The default entry of %2 and the default Hours to be ANCIENT of 168 means that all those messages older 
than a week are displayed with the date.

Format Key ¾ Use the format key to determine how to program entries in the Fixed field and the format fields 
(RECENT, OLD, and ANCIENT) of this Options window. In each field, enter %1 to stand for the Time, enter %2 
to stand for the Date, enter %3 to stand for the Day of the week, and enter %4 to stand for the Time zone, but 
only if the message did not originate from the local time zone. Separate each entry with a space to improve 
readability of the display output: for example, %1%2%4.



Labels Options Window

The Labels options determine the title and color of the seven labels that can be used to categorize messages.

To display the Labels options window, do the following:

1. From the Tools menu, select Options.

2. Scroll and click Labels. The Labels options window appears.

To change a label title, type the new title in the field to the right of the label number. To change a label color, 

single-click the label number to display the Color dialog box.

Color dialog box

You can select from one of the predefined basic colors or create your own custom colors. To assign a basic 

color to a label, select the color and click OK. To create a custom color, click Define Custom Colors to display 

the custom colors palette.

Custom colors palette

To define a custom color, do the following:

1. Select one of the 16 custom color boxes. 

2. Using the mouse pointer, click anywhere on the color palette to select the color hue and saturation. Use the 

color control bar to the right of the color palette to adjust the color. 

3. When you are satisfied with the color, click Add to Custom Colors. 

4. Once you have completed creating the custom colors, select the desired label color and click OK.



Getting Attention Options Window

The Getting Attention options determine what Eudora does when it is running in the background and wants your 

attention, or when new mail arrives.

To display the Getting Attention options window, do the following:

1. From the Tools menu, select Options.

2. Scroll and click Getting Attention. The Getting Attention options window appears

Listed below are field descriptions for Getting Attention:

Use an alert dialog box ¾ If this is on, an alert dialog box notifies you when new mail is received.

Open mailbox ¾ If this is on, mailboxes are automatically opened when new mail arrives in them, and the first 
unread message of the last unread batch of messages is selected.

Play a sound ¾ If this is on, a sound is played when Eudora needs attention. To select a sound (.wav) file, click 
the button below the Play a sound option (the button is empty by default). The Select sound file dialog box is 
then displayed, allowing you to select a sound and click Open. To switch back to the default mail arrival sound, 
click Use Default.

Generate filter report ¾ If this is on, a filter report is generated when filters are used. Filter reports are 
displayed in the Filter Report window, accessed from the Tools menu. Note that this option must be on in order 
for such reports to be displayed in that window. For more details, see Filter Report Window .



Extra Warnings Options Window

The Extra Warnings options determine whether you are warned before making a possible mistake. Most of the 

warnings are displayed with an option to stop that warning from being displayed again. You can toggle warnings 

to be either on or off.

To display the Extra Warnings options window, do the following:

1. From the Tools menu, select Options.

2. Scroll and click Extra Warnings. The Extra Warnings options window appears.

Listed below are field descriptions for Extra Warnings:

Delete unread mail ¾ If this is on, you are warned if you try to delete mail that is marked unread.

Delete queued mail ¾ If this is on, you are warned if you try to delete mail that is queued to be sent (marked 
"Q," or clock icon for timed-queue) in the Out mailbox.

Delete unsent mail ¾ If this is on, you are warned if you try to delete messages that are marked sendable 
(with a bullet in the Out mailbox) but not yet sent.

Queue a message with no subject ¾ If this is on, you are warned if you try to queue a message that contains 
no text in the Subject line. It is considered a point of email etiquette to give each message a subject.

Queue a message bigger than _ K [default: 500] ¾ If this is on, you are warned if you try to queue or send a 
message that is greater in size than the specified number. This number must be between 0 and 1000000 (one 
million, no commas).

Quit with messages queued to be sent ¾ If this is on, you are warned if you try to quit Eudora while there are 
still queued messages in your Out mailbox.

Empty the Trash mailbox ¾ If this is on, you are warned if you try to empty the Trash mailbox (one way is with 
the Special menu Empty Trash command). Once messages are deleted from the Trash, they are completely 
gone from your system.

Start Eudora and it’s not the default mailer ¾ If this is on, you are warned if you try to start Eudora when it’s 
not the default mailer. When Eudora is the default mailer, "mailto:" commands open a Eudora message, 
regardless of what application the command is in.

Switch views for Find ¾ If this is selected, you are warned if you try to perform a Find operation (using the 
Edit menu Find submenu) while viewing an incoming message using the Microsoft Internet Explorer (IE) version 
4.0 viewer. The warning indicates that Eudora will switch to a different viewer to complete the Find operation. 
Eudora uses IE as the default viewer if    IE is installed on your system and the "Use Microsoft’s viewer" option 
is selected in the Viewing Mail options. See Viewing Mail Options Window .

Launch a program from a message — If this is selected, you are warned if you try to launch a program from a 
message. For security reasons, you should never launch a program without performing a virus check on the 
file. Do not launch any program if you do not know sender. Some viruses can infect a file without your knowing 
it. It is always good to perform regular virus checks using a current virus checking program.

Launch a program externally — If this is selected, you are warned if you try to launch an attachment or 
program outside of Eudora, for example directly from the Attachments directory or from a Eudora Sharing 
Protocol (ESP) directory. For security reasons, you should never launch a program without performing a virus 
check on the file. Do not launch any program or open an attachment if you do not know sender. Some viruses 
can infect a file without your knowing it. It is always good to perform regular virus checks using a current virus 
checking program.





Advanced Network Options Window

These options control some of Eudora’s advanced network functions.

Note: Consult your email administrator before modifying any of these options.

To display the Advanced Network options window, do the following:

1. From the Tools menu, select Options.

2. Scroll and click Advanced Network. The Advanced Network options window appears.

Listed below are field descriptions for Advanced Network:

Network open timeout _ seconds [default: 60] ¾ This option lets you set the number of seconds before an 
attempt to make a network connection will time out. For some servers (especially those with heavy loads), the 
attempt to establish the network connection can take longer than it takes to send data back and forth once the 
connection has been made. A familiar example: When you are browsing the World Wide Web, you may find that 
it takes a while to connect to a server, but then, once you have connected to the server, the Web page can 
seem to download very quickly. This option therefore gives you the ability to set a different (and usually longer) 
timeout for establishing the network connection than the timeout after the connection has been made (the latter 
timeout is set via the Network timeout after _ seconds option, below).

Network timeout after _ seconds [default: 60] ¾ This option lets you set the number of seconds before an 
established network connection will time out. See the discussion above for the Network open timeout _ seconds 
option.

Network buffer size of _ bytes [default: 4096] ¾ This option lets you set the size, in bytes, of the buffer that 
Eudora uses to transfer information to and from the server.

Note: If you are having trouble transferring large messages, the size of this buffer may be decreased.

Cache network info ¾ This option causes Eudora to remember the results of previous database functions 
when using the Winsock connection method. This speeds up database functions within a single Eudora 
session.

Unload Winsock DLL after closing socket ¾ If you are using the Trumpet Winsock stack for dialup, select 
this option    if you like to have your computer dial and hang-up between functions, for example sending and 
receiving mail. 



MAPI Options Window

The MAPI Options control the Eudora MAPI Server. Eudora’s MAPI support allows you to quickly attach 

documents to email messages directly from the application that created the document. Without MAPI, users 

must first save the document, remember what folder the document is in, switch to Eudora, and then remember 

to manually attach the document to the outgoing message.

MAPI streamlines this process dramatically. To email the current, open document from your word processor, 

select the Send command from your word processor’s File menu. This automatically activates Eudora and 

attaches a snapshot of the open document to a new composition message.

The MAPI system standardizes how messages are handled by client applications so that each client application 

does not have to have custom code for each target messaging application. MAPI accomplishes this by 

providing a standard application program interface used by all MAPI-enabled client applications.

An additional MAPI feature supported by Microsoft Office applications is the ability to add a "routing slip" to a 

Word, Excel, or PowerPoint document. This routing slip contains a list of email recipients obtained from the 

MAPI subsystem. Once a document has an embedded routing slip, then it can be semi-automatically routed as 

an attachment via email to all recipients listed in the routing slip. Once the routing is complete, the annotated 

document is returned back to the original sender.

See Messaging Application Program Interface (MAPI).

To display the MAPI options window, do the following:

1. From the Tools menu, select Options.

2. Scroll and click MAPI. The MAPI options window appears.

Listed below are field descriptions for MAPI:

Use Eudora MAPI server ¾ If Never is selected, the Eudora MAPI server is off and is never automatically 
loaded. If When Eudora is running is selected, the Eudora MAPI server is on when Eudora is running. If Always 
is selected, the Eudora MAPI server is on and is always loaded on startup.

Delete MAPI attachments ¾ If Never is selected, MAPI attachments are never deleted from the attachment 
directory. If After sending message is selected, MAPI attachments are deleted from the attachment directory 
when their corresponding messages are sent. If    When message emptied from Trash is selected, MAPI 
attachments are deleted from the attachment directory when their corresponding messages are emptied from 
the Trash.

Send single MAPI file attachment as inline attachment (TXT and HTML files only) ¾ Turn this on when you 
need to have the MAPI client send a single TXT or HTML file as an attachment with no body text. Eudora turns 
off the Text As Attachment button in the outgoing message toolbar (if it is on), so that the document is sent to 
the recipient as inline text in the message body. This allows MAPI clients, such as Internet Explorer, to pass 
Web pages and other HTML and TXT documents right into the body of the Eudora message. (The Text As 
Attachment button, if turned on in the outgoing message toolbar, instructs Eudora to attach text files, such as 
TXT and HTML, to the message rather than incorporating the text into the message as part of the message 
body. The default state of this button is controlled by the Put text attachments in body of message option in the 
Attachments options . See the section Using the Composition Window.

Warn on MAPI auto-send of message¾Turn this on to get a security warning when you receive messages 
that are automatically sent from other applications through MAPI. 



Automation Options Window

The Automation options let you control and exchange information with Eudora from other programs that support 

the Windows Automation Interface, such as Microsoft Visual Basic.

Automation gives you external access to Eudora mail folders, mailboxes, and messages, and to the Eudora 

application itself. With automation enabled, you can create, delete, and move Eudora mail folders, mailboxes, 

and messages, as well as get notification of these three operations when they are performed manually. You can 

also get lists of the subfolders under folders and of the messages within mailboxes.

For more information on the automation feature, visit our Web site (click www.eudora.com/developers) where 

you can find up-to-date automation SDKs (Software Developer’s Kits) and documentation.

To display the Automation options window, do the following:

1. From the Tools menu, select Options.

2. Scroll and click Automation. The Automation options window appears.

Listed below is the field description for Automation:

Automation enabled from this machine ¾ If this option is on, you can perform the automation operations 
described above from the computer on which Eudora is installed.

Warn on Automation auto-send of messages¾ If this option is selected, a warning will appear if any 
message is sent automatically. For example, if you have a message set to be sent a certain time, a warning 
appears just before the message is sent. Another advantage is that if a virus ever tries to replicate itself using 
your address book entries, this warning will appear.



Auto Configure Options Window

Eudora needs just a few pieces of information in order for you to send and receive mail. Normally you enter this 

information in the first few windows of the Options windows, but if you like, you can use the Auto Configure 

options to retrieve these basic settings from an ACAP server. Your email administrator can let you know if such 

a server is available to you. ACAP, which stands for Application Configuration Access Protocol, is a 

communications protocol that lets email and other applications store setup data on and retrieve it from a central 

server.

To display the Auto Configure options window, do the following:

1. From the Tools menu, select Options.

2. Scroll and click Auto Configure. The Auto Configure options window appears.

Listed below is the field description for Auto Configure:

Server Name ¾ In this field, enter the name of the ACAP server you wish to connect to in order to retrieve the 
Eudora settings. If you are not sure what to enter here, see your email administrator.

User Name ¾ Enter your user name required for connection to the ACAP server. Your email administrator can 
provide you this name if you do not know it.

Password ¾ Enter your password required for connection to the ACAP server. See your email administrator for 
your ACAP password.

Retrieve Settings Now ¾ After you have entered the Server Name for the ACAP server, your user name, and 
your Password (see above), click this button to retrieve your Eudora settings from the ACAP server. The 
retrieved settings replace your current Eudora settings.



Kerberos Options Window

These options control the Kerberos authentication system. If your network uses Kerberos for authentication, the 

appropriate options are provided by your email administrator.

To display the Kerberos options window, do the following:

1. From the Tools menu, select Options.

2. Scroll and click Kerberos. The Kerberos options window appears.

Listed below is the field description for Kerberos:

Kerberos Authentication —Turn on Kerberos 5 to authenticate the POP, IMAP, and SMTP protocols. 

Kerberos 4 (POP only) —Turn on Kerberos 4 to authenticate POP only.

Kerberos POP3 port ¾ This is the port that the Kerberos POP server is listening on.

Realm ¾ This is the network realm that the Kerberos server resides in.

Service name [default: rcmd] ¾ This is the type of service that you’re requesting.

Service format [default: %1.%4@%3] ¾ This is the name of the ticket that Eudora requests from the Kerberos 
server. The formatting key below this field indicates what to enter. Enter %1 to stand for the service name 
entered in the Service name field; enter %2 to stand for the full domain name of the POP host; enter %3 to 
stand for the realm entered in the Realm field; enter %4 to stand for the name of the POP host.



Miscellaneous Options Window

The Miscellaneous options determine additional Eudora capabilities that are not categorized with other 

functions.

To display the Miscellaneous options window, do the following:

1. From the Tools menu, select Options.

2. Scroll and click Miscellaneous. The Miscellaneous options window appears.

Listed below are the field descriptions for Miscellaneous:

Switch messages with:

Unmodified arrow keys ¾ If this is on and there is an incoming message window open on the screen, the up 
or left arrow key closes the current message and opens the previous message in the mailbox, and the down or 
right arrow key closes the current message and opens the next message in the mailbox. If this is on and the 
Show message preview pane option is on in the Viewing Mail options , and keyboard focus is currently in the 
preview pane of an open mailbox window, then pressing the unmodified arrow keys changes the view in the 
preview pane going up or down the message summary list, as appropriate. If the Unmodified arrow keys option 
is turned off, the arrow keys can be used to move the cursor (insertion point) in messages and the preview 
pane.

Note: Even if Unmodified arrow keys is on, the arrow keys do not switch messages if there is an outgoing 

message topmost on the screen.

Ctrl+arrow keys ¾ If this is on, you can switch messages by holding down the Ctrl key and pressing the arrow 
keys. The switching behavior is as described above under the Unmodified arrow keys option. The Ctrl+arrow 
keystrokes do not work when composition windows are open on the screen.

Alt+arrow keys ¾ If this is on, you can switch messages by holding down the Alt key and pressing the arrow 
keys. The switching behavior is as described above under the Unmodified arrow keys option. The Alt+arrow 
keystrokes do work when composition windows are open on the screen.

Empty Trash when exiting ¾ If this is on, the Trash mailbox is emptied when you exit Eudora. If this is off, the 
Trash is only emptied when you select Empty Trash from the Special menu.

Say OK to alerts after _ second(s) [default: 120] ¾ If this is on, any alerts that announce a problem with the 
network communication automatically go away after the specified number of seconds. Many network problems 
are temporary, so this allows Eudora to try the communication again. This is most useful if you have automatic 
mail-checking enabled for any of your accounts.

Turbo redirect by default ¾ If this is on and you select Redirect To, a redirected message is created with the 
specified recipient, the message is queued, and the original message is deleted.

Include outdated ‘Return-Receipt-To’ ¾ If this is off, Eudora uses the "Disposition-Notification-To:" header in 
return receipt requests to request that you be sent a notification when your message appears by the recipient. If 
this is on, Eudora also sends the "Return-Receipt-To:" header in return receipt requests. This header is 
understood by some older mail delivery systems, and may return you a receipt when your message is delivered 
to your recipient’s mailbox. The "Return-Receipt-To:" header cannot give you any information about whether or 
not your recipient displayed your mail, and is not supported by many newer mail delivery systems.

Automatically expand nicknames ¾ If this is on, nicknames in message headers are replaced with the real 
addresses when you switch fields.

Auto-save messages every _ minutes—Enter the number of minutes between auto-save intervals. In case of 
a system shut-down, the messages saved are from the most current auto-save.



Mailboxes Options Window

The Mailboxes options determine how Eudora displays various objects in mailbox window columns. It also 

allows you to configure Eudora to select and drag message(s) for mailbox transfers.

To display the Mailboxes options window, do the following:

1. From the Tools menu, select Options.

2. Scroll and click Mailboxes. The Mailboxes options window appears.

Listed below are field descriptions for Mailboxes:

Show Mailbox Columns ¾ These options determine which columns are displayed in mailbox windows. Turn 
on an option to display that column in all mailbox windows. The options are Status, Priority, Attachment, Label, 
Sender, Date, Size, Server status, and Subject.

Show mailbox lines ¾ If this option is on, lines are displayed in the message summaries portion of mailbox 
windows, horizontal lines to separate message summaries, and vertical lines to separate columns.

Close messages with mailbox ¾ If this is on, all opened messages in a mailbox will close automatically when 
you close the mailbox .

Select newly inserted messages (FUMLUB) ¾ If this is selected, the first message of the most current block 
of unread messages is highlighted in the Table of Contents window when new messages are added to a 
mailbox, for example, when receiving new messages as a result of a mail check. FUMLUB means First Unread 
Message of the Last Unread Block. For example, you may have a series of unread messages in a mailbox 
scattered throughout your Table of Contents. The first message of the last block of unread messages listed in 
your Table of Contents is selected. 

When dragging in a mailbox: ¾ These options determine how you can move messages from one mailbox to 
another.

Allow drag and drop transfers ¾ If this is on, you can transfer a message to another mailbox using drag and 
drop: select one or more messages in a mailbox, drag them to another mailbox and drop them in the target 
mailbox.

Allow drag-select of messages ¾ If this is on, you can click and drag on adjacent messages to select them as 
a group in the Table of Contents window. This allows you to transfer a group of messages to a mailbox or to 
delete them if the "Allow drag and drop transfers" is turned on. The drag-select works only if the drag starts on 
an unselected (not highlighted) message.



Using PureVoice

QUALCOMM's PureVoice™ Player-Recorder lets you record and send voice messages as attachments to your 

email. You can also receive and play back voice messages created with PureVoice.

To use PureVoice, you must have a computer running a 32-bit Windows operating system or greater. You must 

also have a sound card and speakers. To record messages, you must have a built-in or external microphone.

You can send voice messages to anyone in the world who has an email account and access to the Internet. For 

your recipients to play back your messages, they must be on a Macintosh, 32-bit Windows (Win95/98, Win98, 

NT 3.51 or NT 4.0), Solaris 2.5 or SCO OpenServer Release 5 UNIX    machine, with a sound card and 

speakers, and they must have the PureVoice standalone application or plug-in installed. If they want to record a 

response, they must have a microphone. Your recipients can download PureVoice for free from our Web site 

(click www.eudora.com/purevoice) or choose the "Attach Site Info" option from the PureVoice Option menu.

Launching PureVoice

To launch the PureVoice plug-in from within Eudora, do the following:

1. Open a new message in Eudora.

2. From the Message menu, choose Attach.

3. From the Attach submenu, choose PureVoice.

          The PureVoice dialog box displays.

4.    Record your message using the instructions in the PureVoice Help (see

          "Getting Help" below). You can also play back your message and save it to

          a file.

5.    When you are finished recording your message and are ready to send it,

          click the Attach button in the PureVoice dialog box, or select Attach from

          the File menu. The voice message is attached as a voice file to your open

          email message.

Getting Help

PureVoice has extensive online help. To access this help, launch PureVoice as described just above, then go to 

the Help menu. The Help window displays. Navigate through the extensive online help system.

PureVoice Plug-in Updates and Contact Information

You can download the latest version of the QUALCOMM PureVoice™ Plug-in for Eudora free from our Web 

site. Click here. If you experience something you think might be a bug in QUALCOMM’s PureVoice,    submit 



bug reports by clicking here or you can click the "Bug Report" button on the "About PureVoice" window under 

the PureVoice Help menu. 



Attaching a PureVoice File to a Message

You can attach a voice file to your message. However, your recipient must have the PureVoice player/recorder 

to hear your audio attachment. It is free from our website:    Just click www.eudora.com/purevoice 

To attach a PureVoice file to your message, do the following:

1. Click the PureVoice icon on the toolbar or from the Message menu, choose Attach then PureVoice from 

the Attach submenu. The PureVoice player/recorder appears in an opened message.

Note. QUALCOMM PureVoice contains its own help program. For detailed information on PureVoice, 

choose Topics from the Help menu.

2. To create an audio file, click New, or from the File menu, choose New Recording. If a current recording 

exists, a dialog box appears asking if you want to discard or save the current recording. 

3. To record your voice, click the Record (red round) button or from the Control menu, choose Record. 

Speak clearly into the computer’s microphone. Observe the volume indicator in the digital display, and if 

necessary, adjust the microphone volume/sensitivity control.

4. When finished recording, click the Stop (square) button or from the Control menu, choose Stop.

5. To discard this message and start over, just repeat steps 2 through 5. 

6. To attach the voice file, click Attach in the PureVoice window or from the File menu, choose Attach. You 

may also save the audio message to a file. The PureVoice audio file attaches to your message.

Note:    If your recipient does not have PureVoice, choose Attach Site Info from the Options menu. This 

tells your recipient where on the Internet he/she can retrieve the PureVoice player/recorder. This 

includes a file with download instructions. 

7. To close the PureVoice player/recorder, from the File menu, choose Exit or click the x.



Importing Settings to Create a New Account

Note:    To retain the settings from an older version of Eudora, just install the newer version in the same 

directory as the older version. The Eudora you just installed will then use the same settings, 

mailboxes, address books, etc. that was in the older version. You cannot import settings from one 

version of Eudora to another using the Import option. 

To set up a newly migrated account from Netscape MessengerÔ 4.x, 6.0, and higher, Microsoft Outlook 

ExpressÔ 5.0, Outlook ’98Ô and Outlook 2000 as an alternate or multiple personality account using the New 

Account Wizard, do the following:

1. From the File menu, choose Import. The Import Mail and Addresses window appears (go to step 5). Or 

from the Tools menu, choose Personalities, or if the Personalities window is in a visible tabbed window, 

click its tab (go to step 2).

Note. If you are using the Import command from the File menu and you don’t see the email program you are 

trying to import in the Import Mail and Addresses dialog box, click Advanced. On the Advanced 

Import dialog box, you can browse your hard drive and look for your mail and address book files.

2. In the Personalities window, right-click to display the drop-down context menu (right-click). Choose New. 

The New Account Wizard window, Account Settings, appears.

3. Select Import settings from an existing email account. Click Next and the next Account Wizard window, 

Personality Name, appears.

4. In the Personality Name text box, a default personality name appears. However, you may change the 

name if you wish. Click Next and the next Account Wizard window, Import Settings, appears. 

5. From Outlook: to import your email messages, in Eudora select Import Mail, and to import your address 

book entries, select Import Address Book Entries. Go to step 9.

Note: It is advisable to empty the "Deleted Items" folder in Outlook before you begin the migration.

                  If an Import button does not display in the Import Settings dialog box, Eudora cannot 
detect a program to import from

6. If you want to import your Netscape Messenger address book, select Netscape Navigator and the 

account you want to migrate. The Import Settings window appears for Netscape.

7. From Netscape: to import your email messages, in Eudora select Import Mail. To import your address 

book entries, check the Import Address Book from LDIF file box. LDIF means LDAP Data Interchange 

Format. 

Note: If you don’t check Import Address Book from LDIF file, the Browser button does not appear.

8. Important. Before you import your Netscape Address Book, you must first save it in LDIF format. To save 

your address book in LDIF format, do the following:

a. Launch Netscape. Netscape Navigator appears.

b. From the Communicator menu, choose Address Book.

c. From the File menu in Netscape Navigator, choose Save. The Save dialog box appears.



d. Name the file while retaining the .ldif extension and save it on your computer.

e. Then, in the Eudora Import Settings window, click Browse to locate the address book file you just saved. 

9. To migrate your email account, click Next. Eudora transfers all settings including personalities, incoming and 

outgoing server names, real name, return name, and login name. 

Note: It may take a long time for the migration to occur depending on how much mail, the complexity of your 

settings, and the size of your address book that you’re importing into Eudora. Also, if during the 

migration, the process stops because of a corrupt message. You must go into your Netscape 

Messenger or Microsoft Outlook and delete the corrupt message to resume the migration.

Once migration occurs, the settings you are importing are immediate, and your mail is migrated. 

Note: When the migration is occurring, notice in the Mailbox window that a mailbox tree begins to form. For 

example, you will see the folder "Outlook" and all its mailboxes listed underneath. A plus sign (+) next 

to the folder name indicates that other folders/mailboxes are contained within this folder.



Linking a Signature and Stationery to a Personality

(Sponsored and Paid modes only) 

In Eudora, you can link a signature and a stationery to an existing personality via the Account Settings dialog 

box. For example, if you have a "Business" personality, you can link your "Business" signature and "Business" 

stationery to this personality. For creating signatures and stationery, refer to Creating a Signature and Creating 

a Stationery File. Before you can link a signature and stationery to a personality, you need to create them first. 

To link a signature and stationery to a personality, do the following:

1. From the Tools menu, choose Personalities or select the Personalities tab if grouped in a displayed 

tabbed window.

2. Select the personality and right-click to display the drop-down context menu (right-click).

3. From the context menu (right-click), choose Properties. The Accounts Settings’ Generic Properties panel 

for this is selected personality appears.

4. In the Default Stationery drop-down menu, select the stationery for this personality.

5. In the Default Signature drop-down menu, select the signature for this personality. Note that if the 

stationery you just selected has a signature linked to it, this signature overrides the signature selected 

here.

6. Click OK. This personality is now linked with the stationery and signature you chose from the drop-down 

menus.



Creating an Auto-Reply Message

(Sponsored and Paid modes only)

You can create an email message that can be sent to people automatically when you are on vacation or away 

from your computer. This message is called an auto-reply.

To create an auto-reply, do the following:

1. Write your auto-reply message using Eudora’s Stationery functions. Once the auto-reply message is 

written, name and save it in stationery. See Creating a Stationery File.

2. From the Tools menu, choose Filters. The Filters window appears.

3. In the Match section, choose a header from the Header drop down list. Select a header that matches the 

header in the messages to whom you want to send your auto-reply. <<Any Recipient>> is the most 

common for an auto-reply. 

For example, to set an auto-reply only to messages sent to your user name, just select <<Any Recipient>> 

then choose "contains." In the text box, enter your user name. You can match others as well, but it may 

cause a large number of emails to be auto-replied.

4. In the Action section, choose Reply with in the first drop-down list.

5. In the text box to the right of the first drop-down list, enter the name of the stationery.

6. Click OK. The stationery message you created will be sent to the people you indicated in this filter.

Important: Remember to delete this filter when you want your auto-reply message to stop.



Adding, Moving, and Removing Toolbar Buttons

(Sponsored and Paid modes only)

Adding Toolbar Buttons

To add buttons to the main toolbar, do the following:

1. Right-click anywhere on the toolbar, even on a button, to display the drop-down menu. 

2. From the drop-down menu, choose Customize. The Customize toolbar window appears.

The Customize window contains six tabbed panels: General, Mailboxes, Plugins, Recipients, 

Stationery, and Personalities. Each of these panels lets you add toolbar buttons for functions related to 

the tab title.

Note: The procedures for adding a toolbar button from each panel are similar. 

3. In each panel, choose an item from the categories list on the left, and the corresponding button icons for 

that category are shown in the Buttons section on the right. 

4. Click to select one of the button icons and view a description of the button’s function in the Description 

field at the bottom of the panel. These descriptions also appear in the status bar of the main Eudora 

window if the bar is currently displayed when you position the mouse pointer over the button icon. In this 

case, you don’t have to click the button.

Note: In these button descriptions, any instruction to hold down the Shift key means to do so when you are 

actually using the button from the toolbar, not when you are adding the button to the toolbar, and not 

when you are clicking the button in the Customize window to view its description. For example, if you 

click the New Message button in the main toolbar, a new composition window opens. If you hold down 

the Shift key and click the New Message button in the main toolbar, the Message Options dialog box 

appears, allowing you to select options for creating a new message (Personality and Stationery).

5. Drag the button icon to your desired position on the toolbar.

Note: If you need help at any time during toolbar customization, click the Help button in the Customize 
dialog box.

6. When you are finished adding toolbar buttons, click Close to close the Customize dialog box.

Following are specific instructions for the tabbed panels of the Customize window:

General—The Categories list contains names of menus and submenus. The buttons correspond to commands 

on these menus and submenus. 

Mailboxes—The Mailboxes list shows the same view as your Mailboxes window, accessed by choosing 

Mailboxes from the Tools menu. To add a toolbar button for a mailbox, click the mailbox and drag the 

appropriate button to the toolbar. If the mailbox is in a closed folder, double-click the folder icon to open it and 

display its contents (or click the plus-sign [+] to open the folder), then click the mailbox and drag the desired 

button to the toolbar. Note that you cannot add a toolbar button for a mail folder. 

Plugins—The Plugins list shows installed message and resource plugins. You can add a plug-in button to the 

toolbar so that just by clicking the button, you launch the plug-in application. Note that if you elected to install 

QUALCOMM’s PureVoice voice-messaging software plug-in when you installed Eudora, Eudora automatically 



adds a toolbar button for the PureVoice plug-in at the extreme right of the toolbar. See Plugins (Extended 

Messaging Services).

Recipients—The Recipients list on the left shows all recipients that are listed on your Quick Recipient List, 

which is the list of recipients to whom you frequently send mail. See Using the Quick Recipient List for more 

information. The buttons correspond to functions you can perform when addressing and sending mail to 

recipients on your list: New Message To, Forward To, Redirect To (all on the Message menu), and Insert 

Recipient (on the Edit menu). If there are no recipients on your Quick Recipient List, the Recipients area of this 

dialog box panel is empty.

Stationery—The Stationery list shows all of your stationery files. The buttons correspond to stationery-related 

commands: New Message With, Reply With, and Reply to All With, all under the Message menu. For more 

information on using stationery, see Using Stationery.

Personalities—The Personalities list shows all of your email accounts, if you use multiple personalities 

(multiple accounts). The buttons correspond to personality-related commands, such as the Message menu’s 

Change Personality command. For more information on using multiple personalities, see Using an Alternate E-

Mail Account.

Moving a Toolbar Button

To change the placement of a button on the main toolbar, hold down the Alt key and drag the button to where 

you want it.

Removing a Toolbar Button

To remove a button from the main toolbar, hold down the Alt key and drag the button off of the toolbar.

Adding and Removing Separators

To add a separator line between two toolbar buttons where no line currently exists, first determine which button 

is farther from the gripper bar when the toolbar is docked. Now hold down the Alt key and carefully drag that 

button a little bit in the direction opposite the gripper bar. A separator line will be inserted between the two 

buttons. Be sure to drag the button less than one button-width away from its position; if you overdrag it, you will 

hop over the adjacent button and reposition the dragged button on the toolbar.

To remove a separator line from between two toolbar buttons, again determine which of the two buttons is 

farther away from the gripper bar when the toolbar is docked. Now hold down the Alt key and drag that button 

toward the gripper bar. The separator line is removed. Alternately, you can hold down the Alt key and drag the 

other button slightly in the direction away from the gripper bar, and that will remove the separator line. Again, be 

careful not to drag either button too far, or you will reposition it past the adjacent button on the toolbar.



Background Tasks

In Eudora, you can retrieve, send, and compose mail at the same time! While sending and retrieving mail, you 

can compose a message, access Directory Services to look up addresses, edit stationery and signatures, read 

mail, and so forth because retrieving and sending mail now occurs in the background. 

The Task Status window displays sending and receiving activity as it happens. For example, when you check 

and send mail simultaneously, the progress of these functions is displayed in the Task Status window. Also, you 

can send messages from different personalities at the same time. See Task Status Window.

The Background Tasks options found in Options under the Tools menu allow you to set parameters that 

determine how background tasks behave, and what kind of information you want to see in the Task Status 

window. In other words, you can configure the behavior of background tasks. Also, you can set the Task Status 

and/or the Task Error windows to be brought to the front of other windows in Eudora when activity occurs.

In the Background Tasks options window, you can indicate the number of seconds of user inactivity before your 

newly retrieved mail is actually processed by Eudora. If you have automatic mail checking set up in the 

Checking Mail options, Eudora will retrieve the mail in the background from the incoming server at those time 

intervals. But Eudora will not process it until there is no user activity performed on your computer for the 

amount of seconds you indicate in the Background Tasks options window. An envelope displayed on the status 

bar, located at the lower right-hand corner of the Eudora window, indicates that there is retrieved mail to be 

processed, that is, messages to be filtered and placed in mailboxes.

Technical Note. In the background, Eudora retrieves and sends mail; in the foreground, Eudora processes 

attachments and applies filters.

If you check your mail manually, it is retrieved from the server immediately and delivered to Eudora without 

waiting for user inactivity. However, if you do a manual check and then perform a task in Eudora while Eudora is 

retrieving your mail, Eudora will wait for user inactivity before processing your newly retrieved mail. When this 

occurs, the envelope displays on the status bar until the user inactivity time specified has been reached.

Important: The envelope that displays on the status bar only indicates that mail is waiting to be processed. It 

does not mean that you have new mail waiting on the server. When your mail is processed, user 

inactivity time is needed for your mail to be filtered and attachments decoded. Your inactivity allows 

you to decide when you want your mail processed.

If you click on the envelope, the mail is processed. If you right-click the envelope, a drop-down menu appears. 

Choose Process All Waiting Tasks to process and deliver all your mail, that is, mail sent or retrieved in the 

background.    Choose Show Task Status to display the Task Status showing background activity.



Task Status Window

The Task Status window displays background activity: retrieving mail from incoming servers, and sending mail 

to outgoing servers. Mail can be retrieved and sent from each of your personalities simultaneously. Progress 

information is described in Background Tasks.

To access and display the Task Status window, do the following:

1. From the Tools menu, choose Task Status. Or, if the Task Status window is in a visible tabbed window, 

click its tab. The Task Status window appears. Notice the progress indicators on the status bar located at 

the right-hand bottom of the Eudora window. A progress bar and spinning black and white ball indicate that 

background tasks are occurring.

On the progress bar or spinning indicator, click to display the Task Status window. Right-click to display the 

indicator’s drop-down menu.

Choose Stop All Tasks to cancel the tasks currently occurring.

Choose Go offline to disconnect from the server. An alert window appears letting you know that you are 

offline and cannot connect to the server. This is useful if you are using a laptop computer.

Note: Offline does not apply to personalities that use IMAP incoming servers.

Choose Show Task Status to display the Task Status window.

You can see if your sent messages are sent, queued, or processing in your Out mailbox.

Following are field descriptions for columns in the Task Status window.

Task—(default) An icon and its description displays in this column indicating what function Eudora is 

performing. In the above example, the Send icon appears. 

Persona—This column is available only if you have set up more than one personality. If checked, the 

Personality column displays the personality name for the given task.

Status—(default) Displays a general description of the task’s current status, for example, "Logging into POP 

server."

Details—Displays more information of the task’s status including network protocol commands. 

Progress—(default) Displays a progress bar indicating the overall progress of the tasks.



Task Error Window

The Task Error window displays an error message as it occurs. In the example below, a password error 

appears. You can indicate if you want the Task Error window brought to the front when an error occurs. See 

Background Tasks.

To access and display the Task Status window, do the following:

1. From the Tools menu, choose Task Errors. Or, if the Task Error window is in a visible tabbed window, click 

its tab. The Task Error window appears.

Notice the yellow task error icon on the Eudora tool/status bar at the lowerright of the main Eudora window. 

Click this icon to display the Task Error message.

2.          Click Details to expand the message.

Following are field descriptions for the Task Error details window.

Persona—The personality name associated with this error appears.

Title—The name of the Eudora function when this error occurred.

Status—The name of the system function when this error occurred.

Info—More information on this error appears, if any.

Time—The time and day of this error appears.



Adding a Ph Database

Ph is an online, fully indexed, fast-access white-pages directory service developed and freely distributed by the 

Computer and Communications Services Office at the University of Illinois at Urbana.

To add a new Ph database, do the following: 

1. In the Protocols list, click the Ph protocol to select it. 

2. Click New Database. Or, just double-click Ph in the Protocols list. The New Database window, General 

panel, appears.

3. In the General panel, enter a descriptive name for the Ph server, its Host Name or IP address of the Ph 

server, and the Port in the respective fields. The default port for Ph is 105. Don’t change this port number 

unless you know for certain that the port number is not 105. 

4. Select the Attributes tab to display the Attributes panel. The Attributes pane appears.

In the Attributes panel, you can add, edit, or remove attributes that display in the Results List (top-half of 

left window) and in the Details List (bottom-half of left window). 

Results List

In the Results List, the data associated with the Ph attributes you name are displayed in the columns on the left 

pane of the Directory Services window. You do this by mapping attributes to one of the three special "Present 

As" field selections: Name, Email(w), and Phone(w). See step 5.

For example, if you want to display the data associated with the Ph attribute "Full_Name" in the column named 

"Name" in the Results List, add an attribute mapping for "Full_Name" with "Name" selected as the "Present As" 

value.

Details List

Any attribute name can be renamed before it appears in the Details List. This is done via the Present As field. 

Simply replace the text in the Details List with alternate text.

For example, if your Ph server is configured to display an attribute called Full_Name but you want only Name to 

display, you need to map "Full_Name" to "Name" using the "Present As" field. Therefore, any Ph query you 

perform on that server would display the "Full_Name" data in the Name column in the Results List.

5. To add an attribute mapping to the attributes list, click Add. To edit an attribute mapping, click the attribute 

on the list and click Edit. Edit the attribute name. To remove an attribute mapping, click to select it and then 

click Remove. 

6. When you are finished making entries or changes, click OK. The attributes are added to or changed in the 

database. 

If you added a new database, the database is added to the Databases list with its checkbox.



Adding a Finger Database

Finger is an Internet directory service similar to Ph. 

To add a new Finger database, do the following:

1. In the Protocols list, click the Finger protocol to select it. 

2. Click New Database. Or, just double-click Finger in the Protocols list. The New Database window, General 

panel, appears. 

3. In the General panel, enter a descriptive name for the server, the Host Name or IP address of the server, 

and the Port in the respective fields. The default port for Ph is 79. Don’t change this port number unless 

you know for certain that the port number is not 79.

4. To create the new Finger database, click OK. A Finger database is created.



Adding an LDAP Database

LDAP means Lightweight Directory Access Protocol. An LDAP server is a service that provides information 

about individuals. You can look up virtually anyone on the Internet using public LDAP servers. And furthermore, 

you can add new LDAP servers to query in Eudora. 

To add a new LDAP database, do the following: 

1. In the Protocols list, click the LDAP protocol to select it. 

2. Click New Database. Or, just double-click LDAP in the Protocols list. The New Database window, Network 

panel, appears.

3. In the Network panel, enter a descriptive name for the server, the Host Name or IP address of the server, 

and the Port number in the respective fields. If you select the This server requires me to log on option, 

new fields appear in which to enter an Account name and a Password. However, most LDAP servers do 

not require you to log in. Enter values in these fields if you have specific instructions from your LDAP 

administrator to so do. 

4. Select the Attributes tab to display the Attributes panel.

In the Attributes panel, you can add, edit, or remove attribute mappings using the buttons displayed just 

below the window. You use the Attribute list to manage how information appears in the query results list 

and query results details portion of the screen. 

5. To add an attribute mapping, click Add. The Add Attribute list appears. 

6. In the Attribute Name text box, enter the name for the new attribute you wish map, for example, cn for 

common name. You must know the raw field names for the particular LDAP server you are adding.

Listed are the most common raw LDAP field name attributes. 

· c — Country, expressed in a two-letter country code, such as US (United States), CA (Canada), UK (United 

Kingdom), FR (France), and so forth. 

· st — State or province, expressed in a two-letter state code, such as, California (CA), Massachusetts (MA), 

Ontario (ON). and so forth. Also, if a country is considered a "state," for example, France, then this field can 

show a city name, such as Paris.

· l — Location, that is a city, county, and so forth., such as San Diego, Montreal, London, Paris, and so on.

· mail — Person’s email address. More than one email address may be listed, and more than one search 

listing may be returned for an individual with multiple email addresses.

· gn — Also Givenname. The person’s first name and/or middle initial, or any part of the person’s name 

before the last name, for example, John W, A Raymond, and so forth. Titles are sometimes given, such as 

Dr., Ms., and so forth. 

· sn — Person’s surname or last name. Suffixes are sometimes given, such as Jr., III, M.D., Esq., and so 

forth.

· cn — Person’s common name. This includes the given name: first, middle initial, prefix and the person’s last 



name including suffixes.

· o— Organization, which includes companies, universities, non-profit organizations, government agencies, 

and so forth.

7. In the Presented As text box, enter the text for the attribute you wish to see displayed on the query results 

list, or click the down arrow to display some common attribute names.

Note: Three of the four columns in the query results list window can be assigned to any attribute you 
wish, but you cannot change the name of the column heading. To change the attribute that is 
assigned to each column, enter an attribute in the Attribute Name field, such as, cn, sn, gn, and 
so forth. Then select either Name, Email(w), or Phone(w) in the "Present As" list, which 
corresponds to the Name, Email, and Phone columns in the Results List. You cannot change 
what appears in the "Database" column. It always contains the name of the server where the 
data was found.

For example, if you want to display "cn" in the Name column, "TelephoneNumber" in the Phone 
column, and "mail" in the Email column, you would set up the attributes like this.

Attribute Name Present As

cn Name - select from Present As drop-down list.

TelephoneNumber Phone(w) - select from Present As drop-down list.

mail Email(w) - select from Present As drop-down list.

In the Details portion of the Results window, you can assign attribute names to something more readable.

Attribute Name      Present As

l Location - select from Present As drop-down list

st State -select from Present As drop-down list

So instead of displaying "st: Texas, "State: Texas" would display.

In the attribute list, check the only display these attributes box if you want to limit what appears to only those 

attributes that are mapped. 

Note: In the Present As drop down list, there is a choice called Not Displayed. If you choose "Not 
Displayed," you can prevent a particular attribute from being displayed. For example, mapping 
the c (country) attribute to "Not Displayed" will have "c" removed from the displayed results in the 
Details List. This is useful if there is an usually long or confusing attribute you don’t want to 
display in the window.

8. Select the Search Options tab to display the Search Options panel.

9. On the Search Options panel, specify the Search timeout by moving the bar indicator. You can adjust the 

bar indicator for a short to long timeout.

10. In the Maximum number of matches to return text box, you can select the up arrow to increase or the 

down arrow to decrease the number of matches you’d like to see displayed. Or select the No Limit option 

to specify unlimited matches.

11. In the Search Base text box, you can specify a part of the LDAP server to limit your search. See your 

LDAP administrator to specify the value in this field. However, the default is usually sufficient. 



12. In the Worldwise Search Filter, you enter a type of search filter to form word queries. cn=*^0* is the 

default.      The ^0 is substituted for each word to form a set of word queries. The purpose of this filter is to 

form a term for a word and then (AND) the terms together. Examples are displayed below.

Query: John Smith

Configuration: default (cn=*^0*)

Filter: (& (cn=*John*)(cn=*Smith*) )

Records in which "cn" attributes contain "john" and "smith" are returned. Using the wildcard asterisks (*) before 

and after "john" and "smith" would return matches such as "Johnathon Smithson." If you wish to search whole 

words, remove the wildcard asterisks. The above example would also return records such as "John Dean 

Smith" and "Smithers Johnson."

Query: John Smith

Configuration: ( | (cn=*^0*)(sn=*^0*)(gn=*^0*)(givenname=*^0*))

Filter: 

(&

(|(givenname=*John*)(cn=*John*)(sn=*John*)(gn=*John*)) 

(|(givenname=*Smith*)(cn=*Smith*)(sn=*Smith*)(gn=*Smith*))

) 

The default search filter in this example would possibly return more records than the default because it 

searches more fields for a substring match of the word.

13. In the Whole-query Search Filter, you enter a type of search filter to create a term for the whole query. 

You can set this filter as an alternate (OR) for the worldwise search filter results. Examples are 

displayed below. 

Query: John Smith: whole query search filter

Configuration: 

whole word (cn=*^0*) 

word-wise (|(cn=*^0*)(sn=*^0*)(gn=*^0*)(givenname=*^0*))

Filter: 

(|

 (cn=*John Smith") 

 (&

          (|(givenname=*John*)(cn=*John*)(sn=*John*)(gn=*John*)) 

          (|(givenname=*Smith*)(cn=*Smith*)(sn=*Smith*)(gn=*Smith*))



 )

) 

14. Select the Log tab to display the Log panel.

15. In the Log panel, specify whether you want to generate log files and if so, how to store them; specify 

whether you want to enable logs for Protocol interactions and/or a Configuration data load/store. 

16. Enter a Log file name or select one using the Browse button. And if you want new logs to replace the old 

ones, select the Overwrite existing log file option. 

17. When all your information is entered in the New Database window, click OK and your new LDAP database 

is created with its checkbox.



Background Tasks Options Window

The Background Tasks allow you to set parameters that determine how background tasks behave, and what 

kind of information you want to see in the Task Status window. In other words, you can configure the behavior 

of background tasks. Also, you can set the Task Status and/or the Task Error windows to be brought to the front 

of other windows in Eudora when activity occurs. See Task Status Window and Task Error Window.

In the Background Tasks options window, you can indicate the number of seconds of user inactivity before your 

newly retrieved mail is actually processed by Eudora. If you have automatic mail checking set up in the 

Checking Mail options, Eudora will retrieve the mail in the background from the incoming server at those time 

intervals. But Eudora will not process it until there is no user activity performed on your computer for the 

amount of seconds you indicate in the Background Tasks options window. An envelope displayed on the status 

bar, located at the lower right-hand corner of the Eudora window, indicates that there is retrieved mail to be 

processed; that is, messages to be filtered and placed in mailboxes.

Technical Note. In the background, Eudora retrieves and sends mail; in the foreground, Eudora processes 

attachments and applies filters.

 To display the Background Tasks options window, do the following:

1. From the Tools menu, choose Options.

2. Scroll and click Background Tasks. The Background Tasks options window appears.

Listed below are field descriptions for Background Tasks.

Task Status Columns—These options determine which columns are displayed in the Task Status window. 

Check the box next to the field whose column you want to display. The options are Task, Persona, Status, 

Details, and Progress.

Task—Displays an icon with a short description of the tasks’ actions.

Persona—Available only if you have set up more than one personality. If checked, the Personality column 

displays the personality name for the given task.

Status—Displays a general description of the tasks current status, for example, "Logging into POP server."

Details—Displays more information of the tasks’ status including network protocol commands. 

Progress—Displays a progress bar indicating the overall progress of the tasks.

Wait for _ seconds of idle time before automatically delivering spooled messages—[default: 20 seconds) 

If Eudora is retrieving mail automatically in the background, the amount of time set in this field indicates the idle 

time Eudora waits before delivering mail to your mailboxes and folders. For example, if you are composing a 

message and Eudora is retrieving mail in the background, Eudora will not deliver the mail until you stop typing 

for the amount of time indicated here. If you set the time for 5 seconds, Eudora delivers your mail if you stop 

typing for at least 5 seconds. This field is beneficial if you don’t want to be interrupted too frequently while using 

Eudora. If the number is large in this field, you’ll get fewer interruptions. 

Bring error window to front—Check this option to have the Task Error window brought to the front when an 

error occurs.



Bring task status window to front—Check this option to have the Task Status window brought to the front 

when a task occurs, for example sending or receiving mail.



What's New in Eudora Email 5.2

Welcome to Eudora Email 5.2! Below describes the new features and functions added to Eudora 5.2 for 

Windows. More features will be added at a later release.

· Kerberos 5. If you use Kerberos for user authentication, Kerberos 5 has been added to Eudora. 

Kerberos 5 can be used for all protocols: POP, IMAP, and SMTP.

· New filter settings. In the Match area of the Filters dialog box, new criteria have been added: doesn’t 

intersect nickname, intersects address book, doesn’t intersect address book. 

For details on other changes in Eudora 5.2, refer to the README and RELNOTE text files that reside in the 

directory where Eudora 5.2 is installed.



Using Automatic Name Completion

(Sponsored and Paid modes only)

Similar to the "Finish Address Book Entry" command, Auto-Completion allows you to enter a portion of a name 

in the To, Cc, and Bcc fields, and Eudora automatically completes the name for you. Just start typing and 

Eudora attempts to complete the name. If multiple recipients match the text you’ve entered, a list of names 

from your history file and address book appear in a drop-down name list (provided both the history file and 

address book are selected in the new Auto-Completion option window explained later in this section). Select the 

correct name, and the name and email address appear in the field. 

The history file consists of names and email addresses of people you have previously sent, forwarded, or 

replied to messages within Eudora. 

The address book consists of the nicknames you have entered for each person in your address book. 

For example, you may want to send Barbara a message. Previously, you had to enter her nickname from your 

address book, or if she wasn’t in your address book, her full email address. By using the auto-completion 

feature, just enter B in the To field, and Eudora displays a drop-down name list with names beginning with "B" 

for you to choose from (you can also press [Esc] to prevent the drop-down name list from appearing). If you had 

typed BA, Eudora would have displayed a drop-down name list with all names beginning with "Ba." Scroll 

through the name list, click or press Enter to select the correct name. The name is now entered into the header 

field. 

If you have only a "Barbara" and a "Beth" as names in your address book or history file, Eudora completes the 

first alphabetical name. So when you type B, "Barbara" would appear first on the list (if Names should appear 

in alphabetical order is selected in the Auto Completion options window explained later in this section).

The address book icon (open book with tabs) indicates that the name came from your address book, and the 

history file icon (page with corner bent) indicates that the name came from your history file. If the name is from 

your history file, both the username and email address appear in the drop-down name list as you type. If the 

name is from your address book, only the nickname appears in the drop-down name list.

To complete the name in the field, select the correct name from the drop-down list. If you want to add another 

name in the To field, type a comma (,) after the first recipient’s name. Then you can begin to add another 

recipients name.

To delete a name from the auto-completion drop-down list, choose it and press the Delete key.

To turn the name auto-completion feature off, go to the Tools menu, choose Options, and then select Auto-

completion. Deselect Address Book and History File and click OK.



Finding Messages in Mailboxes

Note. If you are using Eudora in Light mode, you are limited to certain functions when searching for 

messages. 

You can now perform complex searches through messages in all or a selected number of mailboxes or folders. 

Once your search is complete, right-click to display the context menu where    you can sort, open, view the 

mailbox, transfer, reply, reply to all, forward, redirect, or delete the resulting messages. You can search for a 

specific piece of information in all your mail or just search for a particular item that matches the criteria you set. 

Set up the criteria for your search by selecting options from the drop-down lists and by entering text. 

To set up criteria for a message search, do the following:

1. From the Edit menu, choose Find or press [Ctrl] + F. The Find submenu appears.

2. From the Find submenu, choose Find Messages. The Find Messages dialog box appears. 

In the Find Messages dialog box, your mailboxes display along with checkboxes. If the boxes are checked, 

Eudora will perform a search in these mailboxes according to the criteria you are about to set up. To omit a 

mailbox from the search, just deselect the box. 

If you right-click in the Find Messages window, a context menu (right-click) appears allowing you to clear all 

the checkmarks so you can select the mailboxes to search. Choose Clear All to clear the checkmarks; 

choose Check All to check all the mailboxes.

The top part of the dialog box is where you select and enter criteria for your search. Each search can use 

up to five "terms" and "conjunctions" as its criteria, connecting them as appropriate. The drop-down and 

conjunction lists displaying the criteria you can select. 

3. In the drop-down criteria list (Anywhere is the default), choose where in the message you want Eudora to 

search for text. Following is a description of each option.

Anywhere—Choose this option to search everywhere in the message including all header fields and 

message body. This includes headers that are normally exposed only with the Blah Blah Blah icon button 

turned on.

Headers—Choose this option to search only in the header fields of the message. This includes headers 

that are normally exposed only with the Blah Blah Blah icon button turned on.

Body—Choose this option to search only in the body of the message.

Attachment Name(s)—Choose this option to search only attachment names in the message.

Summary—Choose this option to search text entered in only the header From and Subject: fields of the 

message.

Status—Choose this option to search for messages by status. A status drop-down options list displays (the 

default is Unread). You can choose from Unread, Read, Replied, Forwarded, or Redirected. The 

conjunction field defaults to is. 

Priority—Choose this option to search for messages by priority. A priority drop-down options list displays 

priorities (the default is Highest). You can choose from Highest, High, Normal, Low, or Lowest. The 



conjunction field defaults to is.

Attachment Count—Choose this option to search the number of attachments joined to each message. A 

counter appears for you to select the desired number, or you can type the number in the text box. The 

conjunction field defaults to is. 

Label—Choose this option to search for messages by label. Choose Label, and the labels drop-down 

options list displays (the default is None). You can choose from the labels you previously set up. The 

conjunction field defaults to is. 

Date—Choose this option to search for messages by date. Once selected, today’s date appears. Click the 

down arrow to display the current month’s calendar. Using the arrows on the calendar, you can display the 

preceding or proceeding months and years. Choose the date to or from where you want the search to 

begin. 

Size—Choose this option to search for messages by their file size (in kilobytes). A counter appears for you 

to select the desired number of kilobytes, or you can type the number in the text box. The conjunction field 

displays is. 

Age—Choose this option to search for messages by age (in days). A counter appears for you to select the 

desired number of days, or you can type the number in the text box. The conjunction field displays is. 

Personality—Choose this option to search for messages by account. A drop-down list displaying your 

previously set up personalities appears. Select the desired personality.

Mailbox Name—Choose this option to search for messages in a specific mailbox. Enter the name of the 

mailbox in the text box.

To—Choose this option to search text entered in only the To header field of the message.

From—Choose this option to search text entered in only the From header field of the message.

Subject—Choose this option to search text entered in only the Subject: header field of the message.

CC—Choose this option to search text entered in only the Cc header field of the message.

BCC—Choose this option to search text entered in only the Bcc header field of the message.

Any recipient—Choose this option to search text entered in only the To, Cc, and Bcc header fields of the 

message.

4. After you select the option from the drop-down list, select a conjunction to link the first option with the text 

you will be searching for. 

Following is a description of each conjunction option in the drop-drop list. 

contains—If the specific item contains the text string, search and display those messages.

contains whole word—If the specific item contains the exact word, search and display those messages.

does not contain—If the specific item does not contain the text string, search and display those 

messages.

is—If the specific item is an exact match, search and display those messages.



is not—If the specific item is not an exact match, search and display those messages.

starts with—If the specific item starts with the text string, search and display those messages.

ends with—If the specific item ends with the text string, search and display those messages.

matches regexp (case sensitive)—If the specific item matches the regular expressions characters with 

case sensitivity, search and display those messages.

Regular Expression is a search string that uses special characters to match text characters. For example, if 

you are searching for messages sent to you by two people, choose From in the first drop-down options list, 

then choose matches regexp, then type their usernames between brackets separated by a vertical slash, 

e.g., (bobclark)|(janedoe) in the text box. Eudora searches and displays all messages from these 

two people. See Regular Expressions. 

Note. Regular Expressions is an advanced and complex method of searching for text. There are several web 

sites where you can get information on Regular Expressions.

matches regexp—If the specific item matches the regular expressions characters, search and display those 

messages.

is after/is before (Date only)—If the date is after or before the date displayed, search and display those 

messages.

is greater than/is less than (Age, Size, Priority, Attachment Count only)—If the specific item is greater than 

or less than the number indicated, search and display those messages. 

5. Once you have chosen the conjunction, enter the text string in messages you are searching for, or choose 

a value from the drop down list if one displays. In the text box, you can enter as much text as you want.

If you click Search, Eudora will search through all of your mailboxes for every message that contain the 

text you specified anywhere in the header portion of the message. 

6. To continue adding a second level of criteria (you can add up to five levels), click More. Choose and enter 

more criteria to further streamline the search. You can also select Match All or Match Any to include or 

differentiate the criteria from one level to the other. "Match All" will find messages that match all of the 

criteria you entered; "Match Any" will find messages that match any of the criteria you entered.

If you click Search, Eudora will search for every message through every mailbox that contains the word you 

specified anywhere but only if the text you specified is somewhere in the header. 

To continue adding a third level or criteria, click More. Choose and enter more criteria to further reduce the 

search. Click Search to display the messages that contain the criteria you entered.    You can now search 

further from the results of the search by clicking More to continue entering more criteria.

The messages that fulfill the search criteria appear in the Results window.

The Search feature will not work if you have any text boxes blank. You can click Fewer to reach a level where 

all text boxes are filled to conduct your search.

To sort the messages, click the column headings to sort by that column. To sort in descending order, click the 

column header again. 



To open a message, select and double-click the message, or right-click to display the context menu (right-click). 

Choose Open Message. 

To open the mailbox where this message resides, highlight the message, right-click to display the context menu 

(right-click). Choose Open Mailbox.

To delete a message, highlight the message and press the Delete key, or right-click to display the context menu 

(right-click). Choose Delete Message.



Auto-Completion Options Window

(Sponsored and Paid modes only)

The Auto-Completion options determine how you will use the name auto-completion feature to complete names 

and email addresses in the To, Cc and Bcc fields on the message headers of your outgoing messages. Eudora 

completes the names by looking for the names in either your history file or address book. 

To display the Auto-Completion options window, do the following:

1. From the Tools menu, choose Options.

2. Scroll and click Auto-Completion. The Auto-Completion options window appears.

    Listed below are the field descriptions for Auto-completion.

History File—Select to auto-complete names from your history file in the To, Cc, and Bcc fields in the message 

header. Deselect to not display names and email addresses from your history file in the drop-down name list. 

The history file consists of names and email addresses that appear in the To and Cc, fields in the messages 

you send, reply to, or forward. 

Address Book—Select to auto-complete nicknames you’ve previously set up in your address book in the To, 

Cc, and Bcc fields in the message header. Deselect to not display nicknames from your address book in the 

drop-down name list.

Plug-in Addresses—Select this option to make available the email addresses stored elsewhere in Eudora, for 

example in ESP.

Don’t auto-complete, just list matches—Turn this option on if you don’t want Eudora to auto-complete your 

email address as you type it. If you choose this option, you need to just type one letter, and all email addresses 

that start with that letter from your address book and history list appear in the drop-down name list for you to 

choose from.

Use drop down list for completion choices—Select to display the drop-down name list when you begin to 

type a name in the To, Cc, or Bcc fields. Deselect to not display the drop-down name list.

Names should appear in alphabetical order—Select to display names in the drop-down list in alphabetical 

order. Deselect to display names nonconsecutively.

Add the from lines of replied-to messages—Select to add the name appearing in the From field from a 

received message that you replied to. This name and email address goes into your history file. 

Time to wait before popping up Auto-Completion box (Milliseconds)—Enter the number of milliseconds 

you want Eudora to wait before displaying the window containing the address book and history file choice 

entries. The larger the number you enter, the longer the wait. If you enter 0, the window will display immediately. 

Maximum number of entries to keep in history:—Enter the number of names you want to keep in your 

history file at any given time. As you add names, the old entries are removed leaving the amount of names to 

equal the number entered here. 



Automatic Spell Checking

(Sponsored and Paid modes only)

Automatic spell check is a variation of the present inline spell check feature in Eudora. If automatic spell check 

is turned on, misspelled words are double-underlined after you press the spacebar after typing the word in the 

message body. You can correct the word or display a drop-down word list from which to choose the correct 

word by right-clicking the underlined word. 

Before you start using the automatic spell check feature, you must turn this feature on. 

To turn the automatic spell check on, do the following:

1. From the Tools menu, choose Options,

2. Scroll and select Spell Checking. The Spell Checking options window appears.

3. Select Automatically as you type.

4. Click OK. Your automatic spell check should be on.

When you type in your message and misspell a word, the word is immediately underlined after you press 

the Spacebar.

5. If you want to choose the correct word from the drop-down word list, right-click and the drop-down word list 

appears. From the drop-down word list, you can choose Ignore All to ignore the perceived error or Add to 

add the word to your dictionary. If you add the word, it will not display as a misspelled word in future 

messages.



Replying with Selected Text

If you receive a message from someone, and you would like to reply to this message by using a selected part of 

the message, you can do so by just highlighting the text you want to appear in your reply. 

To select text to include in a reply, do the following:

1. In a received message, click and drag to highlight the text you want to include in your reply.

2. Once the selected text is highlighted, choose Reply from the Message menu or click the Reply icon . The 

selected text now appears in your message reply.

3. Add more response, if needed.

4. To send, click Send (or Queue).



Match Whole Word Only

Normally, Eudora ignores a word if it is a part of a larger word when searching. If you want Eudora to consider 

the whole word when searching, check the Match whole word only option in the Find dialog box. When this 

option is checked, Eudora searches for exact matches of the word you entered.



Auto-wrapping Plain Text Messages

This feature allows a received plain text message to adjust to your computer’s display width. When you reply to 

the message, you will initially be given an excerpt bar to the left of the text. You can still adjust the width of the 

window and see the original text adjust accordingly. This feature is used only when viewing messages and 

composing messages that are sent as Replies or Forwards. 

An original plain text message with a plain text reply will be sent out as plain text only. The excerpt bar gets 

converted. Also, if both you and your recipient use Eudora 4.3 or later, format=flowed will be used on all replies.

You can disable this feature by setting the following in your [Settings] section of your Eudora.ini file:

          ConvertFormatFlowedtoExcerpt=0

          InterpretFormatFlowed=0 



Auto Name Completion in Directory Services

(Sponsored and Paid modes only) 

When looking up names in Eudora’s Directory Services, Eudora remembers the name and places it in a 

directory services history file. So whenever you begin typing a name, a drop-down list of names from your 

history file displays alphabetically. Just select the desired name from the list, and the name’s information 

appears.



Suggestions

From time to time, everyone comes up with an idea for something they'd like their software to do differently. 

This is true of all applications, no less Eudora. If you come across an idea that you think might make a nice 

enhancement to Eudora, your input is always welcome. Send any suggestions or requests for new features to 

eudora-suggest@qualcomm.com

You will receive an automated response indicating that your suggestion has been received and forwarded to our 

engineering staff. Unless additional information is needed, you will not receive a direct response.



Reporting Bugs

If you experience something you think might be a bug in Eudora, report it by sending a message to 

win-eudora-bugs@qualcomm.com or choose Report A Bug from the Help menu, Eudora displays a new 

composition window addressed to Windows Eudora Bugs at Qualcomm. If you are having technical problems 

with Eudora, just answer the questions in the email message.

You can describe what you did, what happened, what version of Eudora you have, any error messages Eudora 

gave (the numbers in parentheses ()'s are especially important), what kind of computer you have, which 

operating system you're using, and anything else you think might be relevant.

You will receive an automated response indicating that your bug report has been received and forwarded to our 

engineering staff. Unless additional information is needed, you will not receive a direct response.



Remove or Add Excerpt Bars

In an outgoing message, you now have the ability to add or remove excerpt bars right in the message.

To remove excerpt bars in an outgoing message, do the following:

1. Move the cursor to the paragraph to where you want to delete an excerpt bar or select the paragraph.

2. From the Edit menu, choose Text. The Text submenu appears.

3. From the Text submenu, choose Remove Quote Level or press the Ctrl key + . (period).

One level of excerpt bar is removed.

To add excerpt bars in an outgoing message, do the following:

1. Move the cursor to the paragraph to where you want to add an excerpt bar or select the paragraph.

2. From the Edit menu, choose Text. The Text submenu appears.

3. From the Text submenu, choose Add Quote Level or press the Ctrl key + > (greater than).

One level of excerpt bar is added.



Changing the Eudora Mode

You can choose one of three operating modes on how you wish to use Eudora. They are as follows:

Paid mode

This mode provides the full-featured Eudora desktop email client without advertising.

Sponsored mode

This mode provides the full-featured Eudora desktop email client at no charge, supported by sponsors' 

advertising. It includes all of the features that are in the Paid mode.

Light mode

This is an upgrade to the freeware version formerly known as Eudora Light. It includes fewer features than the 

other modes and a sponsor image or logo, but no advertising.

 If you bought Eudora from a retail store or from a web site, Eudora installs in paid mode. However, if you would 

like to change the operating mode, for example to sponsored mode, you can do so right in the Eudora program. 

(Remember to request a refund from QUALCOMM. See the last page of this guide for details.)

To change the Eudora operating mode after you install Eudora, do the following:

1. From the Help menu, choose Payment & Registration. The Payment and Registration window appears.

2. In the Which Eudora is right for you? section: 

§ To use Eudora in sponsored mode, click Sponsored Mode (free, with ads). Eudora displays the ad 

window. 

§ To use Eudora in paid mode, click Paid Mode (costs money, no ads). Eudora displays the Eudora 

web site for you to purchase Eudora.

§ To use Eudora in light mode, click Light Mode (free, fewer features). Eudora changes to light mode 

by shutting down certain features. The features that will be off are listed in the Light mode dialog box.

3. In the Keeping Current section:

§ To customize the ads, click Customize the Ads You See. Eudora displays a web site where you can 

provide information about yourself to help in customizing which ads should be displayed to you.

§ To find the most current version of Eudora, click Find the Latest Versions. The Eudora web site 

displays where you can retrieve the latest version of Eudora.

You can tell which mode you are in because that button is grayed out. 



Link History

(Sponsored and Paid modes only)

Link History is an option on the Tools menu that displays Internet web site URLs and ads that have appeared in 

Eudora.

To display your link history, do the following:

1. From the Tools menu, choose Link History. The Link History dialog box appears.

2. To view a link in the list, click to highlight it, then click View, or double-click the item. To remove the link 

from the list, click Remove.

If you right-click in the Link History window, a context menu (right-click) appears.

Copy—copies the link item to the clipboard.

View—displays the link item’s web site page.

Remove—deletes the link item. 

Change Date Display—displays a submenu allowing you to set reminders when to see the link, bookmark the 

link, or sort the link items by date.

Note. The items in this window expire and do not appear after 30 days.



Registering Eudora

If you are using Eudora in paid mode, you need to register to be eligible for technical support. 

To register your copy of Eudora, do the following:

1. From the Help menu, choose Payment & Registration. The Payment and Registration window appears.

2. In the Keeping Current section, click Register with Us. Eudora takes you to Eudora’s 

registration web page.

3. Enter your information, click Submit Registration. An email will be sent to you confirming your registration. 



Internet Dialup

The Internet Dialup options determine how Eudora manages your Internet telephone connection. 

To display the Internet Dialup options window, do the following:

1. From the Tools menu, choose Options.

2. Click the Internet Dialup icon. The Internet Dialup options window appears.

Have Eudora connect using Dialup networking—If this is selected, the specified dialup connection (referred 

to in Windows NT 4.0 as a "phonebook entry") is used when Eudora does any network operation. This option is 

available only if you have installed the dialup networking services with Windows 95/98 or Windows NT 4.0.

When Eudora established the connection:

Hang-up after receiving and sending—If this is selected, the connection terminates each time mail is 

retrieved and sent.

Close connection on Exit—If this is selected, the phone connection terminates when you exit Eudora.

Entry:—Use the drop-down list to select a dialup connection in this field. You must have dialup networking set 

up in Windows.

New—Select to create a new dialup networking entry. See the online user manual for information on creating a 

dialup networking entry.

Edit—Select to edit the current entry displayed in the Entry field box. For example, you would edit phone 

number. 

Only do automatic mail checks when a network connection is already established— If this is selected, 

Eudora will do an automatic mail check only if you are connected to a network.



Sorting Messages in Mailboxes

When you check your mail and new messages come into your In box or are filtered into other mailboxes, the 

new messages are placed in their mailboxes in the order in which they arrive. By default, these new messages 

appear at the bottom of the message summary list in the mailbox window. Note that this is not necessarily a 

strict date order, since occasionally messages may arrive out of date order. (The date indicates when the 

message was sent, not when you receive them.)

Similarly, when you transfer messages to another mailbox, those messages appear at the bottom of the 

message summary list in that mailbox.

You can sort messages in a mailbox by status, priority, attachment, label, sender, date, size, server status, 

subject, and group by subject. You can sort these messages in either ascending or descending order one 

column at a time or by combining several columns in the sort.

Simple Sorting

You can access Eudora’s sort feature to perform a simple sort in three ways:

By clicking the column header you want to sort. For example, if you click the Who column, senders of your 

messages are sorted in alphabetically order. 

By right-clicking anywhere on the column headings. The context menu (right-click) appears for you to choose a 

sort criteria for that column. For example, if you choose the item to sort in descending order, the mailbox sorts 

from top to bottom. 

By choosing the Sort from the Edit menu. The Sort submenu appears for you to choose a column heading to 

sort.

The normal sort order is ascending, for example, with the most current dates at the bottom of the list. If you hold 

down the Shift key and click the column header, the sorting becomes descending. You can mix ascending and 

descending sorts when sorting more than one column at a time.

In each column heading, you can choose if that heading has no sort, is sorted in ascending order, or sorted in 

descending order. Also, you can group subjects together by choosing Group by Subject, which keeps 

messages with the same subject together all the time.

Messages (including replies) with the same subject, such as a work project are kept together in the mailbox 

regardless of whether you sort by Date, Sender, and so on. A checkmark next to the Group by Subject option in 

the context menu (right-click) indicates that the option is active.

New messages that come into a sorted mailbox will automatically be placed in the correct sorted order. For 

example, if you have a mailbox sorted by date, and you want all of the messages to be grouped by subject, any 

new messages will be grouped with other messages containing the same subject in a chronological. 

You can also sort message in the Find Messages window when the Results panel is active. 

Complex sorting

You can perform complex sorting by holding down the Ctrl key and click one column, then another column, and 

so on. The columns are sorted in the order you clicked on them. For example, if you click the Subject column 

first and then the Date column, the subjects in this mailbox sort alphabetically and then chronologically. You will 



notice numbers in each column header indicating the order of the sort. 

To perform a complex sort, you can click two columns or all eight! To cancel the sort, just click on the column 

that displays 1. All the sort criteria will cancel.



Using SMTP Authentication

SMTP authentication operates automatically in Eudora.

Eudora can log in to an SMTP server when sending mail, just like it does for receiving mail. Not all SMTP 

servers require or allow such authentication. Eudora will attempt authentication to servers that allow it. The 

preferred SMTP authentication method is CRAM-MD5. If CRAM-MD5 is not available, LOGIN or PLAIN will 

automatically be used. Once Eudora discovers that your SMTP server allows authentication and when you 

send messages, a dialog box appears that prompts you to enter a password.

If for some reason you prefer that Eudora not attempt to login to your SMTP server, you can tell it not to do so 

by doing the following:

1. From the Tools menu, choose Options, then Sending Mail. The Sending Mail options window appears.

2. Turn off the Allow Authentication.

3. Click OK. 

If you turn off the Allow Authentication option, you may not be able to send mail. Please check with your email 

administrator or ISP if you have any difficulties.



Regular Expressions (Sponsored and Paid modes only)

When searching for messages or defining a filter in Eudora, an option you can use is regular expressions. 

Following is a description of regular expressions and how they are used in Eudora.

    There are two functions in Eudora where you can use regular expressions:

§ Filters window¾ Located in the drop-down list where you indicate the relationship between a mail header 

and a piece of text (for example, the "Subject" contains Eudora, "Any Recipient" is joe@xyz.com, and so 

on). There are two regular expression criteria in that list, namely "matches RegEx" and "matches RegEx 

(case insensitive)."

§ Find Messages window¾ Located in the center drop-down list. The option "matches regexp" appears. In 

the Find Messages window, regexp is not case sensitive.

There are various standard implementations of regular expressions, but Eudora uses the POSIX 

implementation. Following are symbols that are supported in Eudora.

. (period) represents any one character.

[ ] (brackets) contain a set of characters from which a match can be made.    It corresponds to one character in the 

search string.

\ (backslash) is an escape character which means that the next character will not have a special meaning.

* (asterisk) is a multiplier.    It will match zero or more of the previous character.    (Note that it's not a wildcard character 

as in file names.)

? (question mark) is a multiplier.    It will match zero or one of the previous character.    (Note that it's not a wildcard 

character as in file names.)

+ (plus) is a multiplier.    It will match one or more of the previous character.

{ } (squiggly brackets) contain a number which specifies an exact number of the previous character.

[^] (brackets containing caret and other characters) means any characters except the character(s) after the caret symbol 

in the brackets.

^  (caret) is the start of the line.

$ (dollar) is the end of the line.

\< represents the start of a word.

\> represents the end of a word.

[:alpha:] represents any alphabetic letter.

[:digit:] represents any single-digit number.

[:blank:] represents a space or tab.

| (pipe) is OR.    It requires that the joined expressions have parentheses around them.

Here are a few examples:



E.*a matches Eudora, Etcetera, Ea

ho+p matches hop, hoop, hoooop, but not hp

etc\. matches etc. but not etc

e.a matches eta, eda, e1a; it only matches Eta if the matching is case-insensitive

[eE].a matches eta and Eta



MoodWatch Options Window

In the Mood Watch options window, you can determine at what level you wish your messages to be monitored 

before a warning appears telling you that, perhaps, your message content may be offensive to your recipient. 

Also, you can set Mood Watch to monitor incoming and stored messages for offensive content. You can also 

set Eudora to hold messages that contain offensive text for ten minutes before you send them. 

If you don't want to use Mood Watch at all, you can turn it off in this dialog. Also, you can choose if you want to 

use Mood Watch for incoming messages only, outgoing messages only, or both.

To display the Extra Warnings settings dialog, do the following.

1. From the Tools menu, choose Options.

2. Scroll and click the Mood Watch icon. The Mood Watch settings window appears.

Select the settings you want to change. Settings are described below.

Enable Mood Watch—If checked, Mood Watch is on. To turn Mood Watch off, just uncheck the box.

Warn when queueing/sending—The following options warn you when MoodWatch detects anything that may 

be offensive in your message. 

Message seems like it might be offensive—Turn this option on to set MoodWatch to its most sensitive 

level. If your message has some content that looks like it might be offensive (one chili pepper appearing), 

you will be warned when you queue it.

Message is probably offensive—Turn this option on to set MoodWatch to a medium sensitivity level. If 

your message has some content that looks like it is offensive (two chili peppers appearing), you will be 

warned when you queue it.

Message is on fire—Turn this option on to set MoodWatch to a low sensitivity level. If your message has 

some content that is offensive (three chili peppers appearing), you will be warned when you queue it.

Never—Turn this option on to never display a warning in your outgoing messages, despite offensive text 

in its content.

Delay when queuing/sending—The following options allow you to delay sending an offending message giving 

you time to "cool off." During the delay period, you can either delete the message or send it. After the delay 

period is over, your message will be sent.

Message seems like it might be offensive—Turn this option on to delay a message to be sent when 

MoodWatch is at its most sensitive level. If your message has some content that looks like it might be 

offensive (one chili pepper or more appearing), your message will sit in your Out box for ten minutes 

before Eudora sends it.

Message is probably offensive—Turn this option on to set MoodWatch to a medium sensitivity level. If 

your message has some content that looks like it is offensive (two chili peppers or more appearing), your 

message will sit in your Out box for ten minutes before Eudora sends it.

Message is on fire—Turn this option on to set MoodWatch to a low sensitivity level. If your message has 

some content that is offensive (three chili peppers appearing), your message will sit in your Out box for 



ten minutes before Eudora sends it.

Never—Turn this option on to never delay your outgoing messages being sent, despite offensive text in 

its content. This is the default.

Scanning incoming mail

Scan new mail as it arrives—Turn this option on to allow MoodWatch to scan all of your incoming mail. 

MoodWatch determines the level of offensive text contained in the message. MoodWatch then displays 

one, two, or three chili peppers in the MoodWatch column of the mailbox where the message resides.

Scan stored mail in the background—Turn this option on to allow MoodWatch to scan all of your 

stored messages. MoodWatch determines the level of offensive text contained in each message. 

MoodWatch then displays one, two, or three chili peppers in the MoodWatch column of the mailbox 

where the message resides.



Statistics

You can now display and print your Eudora usage statistics. These statistics keep track of how many messages 

you receive and send in a particular day, week, month, or year. You can also see how many attachments were 

received and sent as well as how many messages were read. In the Sent Email section, you can see how many 

messages you have replied to, forwarded, and redirected during a specific timeframe.

Note. Eudora usage statistics are statistics for you only. No statistical information is sent to Qualcomm or 

any other web site address. 

Displaying the Statistics Window

To display the Statistics window, do the following:

1. From the Tools menu, choose Statistics. The Statistics window appears.

2. From the drop-down menu, choose to see email usage statistics for the Day, Week, Month, or Year.

3. To see more statistical information, for example Attachments received, check the More Statistics box.

Printing the Statistics Report

To print the information in the Statistics window, do the following:

· With the Statistics window open, go to the File menu and choose Print. Your Statistics report will print.

Changing your Statistics Options

· To change your statistics options, go to Statistics Options Window. 



Statistics Options Window

In the Statistics options window, you can choose the color and graph type you prefer when displaying and 

printing the Statistics window found in the Window menu. The Statistics window displays your email usage, that 

is the statistics on received, sent, and general Eudora usage. You can display this information for the current or 

previous day, week, month, or year.

To display the Statistics settings dialog, do the following:

1. From the Tools menu, choose Options.

2. Scroll and click the Statistics icon. The Statistics options window appears.

Choose the options you want to change. Options are described below.

Series—This column lists the different timeframes displayed in the Statistics window. Current refers to the 

current day, week, month, or year, as selected in the Statistics window. Previous refers to the previous day, 

week, month, or year, as selected in the Statistics window. Average is the cumulative average that occurs on a 

day-to-day basis. For example, if you choose to view your statistics for each day, the current graph would be 

today, and the previous graph would be yesterday. The average graph would indicate the cumulative average 

since you began keeping statistical information in Eudora.

Color—Choose the color you wish to represent the current, previous, and average criteria.

Graph Type—Choose the graph type you prefer to display for the current, previous, and average criteria. The 

graph type you choose will appear in the color you chose in the Color column. The graph types you can choose 

are a line, a solid (filled) area, a graph bar, a circle, diamond, or a square.

Count IMAP messages in Inbox only— Turn this option on if you want Eudora, for statistical purposes, to 

count only the IMAP messages received in the Inbox. Turn this option off if you want Eudora to count all 

received IMAP messages regardless of which mailbox they are received into.

Reset Statistics—Click this button to reset your statistical usage. All historical information on your Eudora 

usage is deleted. Statistical information will then begin from that moment on. 



Using MoodWatch

When you open a new composition window to begin writing a new message, MoodWatch scans each word and 

phrase you type and determines if it might be offensive to your recipient. The level of offensiveness is indicated 

by the appearance of one, two, or three red chili peppers, with three red chilies being the most offensive and 

one the least. As you write, chili peppers appear next to the Send or Queue button.

Less offensive phrases are underlined with a green squiggly line and more offensive phrases are underlined in 

both a red and green squiggly line. 

After you click Send or Queue, a warning appears indicating there is offensive text in your email message. 

To send the message despite the offensive text, click Send Anyway. Your message is sent. If you have Eudora 

set to Queue messages for later transmission, you can still retrieve the message in the Out mailbox to edit or 

delete it. You can then send the message or requeue it. 

To return to the composition window without sending or queueing the message, click Cancel.

By changing the options in the MoodWatch settings dialog, you can have MoodWatch scan your incoming 

messages for offensive text as well. The indicators are one, two, or three chili peppers appearing in the mailbox 

message summary column.

Also, by turning on an option in the MoodWatch options, you can have MoodWatch scan and display chili 

peppers on all of your stored mail. 

See   MoodWatch Options Window.   



Adding a Group to the Address Book

You can set up a group as an address book entry by adding the group’s email addresses or nicknames (if 

already set up in your address book) in the Personal dialog box.

To create a new group in an address book, do the following:

1. From the Tools menu, choose Address Book, or press Ctrl + L. Or, if the Address Book is in an inactive 

window in an open tabbed window group, click its tab.

2. In the Address Book, choose which address book (if more than one is set up) in which you want this 

group's information listed. Click New.

3. Type the nickname in the Nickname text field on the right side of the window, for example "My buddies." 

The nickname entry appears in the list, and you can now add information for this entry.

4. When finished, click anywhere or press Enter and the nickname appears in the list.

5. Click the Personal tab. The Personal dialog box appears. In the Full Name field, type the a descriptive or 

an informal name for the group. This name is included in the "To" field for your recipient to see.

6. In the This nickname will expand to the following addresses text field, type the complete email address 

for each person included in the group. Separate multiple addresses with commas or carriage returns (this 

is the only place you can use a carriage return to separate addresses). You can also use nicknames in this 

field, but be sure that any nicknames you use are defined by their own entry. You can use a mixture of 

nicknames and complete email addresses.

Make sure this field contains no other information except addresses and nicknames, or your messages will 

be addressed incorrectly.

7. If you want to put this group on your recipient list, check the Recipient List box. The group’s name is 

bolded in the address book list.



Introducing ESP

Eudora Sharing Protocol (ESP) is a Eudora feature that allows a group of people, called a share group, to 

collaborate and share a common set of files. ESP automatically gives each member of the share group a copy 

of those files, and when one of the members changes a file, it brings all the other members' copies up to date 

automatically. ESP also makes it easy for the members of a share group to send email messages to each other. 

Unlike other collaboration tools, ESP uses only email to keep everyone in sync on the shared files, so there's 

no need to maintain and administer a shared server. 

ESP allows you to create and manage share groups within Eudora, on both Windows and Mac platforms. If you 

send and receive email through Eudora, you can belong to an ESP share group.

When you join an ESP group, you designate a shared folder on your hard drive. Eudora uses the shared folder 

to keep the most current copies of your group’s documents together. You and each member of your group have 

copies of the shared documents. When you or a member of your group adds, deletes, or updates a document, 

ESP automatically adds, deletes, or updates all copies of the document in all of the members’ shared folder.

You can use ESP for projects at work and for family members at home to help them stay in touch. For example, 

you can create a share group by inviting members of your family to share their most current photos with each 

other. When one member of the family adds a digitized photo to his or her shared folder, all members of the 

family can see it. It’s like maintaining a family album that can be shared with members of family no matter 

where they live. 

When communicating between members of your group, email messages from the group members are 

automatically routed to the mailbox of your choice. However, you can assign only one mailbox per group.

You do ESP functions from the ESP Group window found on the Tools menu. These are the basic tasks in 

creating and maintaining a share group:

§ Create a share group.

§ Assign the share group a mailbox in Eudora and shared folder on your hard drive, for example, your C:\ 

drive.

§ Invite members to join the share group.

§ Configure how ESP will update the shared folders.

§ Configure how your group members are notified of changes to the shared folder.

§ Maintain group membership by inviting or deleting members, or by synchronizing all shared folders.

However, you may be asked to join a share group. If so, answer the invitation and the you can create a new 

shared folder and mailbox. 

Important: You can only belong to a group on one computer. For example, you can use your home computer to 

set up a group for family photos, and you can use your work computer to set up a group for a work related 

project. However, you cannot use both your home and work computer to view your family photos in your family 

group. If you try to do that, one or both computers will miss some of the photos.

However, if you have two different email addresses, you can belong to a share group on more than one 

computer. If you check mail with one email address at work and a different address at home, you just need to 



invite yourself to the share group twice, once for each address. Once you’re in the group with one account, you 

can send an invitation to your other account yourself. ESP will treat your two accounts as two different share 

group members, and each will receive all the updates.



Installing ESP

ESP should install automatically into the Eudora Plugins folder. However, if you need to install ESP yourself, do 

the following:

§ To install ESP on Windows, copy the ESP.dll file to the Plugins folder, located in your Eudora folder. 



Tips on Using ESP

Although ESP is a valuable tool for you and your group when working on the same document or file, there are 

some limitations. Here are a few tips on using ESP that will make working on group files more efficient.

§ Do realize that the ESP folder is shared. If you take a file out of the shared folder, it will be removed from 

each member's shared folder.

§ Do invite people to be in your group. Some of them might have to become familiar with ESP before 

becoming full members. As they are gaining experience, tell them how to become full members.

§ Do use ESP to keep a shared list of current email addresses for group mailings. ESP updates email 

addresses when you change the email address for a personality. When saved in the ESP Group window, 

ESP asks you if you want to update both your ESP's information and other members' information or just 

update your ESP information. If you choose both, an email message is sent to all group members and 

automatically updates your changed email address.

§ Do use ESP as a mini-mailing list for, perhaps, a family, group of friends, coworkers and so on. The list of 

email addresses stays current in all of the members' lists when the addresses are modified.

§ Don't put large files in ESP. Other members of your group may have mail systems with limits on file size.

§ Don't put files in ESP where group members need to work on them at the same time. ESP works best 

when one member works on one file at a time.

§ Don't put files in ESP that need to be updated in realtime. There will be a few minute delay in updated 

group files.



Creating an ESP Group

You can create an ESP group and then invite members to join it. All members of an ESP group are of equal 

importance. Although you are creating the ESP group, it does not mean that you are its leader.

When you create a group, ESP assigns the group a unique identifier, which avoids any naming conflicts.

To create a new group, do the following:

1. From the Tools menu, choose ESP Groups. The ESP Groups window appears.

2. In the ESP Groups window, click New (located at the bottom of the window). The Share Group Settings 

dialog box appears.

3. Choose Create a brand new share group, then click Next. The Share Group Name dialog box appears.

4. In the Share Group Name text box, type the name of your group, then click Next. The Share Group 

Description dialog box appears.

5. In the Share Group Description text box, type a brief description of the group purpose or file contents; 

then click Next. The Share Group Mailbox dialog box appears.

6. Do one of the following:

§ If you want to create a new mailbox for all group messages, choose Transfer to New Mailbox and type 

the name of the mailbox in the text box.

§ If you want all group messages to go to an existing mailbox or a new mailbox in a different location, 

choose Transfer to Existing Mailbox, then click the long gray button. A list of your existing mailboxes 

appears. Right-click to create a mailbox in a different location. Click to select a mailbox, then click OK to 

enter it in the text box.

You can’t transfer messages to either the In mailbox or a mailbox already assigned to another group. 

7. Click Next. The Share Group Folder dialog box appears.

8. Do one of the following:

§ If you want to create a new folder to store all group files, choose Use New Folder and type the name of 

the folder in the text box.

§ If you want to create a new folder in a location other than the one shown under Use New Folder, switch 

to My Computer or Windows Explorer, create the folder, and switch back to Eudora. Choose Use 

Existing Folder to navigate to the folder you’ve just created, then choose it.

§ If you want to store all group files in an existing folder, choose Use Existing Folder and click the long 

gray button. A list of your existing folders appears. Click one of the folders and to enter it in the field, 

click OK.

You can’t use a folder already assigned to a group or a folder that’s inside of another folder already 

assigned to a group.

9. Click Next. The Success dialog box appears. 



10. Click Finish. Your new share group is created.

The share group name appears in the list view attachment of the groups window.



Creating an ESP Group (Advanced Setup)

After you feel comfortable creating groups, you can bypass it and enter the group information directly. 

To use the Advanced Group Setup function, do the following:

1. From the Tools menu, choose ESP Groups. The ESP Groups window appears.

2. Click New (located at the bottom of the window). The Share Group Settings dialog box appears.

3. Choose Skip directly to advanced share group setup. The New Group dialog box appears.

4. Type the new group name in the Group Name text box.

5. Click the Shared Folder long gray button and choose a folder for this group. Click OK. 

6. Click the Mailbox long gray button and choose a mailbox for this group messages. Click OK.

7. Click the Personality long gray button and choose the Eudora personality you want linked with this group. 

Click OK.

8. In the Description text box, type a brief description of the group function or contents (optional).

9. Click OK. 

ESP adds the new share group to your list of groups. The share groups you create are listed in the ESP Groups 

window in the left column.



Inviting Members to Join Your Group

To be fully functional, your group must contain members in addition to yourself. Once you invite someone, you 

can determine at what level a role they will play within the share group. You can invite members to the group 

who can receive only the group messages. 

To invite users to join your group, do the following:

1. From the Tools menu, choose ESP Groups. The ESP Groups window appears.

2. In the left column, choose the Group name to which you want to invite members. 

3. Click the User tab. The User dialog box appears.

4. Click Invite. The Share Group Role Settings dialog box appears.

To add a user to receive the group messages only, press the Shift key while clicking Invite. The Advanced 

Add dialog box appears where you can enter the person’s name and email address. The user’s name and 

email address is stored in your Users list, but ESP doesn’t send an invitation. This user receives only email 

messages that have the group shared documents as attachments. 

5. You can determine which tasks each invitee to your group can do. In the Initial Role area, choose of the 

following roles:

§ No Preference

§ Full Membership (user sends and receives updates). This allows the person you invite to receive from 

and send files to the group, either automatically or manually.

§ Broadcasting Member (user only sends updates, ignores any incoming updates). This allows the 

person you invite to send files top the group only, either automatically or manually. Incoming files are 

ignored.

§ Receiving Member (user never sends updates, but processes incoming updates). This allows the 

person you invite to receive files from the group only. Any changes you make to the shared folder are 

ignored.

The system default is No Preference.

6. In the Notifications area, do the following:

§ If you want ESP to notify the person you invite when updates are coming into your shared folder, check 

the Ask before processing any updates INCOMING TO my shared folder box. This box is checked 

by default. 

§ If you want ESP to notify the person you invite when updates are going out of your shared folder, check 

the Ask before processing any updates OUTGOING FROM my shared folder box. This box is 

checked by default.

§ If you want ESP to warn you when the potential member attempts to change role type, check the Prefer 

that user does not change role (displays warning) box. If checked, the member can change role 

type but is discouraged to do so. 



7. Click OK. A message window opens that contains an invitation message for the selected group. This 

message has a special attachment containing the group invitation. 

8. In an open message window, enter the email addresses of the invitee(s) in the To: header.

When an invitee accepts the invitation, information contained in the attachment creates a group entry in the 

invitee’s Groups window and prompts him or her to specify a group folder and mailbox. ESP sends an RSVP 

message back to the inviter. The inviter then sends an updated copy of the membership list to all the members.



Configuring Shared Folder Settings

Every group member needs a shared folder on his or her hard drive to store documents, schedules, messages, 

illustrations, images, or any other file the members deem necessary for sharing. ESP allows you and your 

group members to determine how often ESP checks each member’s shared folder for updates, and how the 

information in the shared folders is backed up.

To configure shared folder settings for your group, do the following:

1. From the Tools menu, choose ESP Groups. The ESP Groups window appears.

2. In the left column, choose the Group name whose shared folders you want to set. 

3. Click the Settings tab. The Settings dialog box appears.

4. Check the Check shared folder for changes every _ minutes box and specify the time interval at which 

you want ESP to check the shared folder for group updates. If this option is not checked, ESP won’t check 

the shared folder. The system default is for ESP to check the shared folder every 10 minutes.

5. If you want ESP to automatically create a backup when other members update files in the shared folder, 

check the Auto-Backup updated documents box. The box is checked by default.

6. If you want ESP to automatically back up deleted documents from the shared folder, check the Auto-

Backup deleted documents box. The box is checked by default.

7. In the Store up to _ previous versions text box, indicate the number of previous document versions you 

want Eudora to store. The system default is one version.



Configuring Group Change Notifications

You can specify the role you want to play in the group, which determines whether or not you can send or 

receive updates to the shared folder. When you’ve determined your ESP role, you can then decide how you 

want ESP to handle updates to the shared folder and group membership.

1. From the Tools menu, choose ESP Groups. The ESP Groups window appears.

2. In the left column, choose the Group name whose change notifications you want to set for your role. 

3. Click the Notifications tab. The Notifications dialog box appears.

4. Click one of the following in the Role area: 

§ Full Membership (user sends and receives updates). This allows you to receive from and send files to 

the group, either automatically or manually.

§ Broadcasting Member (user only sends updates, ignores any incoming updates). This you to only 

send files to the group, either automatically or manually. Incoming files are ignored.

§ Receiving Member (user never sends updates, but processes incoming updates). This allows you to 

only receive files from the group. Any changes you make to the shared folder are ignored.

§ Custom Member (use the settings in the Advanced tab). Go to step 6.

The Full Member role is the default.

5. In the Notifications area, do the following:

§ If you want ESP to notify you when updates are coming into your shared folder, check the Ask before 

processing any updates INCOMING TO my shared folder box. This box is checked by default. 

§ If you want ESP to notify you when updates are going out of your shared folder, check the Ask before 

processing any updates OUTGOING FROM my shared folder box. This box is checked by default.

§ If you want ESP to monitor any of the group actions, check the Log any group actions box. The box is 

checked by default. A log file is created and placed in a subfolder in the Eudora folder.

§ If you want ESP to notify you prior to changes in the group’s membership, check the Ask before 

responding to a membership update box. The box is checked by default.

§ If you want ESP to record all changes to group membership, check the Log any membership update 

box. A log file is created and placed in a subfolder in the Eudora folder. The box is checked by default.

If you chose Custom Member as your role, you must click the Advanced tab to display the Advanced 

dialog box to configure your role settings. In this dialog box, you are required to make various decisions 

about how you want ESP to handle modifications to the shared folder. It also enables you to choose 

how ESP should track group membership. 

6. In the Shared Folder Action (Custom Member) area, do the following:

§ Determine which type of incoming or outgoing items—New Items, Updated, or Deleted Items—you 

want ESP to handle.



§ From the drop-down lists, choose one of the following:

§ To have ESP notify you before specific files in the shared folder are added, updated or deleted, 

choose Ask first.

§ To have ESP modify specific files in the share folder automatically, choose 

Do file updates.

§ To have Eudora ignore proposed updates to specific files in the shared folder automatically, choose 

Ignore file updates.

7. If you want Eudora to record the activity for each type of incoming or outgoing item, check the Log box. 

The system default options from the drop-down menus for all incoming and outgoing menus correspond to 

the last chosen options you selected in the Notifications dialog box. The Role buttons combined with the 

Ask before processing any updates INCOMING TO my shared folder and Ask before processing any 

updates OUTGOING FROM my shared folder are then equal to the choices in the drop-down menus. The 

Advanced tab dialog box allows you to add, update, and delete settings independently of each other. 

Whereas in the Notifications dialog box, while simpler, keeps the settings locked. For example, you could 

use the Advanced tab dialog box to specify that you want to be asked when a delete occurs, but not when 

additions and updates occur. 

8. To set a group password, click Set Shared Secret. The Set Shared Secret dialog box appears.

9. In the text box, enter a secret word or phrase that will be known only to you and the other members in your 

group. You will need to share the secret word or phrase with the other group members. The secret word or 

phrase is used to make the transmission of file changes more secure so that ESP can verify any incoming 

file changes were actually sent by a group member.

If your shared secret does not match the shared secret of other group members, you will get a security 

error when you receive file changes from them. So if you choose to use a shared secret word or phrase for 

improved security, be sure that all group members set the exact same shared secret word or phrase. The 

secret word or phrase is case-sensitive. 

10. When finished, click OK. 



Maintaining ESP Group Members

In the User dialog box in the Groups window, you can maintain your group members by deleting them from the 

group, inviting new members, or by syncing the selected member’s shared folder.

To maintain group members, do the following:

1. From the Tools menu, choose ESP Groups. The ESP Groups window appears.

2. In the left column, choose the group whose users you wish to maintain.

3. Choose the Users tab. The Users dialog box appears, and a list of members of the selected group 

appears.

4. In this dialog box, you can do all of the following:

§ Invite—To invite a new ESP member to join the group, click Invite. See Inviting Members to Join Your 

Group.

§ Delete—To delete group members, choose the member’s name and click Delete. You should use this 

function to delete invalid members. To preserve group participation and communication, use the Delete 

function sparingly. In most situations, the departing group member uses the Leave function to notify all 

group members of the departure from the group. The Delete function bypasses this process.

§ Sync Folder— To send the entire contents of your shared folder to another group member, choose the 

member’s name and click Sync Folder. 

Note. ESP updates email addresses when you change the email address for a personality. When saved in 

the ESP Group window, ESP asks you if you want to update both your ESP's information and other 

members' information or just update your ESP information. If you choose both, an email message is 

sent to all group members and automatically updates your changed email address.



Joining an ESP Group

ESP manages group membership through a shared mailing list, allowing group members to share files and 

messages. ESP creates the mailing list through a series of processes, called invitations, ensuring that each 

member of the group has explicit knowledge of group membership by acknowledging and approving each new 

member.

To join an existing group, do the following:

1. Wait for an email message from one of the group members inviting you to join their group. The Join ESP 

Share Group dialog box automatically appears after Eudora is done receiving the email message.

2. To join the group, click Join. If you don’t want to join, click Cancel.

ESP prompts you to join the group by opening the New Group Wizard. Choose a folder to store your copies of 

the shared documents and a mailbox to receive messages associated with the group. See " Error! Reference 

source not found."    on page Error! Bookmark not defined. for details.

ESP processes the invitation, adds you as a member of the group, and sends an RSVP message to the 

member who invited you to join. When the inviter's copy of ESP receives your acceptance, you'll be sent a 

membership update message which will add the other group members to your list.

Until you receive an introduction from another group member, ESP doesn’t associate those members with you 

as part of the group.

When all introduction messages are received and answered, you are a member of the group.



Leaving an ESP Group

When you want to leave a group, ESP removes the group from your list of available groups and sends a 

message to the other group members asking them to remove you from the group.

To leave a group, do the following:

1. From the Tools menu, choose ESP Groups. The ESP Groups window appears.

2. In the left column, choose the name of the group you want to leave. 

3. Click Leave (located at the bottom of the Groups window). The Leave Share Group dialog box opens.

4. In the Leave Group dialog box, click Leave. 

ESP creates a message to other group members announcing your departure from the group. This message’s 

attachment deletes you from other group members’ membership lists. 

Until you save changes to the ESP Groups window, you can cancel your departure from the group. Just choose 

the share group that you had planned to leave and click Rejoin, which is what the Leave button will be 

renamed when you chose this group. 

If you're sure you want to leave the group, then save changes to the ESP Groups window by either closing the 

window and choosing Save in the displayed dialog box or by choosing Save from the File menu. ESP will send 

a message to other group members announcing your departure from the group.



Working with Shared Folders

Use the shared folder like any folder in Windows by adding, modifying, or deleting files as needed.

To open the shared folder, do the following:

1. From the Tools menu, choose ESP Groups.

2. In the left column, choose the name of the group you want to open and click Open Folder. The Save 

Changes dialog box opens if you have any unsaved changes to the shared folder. If not, the shared folder 

opens, allowing you to access its files.

ESP periodically scans the folder for changes, according to your settings, and sends the updated files to 

other group members. 

3. To update the shared folder of another group member manually, choose the member from the Users dialog 

box and click Sync Folder. This sends the entire contents of the shared folder to the selected member.

As ESP receives periodic changes to the shared folder from other users, it incorporates the changes according 

to the settings you chose for the group (for example, with or without notification, and with or without archiving).



Changing ESP Group Information

ESP allows you to change the configuration of a share group to meet the changing needs of its members. The 

same tabs (User, Eudora, Settings, Notifications, and Advanced) you used to create a share group and 

configure its attributes can be used to change those of an existing group.

To make changes to an existing share group, do the following:

1. From the Tools menu, choose ESP Groups. The ESP Groups window appears.

2. In the left column, choose the group you wish to change.

3. Click any of the tabs and make your changes in their respective dialog boxes.

4. When finished, click OK.



Configuring ESP Global Settings

You can control the type of messages received by the shared folder through the use of filters and automatic 

processing actions. 

It is recommended that you retain the default settings. 

To configure your group settings, do the following:

1. From the Tools menu, choose ESP Groups. The ESP Groups window appears.

2. Click Settings (located a the bottom of the ESP Groups window). The Group Setting dialog box appears.

3. In the ESP Automatic Filters Precedence area, choose Run automatic filters before user filters or the 

Run automatic filters after user filters. Depending on which option you activate, ESP filters incoming 

messages into the shared folder either before or after your own filters take effect. To run the automatic ESP 

filters before your personal filters is the default.

4. In the Automatic Actions area, check the Allow automatic processing of incoming attachments box if 

you want the shared folder updated automatically with email message attachments as specified in the 

Settings dialog box. The default is to automatically process incoming attachments.

5. If you want your shared folders scanned automatically at the frequency you specified in the Settings dialog 

box, check the Allow automatic scanning of shared folders box. The system default is to allow 

automatic shared folder scanning.



Using the ESP Mailbox and Folder

When you create or choose a mailbox for the ESP group, two tabs appear in the window as well as an icon. 

One contains all the messages in the mailbox, and other contains the shared folder and its files. The icon 

displays the ESP menu. 

When you click the Mailbox tab, messages associated with this group appear. While in the ESP mailbox, you 

can perform all the tasks and functions as in any other Eudora mailbox.

When you click the Folder tab, a browser window appears containing the shared folder and its files. 

When you click the icon, the ESP menu appears. From this menu, you can choose to perform the following 

tasks for the group:

§ New Message—Opens a new composition window addressed to the group for you to type a message.

§ Open Folder—Opens your shared folder in a new window.

§ Invite—Invites a new member or members to join the group.    See Inviting Members to Join Your Group. 

§ ESP Groups—Opens the ESP Groups window.

§ Update Others—Updates the files in other members’ shared folders.



About Security

Eudora supports Secure Sockets (SSL), a security protocol for transferring information. SSL allows you to 

authenticate the server that sends and receives your email messages. Also, SSL is used to encrypt mail 

transfers so no one can read your messages while they are being sent to or received from your mail server. 

SSL uses a security certificate system, just as most web browsers, to authenticate and encrypt your messages. 

Valid certificates should be present for SSL to work properly. These certificates are included in SSL and are 

usually updated by your ISP, email administrator, or Eudora. Valid certificates come with Eudora, and more will 

be provided to you as needed.

For your dominant personality, Eudora supports SSL through the Checking Mail and Sending Mail options 

window.

For any other personality, Eudora support SSL through the Account Settings dialogs accessed from the 

Personalities window. When you set up a new personality, Eudora will be able to detect if the POP, IMAP, or the 

SMTP server for that personality supports SSL depending on which SSL setting you choose.

 
 Using SSL for your Dominant Personality

To access SSL settings for your dominant personality, do the following:

1. From the Tools menu, choose Options. 

2. For SSL when receiving mail, scroll and choose Checking Mail. The Checking Mail options window 

appears. 

For SSL when sending mail, scroll and choose Sending Mail. The Sending Mail options window appears.

3. In the Secure Sockets when Receiving (or Sending) field, click the down arrow to display the drop-

down menu. 

Following is a description of each option on the SSL drop-down menu:

Never— Do not use SSL for server authentication and mail transfer security, even if SSL is available on 

the server. 

If Available STARTTLS (default)— Use SSL for server authentication and mail transfer security by having 

Eudora automatically invoke the STARTTLS command method to start SSL, that is, if the server supports 

STARTTLS. If your server doesn’t support STARTTLS, mail transfers will occur successfully, but they will 

not be secured with SSL.

Required, Alternate Port— Use SSL for server authentication and mail transfer security by having 

Eudora automatically use the older style alternate port method for starting SSL. If your server does not 

support SSL on the appropriate ports, mail transfers will fail. 

Required STARTTLS— Use SSL for server authentication and mail transfer security by having Eudora 

automatically invoke the STARTTLS command method to start SSL. If your server does not support 

STARTTLS, mail transfers will fail. 

Important. If you use SSL and cannot make a connection when receiving or sending mail, you may need to 



check with your ISP to update any invalid SSL certificates. However, to override any issues with SSL 

when retrieving or sending mail, choose Never from the drop-down menu to make a successful 

connection.

To display the most current information for an SSL connection between a server and Eudora since the last time 

you started Eudora, click Last SSL info. The Eudora SSL Connection Information Manager window appears 

with SLL and certificate information. 

If you display the SSL information windows, make certain you don’t change any of the field information unless 

you are familiar with SSL.

Using SSL for Your Other Personalities

To access SSL settings for any other personality, do the following:

1. From the Tools menu, choose Personalities. The Personalities window appears. 

2. For an existing personality, highlight the personality and choose Properties from the context menu. 

3. For a new personality, right-click anywhere in the Personalities window to display the context menu. 

Choose New and then choose Skip directly to advanced account setup. The Account Settings Generic 

Properties dialog appears.

4. For SSL when sending mail, scroll and choose Sending Mail. The Sending Mail options window appears.

For SSL when receiving mail, choose Incoming Mail tab. The Checking Mail options window appears.

See above the for the option descriptions for the SSL drop-down menus.



Import

Displays the Import Mail and Addresses dialog box to import your messages and address book from Netscape 
Communicator and Microsoft’s Outlook ’98, Outlook Express, and Outlook 2000. 



Payment and Registration

Displays the Payment and Registration window where you can change the mode of Eudora you are using and 
register Eudora.



Link History

Displays the Link History window where you can choose ads and Internet links to open.



Report A Bug

Displays a new composition window addressed to Windows Eudora Bugs at Qualcomm. If you are having 

technical problems with Eudora, just answer the questions in the email message.



Priority

Specifies the priority of the message as it appears in the mailbox window.



BLAH, BLAH, BLAH Icon

Click this button to expand and display all message headers for this message.



Font Size Button

Click this button and choose a size from the popup menu to change the selected or current text to that size. 

Choices are Very Small, Small, Medium, Large, Larger, Very Large, and Humongous.



Typewriter Button

Click this button to change the selected or current text to the fixed-width (typewriter-style) font set in the Fixed-

width field of the Message portion of the Fonts Options (Tools:Options:Fonts). Fixed-width fonts are useful for 

composing and reading aligned text, such as in columns and tables.



Fixed Width Button (FW)

Click this button to convert the entire message text to a fixed-width (typewriter-style) font. Fixed-width fonts are 

useful for viewing aligned text, such as columns and tables. Note that this option does not edit the message but 

only changes the view mode while the message is open. Eudora turns the FW button off when you close the 

message.



Pencil Button

Click this button to edit the message text. When you are finished editing, select Save from the File menu, or 

press Ctrl+S, to save your changes. If you close the message without saving changes, Eudora prompts you to 

save or discard your changes. You cannot edit the message headers: only the message body text. Once you 

save your changes, you cannot undo the editing, so edit messages with care.



Insert Object Button

Click this button and select Picture... or Horizontal Line from the popup menu to insert a picture or horizontal 

rule at the current cursor position in the message body. Pictures, once inserted, can be dragged around within 

the message. A horizontal line is inserted on a line by itself. Note that whether or not your recipient can see the 

inserted object depends on the viewing capabilities of his or her email package and computer.



Word Wrap Icon

If this is on, a carriage return is not required at the end of each line. When the message is sent, the text is 

automatically "wrapped," meaning that carriage returns are inserted at the end of each line of text, with roughly 

76 characters per line.



Trash Icon

If this is on, the next time Eudora checks the server for mail it also deletes this message from the server.



Fetch Icon

If this is on, the next time Eudora checks the server for mail it also downloads this entire message.

You can also turn on the Trash icon so that the message is downloaded then deleted.



Subject Field

Use this field to change the subject of the message as it appears in the mailbox window. To change the subject, 

type the new subject in this field and press [Enter].



Signature popup

The Signature popup menu lets you automatically attach a signature file to the end of the message.

If you have a default signature set, it appears in the Signature popup menu, but you can change it at any time 

before you send the message.



Attachment Type popup

The Attachment Type popup menu lets you select what format documents that you attach to outgoing 

messages are encoded in: Multipurpose Internet Mail Extensions (MIME), BinHex, or Uuencode.

MIME is best for recipients with MIME.

BinHex is most compatible with old Macintosh mailers and previous versions of Eudora.

Uuencode is best for communicating with older PC or UNIX systems.



Quoted-Printable Encoding

If this is on, quoted-printable (QP) encoding may be used when sending messages that contain long lines of 

text or special characters. When on, it is used for all attachments. It is recommended that this button always be 

on.



Text as Attachment

If this is on, plain text files (ASCII) are attached as normal. If it is off, plain text files are included in the body of 

the message.



Word Wrap

If this is on, carriage returns are inserted automatically when the message is sent, at roughly 76 characters per 

line.

It is a good idea not to include your own carriage returns within paragraphs if you have this option on. Only use 

carriage returns to create new paragraphs.



Tabs in Body

If this is on, when you press the tab key within the message body, a tab is inserted. If it is not on, when you 

press the tab key within the message body the cursor moves to the To field.



Keep Copy

If this is on, a copy of each sent message is kept in the Out mailbox (their summaries are marked with an S in 

the far left column of the Out mailbox window, indicating that they have been sent). These messages are saved 

until they are deleted or transferred to a different folder.



Return Receipt

If this is on, your recipients receive a request to notify you that they received the message.

This function does not work in all cases, depending on the email application your recipients are using.



Open Next Message

Opens the next message in the mailbox.



Open Previous Message

Opens the previous message in the mailbox.



New File

Opens a text window so you can create a text file from within Eudora.



Open File

Displays the standard File dialog box so you can find and open a file.



Open Attachment

Opens an attachment in a composition window or a received message, as long as the attachment is highlighted 

(in a composition window) or the cursor is on the same line as the attachment (in a received message).



Close

Closes the current message or window.

Hold down the Shift key to close all open windows.



Save

Save changes to the topmost window. This applies to message composition windows, signature windows, the 

Nicknames window, and the Filters window.

Hold down the Shift key to save the changes to all open windows.



Save As

Displays the standard Save As dialog box so that you can save the current message to a plain text file.

If you select several messages they are all saved as one file.



Save As Stationery

Saves the current message to a stationery file.



Send Queued Messages

Sends all queued messages to the mail server.

Hold down the Shift key to display the Mail Transfer Options dialog box.

Queued messages are listed in the Out mailbox with a "Q" in the status column.



Check Mail

Checks your POP or IMAP server for new messages and transfers them to your computer.

Hold down the Shift key to display the Mail Transfer Options dialog box.

If a time appears in parentheses next to this command, it is the next time an automatic mail check will occur.



Print

Prints messages, a text file, a signature file, the address book, the Filter Report window, or the Ph window.



Print Preview

Displays the Print Preview window for messages, a text file, a signature file, the Filter Report window, the dialup 

Navigation Trace window, or the Ph window.



Print One

Send the item to be printed directly to the printer. One copy is printed.



Print Setup

Displays the standard Windows Print Setup dialog box.



Exit

Exits Eudora. If edited messages or windows are still open, you will be asked to save or discard your changes.

Hold down the Shift key to instruct Eudora that all currently open windows are to automatically reopen at the 

next startup.



Undo

Reverses the last editing action done on a piece of text (multiple levels).



Redo

Re-performs the last undone action (multiple levels).



Cut

Deletes the selected text and copies it to the clipboard.



Copy

Copies the selected text to the clipboard.

Hold down the Shift key to remove the carriage returns from "wrapped" text prior to copying it to the clipboard.



Paste

Pastes the contents of the clipboard at the insertion point in a message or message header.



Paste As Quotation

Pastes the contents of the clipboard at the insertion point with quote characters at the beginning of each line to 

denote quoted text.



Clear

Deletes selected text without copying it to the clipboard.



Plain

Makes the selected text plain.



Bold

Makes the selected text bold.



Italic

Makes the selected text italic.



Underline

Makes the selected text underlined.



Select All

Selects the entire contents of a message or mailbox.



Normal

Converts the selected or current paragraph to normal margin (no indentation).



Indent In

Indents the selected or current paragraph in one level.



Indent Out

Removes one level of indent from the selected or current paragraph.



Left

Makes the selected paragraph aligned to the left.



Right

Makes the selected paragraph aligned to the right.



Center

Makes the selected paragraph aligned to the center.



Bulleted List

Converts the selected or current text to a bulleted list.



Make Hyperlink

Lets you convert any piece of selected text or graphic which hyperlinks to a URL you specify. When your 

recipient clicks on the text string or picture, he or she is immediately taken to that URL.



Clear Formatting

Clears all formatting from the message: removes all styles. Styled text is sent as plain text.

Clear all the formatting from the selected text or paragraph.



Picture

Inserts a graphic at the current cursor position in the message. Once the picture is inserted, you can drag it to 

where you want it in the message. Your recipient will see the picture right in the message.



Horizontal Line

Inserts a horizontal rule at the current line level and the drops the text line containing the cursor to the next line 

down.



Wrap Selection

Inserts carriage returns at the end of each line of the current selection, in the same way Eudora does when it 

sends mail.

Hold down the Shift key to unwrap the current selection (removes the carriage returns).



Finish Address Book Entry

Completes the partial text of a nickname in a message header field.

Hold down the Shift key to insert the full nickname expansion in the message header field.



Insert Recipient

Inserts the chosen recipient at the insertion point.



Find

Displays the Find submenu so that you can find a character string within one message or messages within 

mailboxes and folders.



Find Text Again 

Finds the next occurrence of the specified text string, beginning with the current message and searching 

through subsequent messages and mailboxes.



Find Messages

Displays the Find Messages dialog box for you to choose criteria and enter words or numbers for Eudora to 

search for messages in your mailboxes and folders.



Sort by Status

Sorts the message summaries within a mailbox by status.

To sort in descending order, hold down the Shift key and use a Sort command.



Sort by Priority

Sorts the message summaries within a mailbox by priority.

To sort in descending order, hold down the Shift key and use a Sort command.



Sort by Attachment

Sorts the message summaries within a mailbox by attachment.

To sort in descending order, hold down the Shift key and use a Sort command.



Sort by Label

Sorts the message summaries within a mailbox by label.

To sort in descending order, hold down the Shift key and use a Sort command.



Sort by Sender

Sorts the message summaries within a mailbox by sender.

To sort in descending order, hold down the Shift key and use a Sort command.



Sort by Date

Sorts the message summaries within a mailbox by date.

To sort in descending order, hold down the Shift key and use a Sort command.



Sort by Size

Sorts the message summaries within a mailbox by size.

To sort in descending order, hold down the Shift key and use a Sort command.



Sort by Server Status

Sorts the message summaries within a mailbox by server status.

To sort in descending order, hold down the Shift key and use a Sort command.



Sort by Subject

Sorts the message summaries alphabetically within a mailbox by subject.

To sort in descending order, hold down the Shift key and use a Sort command.



Check Spelling

Checks current message composition windows, text files, and signature files for spelling errors. If a misspelled, 

unknown, or repeated word is found, the Check Spelling dialog box appears with the word listed in the 

Unknown field.



Message Plugins

Applies the selected plug-in to the selected message or text.



In

Opens the In mailbox.

All incoming messages are stored in this mailbox until they are filtered, transferred, or deleted.

Note: Try not to keep too many messages in your In box because it can slow down your system’s performance. 
However, you can transfer messages from your In box to other mailboxes. 



Out

Opens the Out mailbox.

All messages you compose, save, and queue are stored in this mailbox until they are sent. Also, if the Keep 

copies option in the Sending Mail Options is on, a copy of each outgoing message is    saved in this mailbox.

Note: Try not to keep too many messages in your Out box because it can slow down your system’s 
performance. However, you can transfer messages from your Out box to other mailboxes. 



Trash

Opens the Trash mailbox.

All deleted messages are stored in this mailbox until you select Empty Trash from the Special menu. If the 

Empty Trash when exiting option in the Miscellaneous Options is on, the Trash is automatically emptied when 

you exit Eudora. Deleting a message from this mailbox permanently deletes the message.

Note: Try not to keep too many messages in your Trash box because it can slow down your system’s 
performance. Try to delete your Trash box on a regular basis.



Your Mailbox

Opens a mailbox you have created.



New... 

Displays the New Mailbox dialog box so that you can create a new mailbox or mailbox folder.



New Message

Opens a new message composition window.



Reply

Generates a reply message to a current incoming message.

To copy the message to yourself, hold down the Shift key while selecting the command.



Reply to All

Generates a reply message addressed to all of the recipients of the selected message.



Forward

Generates a forward message from a current incoming message.



Redirect

Generates a redirect message from a current incoming message.

The address in the From: field of the message header is that of the original sender "by way of" your address.



Send Again

Reformats a message that was returned to you by the mail server so that you can send it again without 

including all of the return information. A message is typically rejected because of an error in the recipient’s 

address, although there are many other possible reasons.



New Message To

Opens a new message to the selected recipient.



Forward To

Opens a forwarded message to the selected recipient.



Redirect To

Opens a redirected message to the selected recipient.



New Message With

Opens a new message with the selected stationery file.



Reply With

Opens a reply message with the selected stationery file.



Attach File (Send File)

Displays a standard File dialog box so that you can attach a file to a new or current message. Any file can be 

attached to and sent with a Eudora message.



Send Immediately

Sends the current message to the SMTP server.

You can change this command to "Queue For Delivery" so that your outgoing messages are put in a queue until 

you send them all at the same time. To do this, turn off Immediate send in the Sending Mail Options.



Queue For Delivery

Saves the current message in the Out mailbox and marks it as Q (queued for delivery). Send your Queued 

messages by selecting Send Queued Messages from the File menu.

You can change this command to Send Immediately so that your outgoing messages are sent out immediately. 

To do this, turn on Immediate send in the Sending Mail Options



Change... Queueing

Displays the Change Queuing dialog box so that you can modify the queueing status of an outgoing message.

Use this dialog box to queue the current messages, unqueue messages, or set a time for queued messages to 

be sent.



Change... Status... Unread

Changes the status of the current messages to unread.



Change... Status... Read

Changes the status of the current messages to read.



Change... Status... Replied

Changes the status of the current messages to replied.



Change... Status... Forwarded

Changes the status of the current messages to forwarded.



Change... Status... Redirected

Changes the status of the current messages to redirected.



Change... Status... Unsendable

Changes the status of the current messages to unsendable.



Change... Status... Sendable

Changes the status of the current messages to sendable.



Change... Status... Queued

Changes the status of the current messages to queued.



Change... Status... Time Queued

Changes the status of the current messages to time queued.



Change... Status... Sent

Changes the status of the current messages to sent.



Change... Status... Unsent

Changes the status of the current messages to unsent.



Change... Priority... Highest

Changes the priority of the current messages to highest.



Change... Priority... High

Changes the priority of the current messages to high.



Change... Priority... Normal

Changes the priority of the current messages to normal.



Change... Priority... Low

Changes the priority of the current messages to low.



Change... Priority... Lowest

Changes the priority of the current messages to lowest.



None

Do not put a label on the current message (take off any existing label).



Change Label

Changes the label of the current messages to the selected label that you have created.



Change... Server Status... Leave

Changes the server status to Leave. The message will stay on the server.



Change... Server Status... Fetch

Changes the server status to Fetch. The message will be transferred from your POP account the next time you 

check or send mail.



Change... Server Status... Delete

Changes the server status to Delete. The message will be deleted from the server the next time you check or 

send mail.



Change... Server Status... Fetch then Delete

Changes the server status to Fetch then Delete. The message will be transferred from your POP account, then 

deleted from the server the next time you check or send mail.



Delete

Transfers the current message to the Trash mailbox, or if your incoming mail server uses IMAP,    marks the 

current message for deletion from your system and the IMAP server.



UnDelete

Unmarks for deletion a message that has been marked for deletion using the Delete command. If your incoming 

mail server uses IMAP, then use Delete to mark your messages for deletion. Use UnDelete to unmark them 

(they will not be deleted), and use Purge Messages to remove the marked messages from your system and the 

IMAP server.



Purge Messages

Purges from your system and from the IMAP server all messages that have been marked for deletion.



In

Transfers the current message(s) to the In mailbox.



Out

Transfers the current message(s) to the Out mailbox.



Trash

Transfers the current message(s) to the Trash mailbox.



Your Mailbox

Transfers the current message(s) to the mailbox you have created.



New...

Displays the New Mailbox dialog box so that you can create a new mailbox and transfer the current message(s) 

into it.



Filter Messages

Runs all manual filters on the current messages.

This is the only way that filters designated as Manual in the Filters window can be used.



Filter Report

Opens the Filter Report window, which displays a report of all filtering activity since the last Eudora startup. The 

Generate filter report option must be turned on in the Getting Attention Options for these reports to be created.



File Browser

Opens the File Browser window, which operates similar (but not identical) to Windows Explorer. It lets you drag 

files to open composition messages to add them as attachments.



Stationery

Opens the Stationery window, which lets you create, edit, rename, delete, and otherwise manage your 

stationery files.



Signatures

Opens the Signature window, which lets you create, edit, rename, delete, and otherwise manage your signature 

files.



Personalities

Opens the Personalities window, which lets you create, edit, delete, and otherwise manage your personalities.



Make Address Book Entry...

Creates a single Address Book entry from selected messages or Address Book entries.

If you make an Address Book entry from incoming messages, the addresses in the From fields are used. If you 

make an Address Book entry from outgoing message, the addresses in the To and Cc fields are used.



Add as Recipient

Adds the highlighted email address(es) to the Quick Recipient list.

To do this, highlight one or more addresses in a message window, then select Add as Recipient.



Remove Recipient

Removes the selected recipient from the Quick Recipient list.



Empty Trash

Permanently deletes messages from the Trash mailbox.

If the Empty Trash when exiting option in the Miscellaneous Options is on, the trash is emptied automatically 

when you exit Eudora.



Compact Mailboxes

Recovers the unused space from all of your mailboxes.

This used space was created when messages were deleted or transferred from the mailboxes.



Forget Password(s)

Makes Eudora forget that you have already entered your password(s) for this session.

You will be prompted to re-enter password(s) at the next mail check.



Change Password...

Displays the Password change dialog box so that you can change the selected password.

This will only work if you have the necessary software on your server.



Message Plug-ins Settings...

Displays the Message Plug-ins Settings dialog box so that you can setup your message plug-ins.



Filters

Displays the Filters dialog box so that you can create filters that automatically sort your incoming and outgoing 

mail.



Mailboxes

Displays the Mailboxes window so that you can create, rename, and remove mailboxes and folders.



Address Book

Displays the Address Book so that you can create, edit, or remove entries and their nicknames.

Entries can consist of multiple addresses so that you can create mailing lists.



Directory Services

Displays the Directory Services window so that you can access information by using Ph and finger directory 

services for example.



New Signature

Displays the New Signature window so that you can add a signature.



Delete Signature

Displays the Delete Signature window so that you can delete a signature.



Standard

Displays the Standard Signature window so that you can create a standard signature to be included at the end 

of your outgoing messages.



Signatures

Displays the Signature window so that you can create a signature to include at the end of your outgoing 

messages.



Options...

Displays the Options dialog box so that you can set Eudora options.



Cascade

Arranges all open windows in a cascade.



Tile Horizontal

Arranges all open windows as horizontal tiles.



Tile Vertical

Arranges all open windows as vertical tiles.



Arrange Icons

Arranges iconified windows along the bottom of the Eudora window.



Send To Back

Sends the active window to the back.



Topics

Displays the online Help contents.



Context Sensitive Help

Displays compact, pop-up help for an item you select or an object at which you point and click.



Insert System Configuration

Inserts detailed information about your system into a composition message. Use this when reporting Eudora 

bugs.



About Eudora

Opens a window giving detailed information about this version of Eudora and its credits. It also displays your 

registration number and name. 



Make Filter

Opens the Make Filter window allowing you to create a simple filter. A message in one of your mailboxes must 

be selected before you can use this command.



Task Status

Display the Task Status window, which lets you see Eudora checking mail for and sending mail from each of 

your personalities simultaneously.



Task Error

Display the Task Error window, which lets you see a detail summary of any error that may occur while in 

Eudora.



Paste Special 

Using Paste Special, you can paste copied text as unformatted, Rich Text Format (RTF), Eudora standard, or 

Hyper Text Markup Language (HTML) text. 

Eudora determines the format of the text on the clipboard and displays the available formats in the Paste 

Special dialog box.

Note. The Paste Link and Display As Icon functions are not available.



Find Text

Displays the Find Text dialog box where you can enter text to search within a message.



Technical Support (menu option)

Displays Eudora’s technical support help page.



Sort by MoodWatch (in open mailbox)

Click this column to sort by mood. The ascending order is by one, two, and three red chili peppers. 

To sort in descending order, hold down the Shift key and use a Sort command.



Statistics

Displays the Statistics window. The Statistics window displays your Eudora usage. You can view it on your screen 
or print a report.



Add Quote Level

Adds one level of excerpt bars to the selected text.



Remove Quote Level

Removes one level of excerpt bars to the selected text.



Use Default

Click this button to use Eudora’s default sound when checking mail.



Mail Server (Incoming POP/IMAP)

Specifies the name of your account on your incoming server (POP or IMAP) that delivers your email.

For example, if your assigned login name is "justine," and the name of the computer where you receive email is 
incoming.qualcomm.com type only incoming.qualcomm.com in this field. (When you enter your server name here, it 
is made available in the incoming Mail Server field of other Options categories.) Then your full email address is 
justine@incoming.qualcomm.com.

A POP account is an account on a computer that runs a Post Office Protocol version 3 (POP3 or POP) server. An 
IMAP account is an account on a computer that runs an Internet Message Access Protocol server. This is the 
account to which your email messages are delivered so that Eudora can find them and transfer them to your 
computer. You must have a POP or IMAP account to be able to receive mail with Eudora. 



Real name

Specifies your real name.

Enter your name as you want it to appear in the From field of your outgoing mail messages. Your return address is 
also given in that field.



Mail Server (Incoming)

Enter the full name of the computer that receives your incoming mail. 

For example, if your assigned login name is "justine," and the name of the computer where you receive email is 
incoming.qualcomm.com type only incoming.qualcomm.com in this field. (When you enter your server name here, it 
is made available in the incoming Mail Server field of other Options categories.) Then your full email address is 
justine@incoming.qualcomm.com.

Your incoming server is either a POP or IMAP server. A POP account is an account on a computer that runs a Post 
Office Protocol version 3 (POP3 or POP) server. An IMAP account is an account on a computer that runs an 
Internet Message Access Protocol server. This is the account to which your email messages are delivered so that 
Eudora can find them and transfer them to your computer. You must have a POP or IMAP account to be able to 
receive mail with Eudora. 

Most likely, you receive your mail from a POP server; however, if you are using Eudora in an organization, please 
check with you system administrator to see what kind of server you are using for your incoming mail.



Login Name

Enter the name you use to log in to your primary email account. This is often the text that appears before the at sign 
(@) in your email address.

Example: For the account beatrixp@qualcomm.com, the login name is beatrixp.



Return address

Specifies a return address if it is different than your incoming account.

If you enter an address in this field, first test the address to be sure that mail sent to it is indeed delivered to you. If 
you use an invalid return address, no one can reply to your mail.



 SMTP server (Outgoing)

This is the name of the server where you send your messages to. The name of this server is SMTP (Simple Mail 
Transfer Protocol).

Enter the name of your SMTP server if it is different from the computer that is running your incoming server. You do 
not need a login name on this server, but you must have access to it through your network.



Launch a program from a message

If this is selected, you are warned if you try to launch a program from a message. For security reasons, you should 
never launch a program without performing a virus check on the file. Do not launch any program if you do not know 
sender. Some viruses can infect a file without you knowing it. It is always good to perform regular virus checks using 
a current virus checking program.



Check for mail every _ minutes

Specifies how often Eudora checks the incoming server(s) for new mail. It's a good idea to set this to at least 15 
minutes. Checking mail more frequently puts an unnecessary drain on your incoming server.



Don’t check when using battery

If this option is on and your computer is running on battery power, mail is not automatically checked even if 
automatic mail-checking is on (that is, even if the Check for mail every _ minutes field has a number other than 0 
in it).



Send on check

If this is checked, any messages that are queued (Q) in the Out mailbox are sent when Eudora checks the incoming 
server for new mail. 



Save password

If this is checked, your password is stored in Eudora and you never have to enter it again, even if you exit Eudora 
and restart.

Only use this option if your computer is in a secure place.



Leave mail on server

If this is checked, incoming messages are transferred to your computer and also left on the server. (Normally your 
mail is transferred, then deleted from the incoming server.)



Delete from server after _ days

This option has a checkbox for turning it on and off and an edit box for specifying the number of days mail that was 
left on the incoming server should be saved before being deleted. It's a good idea not to leave copies of your 
messages on the incoming server indefinitely, as this will create mail storage problems on the server.



POP

Select POP if the incoming mail server for this account uses the POP Internet-mail protocol (Post Office Protocol).



IMAP

Select IMAP if the incoming mail server for this account uses the IMAP Internet-mail protocol (Internet Message 
Access Protocol).



Download Options (IMAP)

Listed are options you can choose when downloading email.



Minimal Headers Only (IMAP)

If this setting is on, only a limited set of message headers is downloaded from the IMAP server for each incoming 
message. If this setting is off, the full set of message headers is downloaded for each incoming message.



Skip Attachments over _ K

If this setting is on and a number is entered in the edit box, then any attachment larger than the specified size will 
not be downloaded with the message. If this setting is off, all attachments are downloaded regardless of size.



Skip messages over _ K in size/Full message except attachments over _ in size

If this setting is on and a number is entered in the edit box, then any message larger than the specified size will not 
be downloaded. If this setting is off, all messages are downloaded regardless of size. If you enter 0 in the text box, 
all attachments regardless of size are retrieved.



IMAP Mailbox Location Prefix

This specifies the mailbox location prefix that IMAP will use when locating your personal mailboxes on the incoming 
mail server. An example prefix is /usr/mail. Ask your email administrator what to enter here, if you are not sure.



HIDS_INI_SERVER_DELETE when emptied from Trash

If this is checked, all messages that you have deleted from your trash mailbox are also deleted from the server.

This only applies to messages that were transferred to your computer under the Leave mail on server option. 
Normally Eudora deletes a message from the server immediately after the message is transferred.



Authentication Style

Specifies the authentication style. Ask your email administrator which one is being used at your site. To get mail 
from a CompuServe incoming server, choose RPA as the authentication style.

For POP, you can use Passwords, Kerberos, APOP, or RPA.

For IMAP, you can use Passwords or CRAM-MD5.



 Domain to add to unqualified addresses (Options)

Specifies a domain to be added to unqualified names.

An unqualified name is one that doesn't have an "@" sign followed by a domain name. If you address a message to 
someone without including their domain name, Eudora automatically adds this domain to that address. This setting 
can be used as a time-saving device when addressing large numbers of messages to users who reside in the same 
domain.



Immediate send (Sending Mail options)

If this is checked, all send options are set to Send Immediately.

If this is not checked, messages are saved in the Out mailbox and marked "Q" (queued for delivery).

Send options include the rightmost button in the icon bar of the message composition window and the Send 
Immediately option in the Message menu.



Default stationery (Composing Mail)

Select a stationery file to use as the default for all your outgoing messages from your main account, or choose <No 
Default> for no default stationery.

Once you select a stationery, new messages are created with that stationery and will include the toolbar settings for 
the stationery.

If there is no stationery selected, new messages are created with toolbar settings based on the options selected 
below the stationery pop-up.



Default signature

Select a signature file to use as the default for all your outgoing messages from your main account (when you are 
not using stationery), or choose <No Default> for no default signature. You can always change the signature for a 
particular message by selecting a signature from the Signature pop-up menu on the message toolbar. Your 
signature is automatically attached to the end of outgoing messages.



Word wrap

If this is checked, carriage returns are inserted automatically when the message is sent, at roughly 76 characters 
per line.

It is a good idea not to include your own carriage returns within paragraphs if you have this option on. Only use 
carriage returns to create new paragraphs.



May use Quoted-Printable

If this is checked, Eudora uses quoted-printable encoding when necessary, such as when messages that contain 
long lines of text or special characters are sent.

If this is not checked, quoted-printable encoding is never used.



Keep copies

If this is checked, a copy of each message you send is saved in the Out mailbox and marked Ö.

If this is not checked, Eudora moves outgoing messages to the Trash mailbox after they are sent.



Tabs in body of message

If this is checked, when you press the tab key within the message body, a tab is inserted.

If this is not checked, when you press the tab key within the message body the cursor moves to the To field.



Encoding Method

These options specify what encoding method should be used with attached files.



MIME

If this is checked, documents attached to outgoing messages are encoded in MIME.

MIME is best for recipients with MIME.



BinHex

If this is checked, documents attached to outgoing messages are encoded in BinHex.

BinHex is best for recipients with old Macintosh mailers and previous versions of Eudora.



Uuencode

If this is checked, documents attached to outgoing messages are encoded in Uuencode Data Fork.

Uuencode is best for communicating with older PC or UNIX systems.



Put text attachments in body of message

If this is checked, Eudora puts any plain-text attachment you send directly in the message body as if it were typed in 
manually. If this is unchecked, the plain-text attachment is sent as an attachment file.



Attachment Directory (Attachments Options)

Specifies what directory your incoming attachments will be put in.

To change the directory, single-click on the directory name button (the default is blank). A dialog box appears 
allowing you to select the attachment destination directory.

If you do not select an attachment directory, attachments are placed in your Eudora directory.



Delete attachments when emptying Trash 

If this is checked, attachments are deleted when their corresponding messages are deleted from the Trash (or the 
Trash is emptied).

The attachment must be in the directory defined as the Attachments Directory.

If you want to save an attachment but delete the message, move the attachment to another directory or leave this 
option off.



Delete automatic attachments: Never

If this is checked, automatic attachments are never deleted automatically.

Automatic attachments are attachments to automatically generated messages, such as with the Insert System 
Configuration command.



Delete automatic attachments: After sending message

If this is checked, automatic attachments are deleted automatically after the corresponding message is sent.

Automatic attachments are attachments to automatically generated messages, such as with the Insert System 
Configuration command.



Delete automatic attachments: When message emptied from Trash

If this is checked, automatic attachments are deleted when their corresponding messages are deleted from the 
Trash (or the Trash is emptied).

Automatic attachments are attachments to automatically generated messages, such as with the Insert System 
Configuration command.



Screen Font

Specifies the font and point size to be used for displaying the text of your Eudora messages and mailbox windows.

To change the selection, click on this button. The Font dialog box appears so that you can select a new font and 
size.



Printer Font

Specifies the font and point size to be used when printing messages using the Print command.

To change the selection, click on this button. The Font dialog box appears so that you can select a new font and 
size.



Proportional

Specifies the proportional font to use in message windows and in the message preview pane in mailbox windows.



Fixed-width

Specifies the fixed-width font to use in message windows and in the message preview pane in mailbox windows.



Use proportional font by default

If this is checked, your specified proportional font is used to display text in message windows and the message 
preview pane. If this is unchecked, your specified fixed-width font is used to display this text.



Size

Specifies the size of the font to be used for text in message windows and the message preview pane.



Size (printer)

Specifies the size of the font to use when printing text from Eudora.



Font (screen)

Specifies the font to use when displaying all Eudora screen text other than that in message windows and the 
message preview pane.



Size (screen)

Specifies the size of the font to use when displaying all Eudora screen text other than that in message windows 
and the message preview pane



Show cool bars

If this is checked, the main window toolbar buttons have a flat look and only become raised when you position the 
mouse pointer over the button. If this is unchecked, the main window toolbar buttons always appear raised.



Show large buttons

If this is checked, the main window toolbar buttons are large. If this is unchecked, the main window toolbar buttons 
appear small.



Show toolbar

If this is checked, the main window toolbar appears.



Show MDI task bar

If this is checked, Eudora displays the Eudora taskbar at the bottom of the window work area. This taskbar contains 
buttons for all open and minimized normal Eudora windows. Click the buttons on the taskbar to activate the 
indicated window. The Eudora taskbar functions similarly to the Microsoft Windows 95 and NT taskbars, but the 
Eudora taskbar cannot be moved and cannot be separately resized.



Use Microsoft viewer

If this is unchecked, Eudora displays advanced formatting, graphics, and multimedia in incoming and outgoing 
messages using its own built-in viewer. If this is checked, Eudora takes full advantage of the Web browser 
capabilities of Microsoft's Internet Explorer 3.0 or 4.0 by showing Web content right in incoming and outgoing 
messages or linking to the Internet, without your having to open the Web browser. This option is only available if 
you have Microsoft's Internet Explorer version 3.0 or higher installed and available on your system.



Show message preview pane

If this is checked, Eudora displays the message preview pane in mailbox windows. The preview pane previews a 
single selected message. A splitter between the preview pane and the message summary list lets you resize the 
preview pane relative to the list.



Mark previewed messages as read after _ second(s)

If this is checked and the Show message preview pane option is checked, the message currently selected in the 
mailbox window and previewed in the preview pane is automatically marked as read (blank in the Status column) 
after the specified number of seconds. If this is unchecked, a previewed message will not be automatically marked 
as read. To return a message to the Unread status (bullet in the Status column) after it has been marked as read, 
press Shift+Space. Press again to return to read status.



Zoom windows when opening

If this option is on, new message windows automatically open to their "zoomed" size. The zoomed size is 
computed on a window-by-window basis. For message windows, zoomed size is just long enough to display all of 
the message (but no longer than the main window), and as wide as the Message window width setting. 
Composition windows zoom to the height specified by the Message window height setting.



Show toolbar tips

If this is checked, holding the mouse pointer over a button in the main window toolbar displays a very brief 
description of that button's function.



Show status bar

If this is checked, a status bar appears at the bottom of the main window. The status bar provides a brief description 
of menu items and toolbar buttons.



Show category icons

If this is checked, the Options categories are presented with icons and the name.

If this is not checked, the categories are presented with just the name.



Labels

The Labels options define the title and color of the seven labels that can be used to categorize messages. To 
change a label title, type the new title in the field to the right of the label number. To change a label color, single-click 
on the label number to display the Color dialog box.

In the Color Dialog, you can select from one of the pre-defined Basic Colors or create your own Custom Colors. To 
assign a basic color to a label, select the color and click OK. To create a custom color, click the Define Custom 
Colors button to display the custom colors palette.

To define a custom color, select one of the 16 custom color boxes. Using the mouse pointer, click anywhere on the 
color palette to select the color Hue and Saturation. Use the color control bar to the right of the color palette to 
adjust the color. When you are satisfied with the color, click the Add to Custom Colors button. Once you have 
completed creating the custom colors, select the desired label color and click OK.



Use an alert dialog box

If this is checked, an alert dialog box notifies you when you have new mail.



Open mailbox

If this is checked, mailboxes are opened when new mail is received, and the first unread message is highlighted.



Play a sound

If this is checked, Eudora plays the sound when new mail arrives.

To select a sound (.wav) file, click on the Play a sound button. The Select Sound File dialog box appears so that 
you can select a sound.    To switch back to the default mail arrival sound, click Use Default.



Select Sound File

Specifies the sound file to be played when new mail arrives.

To select a sound (.wav) file, click on this button. The Select Sound File dialog box appears so that you can select a 
sound.



Generate Filter Report

If this is checked, a Filter Report is generated with information about filtered messages.



Delete unread mail

If this is checked, a warning dialog box appears when you try to delete unread mail.



Delete queued mail

If this is checked, a warning dialog box appears when you try to delete queued mail.



Delete unsent mail

If this is checked, a warning dialog box appears when you try to delete unsent mail.



Queue a message with no subject

If this is checked, a warning dialog box appears when you try to queue a message with no subject.



Ask me each time

If this is checked, a warning dialog box appears when you try to queue a message with styled text.



Quit with messages queued to be sent

If this is checked, a warning dialog box appears when you try to quit with messages queued to be sent.



Queue a message bigger than _ K

If this is checked, a warning dialog box appears when you try to queue a message bigger than the specified size.



Empty the Trash mailbox

If this is checked, a warning dialog box appears when you try to empty the Trash mailbox.



Start Eudora and it's not the default mailer

If this is checked, a warning dialog box appears when you try to start Eudora and it’s not the default email 
application.



Map Ctrl+R to "Reply to All"

If this is checked, when you type Ctrl-r a reply message is created addressed to all the recipients of the selected 
message The change is reflected on the Message menu.



Copy original's priority to reply

If this is checked, when you do a Reply the reply has the same priority as the original message.



Automatically FCC to original mailbox

If this is checked, replies are automatically copied to the mailbox the original message is in.



When Replying to all

These options specify how a reply message will be generated.



Include yourself

If this (and Reply to all) is checked, when you do a Reply the reply includes your address so that you receive a copy 
of your own reply.

If this is not checked, the reply does not include your address and you do not receive a copy. (Unless you have 
checked Keep copies of outgoing mail in the Sending Mail category.)

To determine who you are for the Include yourself option, Eudora uses the "me" nickname. You create the "me" 
nickname in your Address Book. If you do have a "me" nickname, Eudora uses the contents of the    Login Name, 
Mail Server, and Return Address from the Getting Started options. 



Put original To: recipients in Cc: field

If this (and Reply to all) is checked, when you do a Reply the reply includes the addresses of the original message 
recipients in the Cc: field. The To: field contains only the address of the original sender.



Show Mailbox Columns: Status

If this is checked, the Status column appears in Mailbox windows.



Show Mailbox Columns: Priority

If this is checked, the Priority column appears in Mailbox windows.



Show Mailbox Columns: Attachment

If this is checked, the Attachment column appears in Mailbox windows.



Show Mailbox Columns: Label

If this is checked, the Label column appears in Mailbox windows.



Show Mailbox Columns: Sender

If this is checked, the Sender column appears in Mailbox windows.



Show Mailbox Columns: Date

If this is checked, the Date column appears in Mailbox windows.



Show Mailbox Columns: Size

If this is checked, the Size column appears in Mailbox windows.



Show Mailbox Columns: Server status

If this is checked, the Server status column appears in Mailbox windows.



Show Mailbox Columns: Subject

If this is checked, the Subject column appears in Mailbox windows.



Ignore capitalized words

If this is checked, words that start with capital letters, such as proper nouns, are ignored.



Ignore words with numbers

If this is checked, words that contain numbers are ignored.



Ignore words with mixed case

If this is checked, words that contain both upper and lower case characters are ignored.



Report doubled words

If this is checked, words that appear twice in sequence in text are reported and identified as doubled words.



Ignore words with all capitals

If this is checked, the spelling checker ignores words that contain all capital letters, such as acronyms.



Suggest Words

If this is checked, then when the spelling checker encounters an unknown word, it displays Eudora's suggestions for 
the correct spelling of the word in the Suggestions field of the Check Spelling dialog box. You can also select any 
combination of the suggestion options: Phonetic words, Split words, Typographic words. Note that if Eudora has no 
suggestions in its dictionary for the word, then no suggestions are listed.



Ignore Original Text

If this is checked, quoted text (preceded by ">" or "|" ) is ignored. Eudora assumes that this text was originally from 
another message, and therefore does not need to be checked.



Check when message queue/send selected

If this is checked, the spelling in a message is checked when you queue or send the message.



Warn me when I queue/send a message without completing the spell check

If this is checked, a warning dialog box appears when a message is queued or sent without a complete spell check.



Display dates using Sender’s timezone

If this is checked, messages are displayed with the sender’s time and date, as determined by the sender’s time 
zone.



Display dates using Local timezone

If this is checked, messages are displayed with your time and date based on your time zone.



Date formats: Fixed

If this is checked, all messages are displayed with the time and date as specified by the formatting you enter in this 
field. See the formatting key in the Options panel.



Date formats: Age-sensitive

If this is checked, all messages are displayed with times and dates as specified by your entries in the fields related 
to RECENT, OLD, and ANCIENT times. The hours determining these times are specified in the Hours to be OLD 
and Hours to be Ancient fields. See the formatting key in the Options panel.



RECENT format

Enter the formatting you wish to use to display dates and times of the most recent messages. See the formatting 
key in the Options panel.



Hours to be OLD

Enter the number of hours at which messages are to be considered old. The number of hours is measured from the 
current system time. This number is the cutoff point between RECENT and OLD messages.



Hours to be ANCIENT

Enter the number of hours at which messages are to be considered ancient. The number of hours is measured from 
the current system time. This number is the cutoff point between OLD and ANCIENT messages.



OLD format

Enter the formatting you with to use to display dates and times of messages considered OLD. OLD messages are 
determined by the number in the Hours to be OLD field. See the formatting key in the Options panel.



ANCIENT format

Enter the formatting you with to use to display dates and times of messages considered ANCIENT. ANCIENT 
messages are determined by the number in the Hours to be ANCIENT field. See the formatting key in the Options 
panel.



Switch messages with

These options specify what keys can be used to quickly open and close message windows.



Unmodified arrow keys

If this is checked, the keyboard arrow keys can be used to close the current message and open the next or previous 
message in the mailbox.

The up or left arrow key opens the previous message; the down or right arrow key opens the next message. If this 
option is off, the arrow keys can be used to move the caret in messages.

Even if Unmodified arrow keys is on, the arrow keys do not switch messages if there is a message composition 
window topmost on the screen.



Ctrl+arrow keys

If this is checked, you can switch between open messages by holding down the [Ctrl] key and then pressing the 
arrow keys.



Alt+arrow keys

If this is checked, you can switch between open messages by holding down the [Alt] key and then pressing the 
arrow keys.



Close messages with mailbox

If this is checked, all open messages are closed when you close the mailbox they are in.



Empty Trash when exiting

If this is checked, the Trash mailbox is emptied every time you exit Eudora.

If this is not checked, the Trash is only emptied when you select Empty Trash from the Special menu.

If you want to remove some messages from the Trash mailbox but don't want to empty it entirely, highlight the 
summaries you want to delete and select Delete from the Message menu. The selected messages are deleted.



Say OK to alerts after _ seconds

If this is checked and a number of seconds is specified, any notices of network problems are dismissed after the 
specified number of seconds.

If this is not checked, notices are left in place and Eudora cannot try the communication again until you dismiss the 
alert.



Turbo redirect by default

If this is checked, a Redirect to Recipient command does the following:

Opens a redirected message to the selected recipient

Queues the new message

Deletes the original message

To turn this option on or off (regardless of this setting), hold down the [Shift] key while selecting a redirect recipient.



Allow Drag and Drop Transfers

If this is checked, you are able to "drag and drop" messages among mailboxes.



Include outdated ‘Return-Receipt-To’

If this is off, Eudora uses the "Disposition-Notification-To:" header in return receipt requests to request that you be 
sent a notification when your message appears by the recipient. If this is on, Eudora also sends the "Return-
Receipt-To:" header in return receipt requests. This header is understood by some older mail delivery systems, and 
may return you a receipt when your message is delivered to your recipient’s mailbox. The "Return-Receipt-To:" 
header cannot give you any information about whether or not your recipient displayed your mail, and is not 
supported by many newer mail delivery systems.



Automatically expand nicknames

If this is checked, when you enter nicknames into message address fields the entire address(es) of the nickname is 
entered into the field, not just the nickname.



Server Name (ACAP)

This is the ACAP server name to which you wish to connect to retrieve the pre-configured Eudora settings. If the 
ACAP server name is not displayed in this field, contact your administrator or postmaster.



User Name (ACAP)

Enter your user name. With your user name and password, you can access the ACAP server to retrieve your 
preconfigured Eudora settings. Your system administrator or postmaster will provide this user name to you if your 
settings are available on an ACAP server.



Password (ACAP)

Enter your password. With your user name and password, you can access the ACAP server to retrieve your 
preconfigured Eudora settings. Your system administrator or postmaster will provide this password to you if your 
settings are available on an ACAP server.



Retrieve Settings Now

Click this button to retrieve you preconfigured settings. The preconfigured settings will replace the settings you now 
have on Eudora.



Network open timeout _ seconds

Specifies the number of seconds before a network connection will time out.



Network timeout after _ seconds

Specifies the number of seconds before a network connection will time out.



Network buffer size of _ bytes

Specifies the size of the buffer that Eudora uses to transfer information to and from the server.

If you are having trouble transferring large messages, the size of this buffer may be decreased.



Cache network info

If this is checked, Eudora remembers the results of previous database functions when using the Winsock 
connection method.

This speeds up database functions within a single Eudora session.



Unload Winsock DLL after closing socket

If you are using the Trumpet Winsock stack for dial-up, select this option if you like to have your computer dial and 
hang-up between functions, for example sending and receiving mail. 



Entry

Use the drop-down menu to select a dial-up connection in this field. You must have dial-up networking set up in 
Windows.



Username

This specifies the username to be used with the auto connection.



Save password

If this is on, the password for the auto connection is saved in Eudora so that you do not have to re-enter it after 
exiting Eudora.

If you select Forget Password(s) from the Special menu, you will be prompted for the password the first time you try 
to check mail.



Use Eudora MAPI server

These options specify when the Eudora MAPI server should run.



Use Eudora MAPI Server: Never

If this is checked, the Eudora MAPI server is off and is never automatically opened.



Use Eudora MAPI Server: Always

If this is checked, the Eudora MAPI server is on and is always opened on startup.



Use Eudora MAPI Server: When Eudora is running

If this is checked, the Eudora MAPI server is on when Eudora is running.



Delete MAPI attachments

These options specify when MAPI attachments should be deleted.



Delete MAPI attachments: Never

If this is checked, MAPI attachments are never deleted.

MAPI attachments are copied into the Attach directory (or a directory you have specified) when they are sent. If you 
want to save them, use this option.



Delete MAPI attachments: After sending message

If this is checked, MAPI attachments are deleted after their corresponding messages are sent.

MAPI attachments are copied into the Attach directory (or a directory you have specified) when they are sent. If you 
do not want to save them, use this option.



Delete MAPI attachments: When message is emptied from trash

If this is checked, MAPI attachments are deleted after their corresponding messages are emptied from the trash.

MAPI attachments are copied into the Attach directory (or a directory you have specified) when they are sent. If you 
do not want to save them after their corresponding messages have been deleted, use this option.



Kerberos POP3 port

Specifies the port that the Kerberos POP server is listening on.



Realm

Specifies the network realm that the Kerberos server resides in.



Service name

Specifies the type of service that you're requesting.



Service format

Specifies the name of the ticket that Eudora requests from the Kerberos server.



Discard style information

If this is checked, no text style information will be sent with messages.



Add Details

After setting up your filter information, click this button to both create your filter and also open the Filters window so 
that you can add additional information to your new filter and make it more powerful or just change it. The filter is 
added to the bottom of your filters list and is immediately available in the form in which it was set up in the Make 
Filter dialog box. Any changes you make in the Filters window must be saved before they become effective. 



Offline

Turn this on if you don’t want Eudora to make any connections. This is good to have on if you’re using Eudora on a 
laptop computer that is not continuously connected.



Message window height

This specifies the height of new and received message windows (in lines).

Note: If the Zoom windows when opening option is turned on, received message window heights are 
automatically adjusted to the height of the message text.



Automatically open next message

If this is on, deleting or transferring the current message opens the next message in the mailbox, but only if that 
message is unread.



Message window width

This specifies the width of new and received message windows (in characters). This option has no effect on what 
your mail looks like when it is sent. When mail is sent, Eudora wraps at or before 76 columns.

Note: If you use a proportional font, Eudora sets the window width based on the average width of the 
characters in the font.



Show mailbox lines

If this option is on, lines are displayed in the message summaries portion of mailbox windows, horizontal lines to 
separate message summaries, and vertical lines to separate columns.



Select newly inserted messages (FUMLUB)

If this is selected, the first message of the most current block of unread messages is highlighted in the Table of 
Contents window when new messages are added to a mailbox, for example, when receiving new messages as a 
result of a mail check. FUMLUB means First Unread Message of the Last Unread Block. For example, you may 
have a series of unread messages in a mailbox scattered throughout your Table of Contents. The first message of 
the last block of unread messages listed in your Table of Contents is selected. 



Allow drag select messages

Turn this on to click and drag adjacent messages in the Table of Contents window. This allows you to transfer a 
group of messages to a mailbox or to delete them if the "Allow drag and drop transfers" is turned on. The drag 
select works only if the drag starts on an unselected (not highlighted) message.



Show formatting toolbar

Turn this on to display the formatting toolbar by default in new message windows. If this is off, the formatting toolbar 
is hidden by default in new message windows. This toolbar lets you easily format text styles in new messages.



When sending mail with styled text (HTML)

This specifies what to do with HTML text styles when you send mail. The styles are delivered to your recipients 
using the HyperText Marking Language (HTML) format. However, the styles your recipient sees depends on how 
well their email software supports this standard. 

HTML is the text formatting standard used in the World Wide Web by Web browsers and newer email applications. 
HTML allows you use enriched text, which includes different fonts, color, sizes, bold, etc. Also, HTML lets you 
embed pictures and create bullet lists in the emails you send.

Send both plain and styled ¾    Turn this on to send all text including plain and HTML text styles with your 
messages. 

Send styled text only ¾    Turn this on to send only HTML text styles with your messages. 

Send plain text only ¾ Turn this on to send only plain text, not HTML text styles with your messages.



Send single MAPI file attachment as inline attachment (TXT and HTML files only)

Turn this on when you need to have the MAPI client send a single TXT or HTML file as an attachment with no 
message body text. Eudora turns off the Text As Attachment button in the outgoing message toolbar (if it is on), so 
that the document is sent to the recipient as inline text in the message body. This allows MAPI clients, such as 
Internet Explorer, to pass Web pages and other HTML and TXT documents right into the body of the Eudora 
message. (The Text As Attachment button, if turned on in the outgoing message toolbar, instructs Eudora to attach 
text files, such as TXT and HTML, to the message rather than incorporating the text into the message as part of the 
message body. The default state of this button is controlled by the Put text attachments in body of message option 
in the Attachments options. 



Automation enabled from this machine

Turn this on to perform the automation operations from the computer on which Eudora is installed.

The Automation options let you control and exchange information with Eudora from other programs that support the 
Windows Automation Interface, such as Microsoft Visual Basic.

Automation gives you external access to Eudora mail folders, mailboxes, and messages, and to the Eudora 
application itself. With automation enabled, you can create, delete, and move Eudora mail folders, mailboxes, and 
messages, as well as get notification of these three operations when they are performed manually. You can also get 
lists of the subfolders under folders and of the messages within mailboxes.



Allow executables in HTML content

If this is selected, you are able to run programs such as Java Applets, Javascript, VB Script, and Activex Controls 
that are embedded in an HTML texted message. For security reasons, you may want to leave this option 
deselected. 



Task 

Displays an icon with a short description of the task’s actions.



Persona (Task Status)

This column is available only if you have set up more than one personality. If checked, the Personality column 
displays the personality name for the given task.



Status (Task Status)

Displays a general description of the tasks current status, for example, "Logging into POP server."



Details (Task Status)

Displays more information of the tasks’ status including network protocol commands. 



Progress (Task Status)

Displays a progress bar indicating the overall progress of the tasks.



Wait for _ seconds of user inactivity before processing/filtering downloaded messages

If Eudora is retrieving mail automatically in the background, the amount of time set in this field indicates the idle time 
Eudora waits before delivering mail to your mailboxes and folders. For example, if you are composing a message 
and Eudora is retrieving mail in the background, Eudora will not deliver the mail until you stop typing for the amount 
of time indicated here. If you set the time for 5 seconds, Eudora delivers your mail if you stop typing for at least 5 
seconds. This field is beneficial if you don’t want to be interrupted too frequently while using Eudora. If the number 
is large in this field, you’ll get fewer interruptions. 



Bring error window to front

Check this option to have the Task Error window brought to the front when an error occurs.



Bring task status window to front

Check this option to have the Task Status window brought to the front when a task occurs, for example sending or 
receiving mail.



Have Eudora connect using Dial-up networking

If this is selected, the specified dialup connection (referred to in Windows NT as a "phonebook entry") is used when 
Eudora does any network operation. This option is available only if you have installed the dial-up networking 
services with Windows 95, 98, 2000, ME, or Windows NT 4.x.



Hang up after receiving and sending

If this is selected, the connection terminates each time mail is fetched and sent. 



Close connection on Exit

If this is selected, the phone connection terminates when you exit Eudora.



Edit

Select to edit the current entry displayed in the Entry field box. For example, you would edit phone number, etc. 



New

Select to create a new dial-up networking entry. See your Windows manual for information on creating a dial-up 
networking entry.



Show Text Symbols

If this is on, invisible text symbols, such as carriage returns, tabs, spaces, etc. appear in the message, You can see 
these symbols only in your composition window. They do not appear in the message you send.



Auto Configure

Eudora needs just a few pieces of information in order for you to send and receive mail. Normally you enter this 
information in the first few windows of the Options windows, but if you like, you can use the Auto Configure options 
to retrieve these basic settings from an ACAP server. Your email administrator can let you know if such a server is 
available to you. ACAP, which stands for "Application Configuration Access Protocol," is a communications protocol 
that lets email and other applications store setup data on and retrieve it from a central server.



Automation

The Automation options let you control and exchange information with Eudora from other programs that support the 
Windows Automation Interface, such as Microsoft Visual Basic.

Automation gives you external access to Eudora mail folders, mailboxes, and messages, and to the Eudora 
application itself. With automation enabled, you can create, delete, and move Eudora mail folders, mailboxes, and 
messages, as well as get notification of these three operations when they are performed manually. You can also get 
lists of the subfolders under folders and of the messages within mailboxes.

For more information on the automation feature, visit the Web site www.eudora.com, where you can find up-to-date 
automation SDKs (Software Developer’s Kits) and documentation.



Background Tasks (tasks columns)

These options determine which columns are displayed in the Task Status window. Check the box next to the field 
whose column you want to display. The options are Task, Persona, Status, Details, and Progress.



Checking Mail

The Checking Mail Options determine how Eudora checks for and receives incoming mail messages sent to your 
principal email account; that is your dominant personality.



Date Display

The Date Display Options determine how message dates are displayed in the Date column of mailbox window 
message summaries.



Extra Warnings

The Extra Warnings options determine whether you are warned before making a possible mistake. Most of the 
warnings are displayed with an option to stop that warning from being displayed again. You can toggle warnings to 
be either on or off.



Fonts (message)

These fields list the proportional and fixed-width fonts to be used for displaying the text in your received and 
composition messages and in the message preview pane in mailbox windows. Also included are the size of each 
font and the use of proportional or fixed-width font by default.



Fonts (printer)

These fields list the font and size to be used when printing any text from Eudora using the Print... command—
messages, text files, signature files, etc.



Kerberos

These options control the Kerberos authentication system. If your network uses Kerberos for authentication, the 
appropriate options are provided by your email administrator.



Kerberos (service name)

1% to stand for the service name entered in the Service name field.



Kerberos (POP server)

2% to stand for the full domain name of the POP host.



Kerberos (realm)

3% to stand for the realm entered in the Realm field.



Kerberos (host name)

4% to stand for the name of the POP host.



Labels

The Labels options determine the title and color of the seven labels that can be used to categorize messages.



Mailboxes (show columns)

These options determine which columns are displayed in mailbox windows. Turn on an option to display that column 
in all mailbox windows. The options are Status, Priority, Attachment, Label, Sender, Date, Size, Server status, and 
Subject.



Mailboxes (dragging messages)

These options determine how you can move messages from one mailbox to another.



Miscellaneous

The Miscellaneous options determine additional Eudora capabilities that are not categorized with other functions.



Check Spelling (preferences)

These settings determine how you will    use the spell checker in Eudora.



Viewing Mail (Message prefs)

These options determine how Eudora displays received and composition messages.



Viewing Mail (preview pane)

These options determine the visibility and behavior of the message preview pane that appears at the bottom of 
mailbox windows. 



Background Tasks (time)

If Eudora is retrieving mail automatically in the background, the amount of time set in this field indicates the idle time 
Eudora waits before delivering mail to your mailboxes and folders. For example, if you are composing a message 
and Eudora is retrieving mail in the background, Eudora will not deliver the mail until you stop typing for the amount 
of time indicated here. If you set the time for 5 seconds, Eudora delivers your mail if you stop typing for at least 5 
seconds. This field is beneficial if you don’t want to be interrupted too frequently while using Eudora. If the number 
is large in this field, you’ll get fewer interruptions. 



Include signature on reply

If you select this option, your default signature will be included in all of your replies automatically.



Send the signature with styles

If you select this option, your signature with styled text is sent with a message that has no styled text. If this is 
deselected, then the signature is sent but the styles are removed.

Note. If selected, the signature becomes one with the message. However, if an attachment is 
included with you message, this option turns off. 



Automatically as you type

Turn this on when if you want to use the automatic spell checker. Misspelled words are highlighted automatically. 



Only when requested

Turn this on when you don’t want to use the automatic spell checker but would rather check your spelling all at 
once.



Address Book (auto-completion)

Select to auto-complete nicknames you’ve previously set up in your address book in the To:, Cc:, and Bcc: fields in 
the message header. Deselect to not display nicknames from your address book in the drop-down name list.



History File (auto-completion)

Select to auto-complete names from your history file in the To:, Cc:, and Bcc: fields in the message header. 
Deselect to not display names and email addresses from your history file in the drop-down name list. 

The history file consists of names and email addresses that appear in the To: and Cc:, fields in the messages you 
send, reply to, or forward. 



Use drop down list for completion choices

Select to display the drop-down name list when you begin to type a name in the To:, Cc:, or Bcc: fields. Deselect to 
not display the drop-down name list.



Names should appear in alphabetical order

Select to display names in the drop-down list in alphabetical order. Deselect to display names non-consecutively.



Add the from lines of replied-to messages

Select to add the name appearing in the From: field from a received message that you replied to. This name and 
email address goes into your history file. 



Time to wait before popping up - Auto-completion box (Milliseconds)

Enter the number of milliseconds you want Eudora to wait before displaying the window containing the address 
book and history file choice entries. The larger the number you enter, the longer the wait. If you enter 0, the window 
will display immediately. 



Maximum entries to keep in history

Enter the number of names you want to keep in your history file at any given time. As you add names, the old 
entries are removed leaving the amount of names to equal the number entered here.



Auto-save messages every _ minutes

Enter the number of minutes between auto-save intervals. In case of a system shut-down, the messages saved are 
from the most current auto-save file.



Allow authentication

Eudora can log in to an SMTP server when sending mail, just like it does for receiving mail. Not all SMTP servers 
require or allow such authentication. Eudora will attempt authentication to servers that allow it. The preferred SMTP 
authentication method is CRAM-MD5. If CRAM-MD5 is not available, LOGIN or PLAIN will automatically be used. 



Don't check without a network connection

If you select this option, Eudora will not attempt to retrieve mail unless you are connected to a network. 



Enable MoodWatch

If checked, Mood Watch is on. To turn Mood Watch off, just uncheck the box.



Warn when queueing a message (MoodWatch)

Below are three levels of warnings when Mood Watch detects any offensive text in your message. If there is no 
offensive language in your message, an ice cube appears near the Send button.



If the message seems like it might be offensive (MoodWatch)

Turn this option on to set Mood Watch to its most sensitive level. If your message has some content that looks like it 
might be offensive (one chili pepper appearing), you will be warned when you queue it.



If the message is probably offensive (MoodWatch)

Turn this option on to set Mood Watch to a medium sensitivity level. If your message has some content that looks 
like it is offensive (two chili peppers appearing), you will be warned when you queue it.



If the message is on fire (MoodWatch]

Turn this option on to set Mood Watch to a low sensitivity level. If your message has some content that is offensive 
(three chili peppers appearing), you will be warned when you queue it.



Never (MoodWatch)

Turn this option on to never display a warning in your outgoing messages, despite offensive text in its content.



Include original text (MoodWatch)

Turn this option on if you want MoodWatch to scan the original text of a message for offensive language when 
replying.



Scan Incoming Mail (MoodWatch)

Turn this option on to allow Mood Watch to scan all of your incoming mail. Mood Watch determines the level of 
offensive text contained in the message. Mood Watch then displays one, two, or three chili peppers in the Mood 
Watch column of the mailbox where the message resides.



Scan stored mail in the background (MoodWatch)

Turn this option on to allow MoodWatch to scan all of your stored messages. MoodWatch determines the level of 
offensive text contained in each message. MoodWatch then displays one, two, or three chili peppers in the 
MoodWatch column of the mailbox where the message resides.



Series (in statistics options window)

This column lists the different timeframes displayed in the Statistics window. Current refers to the current day, week, 
month, or year, as selected in the Statistics window. Previous refers to the previous day, week, month, or year, as 
selected in the Statistics window. Average is the cumulative average that occurs on a day-to-day basis. For 
example, if you choose to view your statistics for each day, the current graph would be today, and the previous 
graph would be yesterday. The average graph would indicate the cumulative average since you began keeping 
statistical information in Eudora.



Color (in statistics options window)

Choose the color you wish to represent the Current, Previous, and Average criteria.



Reset Statistics button (in the statistical options window)

Click this button to reset your statistical usage. All historical information on your Eudora usage is deleted. 
Statistical information will then begin from that moment on. 



Graph Type (in statistics options window)

Choose the graph type you prefer to display for the current, previous, and average criteria. The graph type you 
choose will appear in the color you chose in the Color column. The graph types you can choose are a line, a solid 
(filled) area, a graph bar, a circle, diamond, or a square.



Count IMAP messages in Inbox only (in statistics options window)

Turn this option on if you want Eudora, for statistical purposes, to count only the IMAP messages received in the 
Inbox. Turn this option off if you want Eudora to count all received IMAP messages regardless of which mailbox they 
are received into. 



Show signature when composing (Composing Mail)

If this is selected, you will see the signature you have previously set up in the message composition window. If off, 
you will not see the signature.



Plug-in Addresses (Auto-completion)

Select this option to make available the email addresses stored elsewhere in Eudora, for example in ESP.



Warn on Automation auto-send of messages

If this option is selected, a warning will appear if any message is sent automatically. For example, if you have a 
message set to be sent a certain time, a warning appears just before the message is sent. Another advantage is 
that if a virus ever tries to replicate itself using your address book entries, this warning will appear.



Secure Sockets when Receiving

The following are the SSL options when receiving mail.

Never— Do not use SSL for server authentication and mail transfer security, even if SSL is available on the 
server. 

If Available STARTTLS (default)— Use SSL for server authentication and mail transfer security by having 
Eudora automatically invoke the STARTTLS command method to start SSL, that is, if the server supports 
STARTTLS. If your server doesn’t support STARTTLS, mail transfers will occur successfully, but they will not 
be secured with SSL.

Required, Alternate Port— Use SSL for server authentication and mail transfer security by having Eudora 
automatically use the older style alternate port method for starting SSL. If your server does not support SSL 
on the appropriate ports, mail transfers will fail. 

Required STARTTLS— Use SSL for server authentication and mail transfer security by having Eudora 
automatically invoke the STARTTLS command method to start SSL. If your server does not support 
STARTTLS, mail transfers will fail. 

Important. If you use SSL and cannot make a connection when receiving or sending mail, you may 
need to check with your ISP to update any invalid SSL certificates. However, to override any 
issues with SSL when retrieving or sending mail, choose Never from the drop-down menu to 
make a successful connection.



Secure Sockets when Sending

The following are the SSL options when sending mail:

Never— Do not use SSL for server authentication and mail transfer security, even if SSL is available on the 
server. 

If Available STARTTLS (default)— Use SSL for server authentication and mail transfer security by having 
Eudora automatically invoke the STARTTLS command method to start SSL, that is, if the server supports 
STARTTLS. If your server doesn’t support STARTTLS, mail transfers will occur successfully, but they will not 
be secured with SSL.

Required, Alternate Port— Use SSL for server authentication and mail transfer security by having Eudora 
automatically use the older style alternate port method for starting SSL. If your server does not support SSL 
on the appropriate ports, mail transfers will fail. 

Required STARTTLS— Use SSL for server authentication and mail transfer security by having Eudora 
automatically invoke the STARTTLS command method to start SSL. If your server does not support 
STARTTLS, mail transfers will fail. 

Important. If you use SSL and cannot make a connection when receiving or sending mail, you may 
need to check with your ISP to update any invalid SSL certificates. However, to override any 
issues with SSL when retrieving or sending mail, choose Never from the drop-down menu to 
make a successful connection.



Secure Sockets when Sending or Receiving

The following are the SSL options when sending or receiving mail:

Never— Do not use SSL for server authentication and mail transfer security, even if SSL is available on the 
server. 

If Available STARTTLS (default)— Use SSL for server authentication and mail transfer security by having 
Eudora automatically invoke the STARTTLS command method to start SSL, that is, if the server supports 
STARTTLS. If your server doesn’t support STARTTLS, mail transfers will occur successfully, but they will not 
be secured with SSL.

Required, Alternate Port— Use SSL for server authentication and mail transfer security by having Eudora 
automatically use the older style alternate port method for starting SSL. If your server does not support SSL 
on the appropriate ports, mail transfers will fail. 

Required STARTTLS— Use SSL for server authentication and mail transfer security by having Eudora 
automatically invoke the STARTTLS command method to start SSL. If your server does not support 
STARTTLS, mail transfers will fail. 

Important. If you use SSL and cannot make a connection when receiving or sending mail, you may 
need to check with your ISP to update any invalid SSL certificates. However, to override any 
issues with SSL when retrieving or sending mail, choose Never from the drop-down menu to 
make a successful connection.



Last SSL Info

To display the most current information for an SSL connection between a server and Eudora since the last time you 
started Eudora, click Last SSL info. The Eudora SSL Connection Information Manager window appears with SLL 
and certificate information. 

Caution: If you display the SSL information windows, make certain you don’t change any of the field 
information unless you are familiar with SSL.



Message seems it might be offensive

Turn this option on to delay a message to be sent when MoodWatch is at its most sensitive level. If your message 
has some content that looks like it might be offensive (one chili pepper or more appearing), your message will sit in 
your Out box for ten minutes before Eudora sends it.



Message is probably offensive

Turn this option on to set MoodWatch to a medium sensitivity level. If your message has some content that looks 
like it is offensive (two chili peppers or more appearing), your message will sit in your Out box for ten minutes before 
Eudora sends it.



Message is on fire

Turn this option on to set MoodWatch to a low sensitivity level. If your message has some content that is offensive 
(three chili peppers appearing), your message will sit in your Out box for ten minutes before Eudora sends it.



Receive MIME digest as a mailbox attachment

Turn this on if you want Eudora to create a mailbox specifically for email messages from a mailing list that supports 
MIME digest.



Automatically download HTML graphics

Turn this option on to receive email messages with embedded web images. Eudora retrieves the images from the 
World Wide Web.



Launch a program externally

If this is selected, you are warned if you try to launch an attachment or program outside of Eudora, for example 
directly from the Attachments directory or from a Eudora Sharing Protocol (ESP) directory. For security reasons, you 
should never launch a program without performing a virus check on the file. Do not launch any program or open an 
attachment if you do not know sender. Some viruses can infect a file without your knowing it. It is always good to 
perform regular virus checks using a current virus checking program.



Never

Turn this option on to never delay your outgoing messages being sent, despite offensive text in its content.



Mark it as deleted

Select this option to mark your messages on the IMAP for deletion. These messages are not removed from the 
server until you choose to remove them.



Move it to (mailbox)

Select this option to move your deleted messages to a specific mailbox. The default is your Trash mailbox.



Quote only the selected text

If this is selected, only the text you highlight in a received message will appear on the reply message.



Show Mailbox Columns: MoodWatch

If this is checked, the MoodWatch column appears in Mailbox windows.



Don't auto-complete, just list matches

Turn this option on if you don’t want Eudora to auto-complete your email address as you type it. If you choose this 
option, you need to just type one letter, and all email addresses that start with that letter from your address book 
and history list appear in the drop-down name list for you to choose from.



Warn on MAPI auto send of messages

Turn this on to get a security warning when you receive messages that are automatically sent from other 
applications through MAPI. 



Kerberos Authentication (ON)

Choose ON to turn on Kerberos 5 to authenticate the POP, IMAP, and SMTP protocols. 



Kerberos Authentication (OFF)

Choose OFF to turn off Kerberos 5.



Kerberos 4 (POP only) ON

Choose ON to turn on Kerberos 4 to authenticate the POP protocol only.



Kerberos 4 (POP only) OFF

Choose OFF to turn off Kerberos 4.
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